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Warranty
Danware Data A/S warrants the quality of the physical material of the user package, that is manual and 
CD-ROM. If these items are defective, we will exchange them at no cost within 60 days of purchase from 
Danware Data.

Disclaimer
Danware Data A/S denies any and all responsibility for damages caused directly or indirectly as a result 
of any faults with the enclosed programs and/or documentation.

License
Danware Data A/S retains the copyright to the user manual. All patent, copyright and other proprietary 
rights in and to the programs will remain with Danware Data A/S or its licensers.

Your purchase gives you the right to copy and use the programs as described on your Danware License 
Certificate included in your package.

Please save your Danware License Certificate and your original CD-ROM. They serve as your legal right 
to use the software. You may also need them in order to receive future updates to the product.

Please be careful not to install or run the software on more PCs than your Danware License Certificates 
permits you to do.

The programs may be copied for backup purposes only, and only as long as the above mentioned rules are 
adhered to.

Trademarks
NetOp® and the red kite are registered trademarks of Danware Data A/S. All other products mentioned in 
this manual are trademarks of their respective manufacturers.
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1.1 Welcome
1.1 Welcome
Welcome to NetOp Remote Control, the remote control software from Danware.
We hope that this product will meet your requirements and fulfill your expectations.
If you encounter problems using this product, first consult with its manuals and help systems.
Additional troubleshooting guidance is available from the NetOp KnowledgeBase that can be searched 
for detailed technical information.
The local supplier of your NetOp product is available for advising you on how to obtain maximum 
benefit from it.
As a last resort, submit a support request to NetOp Customer & Product Support. We will endeavour to 
get back to you as soon as possible with a solution to your problem.
NetOp Customer & Product Support
This chapter includes these sections:
• Features
• Documentation
• Updates
• Compatibility
• Common Controls

1.2 Features
NetOp Remote Control includes these modules:
• NetOp Guest: Enables the computer user to remote control and interact in other ways with another 

computer running NetOp Host or an extended NetOp Host.
• NetOp Host: Enables the computer to be remote controlled and interacted with in other ways from a 

computer running NetOp Guest.
• NetOp Security Server: Extended NetOp Host that can manage Guest access security for multiple 

Hosts.
• NetOp Gateway: Extended NetOp Host that can route NetOp traffic between different 

communication devices.
• NetOp Name Server: Extended NetOp Host that can connect NetOp modules across segmented 

networks.
NetOp Remote Control features include:
• Remote Control
• Other Interaction
• Security
• Operating Systems
• Communication Devices
1.2.1 Remote Control
NetOp Guest can run a Remote Control session with one or multiple NetOp Hosts to display the Host 
computer screen image to enable the Guest user to work with keyboard and mouse on Host computers 
and control them in different ways.
NetOp Host can be remote controlled by one NetOp Guest. NetOp Host can allow multiple simultaneous 
Guest connections to enable a multi Guest session in which one connected Guest has keyboard and mouse 
control while other connected Guests have limited access to the Host computer.
14

http://support.netop.com


1 Introduction
1.2.2 Other Interaction
NetOp Guest can run a File Transfer session with one or multiple NetOp Hosts to transfer and manage 
files and directories. If NetOp Host allows multiple Guest connections, multiple Guests can run separate 
File Transfer sessions with it at the same time.
NetOp Guest can run a Chat session with one or multiple NetOp Hosts to communicate by typed text. If 
NetOp Host allows multiple Guest connections, multiple Guests can join in a multi Chat session with one 
Host. NetOp Host can start a Chat session with one or multiple connected Guests.
One NetOp Guest and one NetOp Host can run an Audio-Video Chat session to communicate by sound 
and live image. NetOp Host can start an Audio-Video Chat session only with a connected Guest that has 
keyboard and mouse control.
NetOp Guest can run a Remote Management session with one or multiple NetOp Hosts to manage Host 
computers. If NetOp Host allows multiple Guest connections, multiple Guests can run separate Remote 
Management sessions with it at the same time.
NetOp Guest can run a specified program on a NetOp Host computer, see Run Program.
NetOp Guest can execute a system control command on a NetOp Host computer, see Execute Command.
NetOp Guest can send a NetOp Message to NetOp Host.
NetOp Guest can Monitor multiple NetOp Hosts to sequentially display their computer screen image.
NetOp Guest can get the hardware and software inventory of a NetOp Host computer, see Get Inventory.
NetOp Host and extended Hosts can Request Help from a NetOp Guest that offers help services.
1.2.3 Security
You can protect NetOp Guest and NetOp Host and extended Host setup by a Maintenance Password.
NetOp Host and extended Host Guest Access Security can protect against unauthorized NetOp Guest 
access and actions:
• The Guest Access Privileges Tab specifies the Guest authentication method and local security roles. 

Use NetOp Security Server uses centralized security information.
• The Guest Policy Tab specifies Guest access security policies.
• The MAC/IP Address List Setup Tab can limit Guest access to specified Guest addresses.
The communication between modules is protected by encryption, see Encryption Tab.
All NetOp Remote Control modules can log NetOp events locally and centrally in a NetOp Log.
15



1.2 Features
1.2.4 Operating Systems
NetOp Remote Control supports a wide range of operating systems. These features are available with 
each operating system:

* Host only. ** With a NetOp product other than NetOp Remote Control version 9.0.
NetOp products running on different operating systems can interact with only few exceptions and 
limitations.
1.2.5 Communication Devices
NetOp Remote Control modules communicate by Communication Devices. These communication 
devices are available on NetOp modules running on computers using different operating systems:

*On terminal server modules only. **DOS to DOS only.

  Operating Systems
Features

Windows ActiveX Windows CE 
**

Linux Solaris Mac OS X Symbian OS OS/2 DOS

Modules:
Guest z z z z z z** z** z**
Host z z z z z z z

Security Server z z**
Gateway z z**
Name Server z

Sessions:
Remote Control z z z z z z z z z

File Transfer z z* z z z z z**
Chat z z* z* z* z z z

Audio-Video Chat z

Remote Management z

Actions:
Run Program z

Execute Command z

NetOp Message z

Monitor z

Get Inventory z

Request Help (Host) z z

Help Services (Guest) z z**

Comm. Devices
Operating systems

NetBIOS IPX ISDN 
(CAPI)

Windows 
modem

Serial 
modem

TCP/IP TCP/IP 
(TCP)

Gate-
way

Infra-
red

Terminal 
Server

Windows Server 2003 z z z z z z z z z z*
Windows XP z z z z z z z z z

Windows 2000 z z z z z z z z z z*
Windows NT 4.0 z z z z z z z z z*
Windows ME/98SE z z z z z z z z z

ActiveX z z

Windows CE z z

Linux z z

Solaris z z

Mac OS X z z

Symbian OS z

OS/2 z z z z z z

DOS z z z** z**
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1.3 Documentation
NetOp Remote Control comes with a Quick Guide, two manuals and three help systems.
The Quick Guide in English is included as a booklet in the CD box when buying or upgrading NetOp 
Remote Control. The Quick Guide in the languages in which NetOp Remote Control is available is 
included as Portable Document (PDF) files on the NetOp Remote Control CD. It contains startup 
information enabling installing and starting to use NetOp Remote Control.
This User’s Manual that is available in the languages in which NetOp Remote Control is available is 
included as PDF files on the NetOp Remote Control CD. It contains these chapters:
• 1 Introduction: Explains NetOp Remote Control features, documentation, updates, compatibility 

and common controls.
• 2 Installation: Explains how to install NetOp Remote Control.
• 3 NetOp Guest: Explains the functionality of NetOp Guest.
• 4 NetOp Host: Explains the functionality of NetOp Host.
• 5 Common Tools: Explains tools that are common to all NetOp Remote Control modules.
The Administrator’s Manual that is available only in English is included as a PDF file on the NetOp 
Remote Control CD. It contains these chapters:
• 1 NetOp Security Management: Explains the functionality of NetOp Security Manager and NetOp 

Security Server.
• 2 NetOp Gateway: Explains the functionality of NetOp Gateway.
• 3 NetOp Name Management: Explains the functionality of NetOp Name Server.
• 4 Advanced Tools: Explains advanced NetOp Remote Control tools.
• 5 Other Operating Systems: Explains the installation and particulars of NetOp Remote Control for 

Linux, Solaris, Mac OS X, OS/2 and DOS.

Note: Manuals are also available from the NetOp KnowledgeBase.

NetOp Guest Help that is available from NetOp Guest (Windows, Linux and Solaris) in the language in 
which it is installed includes these sections:
• Introduction: Explains NetOp Remote Control features, documentation, updates, compatibility and 

common controls.
• Installation: Explains how to install NetOp Remote Control.
• NetOp Guest: Explains the functionality of NetOp Guest.
• Common Tools: Explains tools that are common to all NetOp Remote Control modules.
NetOp Host Help that is available from NetOp Host, NetOp Security Manager, NetOp Security Server, 
NetOp Gateway and NetOp Name Server (Windows) in the language in which it is installed includes 
these sections:
• Introduction: Explains NetOp Remote Control features, documentation, updates, compatibility and 

common controls.
• Installation: Explains how to install NetOp Remote Control.
• NetOp Host: Explains the functionality of NetOp Host.
• Common Tools: Explains tools that are common to all NetOp Remote Control modules.
NDU Help that is available from NetOp Deployment Utility in English explains the functionality of 
NetOp Deployment Utility.
Help system sections contain the same information as the matching manual chapters.

Note: You cannot expect the documentation to be updated with the most recent product updates. Look for 
update information in the ReadMe.txt file that will be updated with major updates.
17
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1.4 Updates
1.3.1 How to Use NetOp Documentation
We recommend first-time NetOp users to read the Quick Guide and then make a test installation and try 
it out using the Help system for guidance.
We recommend experienced NetOp users to review the User’s Manual or Help system Introduction 
chapter/section Features section to get up to date with available features.
Read detailed explanations only when needed to clarify the product functionality.
1.3.2 Typographical Conventions
These typographical conventions are used in the documentation:
• Italics text represents screen text.
• SMALL CAPS text represents keyboard keys (+ indicates that keys must be pressed at the same time).
• Lucida Console font text represents keyboard entries.
• In the Adobe Reader display of PDF files and in Help systems, colored underlined text is a jump 

hotspot. Click the hotspot to jump to the section or topic that explains the underlined text subject.
• [Square brackets] are used around optional entries.
• <Angle brackets> are used around content descriptions.
1.3.3 Standard Buttons
These standard window buttons will be explained in the documentation only if their functionality deviates 
from their standard functionality:
• OK: Click this button to close a window to apply window selections.
• Cancel: Click this button to close a window without applying window selections.
• Help: Click this button to open the Help system on the topic that explains the window content.

1.4 Updates
NetOp products will be improved from time to time through the release of updated builds.
To identify the build of an installed NetOp product, select the Help menu About... command to display 
the About... window. The build number in the format YYYYDDD (Y=year number digit, D=day number 
digit) will be displayed in parentheses next to the version number.
To ensure that your NetOp product is up to the current standard, the most recently released build should 
always be installed.
To update automatically in Windows, enable the Web Update functionality, see Web Update Tab.
To update manually, in the NetOp KnowledgeBase select Download Products to display available 
downloads. If your installed product version is available with a higher build number, you should 
download and install it. Installation requires valid license numbers. Products with the same version 
number down to the first decimal use the same license numbers.
The ReadMe.txt file installed with an update will contain update information.
18
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1 Introduction
1.5 Compatibility
This table provides an overview of older NetOp remote control products and their compatibility with 
NetOp Remote Control version 9.0.

Product Version Language Latest build Version 9.0 compatibility
NetOp Remote Control 
(Language column 
languages apply to the 
Windows version. Other 
operating system versions 
are available in English 
only)

8.0 English
French
German
Italian
Japanese
Portuguese
Spanish

2005271 Full. Added functionalities in newer versions are 
typically not available in older versions.

7.65 English
French
German
Italian
Japanese
Portuguese
Spanish

2004342

7.6 English
French
German
Italian
Japanese
Portuguese
Spanish

2003246

7.5 English
French
German
Italian
Japanese
Portuguese
Spanish

2003048

7.0 English
French
German
Italian
Japanese
Portuguese
Spanish

2002291

6.5 English
French
German
Spanish

2002063

6.0 English
French
German
Spanish

1999309

NetOp for Windows 5.4 English 1998315 Full. Added functionalities in newer versions are 
typically not available in older versions.5.3 English 22497

NetOp for OS/2 6.5 English 2002063 Full. Added functionalities in newer versions are 
typically not available in older versions.5.4 English 1999322

5.3 English 30197
NetOp for DOS (Network) 4.3 English - NetBIOS and IPX only
NetOp for DOS (Modem) 1.01 English - No
NetOp for DOS (ISDN) 1.03 English - No
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1.6 Common Controls
1.6 Common Controls
This section explains the controls of common elements in the NetOp Remote Control user interface. It 
section includes these sections:
• Window Control
• Menu and Toolbar Control
• Table Control
1.6.1 Window Control
Windows with an icon at the title bar left end share these window controls:
Click the title bar left icon, right-click anywhere in the title bar or press ALT+SPACE to display this 
standard window control menu:

Restore: Select this command or click the matching title bar right end button to restore a maximized or 
minimized window to its normal size.
Move: Select this command to display an arrow-pointed +. Press the keyboard arrow buttons to move the 
window. Press ENTER to end the operation.

Note: Typically, move a window by dragging its title bar.

Size: Select this command to display an arrow-pointed +. Press the keyboard arrow buttons to display a 
double arrow at a window edge and move the window edge to resize the window. Press ENTER to end the 
operation.

Note: Typically, resize a window by dragging its edges or corners.

Minimize: Select this command or click the matching title bar right end button to minimize the window. 
The window can minimize into a taskbar button or a notification area button or if inside a window work 
panel into a minimized window typically in the lower left corner of the work panel. Click a taskbar 
minimized window button or double-click a notification area minimized window button to restore the 
window.
Maximize: Select this command or click the matching title bar right end button to maximize the window.
Close: Select this command, click the matching title bar right end button, press ALT+F4 or double-click 
the title bar icon to close the window without applying window selections. If the window represents a 
loaded program, the program will be unloaded.
1.6.2 Menu and Toolbar Control
Enabled menu commands appear as black text. Menu commands that are disabled with the current 
selection appear as gray text. If the window is active, place the mouse pointer on a command to display a 
hint in the status bar. Commands switching a status On/Off can display a checkmark or an icon. If 
checkmarked or if the icon appears pressed in, the status is On and selecting the command will switch the 
status Off. Executing a command closes the menu.
Drag the left end of a toolbar to move it from its default position below the menu bar to place it along 
another edge of the window below the menu bar and above the status bar or anywhere outside the 
window.
Enabled toolbar buttons appear in color. Toolbar buttons that are disabled with the current selection 
appear gray. If the window is active, place the mouse pointer on a toolbar button to display a tooltip with 
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1 Introduction
the button name and a hint in the status bar. A toolbar button switching a status On/Off can appear pressed 
in. If appearing pressed in, the status is On and clicking the button will switch the status Off.
1.6.3 Table Control
Typically, these controls are available with tables in window panes:
Resize the pane by resizing the window by dragging its borders. Change the width of a column by 
dragging the right border of its heading. Sort records (ascending/descending) by any column by clicking 
the column heading. If table content extend beyond the pane, it will have scrollbars.
Click a record to select and highlight it. Click a record and while pressing SHIFT click another record to 
select and highlight both records and records in between. Click a record and while pressing CTRL click 
other records to select and highlight clicked records.
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2.1 Summary
2.1 Summary
This chapter explains how to install NetOp Remote Control on a computer running on a Windows 
operating system.

Note: Installing NetOp Remote Control on other operating systems is explained in the Administrator’s 
Manual Other Operating Systems chapter.

It contains these main sections:
• Box Content
• Requirements
• Install
• Install Alternatives

2.2 Box Content
When buying a licensed version of NetOp Remote Control, the box will contains a NetOp Remote 
Control CD, a Quick Guide booklet, a license certificate and a registration card.
The NetOp Remote Control CD contains available language versions of NetOp Remote Control 
programs, documentation and additional resources.
The Quick Guide booklet contains an installation and startup guide.
The license certificate specifies which NetOp Remote Control modules are licensed and which license 
numbers must be specified when installing. The license certificate should be kept in a safe place as proof 
of license. License numbers are unique to the licensed product and specify which number of licensed 
modules can run at the same time.
Register your NetOp software using the registration card or online via the NetOp Product Registration 
website. This may prove useful if you lose your license certificate or if you want to upgrade to a newer 
version.

2.3 Requirements
To install and use NetOp Remote Control on a computer running on a Microsoft Windows operating 
system, these system requirements apply:

Note: To install NetOp Remote Control on a Windows 2003, XP, 2000 or NT computer, the user must 
have administrator rights.

Before installing, read the ReadMe.txt file that resides in the root directory of the NetOp Remote Control 
CD. This file contains important general information and may contain update information that was not 
available when the documentation was last edited.

Computer Intel Pentium processor or higher, or 100% compatible.
Memory Guest: OS requirement plus additional 16 MB (32 MB or more recommended).

Other modules: OS requirement plus additional 12 MB (16 MB recommended).
Platform Windows Server 2003 Standard, Enterprise, Web Edition.

Windows XP Professional, Tablet PC Edition, Home Edition.
Windows 2000 Server, Advanced Server.
Windows 2000 Terminal Services.
Windows 2000 Professional.
Windows NT 4.0 Terminal Server (SP4).
Windows NT Server 4.0 (SP4).
Windows NT Workstation 4.0 (SP4).
Windows ME, 98, 95.
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2 Installation
2.4 Install
Insert the NetOp Remote Control CD into the computer CD drive to display a window with language 
buttons.

Note: If the window with language buttons does not display automatically, double-click SETUP.EXE in 
the CD root directory to display it.

Click English to display this window:

Click Install <Module name> to install the module using Windows Installer. This will enable you to 
exclude installing subfeatures that you do not need.
Click Other Installation Options and click InstallShield to install NetOp Remote Control using 
Traditional InstallShield.

Note: You can install only modules for which you have a license.
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2.4 Install
2.4.1 Windows Installer
Starting a Windows Installer installation, this window will be displayed:
Welcome

Click Next > to display this window:
26



2 Installation
Read the license agreement in the scrolling pane. Select I accept the terms in the license agreement to 
enable the Next > button. Click Next > to display this window:

Fill in the fields:
User name: []: Specify the user name.
Organization: []: Specify the licensee name.
Serial number: []: Specify the license number.

Note: If you specify an invalid license number, you will be notified after clicking Next > to correct your 
mistake.
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2.4 Install
Click Next > to display this window:

Select Typical or Complete to install all program features and click Next > to display the Windows 
Firewall Configuration window.
Select Custom and click Next > to display this window:
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2 Installation
Custom Setup

In this window, you can exclude installing subfeatures that you do not need. By default, all subfeatures 
will be installed: Select a subfeature to exclude/include it. This table explains available subfeatures:

Note: Re-run the setup wizard to change the subfeature selection, see Change or Remove.

Click Reset to restore the original selection.

Subfeature
Available on module:

Functionality
Guest Host Security 

Server
Gateway Name 

Server

Remote Management Enables Remote Management z z z z z

Web Update Enables Web Update z z z z z

Utilities Enables unhiding module z z z z z

Media files Includes sound and animation files z z z z z

Help system Includes help system z z z z z

Readme file Includes Readme file z z z z z

Script and code examples Includes script and code examples z

SNMP logging Enables SNMP logging z z z z z

Remote printing Enables remote printing z z z z z

ActiveX component Enables ActiveX scripting z

Marker mode Enables NetOp Marker z z z z

Advanced feature driver Enables remote control commands z z z z

Command mode transfer Enables command mode screen transfer z z z z

Security Manager Installs NetOp Security Manager z

Code examples Includes security code examples z
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2.4 Install
Click Disk Usage to display this window:

This window that displays the designation, total and available disk space of available disk drive volumes 
will indicate the disk space requirements of the selected installation. Click OK to close the window.
Click Browse to display this window:
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2 Installation
This window displays the folder, content of directory folders and path of the selected installation 
directory. Click the drop-down box button to display available directories. From the buttons, you can 
move up in the directory structure and create a directory. Select a directory folder to display its path and 
click OK to apply the selection.
When satisfied with the selection in the Custom Setup window, click Next > to display this window:
Windows Firewall Configuration

Leave the box checked to modify the Windows firewall configuration to enable NetOp communication. 
Click Next > to display this window:
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2.4 Install
Ready to Install

Click Install to start the installation. When completed, this window will be displayed:

Leave the box checked to load the module after installation. Click Finish to end the setup wizard.
32



2 Installation
2.4.1.1 Change or Remove
You can change or remove a Windows Installer program installation from Start > (Settings >) Control 
Panel > Add or Remove Programs or by re-running the setup wizard.
In the Add or Remove Programs window, for the installed program click Change or re-run the setup 
wizard to display the Welcome window. Click Next > to display this window:

Click Modify to display the Custom Setup window to change selections and complete installation like a 
Windows Installer.
Click Repair to display a Repair NetOp Remote Control... window like the Ready to Install window to 
complete re-installation like a Windows Installer.

Note: To Modify or Repair, installation files must be available.

Click Remove to display a Remove NetOp Remote Control... window like the Ready to Install window to 
complete removal like a Windows Installer.
In the Add or Remove Programs window, for the installed program click Remove to remove the program 
in a small window.

Note: Change or remove will not affect user configuration files, see NetOp Configuration Files.
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2.4 Install
2.4.2 Traditional InstallShield
Starting a traditional InstallShield installation, this window will be displayed:

Click Next > to display this window:

Read the license agreement and click Yes to continue.
In a typical installation, the Registration window will be displayed.
If installation files include a LICENSE.DAT file that enables installing Guest and Host at the same time, 
this window will be displayed.
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2 Installation
Select Install Components

To install NetOp Guest and NetOp Host or an extended Host, leave both boxes in the pane checked. 
Uncheck a box to install only the other module.
The Destination Folder section will display the default destination folder path. Click Browse to choose a 
different destination folder in the Windows Choose Folder window.
Space Required and Space Available will display disk space requirement and availability in the directory 
specified in the Destination Folder section. Click Disk Space to display this window:

In this window, you can select another disk drive and diplay available and required disk space on it. 
Click OK to specify the selected drive letter in the Select Install Components window Destination 
folder section.

If the Host Files box is unchecked, click Next > to display the Registration window.
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2.4 Install
If the Host Files box is checked, click Next > to display this window:

Select the type of Host that shall be installed and click Next > to display this window:
Registration

Specify in the Licensed to field the licensee name and in the Serial # field the license number of the 
module that shall be installed.
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2 Installation
Note: If you specify an invalid license number, you will be notified after clicking Next > to correct your 
mistake.
If both boxes were checked in the Select Install Components window, this window will contain Guest 
serial # and Host serial # fields that contain license numbers. Click Next > to display the Update Existing 
Installation window if a previous installation is found on the computer. The options in this window are 
unimportant. Click Next > to display the Select Program Folder window.

Click Next > to display this window:
Choose Destination Location

The Destination Folder section will display the default destination folder path. Click Browse to choose a 
different destination folder in the Windows Choose Folder window.
Click Next > to display the Update Existing Installation window if a previous installation is found on the 
computer. The options in this window are unimportant. Click Next > to display this window:
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2.4 Install
Select Program Folder

Accept the suggested program folder (typically NetOp Remote Control) to place the program command in 
a Start > (All) Programs program folder with this name.
Click Next > to display the Start Copying Files window or this window if Windows Firewall is running 
on the computer:

Leave the box checked to modify Windows Firewall configuration to enable NetOp communication. 
Click Next > to display this window:
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2 Installation
Start Copying Files

The pane will display what was specified in previous windows. Click < Back to return to previous 
windows to change specifications.
Click Next > to start the installation. When the installation has completed, this window will be displayed:

Click Finish to end setup and display a program folder window from which you can load the installed 
module.
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2.5 Install Alternatives
2.4.2.1 Change or Remove
To modify or repair a traditional InstallShield installation, re-run the setup program for the installed 
module or modules. Installation files will be required.
To remove a traditional InstallShield installation, click Start > (Settings >) Control Panel > Add or 
Remove Programs to display the Add or Remove Programs window. For the installed module or modules, 
click Change/Remove and confirm removal to display progress in this window:

When completed, click OK to close the window.

Note: Change or remove will not affect user configuration files, see NetOp Configuration Files.

2.5 Install Alternatives
These alternatives to installing from the NetOp Remote Control CD are available:
• Install from a Directory
• Silent Install
• NetOp Deployment
• Terminal Server
2.5.1 Install from a Directory
To install from a directory, typically on a network drive, copy the content of the CD 
\NRC\WINDOWS\INSTALL.WI\<Language> directory (Windows Installer)  or 
\NRC\WINDOWS\INSTALL\<Language> directory (traditional InstallShield) to the directory.
Select the directory to which installation files are copied and run setup.exe to start installing.
2.5.2 Silent Install
Silent Install enables installing NetOp Remote Control modules and setting up NetOp Host on a 
Windows computer with minimum user intervention, see the Administrator’s Manual Advanced Tools 
chapter Silent Install section.
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2 Installation
2.5.3 NetOp Deployment
NetOp Deployment enables an administrator to install or upgrade NetOp Remote Control modules and 
set up Hosts on multiple remote Windows computers without local user intervention, see the 
Administrator’s Manual Advanced Tools chapter NetOp Deployment section.
2.5.4 Terminal Server
Installing NetOp Remote Control on a terminal server computer requires special precautions, see the 
Administrator’s Manual Advanced Tools chapter NetOp in Terminal Server Environments section.
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3.1 Summary
3.1 Summary
This chapter explains the functionality of NetOp Guest on a computer that runs on a Windows operating 
system. 

Note: NetOp Guest on a computer that runs on a Linux or Solaris operating system has a similar 
functionality. The particulars of NetOp Guest for other operating systems are explained in the 
Administrator’s Manual Other Operating Systems chapter.
NetOp Guest ActiveX component is explained in the Administrator’s Manual Advanced Tools chapter  
NetOp Guest ActiveX Component section.

NetOp Guest enables a computer to remote control and interact with a computer that runs NetOp Host or 
an extended Host (NetOp Security Server, NetOp Gateway or NetOp Name Server, see the matching 
Administrator’s Manual chapters).
This chapter contains these main sections: 
• Load and Unload
• Connect Guide
• Host Security Guide
• NetOp Guest Window
• Guest Tools
• Guest Sessions
• Session Tools
• Guest Actions

3.2 Load and Unload
The installation of NetOp Guest is explained in Installation.
To load NetOp Guest, select Start > (All) Programs > NetOp Remote Control > Guest or the alternative 
Guest program command path specified during installation.
Loading alternatives are explained in Loading Alternatives.
If you load NetOp Guest for the first time, the Setup Wizard will be displayed in front of the NetOp Guest 
window.
If you have loaded NetOp Guest before, the NetOp Guest Window will be displayed.
To unload NetOp Guest, click the Window Control Close button, select the matching Window Control 
command or NetOp Guest Window File Menu Exit command or press ALT+F4.
3.2.1  Loading Alternatives
You can load NetOp Guest by these alternative methods:
1. In the Windows XP Start menu, select Guest if pinned to your Start menu or in your list of most 

frequently used programs.
2. Create a desktop shortcut to NGSTW32.EXE and double-click this shortcut.
3. In the directory where NetOp Guest is installed, typically C:\Program Files\Danware Data\NetOp 

Remote Control\Guest, run (double-click) NGSTW32.EXE.
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3 NetOp Guest
4. In the Windows Run or Command Prompt window, execute a command that specifies the 
NGSTW32.EXE path and file name. To execute certain NetOp Guest actions, you can add any of 
these switches to the command. Insert one space before each switch:

Note: Use the same command structure to load or control NetOp Guest from another application.

Examples
<NetOp Guest program path and file> /E:”C:\Documents and 
Settings\Administrator\Application Data\Danware Data\NetOp Remote 
Control\Guest\PhBook\John.dwc” /R: /M:

Switch Function
/A: Start an Audio-Video Chat session with the connected to 

Host.
/B:<Recording file path and name> Play back <Recording file path and name>. Do not 

combine this switch with other switches.
/C:<Communication profile> Connect by <Communication profile> to the Host specified 

by the switch /H: or /P:.
/D: Disconnect from the connected to Host. Do not combine 

this switch with other switches.
/E:<Phonebook file path and name> Display the Connection Properties of <Phonebook file path 

and name> or, if combined with a session switch (/A:, /F:, /
G:, /R: or /V:), start this session with the <Phonebook file 
path and name> Host.

/F: Start a File Transfer session with the connected to Host.
/G: Start a Remote Management session with the connected to 

Host.
/H:<Host name> Connect to the <Host name> Host by an enabled 

networking communication profile or if specified by the 
switch /C: that communication profile.

/LGD:<Gateway logon domain> When connected to a connecting NetOp Gateway, specify 
<Gateway logon domain> to log on.

/LGN:<Gateway logon name> When connected to a connecting NetOp Gateway, specify 
<Gateway logon name> to log on.

/LGP:<Gateway logon password> When connected to a connecting NetOp Gateway, specify 
<Gateway logon password> to log on.

/LHD:<Host logon domain> When connected to a Host, specify <Host logon domain> 
to log on.

/LHN:<Host logon name> When connected to a Host, specify <Host logon name> to 
log on.

/LHP:<Host logon password> When connected to a Host, specify <Host logon password> 
to log on.

/M:[<Recording file path and name>] Combine this switch with /R: to record the remote control 
session. If no <Recording file path and name> is specified, 
a recording file named <Time stamp>-<Guest ID>-<Host 
ID>.dwr will be saved in the NetOp Configuration Files 
record directory.

/P:<Telephone number or IP address> Connect to the <Telephone number or IP address> Host by 
an enabled point-to point communication profile or if 
specified by the switch /C: that communication profile.

/R: Start a Remote Control session with the connected to Host.
/S:<Script file path and name> Run <Script file path and name>. Do not combine this 

switch with other switches.
/V: Start a Chat session with the connected to Host.
/X:<Number of pixels from left 
screen border>[,<Number of pixels 
from upper screen border>[,<Number 
of pixels width>[,<Number of pixels 
height>]]]

Combine this switch with /R: to specify a non-default 
position and size of the Remote Control window.
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3.2 Load and Unload
Explanation: Load the Guest and connect to the Host of the phonebook entry file John.dwc that resides in 
the Administrator NetOp configuration files PhBook directory to start a remote control session with it and 
record the session storing the recording file in its default location with its default name.
<NetOp Guest program path and file> /C:TCP/IP /H:Peter /F:

Explanation: Load the Guest and using the communication profile TCP/IP connect to the Host named 
Peter to start a file transfer session with it.
<NetOp Guest program path and file> /S:”C:\SCRIPTS\MY SCRIPT.DWS”

Explanation: Load the Guest and run the script file MY SCRIPT.DWS that resides in the SCRIPTS 
directory on the C drive.

Note: Switch paths and file names containing spaces and special characters must be enclosed by double 
quotes.

3.2.2 Setup Wizard
If you load NetOp Guest for the first time, this window will display in front of the NetOp Guest window:

Note: By default, the setup of NetOp Guest will be individual to each user logged on to Windows, see 
NetOp Configuration Files.

To skip the Setup Wizard, click Cancel to close the window and apply a default setup.

Note: The default setup lacks features that you may need to connect to a Host. Therefore, we recommend 
that you run the Setup Wizard. You can run the Setup Wizard from the Guest Tools Run Setup Wizard 
command.
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3 NetOp Guest
Click Next > to display this window:

Select one of these options:

~Fast connections: You will typically connect across a local area network (default selection).

{Slow connections: You will typically connect across the Internet or by a telephone connection.
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3.2 Load and Unload
Click Next > to display this window:

Select one of these options:

~No: You will not communicate by modem (default selection).

{Yes: You will communicate by modem.
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3 NetOp Guest
Click Next > to display this window:

We recommend that you leave the default Yes, I want to register my NetOp license on-line selection 
unless you or somebody else in your organization already has registered or will register the license. 
Click Next > to connect to register or display this window:
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3.3 Connect Guide
Click Finish to close the window to end the setup wizard.

3.3 Connect Guide
This guide includes these sections:
• Remote Control
• Other Sessions
• Actions
• Help Request
3.3.1 Remote Control
To start a Remote Control session with a Host on a computer on your network segment:
1. In the Tab Panel Quick Connect Tab Communication Profile Section, select a communication 

profile that matches a communication profile that is enabled on the Host (default: TCP/IP).
2. Click the Buttons Browse button to browse for running Hosts. After browse timeout, records of 

responding Hosts will be displayed on the NetOp Network Tab.
3. Double-click a Host record to typically display a logon window, see Guest Authentication. Specify 

logon credentials and click OK to send them to the Host for approval.
4. When the Host has approved the logon credentials, the Remote Control window will display.
You can also connect by a Host name:
1. In the Tab Panel Quick Connect Tab Host Section Name field, specify the Host name.
2. Click the Buttons Connect button to typically display a logon window, see Guest Authentication.
To reconnect to a Host that you connected to before, in the Tab Panel History Tab Records Pane double-
click the Host record to typically display a logon window, see Guest Authentication.
You can add Host records to the Phonebook Tab to connect like from the History Tab:
1. Right-click a Quick Connect Tab NetOp Network Tab record or select multiple records and right-

click and select Add to Phonebook to display a Windows Browse for Folder window.
2. Select the PhBook folder and click OK to add selected records to the Phonebook Tab Tree Pane 

Phonebook folder Records Pane.
Alternatively, copy records from the Tab Panel Quick Connect Tab NetOp Network Tab or History Tab 
Records Pane and paste them into the Phonebook Tab Records Pane.

Note: Connecting can be more demanding, see Connect Problems and Host Security Guide.

3.3.2 Other Sessions
These other sessions are available:
• File Transfer
• Chat
• Audio-Video Chat
• Remote Management
To start one of these sessions from the Guest window:
1. Click a Tab Panel Quick Connect Tab NetOp Network Tab Host record in the Name column to enter 

the name into the Host Section Name field, specify the Host name in this field or select a Phonebook 
Tab or History Tab Host record.

2. Click the desired session Toolbar Session Buttons button or select the desired session Connection 
Menu command to typically display the Shared NetOp Authentication logon window.

3. After logon, the session window will be displayed.
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3 NetOp Guest
Note: During a Remote Control session, you can start other sessions from the Remote Control window 
Toolbar and Toolbox Session Buttons.

3.3.3 Actions
You can execute these actions on a Host computer:
• Run Program
• Execute Command
• NetOp Message
• Get Inventory
To execute one of these actions from the Guest window:
 1. Select a Quick Connect Tab NetOp Network Tab record in the Name column to enter the name into 

the Host Section Name field, specify the Host name in this field or select a Phonebook Tab or 
History Tab Host record.

 2. Click the desired action Toolbar Action Buttons button or select the desired action Connection 
Menu command to typically display action options.

Note: During a Remote Control session, you can execute actions from the Remote Control window 
Toolbar and Toolbox Action Buttons.

3.3.4 Help Request
A Host user can send a help request to you if you have enabled help services. To enable help services:
1. On the Program Options window Help Request Tab, enable one or multiple help services.
2. Enable one or multiple Communication Profiles at Guest loading.
Host user help requests will be displayed in Tab Panel Help Request Tab records. To respond to a help 
request, typically double-click the record to start a Remote Control session with the help requesting Host.
3.3.5 Connect Problems
If NetOp cannot connect to a specified Host, after a timeout period this window will display:

This window advises you on how to overcome connect problems.
Here is some additional advice:
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3.4 Host Security Guide
• Verify that communication can physically reach the destination:
If communicating across a TCP/IP network, run this command in a Windows Command Prompt 
(MS-DOS Prompt) window:

PING <Destination computer IP address>

This command sends four data packets to the specified IP address requesting replies. 
If positive replies are received, communication can physically reach the destination.
If negative replies are received, check your network setup or consult with your network/system 
administrator.
If communicating across a modem connection using Windows Modem, the setup of your modem in 
Windows may not satisfy NetOp requirements. Try setting up your modem using Serial instead.

• Verify that the destination computer responds to the specified destination name or address with the 
selected communication profile. Read in Communication Devices about the characteristics of the 
communication device used by the selected communication profile.

• Test with other destinations starting with destinations close to you using other communication 
profiles and other destination names and addresses.

• Consult with your network/system administrator.
• As a last resort, submit a support request to NetOp Customer & Product Support.

3.4 Host Security Guide
A Host and a connecting Gateway can apply Guest Access Security to limit which Guests can connect 
and what connected Guests are allowed to do. This guide includes these sections:
• Guest Authentication
• Security Role
• Guest Profile
• Guest Policy
• Address Check
• Encryption
3.4.1 Guest Authentication
A Host and a connecting Gateway can authenticate a connecting Guest or Guest user by logon credentials 
and other checks.

Note: Authentication can validate Guest connect information but cannot verify the identity of a 
connecting Guest or Guest user.

This section contains these sections:
• Shared NetOp Authentication
• Individual NetOp Authentication
• Windows Authentication
• Smart Card Authentication
• Directory Services Authentication
• NetOp Security Server Authentication
• RSA SecurID Authentication
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3 NetOp Guest
3.4.1.1 Shared NetOp Authentication
If the Host or a connecting NetOp Gateway uses shared NetOp authentication, this window will be 
displayed when you become connected (default selection):

Login to <Host name>
Password []: Specify in this field the shared password specified on the Host or connecting Gateway.
The available number of logon attempts is specified by Host Guest Access Security Guest Policy.

3.4.1.2 Individual NetOp Authentication
If the Host or a connecting NetOp Gateway uses individual NetOp authentication, this window will be 
displayed when you become connected:

Login to <Host name>
Guest ID: []: Specify in this field a Guest ID specified on the Host or connecting Gateway.
Password: []: Specify in this field the matching password specified on the Host or connecting 
Gateway.
The available number of logon attempts is specified by Host Guest Access Security Guest Policy.
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3.4.1.3 Windows Authentication
If the Host or a connecting Gateway uses Windows authentication or if the Host uses NetOp Security 
Server and its Preferred Guest Type is Windows user, this window will be displayed when you become 
connected:

Login to <Host name>
User name: []: Specify in this field a Windows logon user name specified in the local or domain 
Windows Security Management used by the Host computer, the connecting Gateway computer or 
NetOp Security Server.
Password: []: Specify in this field the matching password specified in Windows Security 
Management.
Domain: []: Specify in this field the matching domain specified in Windows Security Management.
The available number of logon attempts is specified by Host Guest Access Security Guest Policy.

3.4.1.4 Directory Services Authentication
If the Host uses directory services authentication or if the Host uses NetOp Security Server and its 
Preferred Guest Type is Directory Services user, this window will be displayed when you become 
connected:

Login to <Host name>
User name: []: Specify in this field a directory services user common name specified on the Host or 
NetOp Security Server and on the directory server specified below.
Password: []: Specify in this field the matching password specified on the directory server.
Directory Server: []: Specify in this field the matching directory server.
The available number of logon attempts is specified by Host Guest Access Security Guest Policy.
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3.4.1.5 NetOp Security Server Authentication
If the Host uses NetOp Security Server and its Preferred Guest Type is NetOp Guest ID, this window will 
be displayed when you become connected:

Login to <Host name>
Guest ID: []: Specify in this field a Guest ID specified in the security database used by the NetOp 
Security Server.
Password: []: Specify in this field the matching password specified in the security database used by 
the NetOp Security Server.
Change Password...: Click this button to display this window:

Change password
New password: Specify in this field the new password.
Confirm new password: Re-specify in this field the new password for confirmation.

The available number of logon attempts is specified by Host Guest Access Security Guest Policy. 
and may be further limited by security database specification.
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3.4.1.6 RSA SecurID Authentication
If the Host uses NetOp Security Server and its Preferred Guest Type is RSA SecurID user, this window 
will be displayed when you become connected:

Login to <Host name>
User name: []: Specify in this field your RSA SecurID user name.
Password: []: This field is included only if triple factor security is specified by NetOp Security 
Server. Specify in the field your triple factor security NetOp password.
PASSCODE: []: Specify in this field your RSA SecurID PASSCODE (PIN+token number).
Change Password...: This button is included only if triple factor security is specified by NetOp 
Security Server. Click the button to change your NetOp password like in the Guest Security Server 
Login window above.
The available number of logon attempts is specified by Host Guest Access Security Guest Policy.

3.4.1.7 Smart Card Authentication
If the Host uses NetOp Security Server and its Preferred Guest Type is Smart Card and PIN, this 
window will be displayed when you become connected:

Insert your NetOp authentication Smart Card into your Smart Card reader and click OK to display a 
window that requests the matching PIN number. Specify the PIN number to connect.
The available number of logon attempts is specified by Host Guest Access Security Guest Policy.

3.4.2 Security Role
NetOp Host can specify locally and the NetOp Security Server security database can specify centrally in 
Security Roles which actions shall be allowed to a Guest and which confirm access option shall be 
available to the Host computer user.
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3 NetOp Guest
Each Security Role specifies these elements:

This section includes these sections:
Allow Guest To
Confirm Access

3.4.2.1 Allow Guest To
The Host or security database Security Role specification upper part that is indented under Allow Guest 
to:

specifies which actions will be allowed to a Guest when connected to the Host. Checked actions will be 
allowed, unchecked will be denied.

;Remote control: Start a Remote Control session to view the Host screen image (default: allowed). 
Indented actions below can be allowed if Remote control is allowed.
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;Use keyboard and mouse: Execute keyboard and mouse actions on the Host computer screen 
(default: allowed).

;Lock keyboard and mouse: Disable the Host computer keyboard and mouse (default: allowed).

;Blank the screen: Make the screen turn black to the Host computer user (default: allowed).

;Transfer clipboard: Transfer Guest computer clipboard content to the Host computer and vice 
versa (default: allowed).

;Execute command (Restart, ...): Execute Command on the Host computer including other commands 
like Restart (default: allowed).

;Request chat: Start a Chat session with the Host (default: allowed).

;Request audio-video chat and transfer sound: Start an Audio-Video Chat session with the Host and 
transfer the sound of applications running on the Host computer (default: allowed).

�Request Video: In an Audio-Video Chat session, transfer a Host computer video camera image to the 
Guest Audio-Video Chat window Remote section video frame (default: denied).

;Send files to Host: File Transfer from the Guest computer to the Host computer (default: allowed).

;Receive files from Host: File Transfer from the Host computer to the Guest computer (default: 
allowed).

;Run programs: Run Program on the Host computer (default: allowed).

;Redirect print: While connected, send a print job from one computer to a printer of the other computer, 
see the Program Options window Remote Printing Tab (default: allowed).

;Remote manage: Start a Remote Management session to manage the Host computer (default: allowed).

;Retrieve inventory: Get Inventory from the Host computer (default: allowed).

;Send message: Send a NetOp Message to the Host (default: allowed).

;Join multi Guest session: Join a Remote Control session that another Guest runs with the Host (default: 
allowed).

;Act as multi Guest session administrator: Manage a Remote Control Multi Guest Session (default: 
allowed).
3.4.2.2 Confirm Access
The Host or security database Security Role specification lower part that is indented under Confirm 
access:

specifies whether the Host computer user shall confirm Guest user access to the Host computer. One of 
these options will be selected:

~No: The Host computer user shall not confirm access (default selection).

{Yes, unless: The Host computer user shall confirm access except in the cases checked below.

�Computer locked: If the computer is locked, the Host computer user cannot confirm access 
(default: unchecked).

�No user logged on: If no user is logged on to the Host computer, no user will be available to 
confirm access (default: unchecked).
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3 NetOp Guest
�Guest user logged on: If Guest credentials match the Host computer user logon credentials, 
confirm access is typically not justified (default: unchecked).

If a connected to Host applies confirm access, this message will be displayed when the Guest has logged 
on:

This message will remain until the Host computer user has confirmed access or confirm access has 
timed out, see Host Guest Access Security Guest Policy. If the Host computer user allows access, 
the Guest will access the Host computer. If the Host computer user denies access or confirm access 
times out, the Host will disconnect.
Cancel: Click this button to close the message and disconnect.

3.4.3 Guest Profile
Guest profiles specify Guest, user or group connection properties.
By default, Hosts use Shared NetOp Authentication. This authentication method specifies one local Guest 
profile for all connecting Guests.
To use other authentication methods, Hosts can specify a local Guest profile for each connecting Guest, 
user or group or use a central security database specified Guest profile for each Guest, user or group.
On the Host and/or in a central security database, one Security Role will typically be assigned to each 
Guest profile. By group memberships, multiple Security Roles can apply to each Guest or user. The Host 
or NetOp Security Server will apply the composite of multiple applicable Security Roles.
For instance, this is the Host window for specifying an Individual NetOp Authentication Guest profile:

Each Guest profile specifies these elements:
Credentials
Call Back
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3.4.3.1 Credentials
Guest Profile credentials specify what the Guest user must specify in the Logon... window for 
authentication, see Guest Authentication. NetOp authentication relies upon credentials specified on the 
Host or in a central security database. Other authentication methods rely upon credentials specified in 
other security systems.
3.4.3.2 Call Back
Guest Profile call back specifies if the Host after Guest logon shall disconnect and reconnect to a Host or 
Guest specified telephone number or IP address. Call back applies only to Guests connected by point-to-
point communication such as ISDN (CAPI), Serial, Windows Modem, TCP/IP (TCP) or TCP/IP (TCP 
IPv6).
Host local Guest Profiles have these call back options:

One of these options will be selected:

~No call back: The Host will not disconnect and reconnect (default selection).

{Call back to: []: The Host will disconnect and reconnect to the telephone number or IP address 
that is specified in the field on the Host. If this does not reconnect to the Guest, the Guest cannot 
access the Host, see also Address Check.

{Roving Call back: This window will display on the Guest computer screen:

Enter callback phone number: []: Specify in the field the telephone number or IP address from 
which the Guest computer connected.

The Host will disconnect and reconnect to the specified telephone number or IP address to take over 
any external charges incurred during the connection.

Note: Central security database Guest Profiles have no call back options. No call back is always selected.

3.4.4 Guest Policy
A Host and a connecting Gateway can apply these Guest security policies, see Guest Policy Tab.
• Specify the available number of logon attempts (default: 3).
• Select which action shall be executed if all available logon attempts of a connecting Guest are 

unsuccessful: Disconnect, Disable Host (deny any connection until reset locally) or Restart 
Windows (default: Disconnect).

Note: Restart Windows will typically reload and restart the Host or Gateway.

• Select which action shall be executed after disconnect: None, Lock computer, Log off Windows or 
Restart Windows (default: None).
60



3 NetOp Guest
Note: A Guest can connect to a locked Host computer and a Host computer with no user logged on. 
The Guest user must unlock or log on to the Host computer to access it.

• Disable file transfer when no user is logged on to the Host computer (default: unselected).
• Record remote control sessions and optionally disconnect if session recording fails (default: 

disabled).
• Timeout (disconnect if not completed within a specified number of seconds):

• Confirm Access (default: no timeout).
• Authentication (default: no timeout).
• Inactivity (no Guest computer keyboard or mouse activity, default: no timeout).

3.4.5 Address Check
A Host and a connecting Gateway can allow connections by network communication only from 
computers with specified MAC and IP addresses, see MAC/IP Address List Setup Tab (default: not 
applied).

Note: MAC addresses apply to connections by NetBIOS and IPX communication devices. IP addresses 
apply to connections by TCP/IP and TCP/IP (TCP) communication devices.

A Host and a connecting Gateway can allow connections by ISDN (CAPI) communication only from 
telephone numbers in an Allowed ISDN Numbers list (default: not applied).
A Host and a connecting Gateway can allow connections by point-to-point communication only from a 
specified telephone number or IP address by Call Back (default: not applied).
3.4.6 Encryption
A Host and a connecting Gateway can enable a selection of encryption types (default: all), see Encryption 
Tab.
A Guest can connect only if at least one encryption type enabled on the Guest is also enabled on a 
connecting Gateway and on the Host.
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3.5 NetOp Guest Window
When NetOp Guest is loaded, this window will be displayed:

It contains these elements:
• Title Bar
• Menu Bar
• Toolbar
• Tab Panel
• Status Bar
3.5.1 Title Bar

Title bar window controls are explained in Window Control.
3.5.2 Menu Bar
This is the NetOp Guest Window menu bar:

It contains these menus:
• File Menu
• Connection Menu
• Edit Menu
• View Menu
• Tools Menu
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• Help Menu
3.5.2.1 File Menu
In the Menu Bar, select File or if the NetOp Guest Window is active press ALT+F to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Import to Phonebook: Select this command to display the Import to Phonebook window, see Phonebook 
Export and Import.
Export from Phonebook: Select this command to display the Export from Phonebook window, see 
Phonebook Export and Import.
Exit: Select this command or the Window Control menu Close command, click the Window Control 
Close button or press ALT+F4 to unload the Guest.
3.5.2.2 Connection Menu
In the Menu Bar, select Connection or if the NetOp Guest Window is active press ALT+C to display this 
menu:

Connection menu commands fall into these groups:
• Session Commands
• Action Commands
• Other Commands
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3.5.2.2.1 Session Commands

These are the NetOp Guest Window Connection Menu session commands:

Menu and toolbar controls are explained in Menu and Toolbar Control.
To enable session commands, select a Quick Connect Tab Host record or in the Host Section Name field 
specify a Host name or select one or multiple Phonebook Tab, Connections Tab, History Tab or Help 
Request Tab Host records. You can start a session with multiple Hosts at a time only if the session is not 
running with any selected Host. You can end a session with only one Host at a time.
Remote Control: Select this command or the matching Tab Panel record context menu command or click 
the Toolbar Session Buttons Remote Control button to start or end a Remote Control session. If a Remote 
Control session is running with the last selected record Host, the command will be checkmarked.
File Transfer: Select this command or the matching Tab Panel record context menu command or click the 
Toolbar Session Buttons File Transfer button to start or end a File Transfer session. If a File Transfer 
session is running with the last selected record Host, the command will be checkmarked.
Chat: Select this command or the matching Tab Panel record context menu command or click the 
Toolbar Session Buttons Chat button to start or end a Chat session. If a Chat session is running with the 
last selected record Host, the command will be checkmarked.
Audio Chat: Select this command or the matching Tab Panel record context menu command or click the 
Toolbar Session Buttons Audio Chat button to start or end an Audio-Video Chat session. If an Audio-
Video Chat session is running with the last selected record Host, the command will be checkmarked.

Note: A Guest can run only one audio session at a time.

Remote Management: Select this command or the matching Tab Panel record context menu command or 
click the Toolbar Session Buttons Remote Management button to start or end a Remote Management 
session. If a Remote Management session is running with the last selected record Host, the command will 
be checkmarked.
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If you start sessions with multiple Hosts, this window will be displayed:

The window will display a session type icon and Launch <Session type>.
The pane below will display records of selected Hosts in a table with this column content:
• Description: Progress indicator and Tab Panel record Description. These progress indicators can be 

displayed:

• Name: Tab Panel record Name.
• Phone number: Tab Panel record Phone number.
• Communication Profile: Tab Panel record Communication Profile.
• Status: Textual progress indicator.
Table controls are explained in Table Control.
Commands will execute sequentially as indicated by the progress indicators and Status column content.
If no other session is running with a selected record Host, starting a session will include connecting to the 
Host.

Note: If Guest Access Security on a selected record Host does not allow the session of the selected 
command, command execution will fail, see Allow Guest To.

�Close this dialog box on successful completion: Check this box to close this window when the 
command has executed successfully on all selected record Hosts (default: unchecked).
Cancel/Close:  During progress, this button will display Cancel. Click it to cancel executing the 
command on the current Host record and proceed to the next. After completion, this button will display 
Close. Click it to close the window.

Command execution in progress

Command executed successfully

Command execution failed
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3.5.2.2.2 Action Commands

These are the NetOp Guest Window Connection Menu action commands:

Menu and toolbar controls are explained in Menu and Toolbar Control.
To enable action commands, select a Quick Connect Tab Host record or in the Host Section Name field 
specify a Host name or select one or multiple Phonebook Tab, Connections Tab or History Tab Host 
records.
Run Program: Select this command or the matching Tab Panel record context menu command or click 
the Toolbar Action Buttons Run Program button to display the Run Program drop-down menu.
Execute Command: Select this command or the matching Tab Panel record context menu command or 
click the Toolbar Action Buttons Execute Command button to display the Execute Command drop-down 
menu.
Send Message: Select this command or the matching Tab Panel record context menu command or click 
the Toolbar Action Buttons Send Message button to display the NetOp Message window.
Get Inventory: Select this command or the matching Tab Panel record context menu command or click 
the Toolbar Action Buttons Get Inventory button to Get Inventory from Host computers.

Note: When executing some of these actions, a Command Progress Status window will be displayed, see 
Run Program.

3.5.2.2.3 Other Commands

These are the NetOp Guest Window Connection Menu other commands:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Disconnect: Select a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab connected 
Host record and select this command or the matching Tab Panel record context menu command or click 
the Toolbar Other Buttons Disconnect button to disconnect.

Note: You can disconnect only one Host at a time.

Local File Transfer:  Select this command or click the Toolbar Other Buttons Local File Transfer button 
to start a local File Transfer session.
Playback Session Recording: Select a Recordings Tab record and select this command or the matching 
Tab Panel record context menu command or double-click the record to play back the session recording.
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3.5.2.3 Edit Menu
In the Menu Bar, select Edit or if the NetOp Guest Window is active press ALT+E to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Cut: Select one or multiple Tab Panel folders or records and select this command or the matching context 
menu command to remove selected items and place them on the clipboard.
Copy: Select one or multiple Tab Panel folders or records and select this command or the matching 
context menu command to copy selected items to the clipboard.
Paste: Select a Tab Panel folder and select this command or the matching context menu command to 
paste the clipboard contents into the selected folder.
Delete: Select one or multiple Tab Panel folders or records and select this command or the matching 
context menu command or click the Toolbar Other Buttons Delete button to display a confirmation 
window to confirm deleting selected items.

Caution: Deleting a folder will delete all folders and records in it.

Rename: Select a Tab Panel folder and select this command or the matching context menu command to 
display this window:

New folder name: []: The field highlights the folder name. Edit it to rename the folder.
New: This command expands into these commands:

Phonebook Entry: Displaying the Phonebook Tab, select this command or the matching Records 
Pane context menu command or click the Toolbar Other Buttons Phonebook Entry button to display 
the Connection Properties window to create a phonebook record in the displayed Records Pane.
Script: Displaying the Script Tab, select this command or the matching Records Pane context menu 
command to display an empty Script window to create a NetOp Script.
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Folder: Select a Tab Panel tree pane folder and select this command or the context menu New 
Folder command to display this window:

Enter folder name: []: Specify in this field a folder name to create this folder in the selected 
folder.

Refresh: Select this command to refresh the content of the displayed Tab Panel tab. If the Quick Connect 
Tab is displayed, this will start a browse for Hosts, see Buttons.

Note: Tab content will display changes from outside the tab only if refreshed.

Connection Properties: Select a Phonebook Tab, History Tab or Help Request Tab Host record and select 
this command or the matching context menu command or click the Toolbar Other Buttons Connection 
Properties button to display the Connection Properties window to view or edit the selected Host record 
connection properties.
Edit Script: Select a Script Tab record and select this command to open the record script in the Script 
window, see NetOp Script.
3.5.2.4 View Menu
In the Menu Bar, select View or if the NetOp Guest Window is active press ALT+V to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Tree Window: Select this command or click the matching Toolbar Other Buttons button to hide/display 
the Tab Panel tab left pane with a folder tree structure (default: displayed). If displayed, the command 
will be checkmarked.
Large Icons: Select this command or click the matching Toolbar Other Buttons button to display Tab 
Panel tab records as horizontal rows of large icons. If selected, the command will be checkmarked.
Small Icons: Select this command or click the matching Toolbar Other Buttons button to display Tab 
Panel tab records as horizontal rows of large icons. If selected, the command will be checkmarked.
List: Select this command or click the matching Toolbar Other Buttons button to display Tab Panel tab 
records as vertical columns of small icons. If selected, the command will be checkmarked.
Details: Select this command or click the matching Toolbar Other Buttons button to display Tab Panel 
tab records in a table with details in columns (default selection). If selected, the command will be 
checkmarked.
68



3 NetOp Guest
View File Manager Log: Select this command to display a Windows Open window specifying Files of 
type: Log Files (*.log) to open a File Transfer log (typically named NFM.LOG) to display it in the NFM 
Log Viewer window, see Options Menu.
Modem Dialog: Select this command to display the Modem Dialog window.
3.5.2.5 Tools Menu
In the Menu Bar, select Tools or if the NetOp Guest Window is active press ALT+T to display this menu:

Tools menu commands are explained in Guest Tools.
3.5.2.6 Help Menu
In the Menu Bar, select Help or if the NetOp Guest Window is active press ALT+H to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Contents: Select this command to open the NetOp Guest Help system on the Welcome topic. The left 
pane of the window will display a graphical table of contents.
Online Support: Select this command to open the Support for NetOp Remote Control web page to submit 
a support request.
Apply License/Online Registration: This command will be Apply License if a trial version is installed and 
Online Registration if a licensed version is installed.
69

http://support.netop.com


3.5 NetOp Guest Window
Select Apply License to display this window:

Licensed to: []: Specify in the field a licensee name.
Serial number: []: Specify in the field a Guest license number.
OK: Click this button to replace the trial version licensee name and license number by the specified 
licensee name and license number.

Select Online Registration to open the NetOp Product Registration web page to register your NetOp 
product with the manufacturer.
Quick Guide: Select this command to open the NetOp Guest Help system on the Connect Guide topic.
Help for this Tab: Select this command or click the Toolbar Other Buttons Help for this Tab button to 
open the NetOp Guest Help system on the topic of the displayed Tab Panel tab.
About...: Select this command to display this window:

About NetOp Remote Control Guest

This window contains information on your NetOp Guest installation. The build number in format 
YYYYDDD (Y=year number digit, D=day number digit) is enclosed in parentheses next to the 
version number.
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3 NetOp Guest
System Info...: Click this button to display the System Info window.
3.5.3 Toolbar
The NetOp Guest Window toolbar will be displayed unless hidden from the Program Options window 
Layout Tab:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Toolbar buttons are grouped into these sections:
• Session Buttons
• Action Buttons
• Other Buttons
3.5.3.1 Session Buttons
These are the NetOp Guest Window Toolbar session buttons:

Menu and toolbar controls are explained in Menu and Toolbar Control.
To enable session buttons, select a Quick Connect Tab Host record or in the Host Section Name field 
specify a Host name or select one or multiple Phonebook Tab, Connections Tab, History Tab or Help 
Request Tab Host records. You can start a session with multiple Hosts at a time only if the session is not 
running with any selected Host. You can end a session with only one Host at a time.

Remote Control:  Click this button or select the matching Connection Menu or Tab Panel record 
context menu command to start or end a Remote Control session. If a Remote Control session is 
running with the last selected record Host, the button will appear pressed in.
File Transfer: Click this button or select the matching Connection Menu or Tab Panel record 
context menu command to start or end a File Transfer session. If a File Transfer session is running 
with the last selected record Host, the button will appear pressed in.
Chat: Click this button or select the matching Connection Menu or Tab Panel record context 
menu command to start or end a Chat session. If a Chat session is running with the last selected 
record Host, the button will appear pressed in.
Audio Chat: Click this button or select the matching Connection Menu or Tab Panel record 
context menu command to start or end an Audio-Video Chat session. If an Audio-Video Chat 
session is running with the last selected record Host, the button will appear pressed in.

Note: A Guest can run only one audio session at a time.

Remote Management: Click this button or select the matching Connection Menu or Tab Panel 
record context menu command to start or end a Remote Management session. If a Remote 
Management session is running with the last selected record Host, the button will appear pressed 
in.
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3.5.3.2 Action Buttons
These are the NetOp Guest Window Toolbar session buttons:

Menu and toolbar controls are explained in Menu and Toolbar Control.
To enable action buttons, on the Quick Connect Tab select a Host record or specify the Host name in the 
Host Section Name field or on the Phonebook Tab, Connections Tab or History Tab select one or 
multiple Host records.

Note: When executing some of these actions, a Command Progress Status window will be displayed, see 
Run Program.

Run Program: Click this button or select the matching Connection Menu or Tab Panel record 
context menu command to display the Run Program drop-down menu.
Execute Command: Click this button or select the matching Connection Menu or Tab Panel record 
context menu Execute Command command to display the Execute Command drop-down menu.
Send Message: Click this button or select the matching Connection Menu or Tab Panel record 
context menu command to display the NetOp Message window.
Monitor: Click this button to Monitor Host computers. If the last selected record Host computer is 
being monitored, the button will appear pressed in.
Get Inventory: Click this button or select the matching Connection Menu or Tab Panel record 
context menu Get Inventory command to Get Inventory from Host computers.
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3.5.3.3 Other Buttons
These are the NetOp Guest Window Toolbar other buttons:

Menu and toolbar controls are explained in Menu and Toolbar Control.

Disconnect: Select a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab 
connected Host record and click this button or select the matching Connection Menu or Tab Panel 
record context menu command to disconnect.

Note: You can disconnect only one Host at a time.

Local File Transfer: Click this button or select the matching Connection Menu command to start 
a local File Transfer session.
Connection Properties: Select a Phonebook Tab, History Tab or Help Request Tab Host record 
and click this button or select the matching Edit Menu or Tab Panel record context menu 
command to display the Connection Properties window to view or edit the selected Host record 
connection properties.
Phonebook Entry: Displaying the Phonebook Tab, click this button or select the matching Edit 
Menu or Records Pane context menu command to display the Connection Properties window to 
create a phonebook record in the displayed Records Pane.
Delete: Select one or multiple Tab Panel folders or records and click this button or select the 
matching Edit Menu or context menu command to display a confirmation window to confirm 
deleting selected items.

Caution: Deleting a folder will delete all folders and records in it.

Tree Window: Click this button or select the matching View Menu command to hide/display the 
Tab Panel tab left pane with a folder tree structure (default: displayed). If displayed, the button 
will appear pressed in.
Large Icons: Click this button or select the matching View Menu command to display Tab Panel 
tab records as horizontal rows of large icons. If selected, the button will appear pressed in.
Small Icons: Click this button or select the matching View Menu command to display Tab Panel 
tab records as horizontal rows of small icons. If selected, the button will appear pressed in.
List: Click this button or select the matching View Menu command to display Tab Panel tab 
records as vertical columns of small icons. If selected, the button will appear pressed in.
Details: Click this button or select the matching View Menu command to display Tab Panel tab 
records in a table with details in columns (default selection). If selected, the button will appear 
pressed in.
Help for this Tab: Click this button or select the matching Help Menu command to open the 
NetOp Guest Help system on the topic of the displayed Tab Panel tab.
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3.5.4 Tab Panel
This is the NetOp Guest Window tab panel

It can contain up to all of these tabs (default: all):
• Phonebook Tab
• Quick Connect Tab
• Connections Tab
• History Tab
• Help Request Tab
• Recordings Tab
• Script Tab
• Inventory Tab
By default, the Quick Connect Tab will be displayed in front.
Organize tab panel tabs from the Program Options window Layout Tab.
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3.5.4.1 Phonebook Tab
This NetOp Guest Window Tab Panel tab will be displayed unless hidden from the Program Options 
window Layout Tab:

It works like your personal quick-dial telephone directory. However, connecting to a Host requires much 
more than a phone call:
• You must select the right communication profile
• You must specify the Host name and possible connecting elements correctly
• When connected, you may need to specify logon credentials
• Guest settings should fit Host settings and optimize transmission speed and quality
• Your preferred interactive functionality should be in place when connected
All of this can be specified in Phonebook Records to access Host computers by a few mouse clicks.
The  Phonebook tab contains an optional left Tree Pane and a right Records Pane.
The Tree Pane contains a user-defined phonebook directory structure. To hide/display the Tree Pane, 
click the Toolbar Other Buttons Tree Window button or select the matching View Menu command 
(default: displayed).
The Records Pane contains the Phonebook Records of the phonebook directory selected in the Tree Pane.
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3.5.4.1.1 Tree Pane

This is the NetOp Guest Window Tab Panel Phonebook Tab tree pane:

It initially contains a Phonebook phonebook.
 Right-click in the pane to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
This menu enables you to manage your Phonebook and phonebook reference directories. You can also 
manage directory folders by drag and drop.
Commands in the first three sections match Edit Menu commands.
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Add Phonebook Reference: Select this command to display this window:

A phonebook reference will refer to a Guest computer directory, for instance the phonebook of 
another computer user.
Click the [...] button to display a Browse for Folder window to select a directory to enter its name 
into the Name field and its path into the Folder field. Optionally, in the Name field edit the 
phonebook reference name. A new phonebook reference will display in the tree pane as an 
additional phonebook.

Edit Phonebook Reference: Select a phonebook reference and select this command to display the 
phonebook reference specification in the Add Phonebook Reference window to edit it.
3.5.4.1.2 Records Pane

This is the NetOp Guest Window Tab Panel Phonebook Tab records pane:

It displays the Phonebook Records in the Tree Pane selected Phonebook or folder. Records are displayed 
as icons or table records according to the selection by View Menu commands or Toolbar Other Buttons.
Details view displays records in a table with this column content:
• Description: Communication device type icon (networking, line, network point-to-point, Gateway 

or Infrared) and record identifying description.
• Name: Host Networking Communication name.
• Phone Number: Host or Host network routing NetOp Gateway Line Communication or Gateway 

telephone number or IP address or Network Point-to-Point Communication IP address.
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• Communication Profile: Guest communication profile name.
• Comment: Optional comment specified by the Guest user or the Host computer user name when 

originally browsing for the Host.
Table controls are explained in Table Control.
To start a session with selected record Hosts, click a Session Buttons button or select a Session 
Commands command. To execute an action on selected record Host computers, click an Action Buttons 
button or select an Action Commands command.
Double-click a record to start the default type session with the record Host, see General Tab.
Right-click a record or multiple selected records to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
The first section contains Session Commands.
The second section contains Action Commands.
If one record is selected, a <Custom application> command can be included after action commands. 
Select this command to run the custom application. Assign a custom application to a phonebook record 
on the Connection Properties window Custom Tab.
Disconnect: See Other Commands.
Remaining commands match Edit Menu commands.
3.5.4.1.3 Phonebook Records

Phonebook records specify Host connection properties.
You can create as many phonebook records as you like, including multiple alternative phonebook records 
for the same Host.
To swiftly create phonebook records, add Quick Connect Tab NetOp Network Tab Host records or copy 
Quick Connect Tab NetOp Network Tab or History Tab Records Pane. Host records to your phonebook.
You can create phonebook records by copying phonebook or history dwc files into your phonebook or by 
importing phonebook data in a comma separated file, see Phonebook Export and Import.
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To create a phonebook record from scratch, click the Toolbar Other Buttons Phonebook Entry button or 
select the Edit Menu or Records Pane context menu New Phonebook Entry command to display the 
Connection Properties window. Select a phonebook record first to base the phonebook record on the 
connection properties of the selected phonebook record.
To edit a phonebook record, select it and click the Toolbar Other Buttons Connection Properties button 
or select the Edit Menu or Records Pane context menu Connection Properties command to display its 
connection properties in the Connection Properties window to edit them.
You can copy and move phonebook records between the Phonebook root folder and user-defined folders, 
also by drag and drop.
Phonebook records are saved as files with the extension dwc in the PhBook directory that resides in the 
NetOp Configuration Files directory, typically C:\Documents and Settings\<User name>\Application 
Data\Danware Data\NetOp Remote Control\Guest\PhBook. dwc files are XML format files that can be 
read in any text editor.
To connect to your favorite Hosts without loading NetOp Guest first, copy their phonebook records to 
your computer desktop where they will display as dwc file icons. Double-click the file icon to start the 
default type session with the Host. If not loaded, NetOp Guest will load and run minimized in a 
notification area NetOp Guest button. Right-click the file icon to display a context menu with Session 
Commands, a Connection Properties command and standard desktop icon commands.
3.5.4.1.4 Phonebook Export and Import

You can export and import phonebook data as a comma separated file.
Export
Select in the Tree Pane the Phonebook root folder or a directory folder in it or select in the Records Pane 
one or multiple records and select the File Menu Export from Phonebook command to display this 
window:

Export file name: []: Specify in this field a file path and name. If you specify only a file name, the comma 
separated file will be saved in the directory in which NetOp Guest is installed.
Browse...: Click this button to display a Windows Save As window to select the comma separated file 
directory and specify its name to enter the path and name in the Export file name field.

�Export Passwords: Check this box to include phonebook record passwords in the comma separated file 
(default: unchecked).

Note: You cannot export phonebook record Connection Properties window Display Tab, Keyboard/
Mouse Tab, Compression/Encryption Tab, Desktop Tab and Record Tab properties, but you can specify 
those properties when importing.

Comma Separated File Syntax
The comma separated file is a plain text file. It contains for each phonebook record a line of text with 
entries separated by commas according to this syntax:
<Folder path>,<Description>,<Phone number>,<Name>,<Comment>,<Communication 
profile>,<Host logon name>,<Host logon password>,<Host logon domain>,<Gateway 
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logon name>,<Gateway logon password>,<Gateway logon domain>,<Protect item 
password>,<Wake on LAN MAC address>,<Logon credentials flags>,<Custom 
application description>,<Custom application command line>,

Passwords will be encrypted to be included in the file as 32-digit hexadecimal checksums prefixed by 
ENCRYPTED:.
Import
Select the File Menu Import to Phonebook command to display this window:

Import file name: []: Specify in this field the path and name of the comma separated file from which you 
want to import phonebook data.
Browse...: Click this button to display a Windows Open window to select the comma separated file and 
enter its path and name in the Import file name field.
Connection Properties...: Click this button to display the Connection Properties window with the 
Display Tab, Keyboard/Mouse Tab, Compression/Encryption Tab, Desktop Tab and Record Tab to 
optionally specify properties for all imported phonebook records on these tabs.
OK: Click this button to import the comma separated file phonebook data to create phonebook records in 
the phonebook structure specified in the file, i.e. typically like on the exporting NetOp Guest.
3.5.4.2 Quick Connect Tab
This Tab Panel tab will be displayed unless hidden from the Program Options window Layout Tab:

It enables connecting to a Host by selecting a communication profile and specifying a Host identifier and 
if applicable a routing NetOp Gateway identifier.
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1. Select in the Communication Profile Section a communication profile.
2. Specify in the Host Section the Host name, computer address or modem telephone number and if 

applicable a routing NetOp Gateway computer address or telephone number. 
• Alternatively, if a Networking Communication communication profile is selected click the 

Buttons Browse button to display on the NetOp Network Tab records of responding Hosts. 
Click a record to display its Host ID value in the Host Section Name field or double-click a 
record to start the default session, see General Tab. 

• Alternatively, on the Windows Network Tab click a network computer record to display its 
Name value in the Host Section Name field or double-click the record to start the default 
session, see General Tab.

3. Click the Buttons Connect button or double-click a tab record to start the default session, see 
General Tab.
To start a non-default session or execute an action, click the matching Toolbar button or select the 
matching Connection Menu or tab context menu command.

Note: If connection fails, see Connect Problems.

3.5.4.2.1 Host Section

The content of this Quick Connect Tab section depends on the selected communication profile 
communication device type as explained in these sections:
• Networking Communication
• Line Communication or Gateway
• Network Point-to-Point Communication
• Infrared Communication
Networking Communication
If a communication profile that uses a networking communication device (IPX (including RemPCIPX v. 
4.3), NetBIOS (including RemPCNB v. 4.3), TCP/IP or Terminal Server) is selected, the Quick Connect 
Tab Host Section will have this content:

Name: []: Specify in the field of this drop-down box a name that the Host can respond to, see IPX 
Settings, NetBIOS Settings, TCP/IP Settings or Terminal Server Settings. The drop-down box list 
contains the names of Hosts that have been connected to before. Select a name in the list to display it in 
the field.

Note: NetOp interprets the specified name according to the default Host name qualifier or a prefixed Host 
name qualifier, see Host Name Tab.

This section includes these sections:
Browse for Hosts
Connect to a Network or Network Terminal Server Host through NetOp Gateway

Browse for Hosts
If a communication profile that uses a Networking Communication is selected, you can browse for 
responding network Hosts. Click the Buttons Browse button to send broadcast communication that 
requests that Hosts that receive this communication respond. After a timeout period, records of 
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responding Hosts will display on the NetOp Network Tab. Click a record to display its Host ID value in 
the Host Section Name field or double-click the record to start the default session, see General Tab.
To browse for Hosts with any name, leave the Host Section Name drop-down box field empty or if filled 
in click No when asked if you want to browse for a specific Host name. To browse for Hosts with a 
specific name, specify any number of Host name beginning characters. To browse for Hosts by a non-
default name type, prefix by a Host name qualifier, see Host Name Tab.
Using the LDAP:: Host name qualifier, a browse for Hosts will search directory services specified on the 
Program Options window Directory Services Tab for users to return available matching user name 
attributes and user address attributes. To search for Hosts with a specific name, specify a Host name mask  
(a name containing wildcard characters like * designating any characters). You will be prompted to log 
on to directory services to search for users, see Directory Services Authentication. 
When available user data have been returned, the Guest will browse the network using received user 
address attributes. The NetOp Network Tab will display records of returned users indicating which user 
Hosts have responded.
Connect to a Network or Network Terminal Server Host through NetOp Gateway
If the Networking Communication communication profile used by a Host is unavailable to the Guest or if 
connecting from a network Guest to a network terminal server Host, a NetOp Gateway on the network, 
respectively on the terminal server console, can route the communication.
On the Gateway, enable Networking Communication communication profiles matching the 
communication profiles used by the Guest and the Host.
On the Guest, enable one or multiple Networking Communication Communication Profiles at loading to 
make the networking communication profile <Any initialized communication> available in the 
Communication Profile Section drop-down box list. Connect to the Host after selecting <Any initialized 
communication> that will request that any NetOp Gateway receiving the communication routes it to any 
other enabled Networking Communication communication profile.
Line Communication or Gateway
If a communication profile that uses a line communication device (ISDN (CAPI), Serial or Windows 
Modem) or the Gateway communication device is selected in the Communication Profile Section, this 
Quick Connect Tab Host Section will be displayed:

If you connect by line communication directly to a Host:

specify in the Phone number drop-down box field the Host modem telephone number and leave the Name 
drop-down box field below empty.
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If you connect by the Gateway communication device through a Guest network NetOp Gateway that 
connects by line or network point-to-point communication to a Host:

specify in the Phone number drop-down box field the Host modem telephone number if using line 
communication or the Host IP address if using network point-to-point communication and leave the 
Name drop-down box field below empty.
If you connect by line communication through a Host network NetOp Gateway to a network Host:

specify in the Phone number drop-down box field the Host network NetOp Gateway modem telephone 
number and optionally specify in the Name drop-down box field the Host name.
If you connect by the Gateway communication device through a Guest network NetOp Gateway that 
connects by line or network point-to-point communication through a Host network NetOp Gateway to a 
network Host:

specify in the Phone number drop-down box field the Host network NetOp Gateway modem telephone 
number if using line communication or the Host network NetOp Gateway IP address if using network 
point-to-point communication and optionally specify in the Name drop-down box field the Host name.
The drop-down box lists contains telephone numbers, IP addresses and Host names that have been 
connected to before. Select a list entry to display it in the field.

Note: NetOp will interpret the Name drop-down box field Host name according to the default Host name 
qualifier or a prefixed Host name qualifier, see Host Name Tab.

If no name is specified in the Name drop-down box field, this window will be displayed when connected 
to the Host network NetOp Gateway:
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Select one of these options:

~ Remote Control Gateway: Connect to the Gateway (default selection).

{ Connect to Specific Host: []: Specify in the field a Gateway network Host name to connect 
to the Host.

{ Browse for Hosts: []: Leave the field empty or specify any number of Host name first 
characters to Browse for Hosts on the Gateway network.

Network Point-to-Point Communication
If a communication profile that uses a network point-to-point communication device (TCP/IP (TCP) or 
TCP/IP (TCP IPv6)) is selected in the Communication Profile Section, this Host section will be 
displayed:

If you connect directly to a Host, specify the Host IP address in the TCP/IP Address drop-down box field 
and leave the Name drop-down box field empty. 
If you connect to a Host through a Host network NetOp Gateway, specify the Gateway IP address in the 
TCP/IP Address drop-down box field and optionally specify the Host name in the Name drop-down box 
field.
The drop-down box lists contains IP addresses and Host names that have been connected to before. Select 
a list entry to display it in the field.

Note: NetOp will interpret the Name drop-down box field Host name according to the default Host name 
qualifier or a prefixed Host name qualifier, see Host Name Tab.
If no name is specified in the field, the Gateway Connection window will be displayed when connected to 
the Host network NetOp Gateway, see Line Communication or Gateway.

Infrared Communication
If a communication profile that uses the communication device Infrared (IrDA) is selected in the 
Communication Profile Section, this Host section will be displayed:

If you connect directly to a Host, leave the Name drop-down box field empty.
If you connect to a Host through a Host network NetOp Gateway, optionally specify the Host name in the 
Name drop-down box field.
The drop-down box list contains Host names that have been connected to before. Select a list entry to 
display it in the field.

Note: NetOp will interpret the Name drop-down box field Host name according to the default Host name 
qualifier or a prefixed Host name qualifier, see Host Name Tab.
If no name is specified in the field, the Gateway Connection window will be displayed when connected to 
the Host network NetOp Gateway, see Line Communication or Gateway.
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3.5.4.2.2 Communication Profile Section

To connect to a Host from the NetOp Guest Window Tab Panel Quick Connect Tab, first select in the 
drop-down box of this section:

- a communication profile that matches a communication profile enabled on the Host or on a routing 
NetOp Gateway.

Note: A communication profile is a named configuration of a communication device. NetOp Remote 
Control can use a wide range of Communication Devices.

If you are in doubt which communication profile to select, consult with your network/system 
administrator.
Initially, the drop-down box selection is TCP/IP. The drop-down box list contains the names of Guest 
Communication Profiles. Select a name in the list to display it in the field.
Edit...: Click this button to display the Communication Profile Edit window to edit the selected 
communication profile, see Communication Devices.
New...: Click this button to display the Communication Profile Edit window to create a communication 
profile, see Communication Devices.
Delete: Click this button to delete the selected communication profile.
3.5.4.2.3 Buttons

The NetOp Guest Window Tab Panel Quick Connect Tab has these buttons:

Connect: Click this button to connect to the Host whose name is specified in the Host Section Name drop-
down box field to start a default session, see General Tab. If connection fails, the Name Not Found 
window will be displayed, see Connect Problems.
Browse: This button will be enabled if you can browse for responding network Hosts, see Browse for 
Hosts. Click it to after a timeout period display records of responding Hosts on the NetOp Network Tab.
Disconnect: This button will be enabled only if connected by a line (ISDN (CAPI), Serial or Windows 
Modem) or Gateway communication device, see Line Communication or Gateway. Click the button to 
disconnect the point-to-point connection.
Connection Properties...: Click this button to display the Connection Properties window with a limited 
selection of tabs. Selections in this window will apply if connecting from the Quick Connect Tab.
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3.5.4.2.4 NetOp Network Tab

This NetOp Guest Window Tab Panel Quick Connect Tab tab will display records of Hosts responding to 
a browse for Hosts, see Browse for Hosts:

The section title will display Browse list (created <Time>). To update the tab contents, browse again.
The tab pane will contain Hosts records as icons or table records according to the selection in the View 
Menu or the Toolbar Other Buttons (initially empty).
Details view will display Host records in a table with this column content:
• Host ID: Status indicator and Host ID or directory service user name attribute. These status 

indicators can be displayed:

• User Name: Host computer Windows or network logon user name if enabled, see Host Name Tab.
• Phone Number: Host or Host network routing NetOp Gateway Line Communication or Gateway 

telephone number or IP address or Network Point-to-Point Communication IP address.
• Communication Profile: Guest communication profile name.
• Information: A Gateway record will display (Gateway).
Table controls are explained in Table Control.
Click a record to select it and specify its Host ID value in the Host Section Name field.
Double-click the record of an available Host to start the default session, see General Tab.
Right-click a record or multiple selected records to display this context menu:

A directory service returned this record, but the Host did not respond.

Host responded and is available.

Host responded but it may not be available for a session, typically because another Guest is 
running a session with it. If the Host allows Multi Guest Session, it may be available for a 
Remote Control or Chat session.
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Menu and toolbar controls are explained in Menu and Toolbar Control.
The first menu section contains Session Commands.
The second menu section contains Action Commands.
Disconnect: See Other Commands.
Copy: Select this command or the matching Edit Menu command to copy selected records to the 
clipboard. Pasting clipboard contents into a Phonebook Tab folder will create phonebook records.
Add to Phonebook: Select this command to display a Windows Browse For Folder window to select the 
directory in which to add selected records as phonebook record files, see Phonebook Records.
3.5.4.2.5 Windows Network Tab

This Quick Connect Tab tab will contain Windows network names:

The tab pane will initially contain records of Windows domains and workgroups recognized by the Guest 
computer as icons or table records according to the selection in the View Menu or the Toolbar Other 
Buttons.
Details view will display domain and workgroup records in a table with this column content:
• Name: Domain icon and domain or workgroup name.
Other columns will be empty.
Double-click a record to expand it into its computer records:

The tab pane will contains records of selected domain or workgroup running computers as icons or table 
records according to the selection in the View Menu or the Toolbar Other Buttons.

Note: A computer record verifies that the computer is running but not that NetOp Host is running on the 
computer.

Details view will display computer records in a table with this column content:
• Name: Computer icon and computer name.
• Operating System: Computer operating system name.
• Version: Computer operating system version.
• Comment: Computer comments, if any.
Table controls are explained in Table Control.
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Click a record to select it and specify its Name value in the Host Section Name field. To check if the 
record computer Host responds, click the Buttons Browse button to display its record on the NetOp 
Network Tab if it responds.
Double-click a record to start the default session, see General Tab. If you cannot connect to NetOp Host 
on the computer, the Name not found window will be displayed, see Connect Problems.
Right-click a record or multiple selected records to display this context menu:

This menu matches the NetOp Network Tab context menu.
3.5.4.3 Connections Tab
This tab will be displayed unless hidden from the Program Options window Layout Tab:

It displays current connections and sessions.
Its pane contains records of connected Hosts displayed as icons or table records according to the selection 
in the View Menu or the Toolbar Other Buttons.
Details view will display Host records in a table with this column content:
• Sessions: Icons of running sessions.
• Name: Host networking communication name.
• Phone number: Host point-to-point communication IP address or telephone number or routing Host 

network Gateway IP address or telephone number.
• Communication Profile: Guest communication profile name.
Table controls are explained in Table Control.
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Right-click a record to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
The first section contains Session Commands.
The second section contains Action Commands.
Disconnect: See Other Commands.
3.5.4.4 History Tab
This tab will be displayed unless hidden from the Program Options window Layout Tab:

It stores records of historical Host connections.
The History tab contains an optional left Tree Pane and a right Records Pane. 
The Tree Pane contains a user-defined history directory structure. To hide/display the Tree Pane, click the 
Toolbar Other Buttons Tree Window button or select the matching View Menu command (default: 
displayed).
The Records Pane contains the History Records of the history directory selected in the Tree Pane.
3.5.4.4.1 Tree Pane

This History Tab pane initially contains a History root folder.
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 Right-click in the pane to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
This menu enables you to manage your History directories. You can also manage directory folders by 
drag and drop.
Commands match Edit Menu commands.
3.5.4.4.2 Records Pane

This History Tab pane displays the History Records in the selected Tree Pane folder. Records are 
displayed as icons or table records according to the selection in the View Menu or the Toolbar Other 
Buttons.
Details view displays records in a table with this column content:

Description: Communication device type icon (networking, line, network point-to-point, Gateway 
or Infrared) and record identifying description.
Created: Date and time of last connection.
Name: Host networking communication name.
Phone Number: Host point-to-point communication IP address or telephone number or routing Host 
network Gateway point-to-point communication IP address or telephone number, see Line 
Communication or Gateway.
Communication Profile: Guest communication profile name.
Comment: Optional comment specified by the Guest user or the Host computer user name when 
originally browsing for the Host.
Table controls are explained in Table Control.

To start a session with selected record Hosts, click a Session Buttons button or select a Session 
Commands command. To execute an action on selected record Host computers, click an Action Buttons 
button or select an Action Commands command.
Double-click a record to start the default type session with the record Host, see General Tab.
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Right-click a record or multiple selected records to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
The first section contains Session Commands.
The second section contains Action Commands.
Disconnect: See Other Commands.
Remaining commands match Edit Menu commands.
3.5.4.4.3 History Records

A history record is automatically created in the History root folder when disconnecting from a Host. An 
older history record in the folder with the same Description will be overwritten.
You can copy and move history records between the History root folder and user-defined folders, also by 
drag and drop. Copy your favorite history records to the Phonebook Tab to serve as phonebook records.
History records are saved as files with the extension dwc like Phonebook Records in the History directory 
that resides in the NetOp Configuration Files directory, typically C:\Documents and Settings\<User 
name>\Application Data\Danware Data\NetOp Remote Control\Guest\History.
3.5.4.5 Help Request Tab
This tab will be displayed unless hidden from the Program Options window Layout Tab:

It displays pending Host help requests.
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Note: To service help requests, enable Communication Profiles at Guest loading and set up help services, 
see Help Request Tab.

If help requests are pending, this icon will be displayed in the Status Bar and in the notification area in the 
lower right corner of the screen:

Double-click the notification area button to display the Help Request tab.
The Help Request tab pane displays help request records as icons or table records according to the 
selection in the View Menu or the Toolbar Other Buttons.
Details view displays help request records in a table with thie column content:

Host ID: Help request icon and Host identification.
Time: Time of the help request.
Help Service: Help service name, see Help Request Tab.
Problem Description: Host specified problem description.
Table controls are explained in Table Control.

To respond to a help request, typically double-click the record to start the default session, see General 
Tab.
Right-click a record to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
The first section contains Session Commands.
Copy to clipboard expands into table column name and All commands. Select a table column name 
command to copy the selected table column record value to the clipboard. Select All to copy all record 
values to the clipboard to typically paste them into a help request management system table.

Note: The Program Options window Help Request Tab includes Advanced Help Service options.

Remaining commands match Edit Menu commands.

Note: Delete will remove the selected record but not cancel the record help request.
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3.5.4.6 Recordings Tab
This tab will be displayed unless hidden from the Program Options window Layout Tab:

It provides access to remote control session recordings.

Note: To record remote control sessions, enable recording on the Program Options window Recordings 
Tab or on the Connection Properties window Record Tab.

The Recordings tab contains an optional left Tree Pane and a right Records Pane. 
The Tree Pane contains a user-defined recordings directory structure. To hide/display the Tree Pane, click 
the Toolbar Other Buttons Tree Window button or select the matching View Menu command (default: 
displayed).
The Records Pane contains the Recording Records of the recordings directory selected in the Tree Pane.
3.5.4.6.1 Tree Pane

This Recordings Tab pane initally contains a Recordings root folder.
Right-click in the pane to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
This menu enables you to manage your Recordings directories. You can also manage directory folders by 
drag and drop.
Commands match Edit Menu commands.
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3.5.4.6.2 Records Pane

This Recordings Tab pane displays the Recording Records in the selected Tree Pane folder. Records are 
displayed as icons or table records according to the selection in the View Menu or the Toolbar Other 
Buttons.
Details view displays records in a table with these column contents:

Recorded: Recording icon and recording date and time.
Duration: Duration of recording.
Guest ID: Remote controlling Guest name.
Host ID: Remote controlled Host name.
Description: Remote controlled Host record Description.
Table controls are explained in Table Control.

Double-click a record to play back the remote control session recording in this window::

This window initially has the same size as the remote control window in which the session was 
recorded.
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The title bar displays the name of the session recording remote controlled Host. Title bar window 
controls are explained in Window Control. The window control menu includes playback control 
commands matching the playback control buttons explained below.
The toolbar contains these playback control buttons:

Stop (square): Click this button to close the window.
Pause (two vertical bars): Click this button to make it appear pressed in to pause playback. 
Click this button appearing pressed in to release it to resume playback.
Play (triangle pointing right): Click this button to make it appear pressed in to start playback or 
resume playback when paused. When playback has ended, this button is disabled. 
Back (triangle pointing left to a vertical bar): Click this button to return to the beginning of the 
recording displaying a black display area. The Pause button will appear pressed in and the Play 
button will be enabled.
Playback Speed: By default, the spinbox field will display x1 indicating true speed. Click the 
up/down buttons to change the playback speed by a factor x1 to x20 as displayed in the spinbox 
field.

The status bar contains a colored blocks progress indicator and a playback time counter.
Right-click a record or multiple selected records to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Playback Recording: Select this command to play back the last clicked recording record in the Recording 
Playback window.
Remaining commands match Edit Menu commands.
3.5.4.6.3 Recording Records

If remote control session recording is enabled, each remote control session will create a recording record 
in the Recordings root folder.
You can copy and move recording records between the Recordings root folder and user-defined 
subfolders, also by drag and drop.
Recording records are saved as files with the extension dwr in the record directory that resides in the 
NetOp Configuration Files directory, typically C:\Documents and Settings\<User name>\Application 
Data\Danware Data\NetOp Remote Control\Guest\record. These files can be played back only on NetOp 
Guest.
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3.5.4.7 Script Tab
This tab will be displayed unless hidden from the Program Options window Layout Tab:

It provides access to NetOp scripts and the Script window, see NetOp Script.
NetOp scripts are user-specified command structures that can execute scheduled NetOp actions, typically 
file transfers.
The Script tab contains an optional left Tree Pane and a right Records Pane. 
The Tree Pane contains a user-defined script directory structure. To hide/display the Tree Pane, click the 
Toolbar Other Buttons Tree Window button or select the matching View Menu command (default: 
displayed).
The Records Pane contains the Script Records of the script directory selected in the Tree Pane.
3.5.4.7.1 Tree Pane

This Script Tab pane initially contains a Script root folder.
Right-click in the pane to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
This menu enables you to manage your Script directories. You can also manage directory folders by drag 
and drop.
Commands match Edit Menu commands.
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3.5.4.7.2 Records Pane

This Script Tab pane displays the Script Records in the selected Tree Pane folder. Records are displayed 
as icons or table records according to the selection in the View Menu or the toolbar Other Buttons.
Details view displays script records in a table with these column contents:

Name: Script icon script file name.
Status: Status information, e.g. Edit if the script is being edited or Running if the script is running.
Size: Script file size in bytes.
Comment: An optional comment specified in the Script window, see NetOp Script.
Table controls are explained in Table Control.

Double-click a record to run the record script, see Test a NetOp Script.
Right-click one or multiple selected records to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Edit: Select this command to open the last selected record script in the Script window, see NetOp Script.
Run/Stop: Select this command to run/stop the selected record script, see Test a NetOp Script.
Remaining commands match Edit Menu commands.
3.5.4.7.3 Script Records

By default, records of new NetOp scripts are placed in the Script root folder. You can copy and move 
script records between the Script root folder and user-defined subfolders, also by drag and drop.
Script records are typically saved as files with the extension dws in the script directory that resides in the 
NetOp Configuration Files directory, typically C:\Documents and Settings\<User name>\Application 
Data\Danware Data\NetOp Remote Control\Guest\script. You can open a NetOp script file in a text 
editor to display its textual structure.

Note: You can edit a NetOp script by editing its script file in a text editor. However, we recommend that 
you make use of the Script window graphical NetOp script editor.
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3.5.4.8 Inventory Tab
The tab will be displayed unless hidden from the Program Options window Layout Tab:

It displays retrieved Host computer inventories.
The Inventory tab contains a left Contents Pane and a right Details Pane. 
The Contents Pane contains a user-defined inventory directory structure. Each inventory directory folder 
can contain Host computer inventories that branch out into inventory elements.
The Details Pane displays details of the inventory directory, Host computer inventory or inventory 
element selected in the Contents Pane.
3.5.4.8.1 Contents Pane

This Inventory Tab pane initially contains an Inventory root folder.
Right-click a directory folder or a Host computer inventory to display this context menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
This menu enables you to manage your Inventory directories. You can also manage directory folders by 
drag and drop.
Commands match Edit Menu commands.
Select an inventory directory to display summary details of Host computer inventories in it in the Details 
Pane.
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Select a Host computer inventory to display summary details of it in the Details Pane.
Select a Host computer inventory element to display details of it in the Details Pane.
3.5.4.8.2 Details Pane

This Inventory Tab pane displays details of the element selected in the Contents Pane.
If an inventory directory is selected, it displays the directory Host computer inventories as records in a 
table with inventory details specified on the Program Options window Inventory Tab in columns.
If a Host computer inventory or an inventory element is selected, it displays inventory element details as 
records in a table with the columns Item and Value.
Table controls are explained in Table Control.
Right-click a Host computer inventory record to display this context command:

Select this command to delete the Host computer inventory. You cannot delete details of a Host computer 
inventory.
3.5.4.8.3 Host Computer Inventories

Retrieve Host computer inventories from the Toolbar Action Buttons Get Inventory button or the 
matching Connection Menu command.
When retrieved, Host computer inventories will be placed in the Inventory root folder. A new inventory 
will overwrite an older inventory identified by the same Host name. You can copy and move inventories 
between the Inventory root folder and user-defined subfolders, also by drag and drop.
Retrieved Host computer inventories will be saved as files with the extension xml in the inventor 
directory that resides in the NetOp Configuration Files directory, typically C:\Documents and 
Settings\<User name>\Application Data\Danware Data\NetOp Remote Control\Guest\inventor. You can 
open xml files in any text editor.
To process Host computer inventory information when retrieved, specify in the Program Options 
window Inventory Tab Advanced Inventory Options window an inventory processing program.

Note: NetOp does not undertake to supply or recommend inventory processing programs.

3.5.5 Status Bar
The status bar will be displayed unless hidden from the Program Options window Layout Tab:

It can display these icons at its right end:
Telephone icon: This icon will be displayed if a communication profile using a point-to-point 
communication device (ISDN (CAPI),Serial, Windows Modem, TCP/IP (TCP), TCP/IP (TCP IPv6) or 
Infrared (IrDA)) is enabled at Guest loading.
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Yellow pages icon: This icon is displayed if when a communication profile using the TCP/IP 
communication device is enabled in the Advanced TCP/IP Configuration window the Use NetOp Name 
Server box is checked. These symbols can be displayed on the icon:

Nothing: Specified NetOp Name Servers are available.
Red X: None of the specified NetOp Name Servers is available.
Red exclamation mark (!): One of two specified NetOp Name Servers is available.

Lifebelt icon: This icon will be displayed if a help request is pending, see Help Request Tab.
When the mouse pointer is over a menu command or toolbar button, the status bar will be cleared and a 
hint will be displayed in it unless disabled on the Program Options window Layout Tab.

3.6 Guest Tools
The Guest window Tools Menu contains these commands:

They are explained in these sections:
Program Options
File Manager Options
Log Setup
Maintenance Password
Communication Profiles
Modem Database
Check for New Updates
Publish New Updates
Debug Trace
Run Setup Wizard
Copy Guest to Removable Media

Guest tool settings will be written to NetOp Configuration Files that will typically reside in the directory 
C:\Documents and Settings\<User name>\Application Data\Danware Data\NetOp Remote 
Control\Guest.
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3 NetOp Guest
3.6.1 Program Options
Select the Tools Menu Program Options command to display this window:

This window has these tabs:
Layout Tab
General Tab
Cache Tab
Login Tab
Host Name Tab
Directory Services Tab
Remote Control Tab
Monitor Tab
Audio-Video Chat Tab
Remote Printing Tab
Recordings Tab
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Sounds Tab
Help Request Tab
Run Tab
Encryption Tab
Inventory Tab
Web Update Tab

3.6.1.1 Layout Tab

This tab specifies Guest window layout options.
Enable
;Tool bar: Uncheck this box to remove the Toolbar from the Guest window (default: checked).

;Status line: Uncheck this box to remove the Status Bar from the Guest window (default: checked).

;Menu hints: Uncheck this box to disable the display of menu command and toolbar button hints in the 
Status Bar (default: checked).

;Add Guest icon to tray: Uncheck this box to display no NetOp Guest button in the notification area in 
the lower right screen corner when NetOp Guest is loaded (default: checked).
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3 NetOp Guest
;Hide Guest from taskbar when minimized: This option will be disabled if Add Guest icon to tray 
is unchecked. Uncheck this box to display the minimized Guest as a button in the taskbar at the 
bottom of the screen (default: checked). If checked, the minimized Guest will be displayed only as a 
NetOp Guest button in the notification area in the lower right corner of the screen.

�Save Guest minimize state on exit: Check this box to load the Guest minimized if minimized when last 
unloaded (default: unchecked).

�Stealth mode (hide Guest when started): Check this box to load the Guest hidden to the computer user 
(default: unchecked).
To unhide the Guest when hidden, execute this command in the Start > Run window or a command 
prompt window:

<Guest directory path>\nowutil /g /s

To hide the Guest again, unload and load it.
Tab layout
The scrolling pane contains a checkboxed list of available Tab Panel tab names:

;Phonebook

;Quick Connect

;Connections

;History

;Help Request

;Recordings

;Script

;Inventory
Uncheck a box to remove this tab from the Tab Panel (default: all checked).
Up/Down: The  scrolling pane top-to-bottom tab name order controls the Tab Panel left-to-right tab 
order. Select a scrolling pane tab name and click one of these buttons to move it.

Note: The tab order above is the initial tab order. The Quick Connect Tab will be displayed in front.
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3.6.1.2 General Tab

This tab specifies general connect options.
Host session default mode
Select one of these session options to start the selected session if you connect to a Host by clicking the 
Quick Connect Tab Buttons Connect button or by double-clicking a tab Host record:

~Remote control (default selection)

{File transfer

{Chat

{Audio-video chat

{Remote management
Inactivity
Inactivity timeout: [] min. (0 = Unlimited): Specify in this field a number to disconnect if there has been 
no Guest user keyboard or mouse activity within the specified number of minutes (default: 0, range 0-
999).
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Keep Alive
�Send keep alive message: Check this box to send a data packet at intervals while connected to alert the 
Guest if the connection has been lost (default: unchecked).

Note: To maintain an ISDN (CAPI) connection during short periods of inactivity, do not check this box 
but select the Short-hold mode option, see ISDN (CAPI) Communication Profile Edit.

Confirm when
�Exiting Guest while connected: Check this box to display this warning if you attempt to unload the 
Guest while being connected to a Host (default: unchecked):

Yes: Click this button to unload the Guest.
No: Click this button to cancel the unload attempt.

Connection
Connection attempts: [] (0: Indefinite): Specify in the field a number in the range 1-999 to make this 
number of connection attempts each time you connect to a Host (default: 1).
Auto reconnect: []: The field of this drop-down box will display the selected reconnect option if a 
connection is lost. The drop-down box list contains these options:
• Never: Never reconnect (default selection).
• Abnormal disconnect only: Reconnect only if the connection was lost by an abnormal event.
• Host disconnect only: Reconnect only if the Host disconnected.
• Always: Always reconnect.
Select an option in the list to display it in the field.
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3.6.1.3 Cache Tab

This tab specifies screen image disk cache options.
Host screen command transfer disk cache
When the Guest remote controls a Host in command mode, see the Connection Properties window 
Compression/Encryption Tab, the Guest will store the Host screen image in disk cache memory to 
transfer only image changes to speed up Host screen image update and save transmission bandwidth.
Select one of these options:

~Use separate cache file for each Host: Reserve a disk cache section for each connected and 
disconnected Host. If you connect to many different Hosts, a large total disk cache size will be 
required to achieve high update and reconnect speed (default selection).

{Use shared cache file for all Hosts: Share the available disk cache among connected and 
disconnected Hosts. Total disk cache size demand will typically be lower.

{Don’t save cache between sessions: Share the available disk cache only among connected Hosts. 
Total disk cache demand will be lowest, but reconnects will be slower.

Limit total disk cache size to: [] KB. (200 - 64000): Default size is 10000 KB (10 MB). Specify a number 
in the specified interval, typically larger than default if regularly running command mode remote control 
sessions with many different Hosts.
106



3 NetOp Guest
3.6.1.4 Login Tab

This tab specifies Guest logon and name options.
Guest ID []: This field specifies the name by which the Guest will identify itself when communicating 
(default: Guest computer name). You can edit the field content.

Note: If the Guest runs on a network computer, we generally recommend to name it by its computer 
name. If the Guest runs on a terminal server client, we generally recommend to name it by its computer 
user name, see the Administrator’s Manual Advanced Tools chapter NetOp Naming in a TSE section.

Authentication
�Cache login passwords: Check this box to store the most recently used logon credentials in cache 
memory to apply them when connecting (default: unchecked). Cached logon credentials will be lost when 
the Guest is unloaded.
Access Server 6.x/5.x
�Use Access Server on Guest side: Check this box to enable Guest side authentication with Hosts that 
are Guest side authentication enabled on a NetOp Access Server (default: unchecked).

Note: NetOp Security Server (version 7+ only) does not support Guest side authentication.
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�Ignore if access to Host cannot be authenticated: Check this box to ignore Guest side authentication 
with Hosts that are not Guest side authentication enabled on a NetOp Access Server (default: unchecked).
3.6.1.5 Host Name Tab

This tab specifies Host name and NetOp Name Server name space ID options.
Default Host name qualifier
NetOp Remote Control interprets a specified Host name as being prefixed by the default Host name 
qualifier that identifies the Host name type, unless the Host name is actually prefixed by another Host 
name qualifier. This section specifies the default Host name qualifier. Select one of these options:

~Host ID (H::): Interpret a Host name without a prefix as a Host ID (default selection).

{User name (U::): Interpret a Host name without a prefix as a Windows logon user name.

{DNS name (DNS::): Interpret a Host name without a prefix as a DNS name.

{LDAP name (LDAP::): Interpret a Host name without a prefix as a directory service user attribute 
value.

Note: Prefix a specified Host name by a qualifier (shown above in parentheses) to identify its non-default 
type.
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3 NetOp Guest
Duplicate names
�Check for duplicate names before connecting: Duplicate Host names may exist in a network. By 
default, the Guest will connect to the Host first responding to a specified Host name. Check this box to 
allow the connect attempt to time out and display this window if multiple Hosts have responded (default: 
unchecked):

Multiple Host names found. Select one or more and click OK: []: The pane displays responding 
Hosts as records in a table with this column content:

Host ID: Availability icon (checkmark: available, no entry: unavailable) and Host specified 
Host ID.
User Name: Host computer Windows logon or network logon user name, if enabled.
Communication Profile: Guest communication profile name.
Information: A record of a NetOp Gateway will display (Gateway).
Table controls are explained in Table Control.

Double-click a record or select a record and click OK to connect to the record Host.
NetOp Name Server
Name Space ID: []: By default, this field will display PUBLIC. If the Guest communicates by a 
communication profile that uses the TCP/IP communication device and in its Advanced TCP/IP 
Configuration window the Use NetOp Name Server checkbox is checked to use NetOp Name Server, 
specify in the field the name space ID that will connect you to Hosts that specify the same name space ID.
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3.6.1.6 Directory Services Tab

On this tab, you can specify directory service settings to enable you to connect to and browse for Hosts 
using the LDAP:: Host name qualifier, see Browse for Hosts.
General
Directory Server: []: Specify in this field the directory server IP address or DNS name.
Port: []: Specify in this field the port through which the Guest shall connect to the directory server 
(default: 389, the Lightweight Directory Access Protocol (LDAP) port).

�Use secure connection: Check this box to connect to the directory server by a secure connection. The 
LDAP secure connection port number is 636.
Base DN: []: Specify in this field the directory service distinguished name from which a search shall 
start.
Credentials Tab
This tab specifies the credentials by which the Guest will log on to the directory server. The user identity 
determines which directory service information will be available.

;Anonymous bind: Leave this box checked to search the directory service with anonymous user rights 
(default: checked). Uncheck this box to enable the fields below.
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3 NetOp Guest
User DN: []: Specify in this field a directory service user distinguished name to search the directory 
service with the rights of this user.
Password: []: Specify in this field the matching password.
Confirm password: []: Re-specify in this field the password for confirmation.
Settings Tab

Specify on this tab the settings for searching the directory service for users to return matching name and 
address attribute values. Initially, the fields are empty. 
For guidance on filling in the fields, click Default... to display this window:

The field of the drop-down displays the selected directory service name (default: Microsoft Active 
Directory). The drop-down box list will contain names of available directory services. Select a 
directory service name in the list to display it in the field.
Click OK to specify the selected directory service available default settings in the matching fields.

User search filter: []: Specify or edit the user search filter designation.
User attribute: []: Specify or edit the user attribute designation.
Name attribute: []: Specify or edit the name attribute designation.
Address attribute: []: Specify or edit the address attribute designation.
Search name prefix: []: Specify or edit any prefix (e.g. cn=) that shall be added before search values.
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3.6.1.7 Remote Control Tab

This tab specifies remote control options.
Enable
;Toolbar: Uncheck this box to hide the remote control window toolbar (default: checked).

;Toolbox in full screen: Uncheck this box to hide the remote control full screen display toolbox 
(default: checked).

;Full screen toolbox roll-up: Uncheck this box to not reduce the full screen display toolbox to its title 
bar when not in use (default: checked).

;Status line: Uncheck this box to hide the remote control window status bar (default: checked).
Hot keys assignment
You can assign hot keys (keystroke combinations) to specified actions. By default, CTRL+Z is assigned to 
Zoom in and out (switch between remote control window display and full screen display). Assign desired 
hot keys by checking boxes and specifying a character in the last field.
Remote control window
;Host window auto scroll: Uncheck this box to disable automatic Host screen image scroll when the 
mouse pointer approaches remote control window borders (default: checked).
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3 NetOp Guest
;Auto take control: Uncheck this box to disable acquiring Multi Guest session keyboard and mouse 
control by a keystroke or mouse click, see Multi Guest Session Buttons (default: checked).
Switch to window mode password: []: Specify a password in this field to require this password to switch 
from full screen display to window display. The field will display password characters as dots or 
asterisks.
Disconnect password: []: Specify a password in this field to require this password to disconnect. The 
field will display password characters as dots or asterisks.
3.6.1.8 Monitor Tab

This tab specifies Monitor options.
Monitor interval: [] s: Specify in the field a number in the range 1 - 999 to switch to the next Host after 
monitoring for this number of seconds (default: 15).

�Start Monitor in full screen: Check this box to initially display monitored Host screen images in full 
screen mode (default: unchecked). If unchecked, initially Host screen images will be displayed in 
window mode.
113



3.6 Guest Tools
3.6.1.9 Audio-Video Chat Tab

This tab specifies audio and video chat options.
Audio-Video Chat settings
;Start audio chat when conference is started: Uncheck this box to start an audio-video chat session 
without sound transfer (default: checked). If checked, sound will be transferred.

�Start video when conference is started: Check this box to start an audio-video chat session with video 
image transfer (default: unchecked). If unchecked, no video images will be transferred.
Audio Chat

General
;Enable full-duplex audio: Uncheck this box to disable sound transfer in both directions at the 
same time (default: checked).

Note: Some computer audio systems do not support full-duplex audio.

Microphone sensitivity
Silence level: Drag this slide to specify the microphone sound input level below which no sound 
shall be sent (default: second tick from left).
114



3 NetOp Guest
Line hold: Drag this slide to specify the time after the microphone sound input level has dropped 
below the Silence level in which sound shall be sent (default: seventh tick from the left).

Note: Try out different Silence level and Line hold settings to optimize sound transfer. 

Check sound system: Click this button to check the computer sound system and display a result 
message.
Advanced...: Click this button to display this window:

Playback
Preferred device: []: The field of this drop-down box displays the preferred audio playback 
device (default: <Use any available device>). The drop-down box list will contain the names 
of available playback devices. Select a name in the list to display it in the field.
Record
Preferred device: []: The field of this drop-down box displays the preferred audio recording 
device (default: <Use any available device>). The drop-down box list will contain the names 
of available recording devices. Select a name in the list to display it in the field.

Note: If multiple audio devices are connected to the computer, <Use any available device> 
may select a connected device instead of the computer sound system. In that case, select the 
computer sound system.

Audio Compression
Try audio compression codecs in the following order: []: This pane will contain a prioritized 
list of Guest computer available mono audio compression codecs.
Up/Down: Select a codec and click these buttons to move it up or down.
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Use defaults: Click this button to restore the default codec priority.

Note: Audio communication will use the highest prioritized Guest computer codec that is also 
available on the Host computer.

Video
Capture size []: The field of this drop-down box will display the selected video capture frame width 
times height in pixels (default: 160 x 120). The drop-down box list will contain available video capture 
frame sizes. Select a video capture frame size in the list to display it in the field.
Advanced...: Click this button to display this window:

Select driver to use: []: If a video camera is installed, this drop-down box will contain its driver 
name. Select a driver name in the list to display it in the field.
If a camera that uses the driver whose name is displayed in the Select driver to use drop-down box 
field is enabled, the image frame will display its captured image.
Format: Click this button to display the Windows Video Format window to format the video capture 
image.
Properties: Click this button to display the Windows Video Source window to specify video source 
properties.
� Disable compression: Check this box to disable video data compression (default: unchecked).
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3.6.1.10 Remote Printing Tab

This tab specifies remote NetOp printers and incoming print job redirection.
Remote NetOp printers
The pane will display the names of NetOp printers in the Guest computer Windows Printers folder 
(initially none).
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Add printer...: Click this button to display this window:

Follow these guidelines that will remain on the screen while you add a NetOp printer. Click Ready... 
to start adding a NetOp printer.

Note: The NetOp printer and the selected remote printing device driver must be installed on the 
computer that sends the print job.
Special instructions for remote printing from DOS applications are available in the NetOp 
KnowledgeBase.

Remove printer: Select a NetOp printer in the pane and click this button to remove it.
Redirect print to
You can redirect a print job sent from the Host to the Guest to any printer specified on the Guest 
computer. Select one of these options:

~Default printer: Redirect the print job to the default Guest computer printer (default selection).

{Prompt with a list of available printers: Select this option and click Browse... to display this 
window:

The pane will display the names of Guest computer printers. Select a name and click OK to 
specify the printer name in the field to redirect to this printer.
118

http://help.netop.com


3 NetOp Guest
3.6.1.11 Recordings Tab

This tab specifies remote control session recording options.
Options
�Use compatible mode: Remote control session recording was improved in NetOp Remote Control 
version 8. Older Guest versions cannot play back version 8+ recordings. Check this box to make older 
version compatible recordings (default: unchecked).

�Enforce recording: Check this box to record all remote control sessions even if the Connection 
Properties window Record Tab Record remote control session box is unchecked (default: unchecked).

�Disconnect if recording fails: Check this box to disconnect if a specified recording of a remote control 
session fails (default: unchecked).
Recording
Use the following identity: Every Recordings Tab record and recording file name will identify the Guest. 
Select one of these options:

~Guest ID: Identify by the Guest ID, see Login Tab (default selection).

{Guest user: Identify by the Guest computer Windows logon user name.
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3.6.1.12 Sounds Tab

This tab specifies sounds played upon selected events.
Play sound on event
The pane contains these checkboxed events:

;Incoming help request: A new Host help request has arrived (default: checked).

�Guest start: Guest loads (default: unchecked).

�Guest stop: Guest unloads (default: unchecked).

�Session with Host: Host session has started (default: unchecked).

�Disconnect from Host: Host has been disconnected (default: unchecked).

;Communication error: There has been a communication error (default: checked).

;Keyboard and mouse assigned or revoked: In a Multi Guest session, the Guest has got or lost 
keyboard and mouse control (default: checked).

Check a box to play a sound upon the event. Uncheck to disable.
Select an event and click Play to play the sound assigned to the event.
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Select an event and click Select Sound to open a Windows Open window specifying Files of type: Sound 
Files. Open a sound file with the extension wav to replace the current sound by the sound of the opened 
sound file and mark the event with (*).
Select an event marked (*) and click Default Sound to reassign the default sound to the event and remove 
the (*) mark.
3.6.1.13 Help Request Tab

This tab specifies help request options.

Note: To enable the Guest to receive help requests, in the Communication Profile Setup window enable 
Communication Profiles matching Host help request communication profiles at Guest loading.

Help request settings
�Enable help request: Check this box to enable any type of help request to the Guest (default 
unchecked).

Note: NetOp on Demand Guest has in addition to the Help Request tab below a Service Tickets tab.
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Help Request Tab
;Enable help services: Uncheck this box to disable the help service names specified below (default: 
checked).
Help service 1-3: []: Specify in these fields the names of help services that shall be enabled.

Note: Help service names specified in the fields will be enabled only if the Enable help request and 
Enable help services boxes are checked and if Communication Profiles are enabled at Guest loading. The 
term help provider used on NetOp Host means a help service name specified on NetOp Guest.

Advanced...: Click this button to display this window:

In this window, you can specify actions that shall execute when a help request arrives.
Action: []: The field of this drop-down box will display the selected action. The drop-down box list 
contains these options:
• None: No action (default selection).
• Send message: Run a local program if specified and send a message to the Host. The fields 

below will become enabled.
• Run local program: Run a local program if specified. The fields below except Send message 

will become enabled.
Select an option in the list to display it in the field.
Command line: [] [...]: Specify in this field the command line of a Guest computer program. Click 
[...] to display a Windows Open window specifying Files of type: Programs to select a program file 
whose command will be displayed in the field. You can add these arguments to the command:
• %H: Help request Host name.
• %T: Help request time.
• %P: Help request problem description.

Note: Typically, you would specify a helpdesk program command to register the help request. 
NetOp does not undertake to supply or recommend helpdesk programs.

Timeout: [] s.:  Specify in this field a number (default: 5, range 0-9999, 0 = no timeout) to time out 
(cancel if unsuccessful) the command specified above after the specified number of seconds.
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Send message: [] [...]: Specify in this field the path and name of a rtf (Rich Text Format) file to send 
a NetOp message with the rtf file content to the help requesting Host, see NetOp Message. Click [...] 
to display a Windows Open window specifying Files of type: RTF to select and open a rtf file whose 
path and name will be displayed in the field.

�Clear help request: Check this box to delete the Tab Panel Help Request Tab record when the 
actions specified above have executed successfully (default: unchecked).

Note: Deleting the Help Request Tab record will not cancel the help request on the Host, see 
Request Help.

�Display a notification message when new help request arrives: Check this box to display this 
message when a help request arrives (default: unchecked):

This window will display the help request Host name, time and if specified a problem 
description.
Yes: Click this button to display the Tab Panel Help Request Tab.
No: Click this button to close the window.
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3.6.1.14 Run Tab

This tab specifies programs to include them in the Run Program drop-down menu.
Run program
The pane will display specified programs as records in a table with this column content (initially empty):
• Description: The name that identifies the program in the Run Program drop-down menu.
• Path: Host computer program file path and name.
Table controls are explained in Table Control.

Note: The table content will be stored in the NetOp Configuration Files runprog.ndb file that will 
typically reside in the path C:\Documents and Settings\<User name>\Application Data\Danware 
Data\NetOp Remote Control\Guest.
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Add…: Click this button to display this window:

File
Description: []: Specify in this field the description that shall identify the program in the Run 
Program drop-down menu.
File name: []: Specify in this field the program file path and name.
Command line switches: []: Specify in this field any switches that shall be applied to the program 
file.
Translate: Click this button to replace File name field path elements by available environment 
variables to facilitate identifying the path on Host computers whose directory structure is different 
from the Guest computer directory structure due to e.g. language or operating system.
Browse…: Click this button to display a Windows Open window that specifies Files of type: 
Programs to open a Guest computer program file to display its path and name in the File name field.

Note: The Open window will display only Guest computer directories and program files. Select All 
files in the lower drop-down box list to display all file types. You can also run other file types, e.g. 
text files. To run successfully, the file must be available and identifiable on the Host computer.

Run
Select one of these options:

~Normal: Run the program in a normal size window (default selection).

{Maximized: Run the program in a maximized window.

{Minimized: Run the program minimized.
OK: Click this button to add the program specification to the Run Tab pane.

Properties...: Select a record in the pane and click this button to display its properties in the Run window 
to edit them.
Delete: Select a record in the pane and click this button to delete it.
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3.6.1.15 Encryption Tab

This tab specifies enabled encryption types.

Note: NetOp communication will be protected by encryption. A range of encryption types is available on 
version 7.0+ NetOp Remote Control modules. One encryption type is available on version 6.5- NetOp 
Remote Control modules. Communicating NetOp modules will automatically negotiate to encrypt 
communication by an encryption type that is enabled on both modules, see the Connection Properties 
window Compression/Encryption Tab. NetOp modules on which no common encryption type is enabled 
cannot communicate.

Enabled Encryption Types
The pane displays checkboxed available encryption type icons and names. Leave a box checked to enable 
the encryption type (default: all checked): Uncheck to disable.

;NetOp 6.x/5.x Compatible: NetOp Remote Control version 6.5- compatible encryption.

;None: Module identification encryption but no data encryption.

;Data integrity: Data integrity encryption.

;Keyboard: Keyboard encryption.
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;Data integrity and Keyboard: Data integrity and keyboard encryption.

;High: High level encryption.

;Very High: Very high level encryption.
Show Details: Select an encryption type and click this button to display encryption details.
3.6.1.16 Inventory Tab

This tab specifies Tab Panel Inventory Tab and advanced inventory options.
Summary view
The pane contains a checkboxed list of available Host computer inventory details. Check/uncheck boxes 
to select the columns that shall be displayed in the Tab Panel Inventory Tab Details Pane summary view 
when a folder is selected in the Contents Pane. Checked box detail columns will be displayed in a left-to-
right order like the pane top-to-bottom order.
Up/Down: Select a Host inventory detail and click one of these buttons to move it up or down in the pane 
to change its column’s position in the Tab Panel Inventory Tab Details Pane summary view.
Select All: Click this button to check all pane Host inventory details.
Deselect All: Click this button to uncheck all pane Host inventory details.
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Advanced...: Click this button to display this window:

In this window, you can specify inventory processing and custom inventory items.
Run program after inventory scan
You can specify an inventory processing program to automatically process each newly retrieved 
Host computer inventory. Select one of these options:

~Disable: Disable running the program specified below (default selection).

{Run for each Host: Run the program specified below when a Host computer inventory has 
been retrieved.

{Run after all scans have completed: Run the program file specified below when a batch of 
Host computer inventories has been retrieved.

File name: []: Specify in this field an inventory processing program file path and name including 
required command line switches.
Browse: Click this button to display a Windows Open window specifying Files of type: Programs to 
open an inventory processing program file the path and name of which will be displayed in the File 
name field.

Note: NetOp does not undertake to supply or recommend inventory processing programs.

Custom Inventory Items
The pane displays records of custom inventory items in a table with this column content (initially 
empty):
• Name: Inventory item name.
• Type: Inventory item type.
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• Argument: Inventory item argument.
Table controls are explained in Table Control.
Add...: Click this button to display this window:

This window specifies a custom inventory item.
Name: []: Specify in this field the inventory item name.
Item type: []: The field of this drop-down displays the selected inventory item type. The drop-
down box list contains inventory item types that determine the argument fields below:
• Environment variable: Field: Environment variable (default selection).
• Registry key: Drop-down box: Registry key, field: Sub key.
• Ini File: Field: File name, field: Section, field: Key.
• File Information: Field: File name.
• DLL: Field: DLL file name, field: DLL argument.
• ASCII File Content (max 512 bytes): Field: File name.
Select an inventory item type in the list to display it in the field. Specify in the argument fields 
below the arguments required to define the custom inventory item.
OK: Click this button to display the inventory item specification as a record in the Custom 
Inventory Items table.

Edit: Select a record in the pane and click this button to display its specification in the Custom 
Inventory Item window to edit it.
Delete: Select a record in the pane and click this button to delete it.

Note: The pane content will be stored in the NetOp Configuration Files InvCuItm.xml file that will 
typically reside in the path C:\Documents and Settings\<User name>\Application Data\Danware 
Data\NetOp Remote Control\Guest.
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3.6.1.17 Smart Card Tab

This tab specifies the Smart Card reader whose reading will be applied to Smart Card Authentication.
Select Smart Card reader: []: The field of this drop-down will display the name of the selected Smart 
Card reader. The drop-down box list will contain Default and the names of connected Smart Card readers 
found by Windows. Select an option in the list to display it in the field.
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3.6.1.18 Web Update Tab

This tab specifies web update options to enable updating the NetOp Guest installation from the network.
Update server: []: Specify in this field the web address of the server from which to download Guest 
update files (default: update.netop.com, the NetOp manufacturer web update server).

Note: To update many NetOp installations in an organization, we recommend to Publish New Updates to 
an internal web update server.

HTTP Proxy: []: Specifying a HTTP proxy is typically not required.
Before specifying a HTTP proxy, click Update now to test the web update connection. If this yields a 
message indicating connection to the update server, specify no HTTP proxy. 
If Update now yields no connection, click Detect to make NetOp attempt to detect the HTTP proxy server 
to display its name and port number in the HTTP Proxy field. Click Update now to test the connection.
If unsuccessful, consult with your network/system administrator about what must be specified in the 
HTTP Proxy field (format: <Server name>:<Port number>).
Update now: Click this button to connect to the update server specified in the Update server field. A Web 
Update message will notify you if connection to the update server failed, if no updates are available or if 
updates are available and in the latter case ask you if you want to download and install updates.
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Schedule...: Click this button to display this window:

In this window, you can specify a schedule of checks for updates including download and installation of 
available update files.
Schedule
Select one of these options:

~Disabled: Disable automatic web update (default selection). The other sections in the window 
will be disabled.

{Automatic download, prompt before install: Automatically download any update files and prompt 
the user when downloaded.

{Automatic download and install: Automatically download and install any update files.

�Allow system restart after install: Check this box to automatically restart the computer after 
update installation if required (default: unchecked). Leave unchecked to deny automatic restart 
to after installation display a message that restart is required to complete the installation.

Run
Select one of these options:

~At loading: Check for updates when the Guest is loaded (default selection). The Delay section in 
the image above will be displayed.

Delay
[] minute delay: Specify in this field a number to delay the web update by the specified number 
of minutes (default: 0, range 0-99).

{Daily: Check for updates on a daily basis. This section will be displayed:
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Start at
[] every [] day: In the first field, specify the time of the day (default: 12:00). In the second 
field, specify by a number an interval in days (default: 1, range 1-99).

�Randomize within the hour: Check this box to randomize the update time within the hour 
following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is 
first loaded thereafter.

{Weekly: Check for updates on a weekly basis. This section will be displayed:

Start at
[] every [] week: In the first field, specify the time of the day (default 12:00). In the second 
field, specify by a number an interval in weeks (default: 1, range 1-99).

�<Weekday>: Check boxes to run scheduled web updates on selected weekdays (default: 
Monday only checked).

�Randomize within the hour: Check this box to randomize the update time within the hour 
following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is 
first loaded thereafter.

{Monthly: Check for updates on a monthly basis. This section will be displayed:

Start at
[] on the [] day of the month: In the first field, specify the time of the day (default: 12:00). In 
the second field, specify by a number the day of the month (default: 1, range 1-28).

�Randomize within the hour: Check this box to randomize the update time within the hour 
following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is 
first loaded thereafter.

Start date
Year: [] Month: [] Day: []: Select in the drop-down boxes the schedule start date (default: today).
3.6.2 File Manager Options
Select the Tools Menu File Manager Options command to display the File Manager Options window, 
see File Transfer Options Menu.
3.6.3 Log Setup
Select the Tools Menu Log Setup command to display the Log Setup window.
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Note: Log setup is common to all NetOp modules. Therefore, the Log Setup section is included in the 
Common Tools chapter.

3.6.4 Maintenance Password
Select the Tools Menu Maintenance Password command to display this window:

A maintenance password protects the access to Tools Menu setup commands to prevent unauthorized 
Guest setup changes.
Old Password: []: Specify in this field the current maintenance password (initially none, the field is 
disabled). Keystrokes will display as dots or asterisks.
New Password: []: Specify in this field the new password (maximum 16 characters).
Confirm Password: []: Specify in this field the new password for confirmation.

Note: Disable maintenance password protection by leaving the New Password and Confirm Password 
fields blank.

If maintenance password protection is applied, selecting any Tools Menu setup command will display 
this window:

Enter password: []: Specify in this field the maintenance password.
If the specified password is wrong, an error message will be displayed. There is no limit to the 
number of maintenance password attempts.
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3.6.5 Communication Profiles
Select the Tools Menu Communication Profiles command to display this window:
Communication Profile Setup

In this window, you can enable/disable, create, edit and delete communication profiles.

Note: A communication profile is a named configuration of a communication device. You can create 
multiple communication profiles with different configurations of each communication device. 
Communication devices are common to all NetOp modules. Therefore, the Communication Devices 
section is included in the Common Tools chapter.

Communication Profile List []: This pane contains checkboxed Guest communication profile names. 
Check boxes (default: LAN (TCP) and TCP/IP checked) to enable communication profiles at Guest 
loading.

Note: Enabling communication profiles at Guest loading is required only for these purposes:
• To receive Host help requests, see the Program Options window Help Request Tab.
• To Connect to a Network or Network Terminal Server Host through NetOp Gateway.
• To search the network for Gateway device groups using <Any initialized communication>, see 

Gateway Communication Profile Edit.

New: Click this button to display the Communication Profile Edit window to create a communication 
profile.
Edit: Select in the pane a communication profile to highlight it and click this button to display the 
Communication Profile Edit window to edit it.
Delete: Select in the pane a communication profile and click this button to delete it.

Note: To apply changes to enabled communication profiles, you must reload the Guest.
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3.6.6 Modem Database
Select the Tools Menu Modem Database command to display the Modem window, see Modem Database.

Note: The modem database is common to all NetOp modules. Therefore, the Modem Database section is 
included in the Common Tools chapter.

3.6.7 Check for New Updates
Select the Tools Menu Check for New Updates command to connect to the web update server specified 
on the Program Options window Web Update Tab to check for new updates to the Guest installation.
3.6.8 Publish New Updates
Select the Tools Menu Publish New Updates command to display a Windows Browse for Folder 
window. Select a network folder to copy web update files for the installed version of NetOp Remote 
Control from the URL specified on the Program Options window Web Update Tab to the specified 
network folder.
This system/network administrator tool will enable network users to web update their NetOp installation 
by connecting to an internal web update server.
3.6.9 Debug Trace
Normally, this command is not included in the Tools Menu. Select the Help menu About... command and 
press ALT+Z to display it. Select it to save a debug trace of recent communication. This debug trace may 
be requested by NetOp supporters to troubleshoot communication problems.
This window will be displayed:

It displays where the debug trace is saved.
Yes: Click this button to display the content of the debug trace. It is a text file that logs NetOp 
communication events without logging communicated data. Its interpretation requires NetOp expertise.
No: Click this button to close the window.
3.6.10 Run Setup Wizard
Select the Tools Menu Run Setup Wizard command to run the Setup Wizard.
3.6.11 Copy Guest to Removable Media
Connect a removable data storage media device to your computer, e.g. by its USB socket, and select the 
Tools Menu Copy Guest to Removable Media command to display a Windows Browse For Folder 
window. Select the removable data storage media device to copy your Guest installation including your 
personal Guest settings to the removable data storage media device.
This will enable you to take your NetOp Guest with you to plug the removable data storage media device 
into any compatible Windows computer and run the Guest from there.
NetOp Guest will use around 13 MB plus the space used by personal Guest settings on the removable 
data storage media device.

3.7 Guest Sessions
NetOp Guest on one computer can connect to NetOp Host on another computer to run one session type or 
multiple session types at the same time, see Connect Guide. 
These session types are available:
• Remote Control
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• File Transfer
• Chat
• Audio-Video Chat
• Remote Management
NetOp Host can Allow multiple simultaneous Guest connections on the Program Options window 
General Tab:
Multiple Guests running a Remote Control session with one Host will run a joint Multi Guest Session.
Multiple Guests running a File Transfer session with one Host will run separate sessions.
Multiple Guests running a Chat session with one Host will run a joint Multi Chat Session.
Each Guest and each Host can run only one Audio-Video Chat session at a time.
Multiple Guests running a Remote Management session with one Host will run separate sessions.
3.7.1 Remote Control
If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start a remote control 
session with a Host to display the Host computer screen image on the Guest computer.
The Guest can connect to start a remote control session from the Tab Panel Quick Connect Tab, see 
Remote Control, from a Phonebook Tab or History Tab record or in response to a help request from a 
Help Request Tab record.
When connected, the Guest can start and end a remote control session from a Tab Panel Phonebook Tab, 
Quick Connect Tab, Connections Tab or History Tab record or from the Remote Management NetOp 
Sessions Remote Control command.

Note: If the Host allows multiple simultaneous Guest connections, see Guest Sessions, multiple remote 
control session Guests will run a joint Multi Guest Session.

The Host computer screen image will be displayed on the Guest computer screen, typically in a remote 
control window, see Remote Control Display:

It contains these elements:
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Title Bar
Toolbar and Toolbox
Remote Control Display
Status Bar

3.7.1.1 Title Bar

The Remote Control window title bar will display the name by which you connected to the Host.
Title bar window controls are explained in Window Control.
The Remote Control window title bar menu contains additional commands:

Menu and toolbar controls are explained in Menu and Toolbar Control
Send Keystrokes: This command expands into these commands:

Note: This command will be disabled if Host Guest Access Security does not allow Use keyboard and 
mouse, see Allow Guest To.
Using these keystroke combinations from the keyboard can have undesired effects.

Send Ctrl+Esc: Select this command or click the matching Toolbar and Toolbox Control Buttons 
button to send the keystroke combination CTRL+ESC to the Host to display the Start menu on a 
Windows Host computer or the Window List on an OS/2 Host computer.
Send Ctrl+Alt+Del: Select this command or click the matching Toolbar and Toolbox Control 
Buttons button to send the keystroke combination CTRL+ALT+DEL to the Host to display the 
security dialog box on a Windows 2003/XP/2000 Host computer or restart an OS/2 Host computer.

Note: Send Ctrl+Alt+Del is disabled with a Windows ME, 98 and 95 Host computer.
Select Restart Host PC to restart the Host computer.

Send Alt+Tab: Select this command to send the keystroke combination ALT+TAB to the Host to 
typically shift the active window clockwise on the Host computer screen.
Send Alt+Shift+Tab: Select this command to send the keystroke combination ALT+SHIFT+TAB to 
the Host to typically shift the active window counterclockwise on the Host computer screen.
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Send Print Screen: Select this command to send a PRINT SCREEN command to the Host to copy an 
image of the Host computer screen to the Host computer clipboard.
Send Alt+Print Screen: Select this command to send an ALT+PRINT SCREEN command to the Host 
to copy an image of the Host computer screen active window to the Host computer clipboard.

Clipboard: This command expands into these commands:
Send to Host: Select this command or click the Toolbar and Toolbox Clipboard Buttons Send 
Clipboard button to send the Guest computer clipboard content to the Host computer clipboard.

Note: This command will be disabled if Host Guest Access Security does not allow Transfer 
clipboard, see Allow Guest To.

Retrieve from Host: Select this command or click the Toolbar and Toolbox Clipboard Buttons 
Retrieve Clipboard button to retrieve the Host computer clipboard content to the Guest computer 
clipboard.

Note: This command will be disabled if Host Guest Access Security does not allow Transfer 
clipboard, see Allow Guest To.

Save Screen to Clipboard: Select this command or click the matching Toolbar and Toolbox 
Clipboard Buttons button to capture the Host computer screen image to the Guest computer 
clipboard.
Save Screen to File: Select this command or click the matching Toolbar and Toolbox Clipboard 
Buttons button to capture the Host computer screen image and display a Windows Save As window 
that suggests the file name <Host name>-<Date>-<Time>.bmp and the NetOp Configuration Files 
SnapShot directory. You can change the file name and directory before saving.

Connection Properties: Select this command or click the matching Toolbar and Toolbox Control Buttons 
button to display the Connection Properties window with limited options.
Full Screen: Select this command or click the matching Toolbar and Toolbox Control Buttons button to 
display the Host computer screen image in full screen display.

Note: Press the zoom hotkey to toggle between window display and full screen display. The zoom hotkey 
is CTRL+Z unless modified, see Remote Control Tab.

Marker Mode: Select this command to checkmark it or click the matching Toolbar and Toolbox Tool 
Buttons button to make it appear pressed in to start NetOp Marker Utility. Select the checkmarked 
command to uncheckmark it or click the pressed in button to release it to stop NetOp Marker Utility.

Note: This command will be disabled if Host Guest Access Security does not allow Use keyboard and 
mouse, see Allow Guest To.

Restart Host PC: Select this command or click the matching Toolbar and Toolbox Control Buttons button 
to display a confirmation window to confirm restarting the Host computer.

Note: This command will be disabled if Host Guest Access Security does not allow Execute command 
(Restart, ...), see Allow Guest To.

Lock Keyboard and Mouse: Select this command to checkmark it or click the matching Toolbar and 
Toolbox Tool Buttons button to make it appear pressed in to disable the Host computer keyboard and 
mouse. Select the checkmarked command to uncheckmark it or click the pressed in button to release it to 
enable the Host computer keyboard and mouse.

Note: This command will be disabled if Host Guest Access Security does not allow Lock keyboard and 
mouse, see Allow Guest To.

Blank Display: Select this command to checkmark it or click the matching Toolbar and Toolbox Tool 
Buttons button to make it appear pressed in to make the Host computer screen turn black to the Host 
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computer user. Select the checkmarked command to uncheckmark it or click the pressed in button to 
release it to unblank the Host display.

Note: This command will be disabled if Host Guest Access Security does not allow Blank the screen, see 
Allow Guest To.
While Blank Display works with most Host computers, the design of some display adapters prevents 
executing it. 

Transfer Sound: Select this command to checkmark it or click the matching Toolbar and Toolbox Tool 
Buttons button to make it appear pressed in to transfer Host computer application sound. Select the 
checkmarked command to uncheckmark it or click the pressed in button to release it to not transfer sound.

Note: This command will be disabled if the Guest or the Host is engaged in another audio session or if 
Host Guest Access Security does not allow Request audio chat and transfer sound, see Allow Guest To.
For Transfer Sound to work, these conditions must be met:
1. On the Host, the Audio-Video Chat Tab Advanced Audio Settings window Record section Preferred 

device drop-down box must select the computer sound system.
2. The Host computer sound system must support sound mix.
3. The Host must specify the sound mix recording mode name of the Host computer sound system, see 

[AUDIO] Section.

Refresh: Select this command to redraw the Host screen image.
3.7.1.2 Toolbar and Toolbox
The Remote Control window toolbar or full screen display toolbox will be displayed unless disabled from 
the Program Options window Remote Control Tab.
The Remote Control window toolbar contains these buttons:

Menu and toolbar controls are explained in Menu and Toolbar Control. 
The Remote Control full screen display toolbox contains the same buttons:
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The toolbox will roll up to display only its title bar unless disabled from the Program Options window 
Remote Control Tab.
The toolbar and toolbox contain these button groups:

Session Buttons
Action Buttons
Control Buttons
Multi Guest Session Buttons
Clipboard Buttons
Tool Buttons

3.7.1.2.1 Session Buttons

These are the Remote Control Toolbar and Toolbox session buttons:

Note: You can also control sessions from the NetOp Guest Window.

Remote Control: This button will appear pressed in during a Remote Control session. Click the 
pressed in button to release it to end the Remote Control session.
File Transfer: Click this button to make it appear pressed in to start a File Transfer session. Click 
the pressed in button to release it to end the File Transfer session.

Note: This button will be disabled if Host Guest Access Security does not allow both of Send files 
to Host and Receive files from Host, see Allow Guest To.

Chat: Click this button to make it appear pressed in to start a Chat session. Click the pressed in 
button to release it to end the Chat session.

Note: This button will be disabled if Host Guest Access Security does not allow Request chat, see 
Allow Guest To.

Audio-Video Chat: Click this button to make it appear pressed in to start an Audio-Video Chat 
session. Click the pressed in button to release it to end the Audio-Video Chat session.

Note: This button will be disabled if Host Guest Access Security does not allow both of Request 
audio chat and transfer sound and Request Video or if the Guest is engaged in another audio or 
video session, see Allow Guest To.

Remote Management: Click this button to make it appear pressed in to start a Remote 
Management session. Click the pressed in button to release it to end the Remote Management 
session.

Note: This button will be disabled if Host Guest Access Security does not allow Remote manage, 
see Allow Guest To.
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3.7.1.2.2 Action Buttons

These are the Remote Control Toolbar and Toolbox action buttons:

Note: You can also execute actions from the NetOp Guest Window.

Run Program: Click this button to display a Run Program drop-down menu to run a program on 
the Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Run programs, 
see Allow Guest To.

Execute Command: Click this button to display an Execute Command drop-down menu to 
execute a command on the Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Execute 
command (Restart, ...), see Allow Guest To.

Send Message: Click this button to display a NetOp Message window to send a NetOp message to 
the Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Send message, 
see Allow Guest To.

Get Inventory: Click this button to Get Inventory from the Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Retrieve 
inventory, see Allow Guest To.
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3.7.1.2.3 Control Buttons

These are the Remote Control Toolbar and Toolbox control buttons:

Disconnect: Click this button or the matching NetOp Guest Window Toolbar Other Buttons 
button or select the matching Connection Menu command to disconnect from the Host.
Connection Properties: Click this button or select the matching Title Bar menu command to 
display the Connection Properties window with a limited tab and option selection.
Full Screen: Click this window toolbar button or select the matching Title Bar menu command to 
display the Host computer screen image in full screen display, see Remote Control Display.
Click this full screen toolbox button to display the Host computer screen image in window 
display, see Remote Control Display.

Note: Press the zoom hotkey to toggle between window display and full screen display. The zoom 
hotkey is CTRL+Z unless modified, see Remote Control Tab.

Send Ctrl+Esc: Click this button or select the matching Title Bar menu command to send the 
keystroke combination CTRL+ESC to the Host to display the Start menu on a Windows Host 
computer or the Window List on an OS/2 Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Use keyboard 
and mouse, see Allow Guest To.
Using this keystroke combination from the keyboard can have undesired effects.

Send Ctrl+Alt+Del: Click this button or select the matching Title Bar menu command to send the 
keystroke combination CTRL+ALT+DEL to the Host to display the security dialog box on a 
Windows 2003/XP/2000/NT Host computer or restart an OS/2 Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Use keyboard 
and mouse, see Allow Guest To. 
Using this keystroke combination from the keyboard can have undesired effects.
Send Ctrl+Alt+Del will be disabled with Windows ME, 98 and 95 Host computers.
Click or select Restart Host PC to restart the Host computer.

Restart Host PC: Click this button or select the matching Title Bar menu command to display a 
confirmation window to confirm restarting the Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Execute 
command (Restart, ...), see Allow Guest To.
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3.7.1.2.4 Multi Guest Session Buttons

These are the Remote Control Toolbar and Toolbox control buttons:

All buttons will be disabled if Host Guest Access Security does not allow Act as multi Guest session 
administrator, see Allow Guest To.

3.7.1.2.5 Clipboard Buttons

These are the Remote Control Toolbar and Toolbox clipboard buttons:

Take Keyboard and Mouse Control: Click this button to take keyboard and mouse control.

Note: If on the Program Options window Remote Control Tab the Auto take control box is 
checked, alternatively click in the Remote Control Display or strike a key to take keyboard and 
mouse control.
This button will be disabled if the Guest has keyboard and mouse control.

Start Multi Chat: Click this button to start a Chat session that will include all Guests connected to 
the Host.

Note: This button will be disabled if only one Guest is connected to the Host or a Multi Chat 
Session is running.

Show Connection List: Click this button to display on the Host computer screen the Connection 
List window that displays records of connected Guests, see Host Connection List.
Suspend Further Connections: Click this button to make it appear pressed in to deny further Guest 
connections. Click the pressed in button to release it to allow further Guest connections.

Note: This button will be disabled if the Host does not Allow multiple simultaneous Guest 
connections, see the Host Program Options window General Tab.

Disconnect All Guests Except Your Own: Click this button to disconnect other connected Guests.

Note: This button will be disabled if only one Guest is connected to the Host.

Send Clipboard: Click this button or select the matching Title Bar menu command to send the 
Guest computer clipboard content to the Host computer clipboard.

Note: This button will be disabled if Host Guest Access Security does not allow Transfer 
clipboard, see Allow Guest To.

Retrieve Clipboard: Click this button or select the matching Title Bar menu command to retrieve 
the Host computer clipboard content to the Guest computer clipboard.

Note: This button will be disabled if Host Guest Access Security does not allow Transfer 
clipboard, see Allow Guest To.

Save Screen to Clipboard: Click this button or select the matching Title Bar menu command to 
capture the Host computer screen image to the Guest computer clipboard.
Save Screen to File: Click this button or select the matching Title Bar menu command to capture 
the Host computer screen image and display a Windows Save As window that suggests the file 
name <Host name>-<Date>-<Time>.bmp and the NetOp Configuration Files SnapShot directory. 
You can change the file name and directory before saving.
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3.7.1.2.6 Tool Buttons

These are the Remote Control Toolbar and Toolbox tool buttons:

Marker Mode: Click this button to make it appear pressed in or select the matching Title Bar 
menu command to checkmark it to start NetOp Marker Utility. Click the pressed in button to 
release it or select the checkmarked command to uncheckmark it to stop NetOp Marker Utility.

Note: This button will be disabled if Host Guest Access Security does not allow Use keyboard 
and mouse, see Allow Guest To.

Blank Display: Click this button to make it appear pressed in or select the matching Title Bar 
menu command to checkmark it to make the Host computer screen turn black to the Host user. 
Click the pressed in button to release it or select the checkmarked command to uncheckmark it to 
unblank the Host display.

Note: This button will be disabled if Host Guest Access Security does not allow Blank the screen, 
see Allow Guest To.
While Blank Display works with most Host computers, the design of some display adapters 
prevents executing it.

Lock Keyboard and Mouse: Click this button to make it appear pressed in or select the matching 
Title Bar menu command to checkmark it to disable the Host computer keyboard and mouse. 
Click the pressed in button to release it or select the checkmarked command to uncheckmark it to 
enable the Host computer keyboard and mouse.

Note: This button will be disabled if Host Guest Access Security does not allow Lock keyboard 
and mouse, see Allow Guest To.

Transfer Sound: Click this button to make it appear pressed in or select the matching Title Bar 
menu command to checkmark it to transfer Host computer application sound. Click the pressed in 
button to release it or select the checkmarked command to uncheckmark it to not transfer sound.

Note: This button is disabled if Host Guest Access Security does not allow Request audio chat 
and transfer sound or if the Guest is engaged in another audio session, see Allow Guest To.
For Transfer Sound to work, these conditions must be met:
1. On the Host, the Audio-Video Chat Tab Advanced Audio Settings window Record section 

Preferred device drop-down box must select the computer sound system.
2. The Host computer sound system must support sound mix.
3. The Host must specify the sound mix recording mode name of the Host computer sound 

system, see [AUDIO] Section.
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3.7.1.3 Remote Control Display
The Remote Control window display panel will display an image of the Host computer screen:

In full screen display, the Host computer screen image will cover the Guest computer screen, see Title 
Bar or Control Buttons.
Specify general Remote Control session options on the Program Options window Remote Control Tab.
Specify Remote Control session options for each Host record or session in the Connection Properties 
window.
By default, the Guest user and the Host user can work in the Host computer screen image at the same 
time.
The Guest user can control Host user access to the Host computer screen image in the Connection 
Properties window Startup Tab Actions section and from Toolbar and Toolbox Tool Buttons and Title 
Bar menu commands.
On the other hand, Host Guest Access Security and other Host Tools enable the Host user or system 
administrators to limit Guest access and actions on the Host computer, see Host Security Guide.
3.7.1.4 Status Bar
The Remote Control window status bar will be displayed unless hidden from the Program Options 
window Remote Control Tab:

The left field will display the icon of the encryption type applied to the communication between the Guest 
and the Host, see Compression/Encryption Tab.
The next field with a recording icon will appear if the session is being recorded, see Record Tab.
The two next fields will display the Guest mouse and keyboard mode, see Keyboard/Mouse Tab. 
The right field will display the duration of this remote control session.
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3.7.1.5 Multi Guest Session
If NetOp Host allows multiple simultaneous Guest connections, see Guest Sessions, multiple Guests can 
connect to run a multi Guest Remote Control session.
Host Guest Access Security specifies which multi Guest session actions are allowed to a Guest, see 
Allow Guest To:
• If the Join multi Guest session box is checked, the Guest can join a Remote Control session that 

another Guest runs with the Host (typically checked).
• If the Act as multi Guest session administrator box is checked, the Guest can manage a multi Guest 

session, see Multi Guest Session Buttons (typically checked).
In a Remote Control multi Guest session, one Guest at a time can have keyboard and mouse control. The 
Guest that has keyboard and mouse control can execute all actions allowed to it. Guests that do not have 
keyboard and mouse control can execute only a limited range of actions.
The NetOp Host Window Title Bar will typically display the name of the Guest that has keyboard and 
mouse control, see the Host Program Options window Connection Notification Tab. Other connected 
Guests will be indicated by +<Number of other connected Guests>.
3.7.2 File Transfer
If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start a file transfer session 
with a Host to transfer files between the Guest and Host computer.
The Guest can connect to start a file transfer session from the Tab Panel Quick Connect Tab, see Other 
Sessions, from a Phonebook Tab or History Tab record or in response to a help request from a Help 
Request Tab record.
When connected, the Guest can start and end a file transfer session from a Tab Panel Phonebook Tab, 
Quick Connect Tab, Connections Tab or History Tab record or from the Remote Control Toolbar and 
Toolbox Session Buttons File Transfer button or the Remote Management NetOp Sessions File Transfer 
command.

Note: If the Host allows multiple simultaneous Guest connections, see Guest Sessions, multiple file 
transfer session Guests will run separate sessions.

This window will be displayed on the Guest computer screen:
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NetOp File Manager

No window will be displayed on the Host computer screen.
This window contains these main elements:
• Title Bar
• Menu Bar
• Toolbar
• Two Record Panels for the Guest to the left and for the Host to the right. A local file transfer session 

will display two Guest record panels.
3.7.2.1 Title Bar

The NetOp File Manager window title bar will display the name by which you connected to the Host.
Title bar window controls are explained in Window Control.
3.7.2.2 Menu Bar
This is the Guest NetOp File Manager window menu bar:

It contains these menus:
• File Menu
• Edit Menu
• View Menu
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• Options Menu
• Help Menu
3.7.2.2.1 File Menu

This is the Guest NetOp File Manager window File menu:

Menu and toolbar controls are explained in Menu and Toolbar Control
Copy Files: Select Record Panel records and select this command or the matching Record Panel context 
menu command, press any matching keyboard shortcut (see Layout Tab) or click the File Transfer 
Buttons Copy Files button to display the Copy window, see Copy/Move/Synchronize/Clone.

Note: Alternatively, drag records from one Record Panel to the other and drop them.

Move Files: Select Record Panel records and select this command or the matching Record Panel context 
menu command, press any matching keyboard shortcut (see Layout Tab) or click the File Transfer 
Buttons Move Files button to display the Move window, see Copy/Move/Synchronize/Clone.
Sync Files: Select this command or click the matching File Transfer Buttons button to display the 
Synchronize window, see Copy/Move/Synchronize/Clone.

Note: By default, synchronization will transfer directories and files to include directories and files that 
exist in either Record Panel in both Record Panels replacing older files by newer files.
On the Options window Transfer Tab, you can apply the Synchronize selections Transfer only if file exists 
and Transfer only one way.

Clone Files: Select this command or click the matching File Transfer Buttons button to display the Clone 
window, see Copy/Move/Synchronize/Clone.

Note: Cloning will transfer all directories and files in the selected Record Panel to the unselected Record 
Panel deleting existing directories and files in it.
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New Folder: Select this command or press any matching keyboard shortcut (see Layout Tab) to display 
this window:

New Folder

Enter folder name []: Specify in this field the new folder name.
OK: Click this button to close the window and create the folder in the selected Record Panel.

Drive Info: Select this command to display this window:

Drives: This pane will display icons and letters of the drives found on the selected Record Panel 
computer. Select a drive to display information on the drive in the Information section.
Information: This section will display information on the drive selected in the Drives pane:
• Type: Drive type.
• File System: Drive file system.
• Used Space: Drive used space in bytes.
• Free Space: Drive free space in bytes.
• Capacity: Drive capacity in bytes.

Delete: Select Record Panel records and select this command or the matching Record Panel context menu 
command, press the matching keyboard shortcut (see Layout Tab) or click the matching Other Buttons 
button to delete selected records. A confirmation window may be displayed, see Confirmation Tab.

Caution: Deleting a directory will delete directories and files in it.
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Rename: Select a Record Panel record and select this command or the matching Record Panel context 
menu command or press any matching keyboard shortcut (see Layout Tab) to display this window:

Enter new name []: This field highlights the current record name. Edit it to rename the record.
Properties: Select a Record Panel record and select this command or the matching Record Panel context 
menu command, press the matching keyboard shortcut (see Layout Tab) or click the matching Other 
Buttons button to display this window:

Properties

This window will display the properties of the selected directory or file including attributes that can 
be changed.

Close: Select this command or the matching Window Control menu command, press any matching 
keyboard shortcut (see Layout Tab), click the matching Window Control button or double-click the Title 
Bar icon to close the NetOp File Manager window to end the File Transfer session.
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3.7.2.2.2 Copy/Move/Synchronize/Clone

Selecting any of the File Menu Copy Files, Move Files, Sync Files or Clone Files commands or clicking 
the matching File Transfer Buttons buttons will display a window like this:

Note: For the File Transfer operations Copy Files, Move Files, Sync Files or Clone Files, this window 
differs by its title bar operation name and as explained below.

This window enables modifying file transfer execution.
From
Computer: Displays the source computer name.
Folder/File: Displays the source computer selection path, for one selected directory <Directory 
path>\*.*, for one selected file <Directory path>\<File name>.
To
Computer: Displays the destination computer name.
Folder/File: []: Highlights the destination computer current directory path and for one selected directory 
*.*, for one selected file <File name>. You can edit the field content to specify another destination 
directory and/or another file name.
Selected
Folders: Displays the number of selected directories.
Files: Displays the number of selected files.
Options
�Include subfolders: This box will be enabled and checked if you have selected directories. Leave it 
checked to transfer also selected directory subdirectories and their file content. Uncheck it to transfer 
only the selected directory and its file content.

�End session when finished: Check this box to end the File Transfer session when this file transfer is 
finished (default: unchecked).
OK: Click this button to execute the file transfer to display the Transfer Status window.
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Options: Click this button to display the NetOp File Manager - Options window to change the option 
selections for this file transfer, see Options Menu.
3.7.2.2.3 Transfer Status

This window will be displayed after clicking OK in the Copy/Move/Synchronize/Clone window or 
executing a file transfer by drag and drop:

It contains these tabs:
• Progress Tab
• History Tab
• Session History Tab
Close: This button will be disabled during file transfer. Click it to close the window. 
Cancel: This button will be enabled only during file transfer.Click it to cancel a file transfer in progress.
Progress Tab
This tab contains these sections:

Current Command
Displays during file transfer the command being executed. Displays after file transfer Transfer 
ended.
Overall Progression
Files transmitted: Displays the number of transferred files.
Total files: Displays the number of selected files.
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Bytes transmitted: Displays the number of transferred bytes.
Total bytes: Displays the number of selected bytes.
Elapsed time: Displays the elapsed transfer time in format MM:SS.
Estimated time: Displays the estimated total transfer time in format MM:SS.
The colored blocks indicate overall file transfer progress.
Sending/Sent/Receiving/Received
Displays during file transfer the path and name of the file being transferred. Displays after file 
transfer the path and name of the last transferred file.
The colored blocks indicate current/last file transfer progress.
These values will be displayed below the progress indicator:

Bytes sent/received: Number of bytes sent/received in the current/last file transfer.
BPS: Transfer speed of the current/last file transfer in bytes per second.
Total Bytes: Number of bytes in the current/last file transfer.

[] End session when finished: Check this box (default: unchecked) to end the file transfer session 
when this file transfer is finished.

History Tab

The pane of this tab will display the events of the current/last file transfer like NetOp Script events. Click 
[+] buttons to expand and [-] buttons to collapse the event structure.
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Session History Tab

The pane of this tab will display the events of this File Transfer session like NetOp Script events. Click 
[+] buttons to expand and [-] buttons to collapse the event structure.
3.7.2.2.4 Edit Menu

This is the Guest NetOp File Manager window Edit menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Select All: Select this command or press any matching keyboard shortcut (see Layout Tab) to select all 
directories and files in the selected Record Panel.
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Select By: Select this command, press any matching keyboard shortcut (see Layout Tab) or click the 
Other Buttons Select Files button to display this window:

Select

Select the files: []: In this field, replace *.* designating all directories and files by a file mask that is 
a file name with wildcard characters like * designating any characters to select files and directories 
with common name characters.
OK: Click this button to select unselected directories and files in the selected Record Panel by the 
file mask.

Deselect By: Select this command or press any matching keyboard shortcut (see Layout Tab) to display 
this window:

Deselect the files: []: In this field, replace *.* designating all directories and files by a file mask that 
is a file name with wildcard characters like * designating any characters to deselect files and 
directories with common name characters.
OK: Click this button to deselect selected directories and files in the selected Record Panel by the 
file mask.

Invert Selection: Select this command or press any matching keyboard shortcut (see Layout Tab) to make 
all selected directories and files unselected and all unselected directories and files selected in the selected 
Record Panel.
Clear Selection: Select this command to deselect all directories and files in the selected Record Panel.
3.7.2.2.5 View Menu

This is the Guest NetOp File Manager window View menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
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Large Icons: Select this command to checkmark it or click the matching Other Buttons button to make it 
appear pressed in to display records as horizontal rows of large icons.
Small Icons: Select this command to checkmark it or click the matching Other Buttons button to make it 
appear pressed in to display records as horizontal rows of small icons.
List: Select this command to checkmark it or click the matching Other Buttons button to make it appear 
pressed in to display records as vertical columns of small icons.
Details: Select this command to checkmark it or click the matching Other Buttons button to make it 
appear pressed in to display records in a table with details in columns (default selection).
Local: Select this command to checkmark/uncheckmark it or click the Other Buttons Local button to 
make it appear pressed in/released to switch between remote and local file transfer (default: 
uncheckmarked/released for remote file transfer).
Arrange Icons: This command expands into these commands:

By Name: Select this command or press any matching keyboard shortcut (see Layout Tab) to sort 
file records by file name, ascending/descending like the Details view selection.
By Type: Select this command or press any matching keyboard shortcut (see Layout Tab) to sort file 
records by extension, ascending/descending like the Details view selection.
By Size: Select this command or press any matching keyboard shortcut (see Layout Tab) to sort file 
records by size, ascending/descending like the Details view selection.
By Date: Select this command or press any matching keyboard shortcut (see Layout Tab) to sort file 
records by time, ascending/descending like the Details view selection.
Auto Arrange: Select this command to uncheckmark/checkmark it to disable/enable automatically 
sorting file records by the current selection after changes (default: checkmarked for Auto Arrange 
enabled).

Note: Directory records in alphabetically ascending order will always be displayed before files.
In Details view, sort records ascending/descending by clicking column headings.

Refresh: Select this command or press any matching keyboard shortcut (see Layout Tab) to retrieve new 
information from the computers to refresh the Record Panel content.
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3.7.2.2.6 Options Menu

This is the Guest NetOp File Manager window Options menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Options: Select this command, click the Other Buttons Options button, in the Copy/Move/Synchronize/
Clone window click the Options button or in the NetOp Guest Window Tools Menu select the File 
Manager Options command to display this window:

Options

It contains these tabs:
• Transfer Tab
• Confirmation Tab
• Layout Tab
• Logging Tab
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Transfer Tab

This tab contains these sections:
Synchronize
�Transfer only if file exists: Check this box to synchronize a file only if it exists in the same 
location in both Record Panels (default: unchecked).

�Transfer only one way: Check this box to transfer files only from the selected Record Panel 
to the unselected Record Panel (default: unchecked).
General Transfer
;Include subfolders: Check this box to include the content of subdirectories of selected 
directories in the file transfer (default: checked).

;Use Delta File Transfer: Check this box to compare each source file with its matching 
destination file and transfer only the difference between the source file and the destination file 
to save transmission bandwidth (default: checked).

;Enable crash recovery: Check this box to transfer files in a way that they can be recovered 
after a computer or network crash during file transfer (default: checked).

�Close dialog when finished: Check this box to close the Transfer Status window when a file 
transfer is finished (default: unchecked).

�End session when finished: Check this box to end the File Transfer session when a file 
transfer is finished (default: unchecked).
Default: Click this button to restore the tab default settings.
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Confirmation Tab

This tab contains these sections:
Confirm when…
;Delete non-empty folders: Leave this box checked to display this confirmation window if 
you are about to delete a directory that contains directories or files (default: checked):

Skip: Click this button to skip deleting the specified directory.
Delete: Click this button to delete the specified directory.
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Advanced...: Click this button to display this window:

This window that contains your Confirmation Tab Delete confirmation option 
selections enables you to change selections for this file transfer before proceeding.

Cancel: Click this button to cancel the file transfer at this stage. You cannot undo 
executed file transfer actions.

�Overwriting/deleting files: Check this box to display this window or the Delete window 
explained above if you are about to overwrite/delete files (default: unchecked):

Skip: Click this button to skip overwriting the specified file.
Overwrite: Click this button to overwrite the specified file.
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Advanced...: Click this button to display this window:

Always skip...
Check boxes in this section to skip the selected action in this file transfer with files 
that have checked properties (default: all unchecked):

�Existing files

�Read-only files

�Hidden files

�System files

�On file write error

�On file read error
Confirm when...
This section that contains your Confirmation Tab Overwrite/Delete confirmation 
option selections enables you to change selections for this file transfer before 
proceeding.

Cancel Transfer: Click this button to cancel the file transfer at this stage. You cannot 
undo executed file transfer actions.

;Overwriting/deleting read-only files: Check this box to display the relevant confirmation 
window explained above if you are about to overwrite/delete read-only files (default: checked).

;Overwriting/deleting hidden files: Check this box to display the relevant confirmation 
window explained above if you are about to overwrite/delete hidden files (default: checked).

;Overwriting/deleting system files: Check this box to display the relevant confirmation 
window explained above if you are about to overwrite/delete system files (default: checked).
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�Drag and drop (copying files with mouse): Check this box to display the relevant 
confirmation window explained above if you are about to transfer files by drag and drop 
(default: unchecked).
Default: Click this button to restore the tab default settings.

Layout Tab

This tab contains these sections:
Screen
;Show toolbar: Leave this box checked to display the NetOp File Manager window Toolbar 
(default: checked).

;Show status bar: Leave this box checked to display a status bar at the bottom of the two 
Record Panels (default: checked).

;Save Session Path at Exit: Leave this box checked to display the same Record Panel 
contents when starting a File Transfer session with the same Host next time (default: checked). 
Uncheck the box to always display the system drive contents when starting a File Transfer 
session.
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Keyboard
Select one of these options:

~Use system hotkey layout: Select this option to use the operating system hotkey layout, 
see the table below (default selection).

{Use NetOp hotkey layout: Select this option to use the NetOp hotkey layout, see the 
table below.

Note: Hotkeys will be displayed next to menu commands.

Function Windows hotkeys NetOp hotkeys
Copy File(s) F3
Move File(s) F6
New Folder F7
Delete DELETE F8
Rename F2
Close ALT+F4 F10
Properties ALT+ENTER SHIFT+F1
Select All CTRL+A
Select by +
Deselect by -
Invert selection *
Arrange Icons By Name CTRL+F3
Arrange Icons By Type CTRL+F4
Arrange Icons By Size CTRL+F6
Arrange Icons By Date CTRL+F5
Refresh F5 CTRL+R
Select the left record panel ALT+F1
Select the right record panel ALT+F2
Help F1 F1
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Icons
Select one of these options:

{Local associated and Host 'exe' icons: Display Record Panel file icons according to 
Guest file associations but display Host exe file icons according to Host file associations.

~Local associated icons: Display Record Panel file icons according to Guest file 
associations (default selection, saves transmission bandwidth). 

{Default icons: Display the same default icon for all Record Panel files (saves 
transmission bandwidth and processor capacity).

Default: Click this button to restore the tab default settings.
Logging Tab

This tab contains this section:
Log File
;Generate log file: Leave this box checked to generate a file transfer log file of when ending 
a File Transfer session (default: checked).

�Append if log file exists: Check this box to append new log entries to an existing log file 
(default: unchecked). If unchecked, an existing log file will be overwritten.
Filename []: This field will specify the log file (path and) name, by default NFM.LOG that will 
reside in the NetOp Configuration Files directory, typically C:\Documents and Settings\<User 
name>\Application Data\Danware Data\NetOp Remote Control\Guest.
Browse: Click this button to display a Windows Save As window to specify a log file path and 
name that will be specified in the field.
Default: Click this button to restore the tab default settings.
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View File Manager Log: Select this command to display a Windows Open window that specifies Files of 
type: Log Files (*.log) to open a NetOp File Transfer log to display its content in this window:

The pane of this window will display logged events like NetOp Script events. Click [+] buttons to 
expand and [-] buttons to collapse the event structure.
Open Log...: Click this button to display a Windows Open window specifying Files of type: Log 
Files (*.log) to open another log file in the window.

Script: Select this command or click the Toolbar Script button to display the Script window to create or 
open a NetOp Script.
3.7.2.2.7 Help Menu

This is the Guest NetOp File Manager window Help menu:

Help Topics F1: Select this command or press the matching keyboard shortcut to open the NetOp Guest 
Help system on the File Transfer topic. The left pane of the window contains a graphical table of 
contents.
3.7.2.3 Toolbar
The NetOp File Manager window toolbar will be displayed unless hidden from the Options window 
Layout Tab:

It contains buttons in these groups:
• File Transfer Buttons
• Other Buttons
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3.7.2.3.1 File Transfer Buttons

This NetOp File Manager window Toolbar button group:

includes these buttons:

3.7.2.3.2 Other Buttons

This NetOp File Manager window Toolbar button group:

includes these buttons:

Copy Files: Select Record Panel records and click this button or select the matching File Menu or 
Record Panel context menu command or press any matching keyboard shortcut (see Layout Tab) 
to display the Copy window, see Copy/Move/Synchronize/Clone.

Note: Alternatively, drag records from one Record Panel to the other and drop them.

Move Files: Select Record Panel records and click this button or select the matching File Menu or 
Record Panel context menu command or press any matching keyboard shortcut (see Layout Tab) 
to display the Move window, see Copy/Move/Synchronize/Clone.
Synchronize Files: Click this button or select the matching File Menu command to display the 
Synchronize window, see Copy/Move/Synchronize/Clone.

Note: By default, synchronization will transfer directories and files to include directories and files 
that exist in either Record Panel in both Record Panels replacing older files by newer files.
On the Options window Transfer Tab, you can apply the Synchronize selections Transfer only if 
file exists and Transfer only one way.

Clone Files: Click this button or select the matching File Menu command to display the Clone 
window, see Copy/Move/Synchronize/Clone.

Note: Cloning will transfer all directories and files in the selected Record Panel to the unselected 
Record Panel deleting existing directories and files in it.

New Folder: Click this button or select the matching File Menu command to display the New 
Folder window.
Delete: Select Record Panel records and click this button, select the matching File Menu or 
Record Panel context menu command or press the matching keyboard shortcut (see Layout Tab) 
to delete selected records. A confirmation window may be displayed, see Confirmation Tab.
Properties: Select a Record Panel record and click this button, select the matching File Menu or 
Record Panel context menu command or press the matching keyboard shortcut (see Layout Tab) 
to display the Properties window.
Select By: Click this button or select the matching Edit Menu command or press any matching 
keyboard shortcut (see Layout Tab) to display the Select window.
Options: Click this button or select the matching Options Menu command to display the Options 
window.
Script: Click this button or select the matching Options Menu command to display the Script 
window to open or create a NetOp Script.
Local: Click this button to make it appear pressed in/released or select the matching View Menu 
command to checkmark/uncheckmark it to switch between remote file transfer and local file 
transfer (default: released/uncheckmarked for remote file transfer).
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3.7.2.4 Record Panel
The two NetOp File Manager window record panels have identical layout:

The top title bars display <Guest> in the left record panel and the Host name in the right record panel. In 
a local file transfer session, the right record panel displays Guest.
The selected record panel title bar has a strong color and the unselected record panel title bar has a 
dimmed color. Click in a record panel or press a keyboard shortcut (see Layout Tab) to select it. Press 
TAB to switch the record panel selection. Record panels remain equally sized.
The directory bar below contains a left drive drop-down box and a right directory drop-down box.
The field of the drive drop-down box displays the selected drive icon and letter. The drop-down box list 
contains the icon, letter and name of drives on the computer. Select a drive in the list to display it in the 
field.
The field of the directory drop-down box displays the path of the selected directory. The drop-down box 
list contains the paths of up to 30 directories that have been selected during the current file transfer 
session. Select a directory path in the list to display it in the field to display its content in the records pane 
below. Alternatively, specify a directory path in the drop-down box field and press ENTER to select the 
directory.

Large Icons: Click this button to make it appear pressed in or select the matching View Menu 
command to checkmark it to display Record Panel records as horizontal rows of large icons.
Small Icons: Click this button to make it appear pressed in or select the matching View Menu 
command to checkmark it to display Record Panel records as horizontal rows of small icons.
List: Click this button to make it appear pressed in or select the matching View Menu command to 
checkmark it to display Record Panel records as vertical columns of small icons.
Details: Click this button to make it appear pressed in or select the matching View Menu 
command to checkmark it to display Record Panel records in a table with details in columns 
(default selection).
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The records pane below contains records of directories and files in the selected directory in one of the 
views Large Icons, Small Icons, List or Details. Change the view from the View Menu or the Toolbar 
Other Buttons. Directory records in alphabetically ascending order are displayed before file records. Sort 
file records by clicking Details view column headings or by pressing a keyboard shortcut (see Layout 
Tab).
Details view displays record details in a table with this column content:
• Name: Record name.
• Ext: <DIR> for directory, file extension for file.
• Size: File size in Bytes. Directory size is 0 Bytes.
• Date: Date and time of last record change.
• Attrib: First letters of record attributes:

r: Read-only
a: Archive
h: Hidden
s: System

Table controls are explained in Table Control.
Double-click a directory record to select this directory to display its path in the directory bar and its 
content in the records pane.
Double-click a records pane top directory record with two period characters (..) to move one step up in 
the directory tree structure.
The bottom status bar displays the number of bytes in the number of selected record files. Bytes in files in 
selected directory record directories are not included in the byte count.
Execute file transfers and manage records from menu commands and Toolbar buttons.
Right-click a record or multiple selected records to display this popup menu:

Top section commands that may be different with different file selections and computer setups are 
similar to Windows Explorer right-click popup menu commands.
Lower sections commands match NetOp File Manager window File Menu commands.

Drag selected records in one record pane to the other record pane and drop them to copy them to a record 
directory, if highlighted, or to the directory whose records are displayed in the pane.
Pressing the right mouse button, drag selected records in one record pane to the other record pane and 
drop them to display this popup menu:

Copy here: Select this command to copy selected records to a record directory, if highlighted, or to 
the directory whose records are displayed in the pane.
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Move here: Select this command to move selected records to a record directory, if highlighted, or to 
the directory whose records are displayed in the pane.
Cancel: Select this command to cancel the attempted file transfer.

3.7.3 Chat
If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start a chat session with a 
Host to enable typed text communication between the Guest computer user and the Host computer user.
The Guest can connect to start a chat session from the Tab Panel Quick Connect Tab, see Other Sessions, 
from a Phonebook Tab or History Tab record or in response to a help request from a Help Request Tab 
record.
When connected, the Guest can start and end a chat session from a Tab Panel Phonebook Tab, Quick 
Connect Tab, Connections Tab or History Tab record or from the Remote Control Toolbar and Toolbox 
Session Buttons Chat button or the Remote Management NetOp Sessions Chat command.
The Host can start and end a chat session with a Guest that is connected to it, see also Multi Chat Session.

Note: If the Host allows multiple simultaneous Guest connections, see Guest Sessions, multiple chat 
session Guests will run a joint Multi Chat Session with the Host.

This window will be displayed on the Guest computer screen and a similar window will be displayed on 
the Host computer screen:

Its title bar will display the name of the Host.
Title bar window controls are explained in Window Control.
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Dialog: []: This pane will display the chat dialog with the name of the sender preceding each 
contribution. When the chat dialog exceeds the pane, the pane will get a vertical scrollbar.
Enter Chat contribution and click Send: []: Specify your chat contribution in this pane from the keyboard 
if the Chat window is active or by pasting text. Edit your chat contribution by the keyboard shortcuts 
CTRL+X (Cut), CTRL+C (Copy), CTRL+V (Paste) and DEL (Delete).
Send: Click this button to move your chat contribution from the Enter... pane to the Dialog pane where it 
will be visible to chat participants.
Font…: Click this button to display the Windows Font window to format your chat contribution.
End chat: Click this button to end the session.
Save...: Click this button to display a Windows Save As window suggesting to save the chat dialog in a 
file named Chat <Date> <Time>.rtf in your personal directory on the computer. You can edit the file path 
and name before saving.
3.7.3.1 Multi Chat Session
If NetOp Host allows multiple simultaneous Guest connections, see Guest Sessions, NetOp Guest can 
start a chat session to join a chat session running between another Guest and the Host to form a multi chat 
session.
If multiple Guests are connected to a Host, the Host can start a chat session with all connected Guests or 
a selected connected Guest.
A Guest that Host Guest Access Security allows to Act as multi Guest session administrator, see Allow 
Guest To, can start a multi chat session with all connected Guests from a Remote Control Multi Guest 
Session, see Multi Guest Session Buttons.
A Guest that ends a multi chat session from the Chat window End chat button will leave the session. The 
session will end when the Host or the last session Guest ends the session.
3.7.4 Audio-Video Chat
If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start an audio-video chat 
session with a Host to enable sound and image communication between the Guest computer user and the 
Host computer user.
The Guest can connect to start an audio-video chat session from the Tab Panel Quick Connect Tab, see 
Other Sessions, from a Phonebook Tab or History Tab record or in response to a help request from a Help 
Request Tab record.
When connected, the Guest can start and end a chat session from a Tab Panel Phonebook Tab, Quick 
Connect Tab, Connections Tab or History Tab record or from the Remote Control Toolbar and Toolbox 
Session Buttons Audio-Video Chat button or the Remote Management NetOp Sessions Audio-Video Chat 
command.
The Host can start an audio-video chat session only with a connected Guest that has keyboard and mouse 
control, see Host NetOp Host Button Connected Menu.
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Note: Each Guest and each Host can run only one audio session at a time including Transfer Sound, see 
Remote Control Title Bar or Toolbar and Toolbox Tool Buttons.

This window will be displayed on the Guest computer screen:
Audio-Video Chat

A similar window without the toolbar will be displayed on the Host computer screen. The Host can end 
the session only by disconnecting.
The title bar will display the Host computer name.
Title bar window controls are explained in Window Control.
The toolbar contains these buttons:

Audio: Initially, this button will appear pressed in to indicate that audio communication (by 
talking) is enabled. Click the button to disable/enable audio communication.
Video: Initially, this button will appear released in to indicate that video communication (by live 
image) is disabled. Click the button to enable/disable video communication.

Note: Video communication will remain disabled if Host Guest Access Security does not allow 
Request video, see Allow Guest To. 

Large: Click this button to resize the Guest and Host Audio-Video Chat window to accommodate 
a large Remote video frame.
Medium: Click this button to resize the Guest and Host Audio-Video Chat window to 
accommodate a medium Remote video frame.
Small: Click this button to resize the Guest and Host Audio-Video Chat window to accommodate 
a small Remote video frame (default selection).
End Session: Click this button to end the audio-video chat session.
172



3 NetOp Guest
In the Remote section, the video frame  will display the remote computer video camera image. If the 
toolbar Video button is released, the frame will display No Video. If no camera runs on the remote 
computer, the frame will display No Camera.
In the Local section, the video frame  will display the local computer video camera image. If the toolbar 
Video button is released, the frame will display No Video. If no camera runs on the local computer, the 
frame will display No Camera.
The lower right Volume section has two slides and a display:
• Drag the left  loudspeaker slide to adjust the playback volume (default: maximum).
• Drag the middle microphone slide to adjust the recording volume (default: medium).
• The right microphone display will monitor the recording volume. The display should remain empty 

while not talking. Colored blocks should partly but not completely fill the display while talking.
Specify audio-video chat options on the Guest Program Options window Audio-Video Chat Tab and the 
Host Program Options window Audio-Video Chat Tab.
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3.7.5 Remote Management
If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start a remote management 
session with a Host to access Host computer management tools.
The Guest can connect to start a remote management session from the Tab Panel Quick Connect Tab, see 
Other Sessions, from a Phonebook Tab or History Tab record or in response to a help request from a Help 
Request Tab record.
When connected, the Guest can start and end a remote management session from a Tab Panel Phonebook 
Tab, Quick Connect Tab, Connections Tab or History Tab record or from the Remote Control Toolbar 
and Toolbox Session Buttons Remote Management button.

Note: If the Host allows multiple simultaneous Guest connections, see Guest Sessions, multiple remote 
management session Guests will run separate sessions.

This window will be displayed on the Guest computer screen:

No window will be displayed on the Host computer screen.
This window provides remote access to a range of Host computer management tools. It contains these 
main elements:
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• Title Bar
• Menu Bar
• Toolbar
• Work panel with a left Navigation Panel and a right Display Panel
• Status Bar
Remote management tools are explained in Management.
NetOp session tools are explained in NetOp Sessions.
Host computer details are explained in Details.
3.7.5.1 Title Bar

The title bar will display the name of the session Host and of any selected Management tool.
Title bar window controls are explained in Window Control.
3.7.5.2 Menu Bar
This is the Guest Remote Management window menu bar:

It contains these menus:
• File Menu
• View Menu
• Management Menu
• Help Menu
• <Management tool> Menu

Note: The <Management tool> menu will be available only if a Management tool is selected.

The red NetOp kite at the right end of the menu bar will move while remote management information is 
retrieved from the Host computer.
3.7.5.2.1 File Menu

This is the Guest Remote Management window File menu:

NetOp Sessions: This command expands into commands matching the Navigation Panel NetOp Sessions 
section.
Exit: Select this command or the Window Control menu Close command, press ALT+F4, click the 
Window Control Close button or double-click the Title Bar icon to end the Remote Management session.
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3.7.5.2.2 View Menu

This is the Guest Remote Management window View menu:

Toolbar: Select this command to uncheckmark/checkmark it to hide/display the Toolbar (default: 
checkmarked to display the Toolbar).
Status Bar: Select this command to uncheckmark/checkmark it to hide/display the Status Bar (default: 
checkmarked to display the Status Bar).
Navigation Panel: Select this command to uncheckmark/checkmark it to enable/disable the Navigation 
Panel (default: checkmarked to enable the Navigation Panel).

Note: If enabled, the Navigation Panel can be hidden/displayed from the Navigation Panel left/right 
pointer button.

3.7.5.2.3 Management Menu

This is the Guest Remote Management window Management menu:

It contains commands matching the Navigation Panel Management section commands.
3.7.5.2.4 Help Menu

This is the Guest Remote Management window Help menu:

Help Index: Select this command to open the NetOp Guest Help system on the Remote Management 
topic. The left pane contains a graphical table of contents.
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3.7.5.2.5 <Management tool> Menu

This Guest Remote Management window menu will be available only if a Management tool is selected. It 
will have the name of the selected Management tool, e.g.:

This menu will have different content with different Management tools.
3.7.5.3 Toolbar
The Remote Management window toolbar will be displayed unless hidden from the View Menu Toolbar 
command if a Management tool is selected, e.g.:

The toolbar will contain different buttons with different Management tools.
177



3.7 Guest Sessions
3.7.5.4 Navigation Panel
The Remote Management window work panel left navigation panel will be enabled unless disabled from 
the View Menu Navigation Panel command:

Click the navigation panel left/right button to hide/display the navigation panel.
Click a section up/down button to collapse/expand it.

This Management section contains Management commands.

This NetOp Sessions section contains NetOp Sessions 
commands.

This Details section contains Details information.
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3.7.5.5 Display Panel
The Remote Management window work panel right display panel:

- initially displays Select a management tool in the left pane.
 Select a Management Menu command or a Navigation Panel Management section command to display 
selected Management tool information in the display panel.

Note: While management information is being retrieved from the Host, the red NetOp kite at the right 
end of the Menu Bar will move.

3.7.5.6 Status Bar
The Remote Management window status bar:

- will contain three fields if a Management tool is selected.
The left field can contain information on a selected Management tool object.
The middle field will display In progress…. while information is being retrieved from the session Host. 
When information has been retrieved successfully, it will display Success. 
The right field will display <Retrieved number of records>/<Total number of records>.
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3.7.5.7 Management
To start a remote management task, select in the Remote Management window Management Menu or 
Navigation Panel Management section one of these commands:
• Disk Drives
• Event Viewer
• Task Manager
• Registry
• Services
• Shared Folders
• Inventory
• Command Console
• System Control

Note: Disk Drives, Event Viewer, Services or Shared Folders requires certain rights on the Host 
computer.
Generally, a Remote Management session acquires the rights of the Host that acquires the rights of the 
user logged on to the Host computer.
To assign required rights to a Remote Management session with a Host on a computer to which no user or 
a user with insufficient rights is logged on, run the Host as a user with required rights, see the NetOp Host 
Program Options window Run As Tab.

3.7.5.7.1 Disk Drives

Select the Management Menu or Navigation Panel Management section Disk Drives command to display 
Host computer disk drive information in the Display Panel:

Note: This command will be disabled if the Host does not have the right to display Host computer disk 
drive information. To assign required rights to the Host, run it as a user with required rights, see the 
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NetOp Host Program Options window Run As Tab. You can display the Run As Tab in a Remote Control 
session with the Host.

Host computer disk drive information will be displayed as icons or table records according to the Disk 
Drives menu or toolbar selection, see below. 
Details view will display table records with this column content:
• Name: Disk drive icon and name.
• Type: Disk drive type.
• Total Size: Disk drive total size in bytes.
• Free Space: Disk drive free space in bytes.
• File System: Disk drive file system.
• Total Used: Disk drive used space in bytes.
• Free %: Disk drive free space in percent of total space.
• Used %: Disk drive used space in percent of total space.
Table controls are explained in Table Control.
In the Menu Bar, select Disk Drives, press ALT+D or right-click in the Display Panel to display this 
menu:
Disk Drives Menu

View: Select this command or click the matching Toolbar button to expand into these commands:

�Large Icons: Select this command to dotmark it to display records as horizontal rows of large 
icons.

�Small Icons: Select this command to dotmark it to display records as horizontal rows of small 
icons.

�List: Select this command to dotmark it to display records as vertical columns of small icons.

;Details: Select this command to dotmark it to display records in a table with details in columns 
(default selection).

;Show in Groups: On a Windows 2003 or XP computer, select this command to uncheckmark/
checkmark it to ungroup/group records by drive type (default: checkmarked to group).

Refresh F5: Select this command, press F5 or click the Toolbar Refresh button to retrieve new data from 
the Host computer to refresh the Display Panel content.
Properties: Select a record and select this command or click the matching Toolbar button to display this 
window:
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Properties

This window displays the selected record disk drive properties.
This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

When a disk drive record is selected, the left Status Bar field will display Free Space: <Bytes of free 
space> Total Space: <Bytes of total space>.
Disk Drive Types
These disk drive types can be displayed:
• <Size> Floppy Disk: Host computer diskette drive.

View: Click this button or select the matching Disk Drives menu command to display the View 
submenu, see Disk Drives Menu.
Refresh: Click this button, select the matching Disk Drives menu command or press F5 to retrieve 
new data from the Host computer to refresh the Display Panel content.
Properties: Select a record and click this button or select the matching Disk Drives menu 
command to display record drive properties in the Properties window.
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• Local Disk: Host computer hard disk or partition.
• Compact Disk: Host computer CD drive.
• RAM disk: Part of Host computer memory allocated to file storage.
• Removable Disk: Removable file storage device.
• Mounted Disk: Drive attached to an empty folder in an NTFS volume.
• Network Drive: Network computer hard disk, partition or directory.
3.7.5.7.2 Event Viewer

Select the Remote Management window Management Menu or Navigation Panel Management section 
Event Viewer command to display Host computer Windows event logs in the Display Panel:

Note: This command will be disabled if the Host does not have the right to display Host computer events. 
To assign required rights to the Host, run it as a user with required rights, see the NetOp Host Program 
Options window Run As Tab. You can display the Run As Tab in a Remote Control session with the 
Host.
Only Windows NT+ (2003, XP, 2000 and NT) computers record events. The Event Viewer command will 
be enabled only if the Host computer runs on a Windows NT+ operating system.

The Display Panel will contain tabs named Application, Security and System like the Windows Event 
Viewer. The fourth File tab can display a saved event log. Each tab will display Host computer event 
records in a table with thise column content:
• Type: Event type icon and description.
• Date: Event date.
• Time: Event time.
• Source: Event source.
• Category: Event category if applicable.
• Event: Event ID.
• User: Event user name or N/A if not a user event.
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• Computer: Event computer name.
Table controls are explained in Table Control.
In the Menu Bar, select Event Viewer, press ALT+E or right-click in the Display Panel to display this 
menu:

Open Ctrl+O: Select this command, press CTRL+O or click the matching Toolbar button to display this 
window:

Open Saved Event Log

This window will open a saved event log file on the File tab.
File resides on: Select one of these options:

~Guest computer: Open a saved event log that resides on the Guest computer (default 
selection).

{Host computer: Open a saved event log that resides on the Host computer.
File path and name: []: Specify in this field the saved event log file path and name.
Log type: []: The field of this drop-down box will display (Unspecified). The drop-down box list 
contains the options (Unspecified), Application, Security and System. Select an option in the list to 
display it in the field.

Note: Opening a saved event log will overwrite the existing File tab content.
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Save Ctrl+S: Select this command, press CTRL+S or click the matching Toolbar button to display this 
window:

Save Event Log

This window will save the displayed event log in a file.
Save file on: Select one of the options:

~Guest computer: Save the event log file on the Guest computer (default selection)

{Host computer: Save the event log file on the Host computer.
File path and name: []: Specify in this field the file path and name.

Note: Event binary data in the Event Properties window Data section will be available only if you 
save the event log file with the default extension evt.

Clear: Select this command or click the matching Toolbar button to display this window:
Clear Event Log

Yes: Click this button to display the Save Event Log window, see above. After closing the Save 
Event Log window, all events in the displayed event log will be cleared.
No: Click this button to clear all events in the displayed event log.
Cancel: Click this button to abandon clearing the displayed event log.

Refresh F5: Select this command, press F5 or click the matching Toolbar button to retrieve new data 
from the Host computer to refresh the tab display.
Log Properties: Select this command or click the matching Toolbar button to display a Properties 
window like the Windows <Log type> Properties window with a similar functionality.
Event Properties: Select a tab record and select this command or double-click a tab record to display an 
Event Properties window like the Windows <Event Type> Properties window with a similar 
functionality.
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This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

3.7.5.7.3 Task Manager

Select the Remote Management window Management Menu or Navigation Panel Management section 
Task Manager command to display Host computer running applications and processes in the Display 
Panel:

The Display Panel contains Applications and Processes tabs. 
The Applications tab will contain records of applications running on the Host computer like the Windows 
NT+ (Windows 2003, XP, 2000 and NT) computer Task Manager window Applications tab in a table 
with this column content:
• Task: Windows icon and application description.
• Status: Will display Running if the application is running on the Host computer.
Table controls are explained in Table Control.
The Processes tab has an upper and a lower pane:

Save: Click this button, select the matching Event Viewer menu command or press CTRL+S to 
display the Save Event Log window.
Open: Click this button, select the matching Event Viewer menu command or press CTRL+O to 
display the Open Saved Event Log window.
Clear: Click this button or select the matching Event Viewer menu command to display the Clear 
Event Log window.
Refresh: Click this button, select the matching Event Viewer menu command or press F5 to 
retrieve new data from the Host computer to refresh the Display Panel content.
Properties: Click this button or select the Event Viewer menu Log Properties command to display 
the displayed log Properties window.
Stop: Click this button to stop retrieving information from the Host computer. Retrieved 
information will be displayed.
186



3 NetOp Guest
The upper pane will contain records of processes running on the Host computer like the Windows NT+ 
(Windows 2003, XP, 2000 and NT) computer Task Manager window Processes tab in a table with this 
column content:
• Image Name: Process or executable file name.
• PID: Process identification number.
• CPU Usage: Percent of the currently used central processing unit (CPU) resources used by this 

process.
• Time: Time that the process has run in the format HH:MM:SS:TTT (H=Hour digit, M=Minute digit, 

S=Second digit, T=Thousands fraction of a second digit).
• Kernel Time: Percent of time running in kernel mode.
• User Time: Percent of time running in user mode.
• Threads: Number of threads running in the process.
• Mem Usage: Bytes of memory used by the process.
Table controls are explained in Table Control.
The lower pane will contain records of threads run by the process selected in the upper pane in a table 
with this column content:
• ID: Thread identification number.
• Time: Time that the thread has run in the format HH:MM:SS:TTT (H=Hour digit, M=Minute digit, 

S=Second digit, T=Thousands fraction of a second digit).
• Kernel Time: Percent of time running in kernel mode.
• User Time: Percent of time running in user mode.
• Priority: Priority ranking number (a high number means high priority for CPU resources).
In the Menu Bar, select Task Manager, press ALT+T or right-click in the Display Panel to display this 
menu:

New Task (Run…): Select this command or click the matching Toolbar button to display this window:

Specify path and name of the program: []: Specify in the drop-down box field the Host computer 
path and name of the executable program file of the application that shall run on the Host computer. 
The drop-down box list contains file paths and names that have been specified before. Select a file 
path and name in the list to display it in the field.
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Note: Like in the Windows Run… window, a path is not required for files residing in the Host 
computer system directory (Windows or WINNT). A path from the system directory or a full path is 
required for other file locations. The path can contain environment variables.

End Task/Process: Select an application or a process in the Display Panel and select this command or 
click the matching Toolbar button to end the application or process on the Host computer.

Caution: If you end an application, unsaved application data will be lost. If you end a process, the 
application or system of which it is a part may not function properly.

Refresh F5: Select this command, press F5 or click the matching Toolbar button to retrieve new 
information from the Host computer to display it in the Display Panel.
This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

When Task Manager is opened or refreshed, the left Status Bar field will display Processes: <Number of 
processes> / CPU Usage <Percent CPU usage>%.
3.7.5.7.4 Registry

Select the Remote Management window Management Menu or Navigation Panel Management section 
Registry command to display the Host computer Windows registry like in the Windows Registry Editor 
window in the Display Panel:

Caution: Typical computer users should never attempt to edit the Windows registry, as even minor 
mistakes can have disastrous effects on the operation of the computer.
Knowledgeable computer users can edit the registry to clean up the computer and modify its Windows 
configuration. However, always take suitable safety precautions including backing up the registry to 
avoid ending up in a deadlock.

The Windows registry stores the configuration of the Windows operating system in a structured database. 
It is created when Windows is installed on the computer and is automatically modified when applications 
are installed and used and when users create or change personal settings.

Create Task: Click this button, select the matching Task Manager menu command or press 
CTRL+S to display the Create New Task window, see above.
End Task/Process: Select a task or process and click this button or select the matching Task 
Manager menu command to end the selected task or process.
Refresh: Click this button, select the matching Task Manager menu command or press F5 to 
retrieve new data from the Host computer to refresh the Display Panel content.
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The Windows registry is organized into five predefined subtrees:

Each subtree expands into a tree structure of keys. This image shows the Registry display panel with an 
expanded Host computer Windows registry:

The left keys pane contains registry keys and the right values pane will contain value records of the key 
selected in the left keys pane.
Keys Pane
This pane contains an expandable tree structure of keys displayed as named folders. Click [+] buttons to 
expand and [-] buttons to collapse keys. Double-click a key folder to expand/collapse it. Click a key 
folder to open it and display its value records in the values pane.
A key folder that has not been opened will be gray. A key folder that has been opened will be yellow.
Values Pane
Select a key in the keys pane to display in this pane its values as records in a table with this column 
content:

Subtree Description
HKEY_CLASSES_ROOT Specifies file and data associations pointing to 

HKEY_LOCAL_MACHINE\Software\Classes keys. Its keys determine how 
applications load and associate with data files.

HKEY_CURRENT_USER Specifies the profile of the user currently logged on to the computer. Its keys that 
are part of the logged on user’s keys in HKEY_USERS take precedence over 
HKEY_LOCAL_MACHINE keys for duplicated data.

HKEY_LOCAL_MACHINE Specifies the Windows configuration on the computer and determines how 
Windows loads.

HKEY_USERS Contains a DEFAULT subtree that specifies the user profile when no user is logged 
on to the computer and a subtree that specifies the user profile of the user currently 
logged on to the computer.

HKEY_CURRENT_CONFIG Specifies the hardware profile that determines how the installed software uses 
available hardware. It specifies associations between 
HKEY_LOCAL_MACHINE\Software keys and HKEY_LOCAL_MACHINE\System 
keys.
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• Name: Value type icon and value name. The name of the first value is always (Default).
• Type: Type designation, see the table below.
• Data: Value data in the required format, see the table below. The first value is always (value not 

set).
Table controls are explained in Table Control.

 in the Menu Bar, select Registry or press ALT+R to open this menu:
Registry Menu

New: This command expands into these commands:
Key: Select this command to create a key as a subkey of the selected key. Replace the highlighted 
default key name by the desired key name by typing or pasting from the clipboard (CTRL+V).

Value Type Type Designation Value Data Format
String Value REG_SZ One value that must be a string of characters.
Binary Value REG_BINARY One value that must be a string of hexadecimal digit pairs. Each 

hexadecimal digit pair is interpreted as a byte value.
DWORD Value REG_DWORD One value that must be a string of 1-8 hexadecimal or decimal 

digits.
Multi-String Value REG_MULTI_SZ Multiple values that must be strings of characters separated by a 

null character.
Expandable String Value REG_EXPAND_SZ One value that must be a string of characters that can include 

replaceable environment variables.
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String Value: Select this command to create a string value record. Replace the highlighted default 
value name by the desired value name by typing or pasting from the clipboard (CTRL+V). Right-
click the record and select Modify to display this window:

Value Name: []: This disabled field will display the value name.
Value Data: []: Specify in this field the value data as a string of characters.

Binary Value: Select this command to create a binary value. Replace the highlighted default value 
name by the desired value name by typing or pasting from the clipboard (CTRL+V). Right-click the 
record and select Modify to display this window:

Value Name: []: This disabled field will display the value name.
Value Data: []: Specify in this pane the value data as a string of hexadecimal digit pairs.
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DWORD Value: Select this command to create a DWORD value. Replace the highlighted default 
value name by the desired value name by typing or pasting from the clipboard (CTRL+V). Right-
click the record and select Modify to display this window:

Value Name: []: This disabled field will display the value name.
Value Data: []: Specify in this field the value data as a string of 1-8 digits according to the 
selected base, see below.
Base: Select one of the options:

~Hexadecimal: Select this option to interpret digits as hexadecimal (default selection).

{Decimal: Select this option to interpret digits as decimal.
Multi-String Value: Select this command to create a multi-string value. Replace the highlighted 
default value name by the desired value name by typing or pasting from the clipboard (CTRL+V). 
Right-click the record and select Modify to display this window:

Value Name: []: This disabled field will display the value name.
Value Data: []: Specify in this pane the value data as strings of characters separated by a null 
character.

Expandable String Value: Select this command to create a expandable string value. Replace the 
highlighted default value name by the desired value name by typing or pasting from the clipboard 
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(CTRL+V). Right-click the value record and select Modify to display the Edit String window to 
specify the value data, see above.

Find… Ctrl+F: Select this command, press CTRL+F or click the matching Toolbar button to display this 
window:

Find

Find What: []: Specify in this field the string of characters that shall be searched for.
Look at
;Keys: Leave this box checked to find keys whose name contains the specified string of characters 
(default: checked).

;Values: Leave this box checked to find value records whose name contains the specified string of 
characters (default: checked).

;Data: Leave this box checked to find value data that contain the specified string of characters 
(default: checked).

�Match Whole String Only: Check this box to find only elements that exactly match the specified 
string of characters (default: unchecked).
Find Next: Click this button or press F3 to start or continue the search from the selected key or value 
downwards.

Tip: This is a useful tool for cleaning up the registry after removing applications.

Find Next F3: Select this command or press F3 to search for the next occurrence of the character string 
specified in the Find window.
Delete Del: Select a key folder or value record and select this command, press DELETE or click the 
matching Toolbar button to display a confirmation window to confirm deleting the selected key or value. 
You cannot delete predefined subtrees and (default) value records.

Caution: Deleting a key will delete all of its subkeys.

Rename: Select a key or value record and select this command to highlight and frame the selected key or 
value name to change it. You cannot rename predefined subtrees and (default) value names.
Import…: Select this command or click the matching Toolbar button to display an Import Registry File 
window like a Windows Open window specifying Files of type: Registration Files (*.reg) to locate and 
open a registration file to import its content into the registry.

Extreme Caution: Importing a registration file will overwrite any matching keys and value records. If 
imported keys and value records and existing keys and value records mismatch, the registry will become 
corrupted.

Export…: Select a key and select this command or click the matching Toolbar button to display an Export 
Registry File window like a Windows Save As window specifying Files of type: Registration Files 
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(*.reg) to specify the path and name of a file that contains the keys and value records of the selected key 
branch.
Modify: Select a value record and select this command or click the matching Toolbar button to display the 
value type matching Edit <Value type> window, see above, to modify value data. You cannot modify the 
(default) value record (value not set) data.
Copy Key Name: Select a key and select this command or click the matching Toolbar button to copy the 
registry path and name of the selected key to the clipboard.
Refresh F5: Select this command, press F5 or click the matching Toolbar button to retrieve new data 
from the Host computer to refresh the Display Panel contents.
Organize Favorites…: Select this command to display this window:

The pane displays your favorites in the Toolbar right drop-down box list (initially none).
Delete: Select a favorite in the pane and click this button to delete it.

Add To Favorites: Select a key and select this command or click the matching Toolbar button to display 
this window:

Add to Favorites

Favorite Name: []: This field will display the name of the selected key. Edit the field content to 
name the added favorite as desired.

Note: Your favorites will be available in the Toolbar right Favorites drop-down box list.

Right-click a keys pane folder to display this menu:
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Expand/Collapse: Select this bolded command or double-click a key to expand/collapse the selected 
key folder.
Other menu commands are explained above.

Right-click a values pane record to display this menu:

Menu commands are explained above.
This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

New: Click this button or select the matching Registry menu command to display the 
New submenu, see Registry Menu.
Delete: Select a key folder or a value record and click this button or select the matching 
Registry menu command to display a confirmation window to confirm deleting the 
selected key or value record. You cannot delete predefined subtrees and (default) value 
records.

Caution: Deleting a key will delete all of its subkeys.

Find: Click this button or select the matching Registry menu command to display the 
Find window.
Import: Click this button or select the matching Registry menu command to display an 
Import Registry File window like a Windows Open window specifying Files of type: 
Registration Files (*.reg) to locate and open a registration file to import the registration 
file specifications into the registry.

Extreme Caution: Importing a registration file will overwrite any matching registry 
keys and value records. If imported keys and value records and existing keys and value 
records mismatch, the registry will become corrupted.

Export: Select a key and click this button or select the matching Registry menu 
command to display an Export Registry File window like a Windows Save As window 
specifying Files of type: Registration Files (*.reg) to specify the path and name of a file 
that contains the keys and value records of the selected key branch.
Modify: Select a value record and click this button or select the matching Registry menu 
command to display the value type matching Edit <Value type> window, see Registry 
Menu, to modify value data. You cannot modify the (default) value record (value not 
set) value data.
Copy Key Name: Select a key and click this button or select the matching Registry 
menu command to copy the registry path and name of the selected key to the clipboard.
Refresh: Click this button, select the matching Registry menu command or press F5 to 
retrieve new data from the Host computer to refresh the Display Panel content.
Add to Favorites: Select a key and click this button or select the matching Registry 
menu command to display the Add to Favorites window.
195



3.7 Guest Sessions
3.7.5.7.5 Services

Select the Remote Management window Management Menu or Navigation Panel Management section 
Services command to display Host computer services in the Display Panel:

Note: This command will be disabled if the Host does not have the right to manage Host computer 
services. To assign required rights to the Host, run it as a user with required rights, see the NetOp Host 
Program Options window Run As Tab. You can display the Run As Tab in a Remote Control session 
with the Host.
Only on Windows NT+ (2003, XP, 2000 and NT) computers, you can manage services. The Services 
command will be enabled only if the Host computer runs on a Windows NT+ operating system.

The Extended tab displays in a left column the selected service name, hotspots enabling its available 
actions and its description.

<Favorites>: By default, the field of this drop-down box will be empty. The drop-down 
box list will contain your favorite keys (initially none). Select a favorite key in the list 
to display it in the field to open this favorite key in the keys pane.
196



3 NetOp Guest
The alternative Standard tab displays only the table:

The table contains record of available services with this column content:
• Name: Service icon and name.
• Description: Service description.
• Status: Started, Stopped or Paused.
• Startup Type: Automatic, Manual or Disabled.
• Log On As: LocalSystem, NT AUTHORITY/LocalService, NT AUTHORITY/NetworkService or 

<User name>.
Table controls are explained in Table Control.
In the Menu Bar, select Services, press ALT+S or right-click in the Display Panel to open this menu:
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Add... Ctrl+N: Select this command, press CTRL+N or click the matching Toolbar button to display this 
first Service Installation wizard window:

Service Installation

Service Name: []: Specify in this field the service name.
Service Display Name: []: Specify in this field the name by which the service shall be displayed.
Next >: Click this button to display this second Service Installation wizard window:

Service Executable File Location: []: Specify in this field the Host computer path and name of the 
service executable file.
< Back: Click this button to return to the previous wizard window.
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Next >: Click this button to display this third Service Installation wizard window:

The options in this window are explained in the Log On Tab section.
Next >: Click this button to display this fourth and final Service Installation wizard window:

Select one of these options:

~Automatic: Start this service automatically, typically when the operating system starts 
(default selection).

{Manual: Start this service manually.

{Disabled: Disable starting this service.

;Start Service After Installation: Leave this box checked to start this service after its installation 
(default: checked). If Disabled is selected above, the service will not start.
Finish: Click this button to install the service on the Host computer to display its record in the 
Display Panel.
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Remove Del: Select a record and select this command, press DELETE or click the matching Toolbar button 
to display a confirmation window to confirm deleting it.

Note: If you remove a service of a running application, the service will become Stopped and Disabled. 
When the application is unloaded, the record will be removed.
Caution: Removing a service may affect dependent services, see Dependencies Tab.

Start: If enabled, select this command or click the Toolbar Start/Resume button to start the selected 
service.
Stop: If enabled, select this command or click the matching Toolbar button to stop the selected service.
Pause: If enabled, select this command or click the matching Toolbar button to pause the selected 
service.
Resume: If enabled, select this command or click the Toolbar Start/Resume button to resume the selected 
selected service.
Restart: If enabled, select this command or click the matching Toolbar button to stop and start the 
selected service.

Caution: Stopping, pausing or restarting a service may affect dependent services, see Dependencies Tab.

Refresh: Select this command or click the matching Toolbar button to retrieve new information from the 
Host computer to refresh the Display Panel content.
Properties: Select a record and select this command or double-click a record to display this window:

This window that enables viewing and changing certain properties of the selected record Host 
computer service has these tabs:
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• General Tab
• Log On Tab
• Dependencies Tab.

Caution: Do not change Host computer service properties unless you know exactly what you are 
doing. Keep notes of changes to enable restoring properties if changes cause an unexpected 
behaviour.

General Tab
This Remote Management Services tab specifies general service properties:
Service Name: Displays the service name.
Display Name: []: Displays the name by which the service is displayed.
Description: []: Displays a service description.
Path to Executable: []: Displays the Host computer path to the service executable file.
Startup Type: []: The field of this drop-down box displays the selected service startup type. The 
drop-down box list contains the options Automatic, Manual and Disabled. Select an option in the list 
to display it in the field.

Note: If you select Disabled, a Started service will keep running, you can Resume a Paused service 
but you cannot Start a Stopped service.

Service Status: Displays the service status (Started, Paused or Stopped).
Start: If enabled, click this button to start the service.
Stop: If enabled, click this button to stop the service.
Pause: If enabled, click this button to pause the service.
Resume: If enabled, click this button to resume the service.

Caution: Stopping or pausing a service may affect dependent services, see Dependencies Tab.

Start Parameters: []: This field will be enabled if the service is Stopped. Specify in this field any 
command line parameters that shall apply when starting the service.

Note: Specified Start Parameters will not be saved. A backslash (\) will be interpreted as an ESCAPE 
character. Specify two backslashes for each backslash in a parameter.
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Log On Tab

This Remote Management Services tab specifies the log on properties of the selected record Host 
computer service.
Log On As: Select one of these options:

~Local System Account: Select this option to make the selected record Host computer service 
log on as a local system account that has extensive rights on the Host computer but no rights on 
other computers (typically the default selection).

�Allow Service to Interact with the Desktop: Check this box to allow the service to 
display user interaction windows on the desktop (typically unchecked).

{This Account: []: Select this option to make the selected Host computer service log on as a 
specific user and specify the user credentials in the fields.

Note: To specify that the selected Host computer service shall use the Local Service account, 
specify NT AUTHORITY\LocalService. To specify that it shall use the Network Service 
account, specify NT AUTHORITY\NetworkService. Do not specify a password for these 
accounts.

Browse: Click this button to display this window:
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Select Users

List Names From: []: The field of this drop-down box will typically display the name of 
the Host computer. The drop-down box list will contain the names of domains recognized 
by the Host computer. Select a name in the list to display it in the field.
Groups and Users: []: This pane will display users on the computer or in the domain 
displayed in the List Names From drop-down box field as table records with this column 
content:
• User Name: Windows logon user name.
• Full Name: Windows user full name, if specified.
• Description: Windows user description, if specified.
Table controls are explained in Table Control.
Double-click a record to add it to the Added Users pane below.
Added Users: []: This pane can contain only one record. To remove a record from the 
pane, double-click it.
OK: Click this button to close the window and specify the Added Users pane record user 
name in the in the Properties window This Account field.

Password: []: Specify in this field the password that shall be used with the user name specified 
in the This Account field. Keyboard entries will display as asterisks (*):
Confirm Password: []: Re-specify the password in this field for confirmation.
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Dependencies Tab

This tab displays in the upper pane system components on which the selected record service depends 
and in the lower pane system components that depend on this service. If there are dependencies, the 
pane background will be white, otherwise gray. You cannot change dependencies on this tab.

Caution: If system components depend on the selected record service, the computer may not 
function properly if the properties of the service are changed.
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This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

3.7.5.7.6 Shared Folders

Select the Remote Management window Management Menu or Navigation Panel Management section 
Shared Folders command to display Host computer shares, sessions and open files in the Display Panel:

Note: This command will be disabled if the Host does not have the right to manage Host computer shared 
folders. To assign required rights to the Host, run it as a user with required rights, see the NetOp Host 
Program Options window Run As Tab. You can display the Run As Tab in a Remote Control session 
with the Host.

The Display Panel contains these tabs:
• Shares Tab
• Sessions Tab
• Open Files Tab

Add: Click this button, select the matching Services menu command or press 
CTRL+N to display the first Service Installation wizard window.
Remove: Select a record and click this button, select the matching Services menu 
command or press DELETE to display a confirmation window to confirm removing 
the record.

Note: If you remove a service of a running application, the service will become 
Stopped and Disabled. When the application is unloaded, the record will be 
removed.
Caution: Removing a service may affect dependent services, see Dependencies 
Tab.

Start/Resume: If enabled, click this button or select the matching Services menu 
command to start or resume the selected service.
Stop: If enabled, click this button or select the matching Services menu command 
to stop the selected service.
Pause: If enabled, click this button or select the matching Services menu command 
to pause the selected service.
Restart: If enabled, click this button or select the matching Services menu 
command to stop and start the service.

Caution: Stopping, pausing or restarting a service may affect dependent services, 
see Dependencies Tab.

Refresh: Click this button, select the matching Services menu command or press F5 
to retrieve new data from the Host computer to refresh the Display Panel contents.
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Shares Tab
This Remote Management window Shared Folders tab displays Host computer shared resources as table 
records with this column contents:
• Share Name: Shared resource icon and name.
• Folder Path: Directory path or resource description.
• Type: Unknown or resource type name.
• # Client Connections: Number of current connections from remote computers.
• Description: Shared resource description, if available.
Table controls are explained in Table Control.
Special Shares
For administrative and system use, the operating system automatically creates special shares as hidden 
resources, typically with $ as the last character in the share name.

Note: Typically, you should not delete or change special shares. If you delete or change special shares, 
they may become restored when the server service or the computer is restarted.

These special shares can be displayed on the Shares tab:
<Drive letter>$: Enables administrators to connect to the root directory of a drive.
ADMIN$: Enables remote administration of a computer. Its path is always the path of the system root 
directory.
IPC$: Enables interprogram communication by named pipes during remote administration and when 
viewing a computer's shared resources. It cannot be deleted.
NETLOGON: Required on domain controllers. If you remove it, domain client computers will lose 
functionality.
SYSVOL: Required on domain controllers. If you remove it, domain client computers will lose 
functionality.
PRINT$: Used during remote administration of printers.
FAX$: A server folder that stores temporary telefax files and telefax cover pages. It is used by clients 
when sending a telefax.
Sessions Tab

This tab will display Host computer shared folder sessions as table records with this column content:
• User: Session user icon and Windows logon name.
• Computer: Session computer name or address.
• Type: Session computer operating system type.
• Transport: Session communication device specification.
• # Open Files: Number of session open files.
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• Connected Time: Session time in format HH:MM:SS (H=Hour digit, M=Minute digit, S=Second 
digit).

• Idle Time: Time since last session user action in format HH:MM:SS (H=Hour digit, M=Minute 
digit, S=Second digit).

• Guest: Displays Yes if the session user is logged on to Windows by a Guest account with typically 
very limited rights. Displays No if not.

Table controls are explained in Table Control.
Open Files Tab

This tab will display Host computer shared folder open files as table records with this column content:
• Open File: File icon, path and name.
• Accessed By: File session user Windows logon name.
• # Locks: File number of locks.
• Mode: File permission type.
Table controls are explained in Table Control.
In the Menu Bar, select Shared Folders, press ALT+S or right-click in the display panel to display this 
menu:

Add... Ctrl+N: Displaying the Shares tab, select this command, press CTRL+N or click the matching 
Toolbar button to display this first Share a Folder Wizard window:
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Share a Folder Wizard

Next >: Click this button to display this window:

Computer name: []: Displays the name of the Host computer.
Folder path: []: Specify in this field the Host computer path of a folder that shall be shared.
< Back: Click this button to return to the previous wizard window.
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Next >: Click this button to display this window:

Share name: []: Displays the share name (default: the folder name specified in the previous wizard 
window). You can edit the share name.

Note: Using $ as the last character of the share name, the shared folder will be hidden to not appear 
to a browsing network user. Network users can map a drive to a hidden shared folder.

Share path: []: Displays the share path as specified in the previous wizard window.
Description: Optionally, specify in this field a share description that will be displayed in the 
Description column on the Shares tab.
Finish: Click this button to end the Share a Folder Wizard to add the share record to the Shares tab.

Tip: To create permissions to a share, double-click its record to display the Properties window, see 
below.

Remove Del: Select a Shares tab, Sessions tab or Open Files tab record and select this command, press 
DELETE or click the matching Toolbar button to display a confirmation window to confirm to remove the 
record share or disconnect the session user.

Note: Remove may cause loss of data to session users. Typically, you should not remove Special Shares.

Refresh F5: Select this command, click the matching Toolbar button or press F5 to retrieve new 
information from the Host computer to refresh the Display Panel content.
Properties: Displaying the Shares tab, select a record and select this command, click the matching 
Toolbar button or double-click a record to display this window:
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Properties

This window contains a General Tab and, if permissions can be assigned to the share, a Share 
Permissions Tab.
General Tab
This tab specifies general share properties.
Share name: []: Displays the share name that you cannot change.
Folder path: []:  Displays the share path or resource specification that you cannot change.
Description: []: The content of this field will be disabled (gray characters) with certain special 
shares. If enabled, you can change the field content that will be displayed on the Shares tab.
User limit: For some shares, the options in this section are disabled. If enabled, select one of these 
options:

~Maximum allowed: Allow the maximum available number of simultaneous users of the 
share (default selection).

{Allow this number of users: []: Select this option to limit the number of simultaneous users 
of the share. The spinbox displays the allowed number of users (default: 1). Click the up/down 
buttons to adjust the number or specify the number in the spinbox.

Note: The maximum available number of users may be limited by the applicable software 
license.
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Share Permissions Tab

Group or user names: []: This pane displays groups and users as table records with this column 
content:
• User Name: Group or user icon and name.
• Full Name: User full name, if available.
• Description: Group or user description, if available.
Table controls are explained in Table Control.
Add…: Click this button to display the Select Users window to add groups and/or users.
Remove: Select a record in the pane and click this button to remove it.
Permissions: This section specifies the permissions of the group or user selected in the pane above. 
Check boxes in the Allow column to grant permissions. Click boxes in the Deny column to deny 
permissions even if granted on the file system level.
• Full Control: Change permissions plus change permissions of NTFS files and folders.
• Change: Read permissions plus add files and subfolders, change data in files and delete 

subdirectories and files.
• Read: View file and subfolder names, view data in files and run program files.

Note: Checking an upper box checks lower boxes.
Share permissions apply only to network users. They do not apply to users that log on locally 
including terminal server users.
Preferably, assign permissions to groups and add users to groups rather than assign identical 
permissions to multiple users.
If you change permissions on special shares, the original permissions may be restored when the 
server service or the computer is restarted.
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This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

3.7.5.7.7 Inventory

Select the Remote Management window Management Menu or Navigation Panel Management section 
Inventory command to display the Host computer inventory in the Display Panel:

Note: This command will be disabled if the Host computer does not run on a Windows operating system.

The Host computer inventory will be displayed like on the NetOp Guest Window Inventory Tab. This is a 
view only display from which you cannot save Host computer inventory information.
In the Menu Bar, select Inventory or press ALT+I to open this menu:

Refresh F5: Select this command, click the matching Toolbar button or press F5 to retrieve new 
information from the Host computer to refresh the Display Panel content.
This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

Refresh: Click this button, select the matching Inventory menu command or press F5 to retrieve new 
information from the Host computer to refresh the Display Panel content.

Add: Displaying the Shares tab, click this button, select the matching Shared Folders menu 
command or press CTRL+N to display the first Share a Folder Wizard window.
Remove: Select a record and click this button, select the matching Shared Folders menu command 
or press DELETE to display a confirmation window to confirm deleting the record.

Note: Remove may cause loss of data to session users. Typically, you should not remove Special 
Shares.

Refresh: Click this button, select the matching Shared Folders menu command or press F5 to 
retrieve new data from the Host computer to refresh the Display Panel content.
Properties: Displaying the Shares tab, select a record and click this button, select the matching 
Shared Folders menu command or double-click the record to display the Properties window.
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3.7.5.7.8 Command Console

Select the Remote Management window Management Menu or Navigation Panel Management section 
Command Console command to display this window:
Startup Information

Select one of these options:

~Use Host account: Open the Command Console display with the rights of the user logged on to 
Windows on the Host computer (default selection).

{Use this account information: Open the Command Console display with the rights of the user 
credentials specified below.

Login Name: []: Specify in this field a Host computer domain recognized user name.
Password: []: Specify in this field the matching password. Characters will display as asterisks.
Domain: []: Specify in this field the matching domain name.

;Load user profile: Leave this box checked to load a Host computer user profile for the specified 
user name (default: checked).

Click OK to display a Host computer Command Prompt window in the Display Panel:
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In this window, you can specify commands that will execute on the Host computer.
In the Menu Bar, select Command Console or press ALT+C to open this menu:

Restart: Select this command or click the matching Toolbar button to restart Command Console to 
display the Startup Information window.
This Toolbar will be displayed unless hidden from the View Menu Toolbar command.

Restart: Click this button or select the matching Command Console menu command to restart Command 
Console to display the Startup Information window.
3.7.5.7.9 System Control

Select the Remote Management window Management Menu or Navigation Panel Management section 
System Control command to display this Display Panel content:

From these elements, you can control the Host computer state:
Current Host state
This section displays the Host computer user logon status:
Logged off/Logged on <Logged on user name>: Logged off indicates that no user is logged on to the Host 
computer. Logged on <Logged on user name> specifies the name of the user logged on to the Host 
computer.

Note: You can log on to the Host computer from a Remote Control session.
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Action to perform
Select one of these actions to execute it when clicking the Display Panel Send or Toolbar Send Command 
button:

~Lock computer (Windows NT, 2000, XP only): Select this option or press L to select to lock the 
Host computer if running on Windows 2003, XP, 2000 or NT (default selection).

{Log off user: Select this option or press O to select to log off the user from the Host computer.

{Restart computer: Select this option or press C to select to restart the Host computer.

{Shut down computer: Select this option or press D to select to shut down the Host computer.
Options
Optionally, specify options in this section to modify the action selected in the Action to perform section:

�Prompt user Timeout for prompt: [] seconds: Check this box or press P to check it to alert the Host 
computer user by a popup message (default: unchecked). The spinbox specifies which number of seconds 
after prompting the user the action selected in the Action to perform section will be executed. Click the 
up/down buttons to adjust the number or specify a number (default: 1, range 1- 999).

Message to display: []: Specify in this pane up to four lines of text that shall be displayed in the 
Host computer popup message.

�Allow user to cancel: Check this box or press U to check to enable an Abort button in the Host 
computer popup message to enable the Host computer user to cancel the action (default: 
unchecked).

�Close open programs without saving data: Check this box or press V to check it to close open Host 
computer programs without saving data when executing the action (default: unchecked).
Send: Click this button or the matching Toolbar button, select the matching System Control menu 
command or press S to execute the action specified above.
The Host computer popup message will be displayed in this window:

The Time: display in format HH:MM:SS (H=Hour digit, M=Minute digit, S=Second digit) will 
count down to 00:00:00 before the system control action executes.

Note: Generally, you cannot cancel a sent System Control command. However, if the Abort button 
is enabled in a Host computer popup message, you can cancel the action by clicking this button in a 
Remote Control display.

In the Menu Bar, select System Control, press ALT+S or right-click in the display panel to open this 
menu:
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Refresh F5: Select this command, click the matching Toolbar button or press F5 to retrieve new 
information from the Host computer to refresh the Display Panel content.
Send: Select this command, click the matching Toolbar or Display Panel button or press S to execute the 
action specified in the display panel.
This Toolbar will be displayed unless hidden from the View Menu Toolbar command:

3.7.5.8 NetOp Sessions
You can start and stop other NetOp sessions with the remote managed Host from the File Menu NetOp 
Sessions command submenu:

and from the Navigation Panel NetOp Sessions section:

File Menu commands will begin with Start if no session is running or Stop if a session is running.
Navigation Panel command icons will display a red X if a session is running.
Select a command to start or stop a session.

Note: If Host Guest Access Security does not allow the Guest to start a type of session, the command will 
be disabled, see Allow Guest To. 
Start Audio-Video Chat will be disabled if the Guest and Host computers are not both interactive audio 
enabled or if any of them is running another audio session.

Refresh: Click this button, select the matching System Control menu command or press F5 to 
retrieve new data from the Host computer to refresh the Display Panel content.
Send: Click this button or the matching Display Panel button, select the matching System Control 
menu command or press S to execute the action specified in the Display Panel.
216



3 NetOp Guest
3.7.5.9 Details
The Navigation Panel Details section:

will display these details:
• <Host ID>
• <Host computer IP or MAC address>
• <Guest communication profile name>
• Communication encryption type icon and <Description>
• <Host computer operating system name>
• Remote Management session duration in format HH:MM:SS (H=hour digit, M=Minute digit, 

S=Second digit)
You cannot execute any actions from the Details section.
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3.8 Session Tools
This section explains these session tools:
• Connection Properties
• NetOp Marker Utility
• NetOp Script
• Run Program
• Execute Command
• NetOp Message
• Get Inventory
3.8.1 Connection Properties
The Connection Properties window specifies the individual settings that can be applied when connecting 
to a Host in this window:

It contains these tabs:
• Connect Tab
• Login Tab
• Protect Item Tab
• Startup Tab
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• Display Tab
• Keyboard/Mouse Tab
• Compression/Encryption Tab
• Desktop Tab
• Record Tab
• Custom Tab
You can display the Connection Properties window from Tab Panel tabs and the Remote Control display:
• If the Phonebook Tab is displayed, select the Edit Menu or Records Pane context menu New 

Phonebook Entry command or click the Toolbar Other Buttons Phonebook Entry button to display 
the all tabs Connection Properties window with default selections to create a phonebook record.

• If the Phonebook Tab or History Tab is displayed, select a records pane record and select the Edit 
Menu or records pane context menu Connection Properties command or click the Toolbar Other 
Buttons Connection Properties button to display the all tabs Connection Properties window with 
selected record connection properties to view or edit them.

• If the Quick Connect Tab is displayed, click the Buttons Connection Properties button to display a 
limited tabs Connection Properties window the Login Tab, Startup Tab, Display Tab, Keyboard/
Mouse Tab, Compression/Encryption Tab, Desktop Tab and Record Tab with the connection 
properties applied to connections from the Quick Connect Tab to view or edit them.

• If the Help Request Tab is displayed, select a record and select the Edit Menu or context menu 
Connection Properties command or click the Toolbar Other Buttons Connection Properties button 
to display a limited tabs Connection Properties window with the Login Tab, Startup Tab, Display 
Tab, Keyboard/Mouse Tab, Compression/Encryption Tab, Desktop Tab and Record Tab with the 
selected record connection properties to view or edit them.

• In the Remote Control display, select the window Title Bar menu Connection Properties command 
or click the Toolbar and Toolbox Control Buttons Connection Properties button to display a limited 
tabs Connection Properties window with partly enabled Display Tab, Keyboard/Mouse Tab, 
Compression/Encryption Tab, Desktop Tab and Record Tab with editable Remote Control session 
connection properties to view or edit them.
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3.8.1.1 Connect Tab
This tab will be included only if you display the window from the Phonebook Tab or History Tab:

It specifies connect properties.
Host PC Information
Description: []: This field specifies the name that identifies the Host record (default: empty). You can 
specify or edit a name in the field. If left empty, the content of the Name field below will automatically be 
specified in it.
Phone number [or IP address]: []: This field will be included if the communication profile selected in 
the Communication section Communication profile drop-down box below uses a Line Communication or 
Gateway or Network Point-to-Point Communication device (default: empty). It must specify the 
telephone number or IP address of a Host connected to directly or a connecting Host network NetOp 
Gateway.
Name [(optional with Gateway)]: []: If the communication profile selected in the Communication section 
Communication profile drop-down box below uses a Networking Communication device, this field must 
specify a name that is enabled on the Host, see Names Tab. If connecting through a Host network NetOp 
Gateway, this field can specify a Host name.
Comments: []: This field can specify a comment that will be displayed in the Tab Panel tab records pane 
Details view Comment column (default: empty).
Communication
Communication Profile: []: The field of this drop-down box list specifies the selected communication 
profile (default: TCP/IP). The drop-down box list contains available Guest communication profiles. 
Select a name in the list to specify it in the field.
220



3 NetOp Guest
Wake on LAN MAC address: []: In this field, you can specify the MAC address of the Host computer 
Wake on LAN network card to enable starting the Host computer by connecting to the Host, see Execute 
Command (default: empty).
3.8.1.2 Login Tab
This tab will be included unless you display the window from the Remote Control display:

It enables you to specify Host and any connecting Host network NetOp Gateway logon credentials to 
connect without being prompted for logon credentials.
It has two tabs with identical content:
Host login/Gateway login
Login name: []: Specify in this field the logon name, if required (default: empty).
Login password: []: Specify in this field the matching logon password, if required (default: empty).
Login domain: []: Specify in this field the authenticating Windows domain or directory server, if 
required (default: empty).

�Use current login credentials for Windows Security authentication: Check this box to log on by the 
Windows logon user name, password and domain of the Guest computer user (default: unchecked).
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3.8.1.3 Protect Item Tab
This tab will be included only if you display the window from the Phonebook Tab or History Tab:

It enables you to protect the Host record and file by a password.
Protect the phonebook file with a password
Password: []: Specify in this field a password (default: empty).
Confirm password: []: Re-specify in this field the password for confirmation (default: empty).

Note: Password characters will display as asterisks or dots. Leave fields empty to disable password 
protection.
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3.8.1.4 Startup Tab
This tab will be included unless you display the window from the Remote Control display:

It specifies Remote Control session startup properties.
Host window startup size
Select one of these options:

~Windowed: Display the Host screen image in a Remote Control window display panel (default 
selection). If the Host screen image has less pixels than the display panel, the Host screen image will 
be surrounded by black borders. If the Host screen image has more pixels than the display panel, the 
display panel will have scrollbars. If on the Display Tab the option Fit window to Host screen is 
selected, the remote control window may resize up until its maximized size, see also below.

{Full screen: Display the Host screen image in full screen display mode to cover the entire Guest 
computer screen. If the Host screen image has less pixels than the Guest computer screen, the Host 
screen image will be surrounded by black borders. If the Host screen image has more pixels than the 
Guest computer screen, the Guest computer screen will have scrollbars.

{Maximized: Display the Host screen image in the display panel of a maximized Remote Control 
window that covers the entire Guest computer screen except the Windows taskbar. If the Host 
screen image has less pixels than the display panel, the Host screen image will be surrounded by 
black borders. If the Host screen image has more pixels than the display panel, the display panel will 
have scrollbars.

{Minimized: Display the Host as a button in the Windows taskbar.
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Remote control window startup size
�Enable: Check this box to enable this section’s elements and apply their values. Leave unchecked to 
apply the last displayed remote control window position and size (default: unchecked).
x: []: Specify in this field the horizontal pixels offset of the startup Remote Control window upper left 
corner from the Guest computer screen upper left corner (default: 0).
y: []: Specify in this field the vertical pixels offset of the startup Remote Control window upper left 
corner from the Guest computer screen upper left corner (default: 0).
Width: []: Specify in this field the pixels width of the startup Remote Control window (default: 0).
Height: []: Specify in this field the pixels height of the startup Remote Control window (default: 0).
Actions
�Lock Host keyboard and mouse: Check this box to disable the Host computer keyboard and mouse at 
startup, see also the Remote Control section Title Bar section (default: unchecked).

�Blank Host display: Check this box to make the Host computer screen appear black to the Host user at 
startup, see also the Remote Control section Title Bar section (default: unchecked).

�Transfer Sound: Check this box to transfer Host computer application sound at startup, see also the 
Remote Control section Title Bar section (default: unchecked).

�Suspend other Guests from connecting to Host: Check this box to deny further Guest connections to 
the Host at startup, see also the Remote Control section Multi Guest Session Buttons section (default: 
unchecked).
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3.8.1.5 Display Tab
This tab will always be included in the window:

It specifies Remote Control session Host screen image display properties.
Host Window Fit
Select one of these options:

~Fit window to Host screen: Resize the Remote Control window to fit the 1:1 scale Host screen 
image within its display panel. If the Host screen image has more pixels than the maximized Remote 
Control window display panel, it will have scrollbars (default selection).

{Fit Host screen to window: Scale the Host screen image to fit within the Remote Control window 
display panel.

{Do not fit: Display the part of the 1:1 scale Host screen image that will fit within the Remote 
Control window display panel. If the Host screen image has less pixels than the display panel, it will 
be surrounded by black borders. If the Host screen image has more pixels than the display area, it 
will have scrollbars.

Limit number of colors in bitmap mode
Select one of these options:

~No, use actual number of colors: Consumes most transmission bandwidth, displays true colors 
(default selection)

{Max 256 colors: Consumes less transmission bandwidth, displays almost true colors.
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{Max 16 colors: Consumes little transmission bandwidth, displays distorted colors.

{Max 2 colors: Consumes minimum bandwidth, displays black and white colors.

Note: This section will disabled if displayed from the Remote Control display.

DOS Box Font
In command mode, see Compression/Encryption Tab, command prompt window characters will by 
default be displayed with the Guest computer system default font.

;System default: Uncheck this box to enable selecting another font (default: checked).
Select font...: Click this button to display the Windows Font window to select the font.
3.8.1.6 Keyboard/Mouse Tab
This tab will always be included in the window:

It specifies Remote Control session keyboard and mouse control properties.
Keyboard
Select one of these options:

~Remote keyboard (Send all keystrokes to Host): Send all Guest computer keystrokes to the Host 
(default selection).

{Local keyboard (Don’t send special keystrokes): Send Guest computer keystrokes except special 
Send Keystrokes keystroke combinations to the Host. Send special Send Keystrokes keystroke 
combinations to the Guest computer, see the Remote Control section Title Bar section.
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{No keyboard control: Select this option to send all Guest computer keystrokes to the Guest 
computer.

�Use Guest Keyboard layout: If Guest and Host computer keyboard layouts are different, some Guest 
computer keystrokes may come out wrong on the Host computer. To avoid this, check this box (default: 
unchecked).

�Don’t transfer Host Num Lock, Scroll Lock, Insert and Caps Lock: With some display adapters, 
enabling these Host computer keyboard options may cause the Guest keyboard lights to flash. To avoid 
this, check this box (default: unchecked).
Mouse
Select one of these options:

~Remote mouse (send all mouse events): Send all Guest computer mouse events (clicks, drags and 
movements) to the Host (default selection).

{Local mouse (Only send clicks and drags): Send only Guest computer mouse clicks and drags to 
the Host (saves transmission bandwidth).

{No mouse control: Send no Guest computer mouse events to the Host.

�Display Host mouse movements: Check this box to move the Guest computer mouse pointer in concert 
with Host computer mouse pointer movements (default: unchecked).

Note: To suppress Host induced Guest computer mouse pointer movements, press CTRL.
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3.8.1.7 Compression/Encryption Tab
This tab will always be included in the window:

It specifies data transmission properties.
Compression level
NetOp can compress transmitted data to speed up transmission across slow communication links. 
However, data compression slows down transmission.
Select one of these options:

~Automatic: Selects compression based on communication profile properties. In most cases, this 
will provide the fastest transmission (default selection).

{No compression: Typical selection for fast communication links.

{Low: Typical selection for medium fast communication links.

{High: Typical selection for slow communication links.
Host screen transfer
Select one of these options:

~Transfer Host screen as commands: Typically faster, but with some Host computer display 
adapters some Host screen image details may be lost or corrupted (default selection).

{Transfer Host screen as bitmap: Typically slower, but transfers Host screen image details 
correctly.
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�Disable accelerated bitmap transfer: Accelerated bitmap transfer is by default applied 
between version 7.6+ NetOp modules. Check this box to disable accelerated bitmap transfer in 
the unlikely event that it causes problems (default: unchecked).

Note: This section will be disabled if displayed from the Remote Control display.

Cache
Command mode Host screen transfer stores the screen image in cache memory and transfers only image 
changes to save transmission bandwidth and optimize update speed.
Cache size: []: The field of this drop-down box displays the selected cache memory size option (default: 
Automatic). The drop-down box list contains the options Automatic and values from None to 10240 kb. 
Automatic selects the cache memory size based on communication profile properties. In most cases, this 
will provide the optimum. Select another option in the list to display it in the field.

Note: This section will be disabled if displayed from the Remote Control display.
Total NetOp cache memory sharing and size is specified on the Program Options window Cache Tab.

Preferred Encryption Type []: The field of this drop-down box will display the encryption type preferred 
by the Guest (default: NetOp 6.x/5.x Compatible). The drop-down box list contains the names of 
available encryption types, see Encryption Tab. Select an encryption type in the list to display it in the 
field to prefer it.
If the preferred encryption type is enabled on Guest and Host, it will be applied.
If NetOp 6.x/5.x Compatible is preferred and not enabled on Guest and Host, this message will be 
displayed:

In this case, select another preferred encryption type.
If another encryption type is preferred and this encryption type is not enabled on the Host, an encryption 
type that is enabled on both of Guest and Host will be applied.
If no common encryption type is enabled on Guest and Host, this message will be displayed:

In this case, enable additional encryption types on the Encryption Tab to achieve a match.

Note: The icon of the encryption type applied in a Remote Control session will be displayed in the 
window Status Bar.
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3.8.1.8 Desktop Tab
This tab will always be included in the window:

This tab specifies Remote Control session Host computer desktop features transfer properties.
Optimize Screen Transfer
Advanced Host computer desktop features slow down command mode Host screen transfer and are 
typically unimportant to the Guest user. Therefore, NetOp by default transfers the Host screen image 
without advanced desktop features. If unacceptable, select which advanced desktop features to transfer.
Select one of these options:

~Always: Always transfer without advanced desktop features (default selection).

{Only when high compression: Transfer without advanced desktop features only with high 
compression, see Compression/Encryption Tab.

{Never: Never transfer without advanced desktop features.
Optimization parameters
Select one of these options:

~Full optimization: Transfer without the desktop features listed below (default selection).

{Custom optimization: Enable the Custom options section below to uncheck selected boxes to 
enable transfer of selected advanced desktop features.
Custom options
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;Disable wallpaper

;Disable screen saver

;Disable animation gimmicks

;Disable full window drag

;Disable Active Desktop
By default, all boxes are checked.

3.8.1.9 Record Tab
This tab will always be included in the window:

This tab selects Remote Control session recording.
Record
�Record remote control session: Check this box to record remote control sessions (default: unchecked).

Note: Recording a Remote Control session will create a session record on the Recordings Tab.
Checking the Program Options window Recordings Tab Enforce recording box will record remote 
control sessions regardless of the selection on this tab. Recording will reduce Remote Control session 
transfer speed.
This section will be disabled if displayed from the Remote Control display.
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3.8.1.10 Custom Tab
This tab will be included only if the window is displayed from the Phonebook Tab or History Tab:

It specifies the properties of a custom application command.
Custom
Description []: Specify in this field a custom application name that will be added as an command to the 
Host record context menu, see Records Pane (default: empty).
Command line []: Specify in this field the custom application command line (program file path, name 
and required command line switches) (default: empty).
Browse...: Click this button to display a Windows Open window specifying Files of type: Programs to 
open a program file the path and name of which will be displayed in the Command line field.
3.8.2 NetOp Marker Utility
NetOp Marker Utility enables creating figure and text markers on top of the Host screen image and 
magnifying a section of the Host screen image.

Note: The NetOp Marker Utility program VITAWRAP.EXE resides on the Host computer and marks and 
magnifies on the Host computer screen. The Guest user and Host user can control NetOp Marker Utility.

To load NetOp Marker Utility from the Guest, click the Remote Control display Toolbar and Toolbox 
Tool Buttons Marker Mode button to make it appear pressed in or select the matching Remote Control 
window Title Bar menu command to checkmark it.
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To unload NetOp Marker Utility from the Guest, click the Remote Control display Toolbar and Toolbox 
Tool Buttons Marker Mode button to release it or select the matching checkmarked remote control 
window Title Bar menu command to uncheckmark it.
To load NetOp Marker Utility from the Host computer, run (double-click) the file VITAWRAP.EXE that 
resides in the directory where NetOp Host is installed.
To unload NetOp Marker Utility from the Host computer, use Windows Task Manager.
NetOp Marker Utility displays this window:
NetOp Marker Utility

It contains these elements:
• Title Bar
• Upper Toolbar
• Lower Toolbar
• Status Bar
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3.8.2.1 Title Bar

Click the title bar icon or right-click in the title bar to display this menu:
NetOp Marker Utility window menu

The top section contains window control commands, see Window Control. The other sections contain 
these types of NetOp Marker Utility commands:
• Figure marker commands, see Figure Markers
• Text marker command, see Text Marker
• Magnifier command, see NetOp Magnifier
• Undo and Clear All commands, see Delete Markers
• Properties and Help commands, see Marker Properties and Help
Select Minimize to minimize the NetOp Marker Utility window into this Host computer screen 
notification area button:

Behind the pencil, the most recently enabled marker tool symbol will be displayed.
Right-click this button to display this menu:
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NetOp Marker Utility minimized menu

This menu contains a Restore command that will restore the NetOp Marker Utility window and the same 
NetOp Marker Utility commands as the NetOp Marker Utility window menu.
3.8.2.2 Upper Toolbar

Toolbar buttons are identified by tooltips.

Draw Ellipse: Click this button to make it appear pressed in or select the NetOp Marker Utility 
window menu or NetOp Marker Utility minimized menu Ellipse command to enable the ellipse 
tool, see Figure Markers.
Draw Rectangle: Click this button to make it appear pressed in or select the NetOp Marker Utility 
window menu or NetOp Marker Utility minimized menu Rectangle command to enable the 
rectangle tool, see Figure Markers.
Draw Arrow: Click this button to make it appear pressed in or select the NetOp Marker Utility 
window menu or NetOp Marker Utility minimized menu Arrow command to enable the arrow 
tool, see Figure Markers.
Draw Lines (Stop=MB2): Click this button to make it appear pressed in or select the NetOp 
Marker Utility window menu or NetOp Marker Utility minimized menu Line command to enable 
the sectioned line tool, see Figure Markers.
Draw Freehand: Click this button to make it appear pressed in or select the NetOp Marker Utility 
window menu or NetOp Marker Utility minimized menu Freehand command to enable the 
freehand tool, see Figure Markers.
Show Free Text: Click this button to make it appear pressed in or select the NetOp Marker Utility 
window menu or NetOp Marker Utility minimized menu Text command to enable the Text 
Marker tool.
Show Magnifier: Click this button to make it appear pressed in or select the NetOp Marker Utility 
window menu or NetOp Marker Utility minimized menu Magnifier command to display the 
NetOp Magnifier window.
Undo: Click this button or select the matching NetOp Marker Utility window menu or NetOp 
Marker Utility minimized menu command to delete the most recently selected marker, see Delete 
Markers.
Clear All: Click this button or select the matching NetOp Marker Utility window menu or NetOp 
Marker Utility minimized menu command to delete all markers, see Delete Markers.
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3.8.2.3 Lower Toolbar

Toolbar buttons are identified by tooltips.

3.8.2.4 Status Bar

The status bar will display a hint to the mouse pointer position button or highlighted menu command.
3.8.2.5 Figure Markers
To select a figure marker tool with the mouse, in the NetOp Marker Utility window Upper Toolbar click 
the figure marker button to make it appear pressed in or in the NetOp Marker Utility window menu or 
NetOp Marker Utility minimized menu select the figure marker command to change the mouse pointer 
into a pencil with the figure marker shape.
To enable a figure marker tool from the keyboard, place the mouse pointer on the active NetOp Marker 
Utility window Upper Toolbar figure marker button and press F9 to change the mouse pointer into a 
pencil with the figure marker shape. Alternatively, while the NetOp Marker Utility window is active press 
ALT+SPACE to display the NetOp Marker Utility window menu and press the figure marker command 
first character keyboard key or highlight the figure marker command and press ENTER.
To change figure marker tool properties, right-click or press F10 to display this menu:

This menu is similar to the Figure Marker Menu but has Unselect instead of Undo.
Unselect: Select this command, press ESCAPE, click the NetOp Marker Utility window Upper 
Toolbar pressed in figure marker button to release it or select the NetOp Marker Utility window 
menu or NetOp Marker Utility minimized menu figure marker command to unselect the figure 
marker tool to restore the normal mouse pointer.

Note: Selecting another marker tool will unselect the selected marker tool.

To create a figure marker with the mouse, drag (sectioned line: click). To end a sectioned line, right-click.

Select Font: Click this button or select the NetOp Marker Utility window menu or NetOp Marker 
Utility minimized menu Font command to display the Windows Font window to select a text 
marker font, see Marker Properties and Help.
Select Color: Click this button or select the NetOp Marker Utility window menu or NetOp Marker 
Utility minimized menu Color command to display the Windows Color window to select a 
marker color, see Marker Properties and Help.
Select Pen Thickness: Click this button to display a line width drop-down box or select the NetOp 
Marker Utility window menu or NetOp Marker Utility minimized menu Line Width command to 
select a figure marker or text marker frame line width, see Marker Properties and Help.
Help: Click this button or select the NetOp Marker Utility window menu or NetOp Marker Utility 
minimized menu Help command to open NetOp Host Help on the NetOp Marker Utility topic, see 
Marker Properties and Help.
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To draw a figure marker from the keyboard, move the figure marker with the arrow keys. Press INSERT to 
engage, move with the arrow keys and press INSERT to disengage or section a line. To end a sectioned 
line, press F10.
To move a marker or change its appearance, move the mouse pointer to it to display an arrow-pointed +.
To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage. 
To change appearance, right-click or press F10 to display this menu:

Figure Marker Menu

Color: Select this command or click the marker and click the NetOp Marker Utility window Lower 
Toolbar Select Color button to display the Windows Color window to change the marker color 
selection (default: Red).
Line Width: Select this command to expand it into a selection of numbers of pixels or click the 
marker and click the NetOp Marker Utility window Lower Toolbar Select Pen Thickness button to 
display a drop-down box with a selection of line widths to change the marker line width selection 
(default: 2 pixels).
Undo: Select this command to delete the selected marker.
Clear All: Select this command to delete all markers.
Click outside the menu or press F10 to close the menu.

3.8.2.6 Text Marker
To select the text marker tool with the mouse, in the NetOp Marker Utility window Upper Toolbar click 
the Show Free Text button to make it appear pressed in or in the NetOp Marker Utility window menu or 
NetOp Marker Utility minimized menu select Text to change the mouse pointer into an angle that 
indicates a text marker box corner.
To select the text marker tool from the keyboard, place the mouse pointer on the active NetOp Marker 
Utility window Upper Toolbar Show Free Text button and press F9 to make the button appear pressed in 
and change the mouse pointer into an angle that indicates a text marker box corner. 
Alternatively, while the NetOp Marker Utility window is active press ALT+SPACE to display the NetOp 
Marker Utility window menu and press the T key or highlight the Text command and press ENTER.
To unselect the text marker tool, press ESCAPE or use one of the selection procedures explained above to 
release the Show Free Text button and restore the normal mouse pointer.

Note: Selecting another marker tool will unselect the selected marker tool.

When the text marker tool is selected:
• To create a text marker with the mouse, drag a dotted rectangle to display the Text Marker window.
• To create a text marker from the keyboard, move the text marker tool with the arrow keys. Press 

INSERT to engage, move with the arrow keys to create a dotted rectangle and press INSERT to 
disengage and display this window:
237



3.8 Session Tools
Text Marker

This window specifies the text marker content and appearance.
In the pane, specify the text marker text. Right-click to display an edit menu.
Use frame: []: The field of this drop-down box by default displays No to display no frame around 
the text marker. The drop-down box list contains No and a selection of frame line widths. Select an 
option in the list to display it in the field.
Font: Click this button display the Windows Font window to change the text marker font and color 
selection (default: Arial Bold 30pt Red).
OK: Click this button to close the Text Marker window to display the text marker.

To move a marker or change its appearance, move the mouse pointer to it to display an arrow-pointed +. 
To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage. 
To change appearance, right-click or press F10 to display this menu:

This menu is similar to the Figure Marker Menu but has Font instead of Color.
Font: Select this command to display the Windows Font window to change the text marker font and 
color selection (default: Arial Bold 30pt Red).

Note: This menu will include a Line Width command only if a framed text marker is selected to 
apply the selection from it to the frame.

3.8.2.7 NetOp Magnifier
To display the NetOp Magnifier window with the mouse, in the NetOp Marker Utility window Upper 
Toolbar click the Show Magnifier button to make it appear pressed in or in the NetOp Marker Utility 
window menu or NetOp Marker Utility minimized menu select Magnifier.
To display the NetOp Magnifier window from the keyboard, place the mouse pointer on the active NetOp 
Marker Utility window Upper Toolbar Magnifier button and press F9 to make the button appear pressed 
in. 
Alternatively, while the NetOp Marker Utility window is active press ALT+SPACE to display the NetOp 
Marker Utility window menu and press M or highlight the Magnifier command and press ENTER.
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NetOp Magnifier

If the mouse pointer is outside this window, this window pane will display a magnified image of the 
mouse pointer surroundings.
To move the window, drag its title bar or place the mouse pointer in the title bar, press INSERT to engage, 
move with the arrow keys and press INSERT to disengage.
To resize the window, drag its sides or corners or position the mouse pointer on a side or corner to display 
a double arrow, press INSERT to engage, move with the arrow keys and press INSERT to disengage.
To change the pane image magnification, drag the right side scrollbar button or place the mouse pointer 
above or below below it and press F9. Its top position will display a 1:1 scale pane image. 
Right-click in the window or place the mouse pointer in the window and press F10 to display this menu:

Close: Select this command or click the NetOp Marker Utility window Upper Toolbar Show 
Magnifier button appearing pressed in to release it to close the NetOp Magnifier window.
Copy Ctrl+C: Select this command or press CTRL+C to copy the pane content to the clipboard.
Refresh F5: The pane image will refresh when the mouse pointer is moved but by default not refresh 
if the mouse pointer is not moved. Select this command or press F5 to refresh the pane image.
Refresh Rate…: Select this command to display this window:

�Enable refresh timer: Check this box to refresh the pane image if the mouse pointer is not 
moved (default: unchecked).
Interval (tenths of seconds): []: Specify in this field a number to refresh at the specified 
interval (default: 20).

3.8.2.8 Delete Markers
To delete markers, click one of these NetOp Marker Utility window Upper Toolbar buttons or select the 
matching NetOp Marker Utility window menu or NetOp Marker Utility minimized menu command:
Undo: Delete the most recently selected marker.
Clear All: Delete all markers.
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Note: When NetOp Marker Utility is unloaded, all markers and any NetOp Magnifier window will be 
removed.

3.8.2.9 Marker Properties and Help
Specify marker properties and display help from the NetOp Marker Utility window Lower Toolbar 
buttons or the matching NetOp Marker Utility window menu or NetOp Marker Utility minimized menu 
commands:
(Select) Font: Click this button or select this command to display the Windows Font window to select a 
text marker font and color (default: Arial Bold 30pt Red).
(Select) Color: Click this button or select this command to display the Windows Color window to select 
a figure marker color (default: Red).
Select Pen Thickness/Line Width: Click this button to display a line width drop-down box or select this 
command to expand it into a selection of numbers of pixels to select a figure marker or text marker frame 
line width (default: 2 pixels).
Help: Click this button or select this command to open the NetOp Host Help system on the NetOp Marker 
Utility topic.
3.8.3 NetOp Script
A NetOp script is a user specified NetOp command structure that can execute a NetOp task, typically an 
unattended scheduled file transfer between computers.
To create a NetOp script, in the NetOp Guest Window Tab Panel Script Tab Records Pane context menu 
select New Script or in the NetOp File Manager window Toolbar Other Buttons select the Script button or 
select theNetOp File Manager window Options Menu Script command to display the Script window.
To view or edit an existing NetOp script, on the NetOp Guest Window Tab Panel Script Tab select the 
script record and select the Edit Menu Edit script command or the record context menu Edit command to 
display the script in the Script window:
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Script

This window creates and edits a NetOp script in a graphical display.
Title bar window controls are explained in Window Control.
Script File
Filename []: This field will display the script file path and name (default: empty). To create a NetOp 
script, specify the script file name in the field. If you do not specify a file extension and a path, the script 
file will get the extension dws and reside in the NetOp Configuration Files directory, typically 
C:\Documents and Settings\<User name>\Application Data\Danware Data\NetOp Remote 
Control\Guest\script. If you create a new script, you will be prompted for confirmation. Click Yes to 
display the Global Settings window.
Open Script: Click this button to display a Windows Open window that specifies Files of type: NetOp 
Script Files (*.dws) to open a NetOp script file in the window displaying its path and name in the 
Filename field.
Comment []: This field can contain a comment that will be displayed in the Script Tab Records Pane 
Comment column.
Save Script: Click this button to save a new or edited script.
(Script pane): If a script is opened in the window, this upper pane will display the script content in an 
expandable graphical tree structure, see Test a NetOp Script (default: empty).
(Debug messages pane): If a script is opened in the window, this lower pane will display debug messages, 
see Test a NetOp Script (default: empty).
Add: Click this button to add a script command in the script pane under the selected script command, see 
Commands.
Edit:  In the script pane, select a script command and click this button to display the matching editing 
window.
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Run Script: Click this button to run the script, see Test a NetOp Script.
Delete: In the script pane, select a script command and click this button to delete it and the subtree under 
it.
3.8.3.1 Global Settings
Global settings specify initial script settings. Confirm creating a new script by Yes or in the script pane 
select Global Settings and click Edit to display this window:

It has these tabs:
• General Tab
• Transfer Tab
• Overwrite/Delete Tab
• Advanced Tab 

Note: Global Settings in the Script File explains how global settings will appear in the script file.
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3.8.3.1.1 General Tab

This NetOp Script Global Settings window tab specifies the global file transfer direction.
From: []: The field of this drop-down displays the selected source NetOp module name (default: Guest). 
The drop-down box list contains the options Guest and Host. Select an option in the list to display it in the 
field.
To: []: This disabled field displays the From drop-down box unselected NetOp module name.
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3.8.3.1.2 Transfer Tab

This NetOp Script Global Settings window tab specifies global file transfer options.
Transfer Options
;Use Delta File Transfer: Leave this box checked to compare source files with destination files and 
transfer only the difference between source files and destination files to save transmission bandwidth 
(default: checked).

;Enable crash recovery: Leave this box checked to transfer files in a way that they can be recovered 
after a computer or network crash during transfer (default: checked).
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3.8.3.1.3 Overwrite/Delete Tab

This NetOp Script Global Settings window tab selects global overwrite and delete options.
Overwrite/Delete
;Allow overwriting/deleting existing files/folders: Leave this box checked to allow overwriting and 
deleting files and folders on the destination computer (default: checked).

;Allow overwriting/deleting system files: Leave this box checked to allow overwriting and deleting 
system files on the destination computer (default: checked).

;Allow overwriting/deleting read-only files: Leave this box checked to allow overwriting and deleting 
read-only files on the destination computer (default: checked).

;Allow overwriting/deleting hidden files: Leave this box checked to allow overwriting and deleting 
hidden files on the destination computer (default: checked).
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3.8.3.1.4 Advanced Tab

This NetOp Script Global Settings tab specifies advanced global settings.
Error Handling
On communication error []: The field of this drop-down box specifies the action in case of a 
communication error. The drop-down box list contains these options:

Exit: End the script.
Next Host: Proceed to the next Host specified in the script (default selection).
Retry 1 time: Retry the failed command once.
Retry 2 times: Retry the failed command twice.
etc.
Retry 9 times: Retry the failed command 9 times.

Select an option in the list to display it in the field.
On transfer error []: The field of this drop-down box specifies the action in case of a file transfer error. 
The drop-down box list contains these options:

Exit: End the script.
Next Host: Proceed to the next Host specified in the script.
Next File: Proceed to the next file specified in the script (default selection).
Retry 1 time: Retry the failed command once.
Retry 2 times: Retry the failed command twice.
etc.
Retry 9 times: Retry the failed command 9 times.

Select an option in the list to display it in the field.
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Log File
;Generate log file: Leave this box checked to generate a log file when running the script (default: 
checked).

�Append if log exists: Check this box to append the log to an existing log file with the specified name 
(default: unchecked). Leave unchecked to overwrite.
[<Log file path and name>]: This field will specify the log file path and name (default: SCRIPT.LOG). If 
no path is specified, the log file will reside in the NetOp Configuration Files directory, typically 
C:\Documents and Settings\<User name>\Application Data\Danware Data\NetOp Remote 
Control\Guest\.
Browse: Click this button to open a Windows Open window that specifies Files of type: Log Files (*.log) 
to open a log file to specify its path and name in the field.

Note: The script log file is explained in Script Log.

�Restart script when finished: Check this box to restart the script at script end (default: unchecked).

�Close Guest when finished: Check this box to unload NetOp Guest at script end (default: unchecked).
3.8.3.1.5 Global Settings in the Script File

NetOp Script Global Settings will appear in the script file as explained in this table:

Setting Value Description
SET Copy= G_H Transfer from Guest to Host.

H_G Transfer from Host to Guest.
SET Delta= No Do not use Delta file transfer.

Yes Use Delta file transfer.
SET CrashRecovery= No Do not enable crash recovery.

Yes Enable crash recovery.
SET OverwriteExisting= No Do not overwrite/delete existing files.

Yes Overwrite/delete existing files.
SET OverwriteSystem= No Do not overwrite/delete system files.

Yes Overwrite/delete system files.
SET OverwriteReadOnly= No Do not overwrite/delete read-only files.

Yes Overwrite/delete read-only files.
SET OverwriteHidden= No Do not overwrite/delete hidden files.

Yes Overwrite/delete hidden file.
SET OnComError= Exit On a communication error, end the script.

NextHost On a communication error, proceed to the next Host in the script.
<Number> On a communication error, retry connecting <Number> times (1 to 

9).
SET OnError= Exit On a transfer error, end the script.

NextHost On a transfer error, proceed to the next Host in the script.
NextFile On a transfer error, proceed to the next file in the script.
<Number> On a transfer error, retry transferring <Number> times (1 to 9).

SET LogAppend= No Do not append a log in an existing log file.
Yes Append a log in an existing log file.

SET Log= None Do not generate a script log.
“<Log 
file path 
and 
name>”

Generate a script log in the specified log file.
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3.8.3.2 Commands
To specify the first command of a NetOp Script, in the Script window script pane select Global Settings 
and click Add to display this drop-down menu:

This menu contains script commands that can execute on the Guest:
Connect: Select this command to display the Connect to Host window to add a Connect Command 
that connects to a Host.
Wait: Select this command to display the Wait Dialog window to add a Wait Command that delays 
script execution.
Run: Select this command to display the Run Program window to add a Run Command that runs a 
program on the Guest computer.

A Connect command branches the script into commands that execute with or on the connected Host 
computer or in case of a Connect /Mode=Guest command on the Guest computer.
In the script pane, click the [+] button before a Connect command to expand it and select the expanded 
Connect command or a command below it and click Add to display this menu:

This menu contains script commands that can execute with a connected Host or a Guest connected 
locally to itself:
Copy to Delete: Select one of these commands to display a <File transfer> (Dialog) window to add 
a File Transfer Command.
Wait: Select this command to display the Wait Dialog window to add a Wait Command to delay 
script execution.
Run: Select this command to display the Run Program window to add a Run Command to run a 
program on the connected to computer.
Logoff to Send Message: Select one of these commands to add an Action Command to execute an 
action on the connected to computer.

Note: Commands in the Script File explains how commands will appear in the script file.

SET AtEnd= None Do not restart the script at script end.
Restart Restart the script at script end.

SET CloseGuest= No Do not unload NetOp Guest at script end.
Yes Unload NetOp Guest at script end.
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3.8.3.2.1 Connect Command

To add a Connect command to a NetOp script, in the Script window script pane select Global Settings or 
the command directly under Global Settings after which you want to connect to a Host or locally to the 
Guest and click the Add button. In the Commands drop-down menu select Connect to display the Connect 
to Host window. 
To edit a Connect command, in the script pane select a Connect command and click the Edit button to 
display the Connect to Host window:
Connect to Host

This window adds or edits a Connect command.
Connect using: []: The field of this drop-down box displays the selected connect option. The drop-down 
box list contains these options:
• Phonebook File: Select this option to connect to a Host computer by specifying its NetOp 

phonebook file (default selection).
• Communication Profile: Select this option to connect to a Host computer by specifying a 

communication profile and Host connect information.
• Local: Select this option to connect locally to the Guest computer.
Select an option in the list to display it in the field.
If you select Phonebook file, this will be displayed below:

Phonebook file: [] [Browse]: Click Browse to display a Windows Open window specifying Files of 
type: NetOp Phonebook Files (*.dwc) to open a phonebook file to display its path and name in the 
field. Alternatively, specify the path and name in the field.
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If you select Communication profile, this will be displayed below:

Communication profile []: The field of this drop-down box will display the selected communication 
profile (default: TCP/IP). The drop-down box list will contain available Guest communication 
profiles. Select one in the list to display it in the field.
<Host connect information>: []: Specify Host connect information in one or two fields according to 
the communication profile selection above, see Host Section (default: empty). In a field in which 
you can specify an IP address, you can also specify an IP address range, e.g. 192.168.1.1-
192.168.1.5, to connect to multiple Host computers from one script.
Logon name: []: Specify in this field any logon name required by the Host (default: empty).
Logon password: []: Specify in this field the Logon name matching password (default: empty).
Logon domain: []: Specify in this field the Logon name matching domain or directory server 
(default: empty).

�Use current logon credentials for Windows Security authentication: Check this box to log on to 
the Host by the Windows logon user credentials of the Guest computer user instead of the logon 
credentials specified above (default: unchecked).

If you select Local, no further specification is required.
Click OK to specify the added or edited Connect command in the script pane.
3.8.3.2.2 Wait Command

To add a Wait command to a NetOp script, in the Script window script pane select the command after 
which you want to wait before continuing script execution and click the Add button. In the Commands 
drop-down menu select Wait to display the Wait Dialog window. 
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To edit a Wait command, in the script pane select a WAIT command and click Edit to display the Wait 
Dialog window:
Wait Dialog

This window adds or edits a Wait command.
Type: []: The field of this drop-down box displays the selected wait type. The drop-down box list 
contains these wait types:
• Delay: Delay script execution for a specified time.
• Wait until: Wait until a specified date and time to continue script execution (default selection).
• Repeat daily: Repeat script execution daily at a specified time.
• Repeat weekly on day: Repeat script execution weekly at a specified time on specified weekdays.
• Repeat monthly on day: Repeat script execution monthly at a specified time on specified weekdays.
• Repeat monthly on date: Repeat script execution monthly at a specified time on specified dates.
Select a wait type in the list to display it in the field.
If you selected Delay, this section will be displayed below:

Delay: HH[]-MM[]-SS[]: Specify a delay between 00-00-00 and 23-59-59 (default: 12-00-00).
If you selected Wait until, this section will be displayed below:

Time: HH[]-MM[]-SS[] [AM/PM]: Specify a time of day between 00-00-00 AM and 11-59-59 PM 
(default: 12:00:00 AM (noon)).
Date: MM[]-DD[]-YYYY[]: Optionally, specify a date between 01-01-1900 and 12-31-2200 
(default: <Current date>).
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Note: If you clear the Date fields, script execution will wait until the next occurrence of the time of 
day specified in the Time fields.

If you select one of the remaining wait types, this section will be displayed below:

Time: HH[]-MM[]-SS[] [AM/PM]: Specify a time of day between 00-00-00 AM and 11-59-59 PM 
(default: 12:00:00 AM (noon)).
Select days...: This button will not be not included if you selected Repeat daily in the Type drop-
down box. Click this button to display one of these windows:

If you selected Repeat weekly on day in the Type drop-down box field:

If you selected Repeat monthly on day in the Type drop-down box field:
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If Repeat monthly on date is selected in the Type drop-down box field:

Click days or dates to give them a white frame to select them (default: (first) Monday or 1).
3.8.3.2.3 Run Command

To add a Run command to a NetOp script, in the Script window script pane select the command after 
which you want to run a command and click the Add button. In the Commands drop-down menu select 
Run to display the Run Program window. 

Note: A Run command directly under Global Settings or under a Connect /Mode=Guest command will 
execute on the Guest computer. 
A Run command directly under a Connect command other than Connect /Mode=Guest will execute on 
the connected to Host computer. 
The specified program file must reside on the computer on which it shall run.

To edit a Run command, in the script pane select a RUN command and click the Edit button to display the 
Run Program window:
Run Program

This window adds or edits a Run command.
If you are adding a Run command, the field will be empty. If you are editing a Run command, the field 
will display the program path and command. Specify or edit the program path and command.  Right-click 
in the field to display a standard editing menu. You can include command line switches.
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Browse: Click this button to display a Windows Open window that specifies Files of type: Exe files 
(*.exe) to open an exe file to display its path and name in the field above.

Note: See also Run Program.

Timeout []: The field of this drop-down box displays the selected timeout (default: 1 Min). The drop-
down box list contains timeouts from None to Never with from 5 Sec to 10 Min in between. None will 
cause script execution to proceed without waiting for program execution to complete. A specific timeout 
will cause a script error if program execution has not completed within the specified timeout. Never will 
cause script execution to wait for program execution to complete before proceeding.

Caution: An invalid command specification will cause a script error, see Test a NetOp Script.

3.8.3.2.4 File Transfer Command

To add a file transfer command to a NetOp script, in the Script window script pane select the command 
after which you want to add a file transfer command and click the Add button. In the Commands drop-
down menu select Copy, Move, Synchronize, Clone or Delete to display the matching <File transfer> 
(Dialog) window explained below. 
To edit a file transfer command, in the script pane select a file transfer command and click the Edit button 
to display the matching <File transfer> (Dialog) window explained below. 
File transfer commands include Copy, Move, Synchronize, Clone and Delete.
The Copy Dialog, Move Dialog, Synchronize Dialog and Clone Dialog windows have the same layout. 
Only the Copy Dialog window will be explained with notes on differences. It has these tabs:
• General Tab
• Transfer Tab
• Copy Tab
• Overwrite/Delete Tab
• Advanced Tab
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Copy Dialog
General Tab

From
(Upper drop-down box) []: The field of this drop-down box displays the selected source NetOp 
module name (default: the Global Settings window General tab selection). The drop-down box list 
contains the options Guest and Host. Select an option in the list to display it in the field.
(Lower field) []: If you are adding a file transfer command, this field will be empty. If you are 
editing a file transfer command, this field will display the source specification. Specify or edit the 
source specification. Specify a file mask (a file name with wildcard characters like * signifying any 
characters) to include multiple file names with common characters. The file mask *.* specifies a 
directory.

Note: A Synchronize or Clone command must specify a source directory.

Browse

Note: This section will be enabled only if the From section upper drop-down box field displays 
Guest.

Folders...: Click this button to display a Windows Browse for Folder window to select a source 
directory whose path and name (ending with *.*) will be displayed in the lower field.
Files...: Click this button to display a Windows Open window that specifies Files of type: All 
Files (*.*) to open a source file whose path and name will be displayed in the lower field.

Note: The Files button will be disabled if you are specifying a Synchronize or Clone command.

To
(Upper field) []: This disabled field will always display the From section upper drop-down box 
unselected option.
(Lower field) []: If you are adding a file transfer command, this field will be empty. If you are 
editing a file transfer command, this field will display the destination specification. Specify or edit 
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the destination specification that will typically be a directory path ending with *.*. To rename a 
single transferred file, specify a destination file name.

Note: A Synchronize or Clone command must specify a destination directory.

Browse

Note: This section will be enabled only if the To section upper drop-down box field displays 
Guest.

Folders...: Click this button to display a Windows Browse for Folder window to select a 
destination directory whose path ending with *.* will be displayed in the lower field. 
Existing files in the destination directory with the same location and name as transferred files 
will be overwritten by transferred files, except in the case of synchronization where source and 
destination directory older files will be overwritten by newer files in either directory.
Files...: Click this button to display a Windows Open window that specifies Files of type: All 
Files (*.*) to open a destination file whose path and name will be displayed in the lower field.
Specifying a destination file name will rename a single transferred file into the specified name. 
If the specified destination file exists, it will be overwritten by the transferred file.

Note: The Files button will be disabled if you are specifying a Synchronize or Clone command.

Caution: An invalid file transfer specification will cause a script error, see Test a NetOp Script.

Transfer Tab
This tab contains the same elements as the Global Settings window Transfer Tab. Default selections 
are the Global Settings selections. Changed selections will apply to this file transfer command only.
256



3 NetOp Guest
Copy Tab

Copy options
�Copy files newer than: []: Check this box and specify a date in the fields to transfer only files 
newer than the specified date (default: unchecked).

�Include subfolders: Check this box to transfer files in subdirectories of a specified directory 
(default: unchecked). Leave unchecked to transfer only specified directory files.

;Copy hidden and system files: Leave this box checked to transfer hidden and system files (default: 
checked). Uncheck to not transfer hidden and system files.

�Copy only if file exists on target: Leave this box unchecked to transfer all specified files (default: 
unchecked). Check this box to transfer only files that exist on the destination computer in the 
specified location.

�Transfer only one way: This option is enabled only with a Synchronize command. Check this box 
to transfer files only from the source computer to the destination computer (default: unchecked).

Note: With a Clone command, all options except Include subfolders are disabled.

Overwrite/Delete Tab
This tab contains the same elements as the Global Settings window Overwrite/Delete Tab. Default 
selections are the Global Settings selections. Changed selections will apply to this file transfer 
command only.
Advanced Tab
This tab contains the same elements as the Global Settings window Advanced Tab. However, the 
Log File section and the Restart script when finished and Unload Guest when finished options are 
disabled. Default selections are the Global Settings selections. Changed selections will apply to this 
file transfer command only.
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Delete

From
(Upper drop-down box) []: The field of this drop-down box displays the selected NetOp module name 
(default: the Global Settings window General Tab unselected option). The drop-down box list contains 
the options Guest and Host. Select an option in the list to display it in the field.
(Lower field) []: Specify a directory or file path and name. Specify a file mask (a file name with wildcard 
characters like * signifying any characters) to specify multiple file names with common characters. The 
file mask *.* specifies a directory.
Options
�Include subfolders: Check this box to delete a specified directory, its subdirectories and files in them 
(default: unchecked). Leave unchecked to delete only files in a specified directory.

;Delete hidden and system files: Leave this box checked to delete hidden and system files in a specified 
directory (default: checked). Uncheck to not delete hidden and system files.

�Delete read only files: Check this box to delete read-only files in a specified directory (default: 
unchecked). Leave unchecked to not delete read-only files.
3.8.3.2.5 Action Command

Action commands include the simple commands Logoff, Restart, Poweroff and Lock and the composite 
commands Inventory and Send Message.

Note: Action commands will work only with a connected Host, not when connecting locally to the Guest.

To add an action command to a NetOp script, in the Script window script pane select the command after 
which you want to execute it. Click the Add button and in the drop-down menu select one of these 
commands:
Logoff: Add a command that will log off the user from Windows on the connected to Host computer.
Restart: Add a command that will restart Windows on the connected to Host computer.
Poweroff: Add a command that will close down and power off the connected to Host computer.
Lock: Add a command that will lock the connected to Host computer.
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Inventory: Display this window:

Inventory step: The field of this drop-down box displays the selected Inventory step option. The 
drop-down box list contains these options:

One Step: Generate, retrieve, copy and complete a connected to Host computer inventory.
Generate: Generate a Host computer inventory on the Host computer.
Retrieve: Retrieve the generated Host computer inventory into the Host computer file 
%TEMP%\si_out.xml.

Note: A retrieved inventory file must be copied from the connected to Host computer to the 
Guest computer by a Copy File Transfer Command, typically to the Guest computer %TEMP% 
directory, to be ready for completion.

Complete: Move a Host computer inventory file copied to the Guest computer to the Guest 
computer user inventor directory to make it displayable on the NetOp Guest Window Tab 
Panel Inventory Tab. The inventor directory resides in the NetOp Configuration Files 
directory, typically C:\Documents and Settings\<User name>\Application Data\Danware 
Data\NetOp Remote Control\Guest\inventor.

Select an option in the list to display it in the field.
Inventory file path: This field will be enabled only if Complete is displayed in the Inventory step 
drop-down box field. Specify the Guest computer path and name of the inventory file that shall be 
completed.

Send Message: Display this window:

Send Message step: The field of this drop-down box displays the selected Send Message step option. 
The drop-down box list contains these options:

One Step: Copy a Guest computer message file to the connected to Host Messages directory 
and display the message on the Host computer screen.

Note: Create and save a message file in the Send Message window, see NetOp Message.

Display Message: Display a message file residing in the Host Messages directory on the Host 
computer screen.

Select an option in the list to display it in the field.
Message path: []: Specify in this field the Guest (One Step) or Host (Display Message) computer 
path and name of the message file that shall be (copied and) displayed.
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Note: The Host Messages directory is identified by the environment variable 
%RootConfig%Messages.
To display in the Host Message window, the message file name must use the syntax 
<Date>T<Time>;<Sender>.rtf with the date and time format YYYY-MM-DDTHH-MM-SS.

Browse...: Click this button to display a Windows Open window specifying Files of type: Rtf Files 
(*.rtf) to open a Guest computer message file to display its path and name in the Message path field.

3.8.3.2.6 Commands in the Script File

Script commands will appear in the NetOp script file as explained in this table:

Command/Setting Arguments/Value Description
Connect /Mode=Phonebook <Drive>:\<Path>\<File> Connect to the Host of the phonebook 

file <Drive>:\<Path>\<File>.
Connect /Mode=CommProfile /Profile=”<Communication profile>” 

/Name=<Host name or IP address 
range>
/Loginname=<Login name> 
/Loginpassword=<Password 
(encrypted)> 
/Logindomain=<Domain or directory 
service name> 
/LoginCredentials=<Yes/No>

Connect using the communication 
profile <Communication profile> to 
<Host name or IP address range> 
logging on to the Host by <Login 
name>, <Password> and <Domain or 
directory service name> or current 
Windows credentials <Yes/No>.

Connect /Mode=Guest Connect locally to the Guest.
WAIT /Mode=Delay HH:MM:SS Wait for HH:MM:SS before proceeding.
WAIT /Mode=Until HH:MM:SS [MM-DD-YYYY] Wait until HH:MM:SS (hours), if 

specified on MM-DD-YYYY, otherwise 
next, before proceeding.

WAIT /Mode=Repeat HH:MM:SS Repeat daily at HH:MM:SS (hours).
WAIT /Mode=WeekDay /Days=”<n1>,<n2>,...” HH:MM:SS Repeat weekly on days number <n1>, 

<n2> and others specified (1=Monday, 
2=Tuesday, etc.) at HH:MM:SS (hours).

WAIT /Mode=MonthDay /Days=”<n1>,<n2>,...” HH:MM:SS Repeat monthly on days number <n1>, 
<n2> and others specified (1=Monday of 
first week, 8=Monday of second week, 
29=Monday of last week) at HH:MM:SS 
(hours).

WAIT /Mode=MonthDate /Days=”<n1>,<n2>,...” HH:MM:SS Repeat monthly on dates number <n1>, 
<n2> and others specified at 
HH:MM:SS (hours).

Run <Drive>:\<Path>\<File> [<Any command line switch>] Run the program 
<drive>:\<path>\<file>. Command line 
switches can be added.

/Guest Run the program <drive>:\<path>\<file> 
on the Guest.

/TimeOut=0 Run the program <drive>:\<path>\<file> 
and proceed immediately without 
waiting for its execution to end.

/TimeOut=<n> Run the program <drive>:\<path>\<file> 
and proceed when its execution has 
ended. After n seconds (0<n<1000), 
proceed even if execution has not ended 
and report an error.

/TimeOut=1000 Run the program <drive>:\<path>\<file> 
and wait for its execution to end.
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COPY <Source> <Destination> Copy the <Source> folders or files on 
the source computer to the 
<Destination> folder or file on the 
destination computer.

/<Setting without SET_> Apply the specified setting to the 
transfer. If unspecified, the global 
setting specified for the script applies, 
see Global Settings in the Script File.

/D=YYYY-MM-DD Copy files newer than Year-Month-
Date.

/S Include subfolders.
/H Copy hidden and system files.
/U Copy only if file exists in the destination 

directory.
MOVE <Source> <Destination> Move the <Source> folder(s) or file(s) 

on the source computer to the 
<Destination> folder or file on the 
destination computer.

/<Setting without SET_> Apply the specified setting to the 
transfer. If unspecified, the global 
setting specified for the script applies, 
see Global Settings in the Script File.

/D=YYYY-MM-DD Move files newer than YYYY-MM-DD.
/S Include subfolders.
/H Move hidden and system files.
/U Move only if file exists in the destination 

directory.
SYNC <Source> <Destination> Synchronize the <Source> folder on the 

source computer with the <Destination> 
folder on the destination computer.

/<Setting without SET_> Apply the specified setting to the 
transfer. If unspecified, the global 
setting specified for the script applies, 
see Global Settings in the Script File.

/D=YYYY-MM-DD Synchronize files newer than Year-
Month-Date.

/S Synchronize subfolders.
/H Synchronize hidden and system files.
/U Synchronize only files that already exist 

in the destination directory.
/OneWay=Yes Transfer files only from the source 

computer.
CLONE <Source> <Destination> Clone the <Source> folder on the source 

computer to the <Destination> directory 
on the destination computer.

/<Setting without SET_> Apply the specified setting to the 
transfer. If unspecified, the global 
setting specified for the script applies, 
see Global Settings in the Script File.

/S Clone subfolders.
LOGOFF Log off the current user from Windows 

on the Host computer.
RESTART Restart Windows on the Host computer.
POWEROFF Close down and power off the Host 

computer.
LOCKWORKSTATION Lock the Host computer.
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3.8.3.3 Script File
Below is an example of a NetOp script file. The script file is displayed to the left and explanations to each 
line to the right. You can save a script file as a *.DWS or *.TXT file.

USERCMD “GET_INVENTORY=SI_ONESTEP” Create a Host computer inventory on the 
Guest.

USERCMD “GET_INVENTORY=SI_GENERATE” Generate an inventory on the Host 
computer.

USERCMD “GET_INVENTORY=SI_RETRIEVE” Retrieve a generated Host inventory to 
an inventory file on the Host computer.

USERCMD “GET_INVENTORY=SI_COMPLETE <Inventory file 
path>”

Move an inventory file in <Inventory 
file path> on the Guest computer to the 
inventor directory.

USERCMD “SHOWMSG=<Host computer message file path>” Display a message file in <Host 
computer message file path> in a 
Message window on the Host computer 
screen.

Script file Explanation
;This is my new script
;*************************

The script must start with a semicolon (;) followed by an optional 
comment.

Script Start the script.
Global settings:

SET Copy=G_H Transfer files from Guest to Host.
SET Delta=Yes Use delta file transfer.
SET CrashRecovery=Yes Enable crash recovery.
SET OverwriteExisting=Yes Allow overwriting/deleting existing files/folders.
SET OverwriteSystem=Yes Allow overwriting/deleting system files.
SET OverwriteReadOnly=Yes Allow overwriting/deleting read-only files.
SET OverwriteHidden=Yes Allow overwriting/deleting hidden files.
SET OnComError=NextHost On a communication error, proceed to the next Host.
SET OnError=NextFile On a transfer error, proceed to the next file.
SET AtEnd=None Do not restart the script at script end.
SET CloseGuest=No Do not unload the Guest at script end.
SET AppendLog=No Do not append an existing log in the log file.
SET Log=”SCRIPT.LOG” Create a log in the file SCRIPT.LOG.

Commands:
Connect Mode=Phonebook 
“C:\Documents and 
Settings\User1\Application 
Data\Danware Data\NetOp 
Remote 
Control\Guest\PhBook\Host1.
dwc

Connect to the Host of the phonebook file Host1.dwc in the 
default phonebook directory of the computer user User1.

COPY “C:\test.txt” C: /H Copy the file C:\test.txt on the source computer (in this case 
Guest) to the C: folder on the destination computer (in this case 
Host).

ConnectEnd Disconnect.
ScriptEnd End the script.
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3.8.3.4 Test a NetOp Script
A completed script may look like this in the Script window:

Note: This is the script example in Script File.

While creating and editing a script in the Script window, the lower debug messages pane will report any 
syntax errors.
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These syntax errors can be displayed:

Note: You can avoid most of these syntax errors by creating the script in the Script window.

A script will execute from its beginning to its end, in the Script window from top to bottom, completing 
each Connect branch before proceeding to the next Connect branch.
To test a script displayed in the Script window, click the Run Script button and see if the script executes 
its actions and if it reports any execution errors in the debug messages pane. If the script fails, edit it and 
re-run it until it executes as intended.
You can view script errors in a Script Log.
3.8.3.5 Script Log
Running a script will generate a script log if selected on the Global Settings window Advanced Tab.
By default, the script log file named SCRIPT.LOG will reside in the NetOp Configuration Files directory, 
typically C:\Documents and Settings\<User name>\Application Data\Danware Data\NetOp Remote 
Control\Guest.

Error Description
101 Unterminated string, e.g. "test.txt  (no end quotes).
102 More than 512 characters in a line.
103 Invalid character, e.g. drive specification É:.
201 Invalid boolean parameter value, e.g. SET OverwriteHidden=True.
202 A line starting without a command.
203 Too many commands.
204 Unknown command.
205 Invalid enumeration parameter value, e.g. SET OnComError=11.
206 Out of range integer parameter value, e.g. /TimeOut=1500.
207 Too many parameters.
208 Unknown parameter name, e.g. SET ComErr=5.
209 Syntax error, e.g. SET OverwriteSystem=5.
300 A SET command occurs before a Script command.
301 The script ends without a ScriptEnd command.
302 A file transfer command occurs before a Connect command.
303 A Connect command occurs before the previous connection was ended.
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To view the script log graphically, in the NetOp Guest Window View Menu select View File Manager 
Log to display a Windows Open window that specifies Files of type: Log Files (*.log) to open the script 
log in this window:

The NFM Log Viewer window is explained in Options Menu. 
The graphical script log displays script execution like the NetOp Script Script window. Script errors are 
indicated by red exclamation marks and are explained in clear text.
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Open the script log file in a text editor like Notepad to display a textual log:

The textual log contains lines of logged events like a table of records with the column content Date 
(YYYYMMDD), Time (HH:MM), Error code, Extended error code, Action code, Action specification.
The script log can display these errors:

Code Description Code Description
0 No error 34 Path does not exist
01 Syntax error 35 File does not exist
02 Invalid command 36 File already exists
03 Memory error 37 File is marked Read only
04 Script busy 38 File is marked Hidden
05 Command cancelled 39 File is marked System
06 Script not initialized 40 Skipped due to time stamp
07 Internal Error - no control handler 41 Same time stamp and name, different attributes
08 Internal Error - no copy handler 42 Error opening file for read
09 Internal Error - invalid state 43 Error opening file for write
10 Error opening log file 44 Skipped due to date
11 Error writing log file 45 Skipped due to attribute
12 Invalid log version 46 Skipping file
13 Internal error 47 File is locked
14 User does not have read rights 48 Disk full
15 User does not have write rights 80 I/O error
16 Program timeout 81 Communication error
17 Command not supported by Host 160 Verify failure
32 Internal error 255 Unknown error
33 Folder not empty
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Among many others, the script log can display these actions:

Advanced NetOp scripting is explained in the Administrator’s Manual Advanced Tools chapter NetOp 
Scripting ActiveX Control section.

3.9 Guest Actions
You can execute these actions on Hosts:
• Run Program
• Execute Command
• NetOp Message
• Monitor
• Get Inventory
3.9.1 Run Program
You can run a program on one or multiple Host computers from the NetOp Guest Window or from a 
NetOp Script.
• In the NetOp Guest Window, select one or multiple Tab Panel Host records and click the Toolbar 

Action Buttons Run Program button or select the matching Connection Menu command to display 
the Run Program Menu.

• In a NetOp Script, include a Run Command.
You can run a program on a Remote Control session Host computer. Click the Toolbar and Toolbox 
Action Buttons Run Program button to display the Run Program Menu.
Run Program Menu

This menu will contain a Browse command and program commands that have been specified on the 
Program Options window Run Tab.
Select the Browse command to display the Run Program Browse window to specify a program and run it 
on selected record Host computers or on the Remote Control session Host computer.
Select a program command to run the program on selected record Host computers or on the Remote 
Control session Host computer.

Note: The program file must be available on the Host computer in the location specified in the Run 
Program Browse window or on the Run Tab. 

Code Description
FILE ROPEN File opened for reading
FILE WOPEN File opened for writing
FILERCLOSE File closed after reading
FILEWCLOSE File closed after writing
FILE DEL File deleted
DIR DEL Directory deleted
LOG OPEN Log file opened
LOG CLOSE Log file closed
ERROR Error during transfer
CALL Connected to Host
CALLEND Disconnected from Host
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When executing a Run Program command, this window will be displayed:
Command Progress Status

<Run Program icon> Run program: Displays the program file path and name.
The pane displays selected Host records in a table with this column content:
• Description: Progress indicator and Host record Description, see e.g. Phonebook Records. These 

progress indicators can be displayed:

• Name: Host name according to the tab record, if applicable.
• Phone number: Host or connecting NetOp Gateway modem telephone number or IP address 

according to the tab record, if applicable.
• Communication Profile: Guest communication profile according to the tab record.
• Status: Textual progress indicator.
Table controls are explained in Table Control.
Multiple commands will execute sequentially as indicated by the progress indicators and Status column 
contents.

Note: If Host Guest Access Security does not allow Run Programs, the command will not execute, see 
Allow Guest To.

�Close this dialog box on successful completion: Check this box to close the window when the 
command has executed successfully on all selected Hosts (default: unchecked).
Cancel/Close:  During progress, this button will display Cancel. Click it to cancel the command on the 
computer where it is executing or attempting to execute and proceed to the next Host record. After 
completion, this button will display Close. Click it to close the window.

Command execution in progress

Command executed successfully

Command execution failed
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3.9.1.1 Run Program Browse
Select the Run Program Menu Browse command to display this window:

This window specifies a program and its run properties and runs it on selected record Host computers.
Program path: []: The field of this drop-down box will display the program file path and name (default: 
none). The drop-down box list contains paths and names of files that have been run from this window 
before. Select a path and name in the list to display it in the field or specify in the field a file path and 
name.
Browse...: Click this button to display a Windows Open window that specifies Files of type: Programs to 
open a Guest computer program file to display its path and name in the Program path field.

Note: The Open window will display only Guest computer directories and program files. Select All files 
in the lower drop-down box list to display all file types. You can also run other file types, e.g. text files. 
To run successfully, the file must be available and identifiable on the Host computer.

Command line switches: []: The field of this drop-down box will display switches that will be applied to 
the command specified in the Program path drop-down box (default: none). The drop-down box list will 
contain switch sets that have been applied in this window before. Select a switch set in the list to display 
it in the field or specify in the field the switches that shall be applied to the file.
Translate: Click this button to replace Program path field path elements by available environment 
variables to facilitate identifying the path on Host computers whose directory structure is different from 
the Guest computer directory structure because of e.g. language or operating system.
Run
Select one of these options:

~Normal: Run the program in a normal size window (default selection).

{Maximized: Run the program in a maximized window.

{Minimized: Run the program minimized.
OK: Click this button to run the specified program on selected record Host computers to display the 
Command Progress Status window.
3.9.2 Execute Command
You can execute a computer control command on one or multiple Host computers from the NetOp Guest 
Window or from a NetOp Script.
• In the NetOp Guest Window, select one or multiple Tab Panel Host records and click the Toolbar 

Action Buttons Execute Command button or select the matching Connection Menu command to 
display the Execute Command Menu.
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• In a NetOp Script, include a computer control Action Command.
You can execute a computer control command on a Remote Control session Host computer. Click the 
Toolbar and Toolbox Action Buttons Execute Command button to display the Execute Command Menu.
Execute Command Menu

Log Off: Select this command to log off the user from Windows on selected record Host computers.
Restart: Select this command to restart selected record Host computers.
Shut Down: Select this command to shut down selected record Host computers.
Lock Workstation: Select this command to lock selected record Host computers.
Wake on LAN: Select this command to start selected record Host computers whose Wake on LAN MAC 
address is registered, see Connect Tab.
The Command Progress Status window will display command execution.

Note: If Host Guest Access Security does not allow Execute command (Restart, ...), the command will 
not execute, see Allow Guest To.

3.9.3 NetOp Message
You can send a NetOp message to one or multiple Hosts from the NetOp Guest Window and from a 
NetOp Script.
• In the NetOp Guest Window, select one or multiple Tab Panel Host records and click the Toolbar 

Action Buttons Send Message button or select the matching Connection Menu command to display 
the NetOp Message window.

• In a NetOp Script, include a Send Message Action Command.
You can send a NetOp message to a Remote Control session Host computer user. Click the Toolbar and 
Toolbox Action Buttons Send Message button to display the NetOp Message window.
NetOp Message
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In this window, you can create, edit and send a NetOp message that will pop up on the Host computer 
screen like this:

The NetOp Message window contains these elements:
• Title Bar
• Menu Bar
• Toolbar
• Message Pane
• Status Bar
3.9.3.1 Title Bar
This is the NetOp Message window title bar:

It initially displays Untitled. If the message in the window has been saved in a file, its path and name will 
be displayed.
Window controls are explained in Window Control.
3.9.3.2 Menu Bar
This is the NetOp Message window menu bar:

It contains these menus:
• File Menu
• Edit Menu
• Search Menu
• Format Menu
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3.9.3.2.1 File Menu

This is the NetOp Message window File menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Send Message: Select this command or click the matching Toolbar button to send the message to selected 
record Hosts.
The Command Progress Status window will display command execution.

Note: If Host Guest Access Security does not allow Send Message, the command will not execute, see 
Allow Guest To.

New: Select this command or click the matching Toolbar button to empty the Message Pane to create a 
message. You will be prompted to save any unsaved current message changes.
Open: Select this command or click the matching Toolbar button to display a Windows Open window 
that specifies Files of type: Rtf Files (*.rtf) to open the content of a rich text format file in the window. 
You will be prompted to save any unsaved current message changes.
Save: This command will be enabled only if a file path and name has been specified for the window 
message. Select it or click the matching Toolbar button to save the window message in its specified file.
Save As...: Select this command to display a Windows Save As window specifying Files of type: Rtf Files 
(*.rtf) to save the window message with a specified name and extension in a selected directory.

Note: A new message is not automatically named, provided with an extension and saved on the Guest 
computer, but when received on a Host computer it is automatically named, provided with an extension 
and saved.

Print: Select this command or click the matching Toolbar button to display a Windows Print window to 
print the window message content without header or footer.
Close Ctrl+F4: Select this command or the matching Window Control menu command, click the 
Window Control Close button or press CTRL+F4 to close the NetOp Message window. You will be 
prompted to save any unsaved current message changes.
3.9.3.2.2 Edit Menu

This is the NetOp Message window Edit menu:
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Menu and toolbar controls are explained in Menu and Toolbar Control.
Undo Ctrl+Z: Select this command, press CTRL+Z or click the matching Toolbar button to undo/redo the 
last Message Pane action.
Cut Ctrl+X: Select Message Pane text and select this command, press CTRL+X or click the matching 
Toolbar button to remove the selected text and place it on the clipboard.
Copy Ctrl+C: Select Message Pane text and select this command, press CTRL+C or click the matching 
Toolbar button to copy selected text to the clipboard.
Paste Ctrl+V: Select this command, press CTRL+V or click the matching Toolbar button to paste the 
clipboard contents in the Message Pane cursor position.
Clear All Ctrl+Del: Select this command or press CTRL+DEL to clear all Message Pane content.
Delete Del: Select Message Pane text and select this command or press DEL to delete selected text.
3.9.3.2.3 Search Menu

This is the NetOp Message window Search menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Find...: Select this command or click the matching Toolbar button to display the Windows Find window 
to find Message Pane text.
Replace...: Select this command to display the Windows Replace window to replace Message Pane text. 
Next F3: Select this command or press F3 to highlight the next occurence of Find or Replace window 
specified text in the Message Pane.
3.9.3.2.4 Format Menu

This is the NetOp Message window Format menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Character: This command expands into these commands:

Bold: Select Message Pane text and select this command to checkmark/uncheckmark it or click the 
matching Toolbar button to make it appear pressed in/released to bold/unbold selected text.
Italic: Select Message Pane text and select this command to checkmark/uncheckmark it or click the 
matching Toolbar button to make it appear pressed in/released to italicize/un-italicize selected text.
Underline: Select Message Pane text and select this command to checkmark/uncheckmark it or click 
the matching Toolbar button to make it appear pressed in/released to underline/un-underline 
selected text.
Strikeout: Select Message Pane text and select this command to checkmark/uncheckmark it to 
strikeout/un-strikeout selected text.

Font...: Select Message Pane text and select this command to display the Windows Font window to 
change selected text font and color.
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Text data/RTF data: Select the uncheckmarked command to switch checkmarks to change the Message 
Pane text data format into the checkmarked type.

Note: The RTF format supports hyperlinks.

3.9.3.3 Toolbar
This is the NetOp Message window toolbar:

Menu and toolbar controls are explained in Menu and Toolbar Control.
The toolbar contains these buttons:

Send: Click this button or select the matching File Menu command to send the window message 
to selected record Hosts.
The Command Progress Status window will display command execution.

Note: If Host Guest Access Security does not allow Send Message, the command will not execute, 
see Allow Guest To.

New: Click this button or select the matching File Menu command to empty the Message Pane to 
create a message. You will be reminded to save any unsaved current message changes.
Open: Click this button or select the matching File Menu command to display a Windows Open 
window that specifies Files of type: Rtf Files (*.rtf) to open the content of a rich text format file in 
the window. You will be reminded to save any unsaved current message changes.
Save: This button will be enabled only if a file path and name have been specified. Click it or select 
the matching File Menu command to save the message in its specified file.
Print: Click this button or select the matching File Menu command to display a Windows Print 
window to print the window message content without header or footer.
Undo/Redo: Click this button or select the matching Edit Menu command to undo/redo the last 
Message Pane action.
Cut: Select Message Pane text and click this button, select the matching Edit Menu command or 
press CTRL+X to remove selected text and place it on the clipboard.
Copy: Select Message Pane text and click this button, select the matching Edit Menu command or 
press CTRL+C to copy selected text to the clipboard.
Paste: Click this button, select the matching Edit Menu command or press CTRL+V to paste the 
clipboard content in the Message Pane cursor position.
Find: Click this button or select the matching Search Menu command to display the Windows 
Find window to find Message Pane text.
Bold: Select Message Pane text and click this button to make it appear pressed in/released or 
select the matching Format Menu command to checkmark/uncheckmark it to bold/unbold selected 
text.
Italic: Select Message Pane text and click this button to make it appear pressed in/released or 
select the matching Format Menu command to checkmark/uncheckmark it to italicize/un-italicize 
selected text.
Underline: Select text in the Message Pane and click this button to make it appear pressed in/
released or select the matching Format Menu command to checkmark/uncheckmark it to 
underline/un-underline selected text.
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3.9.3.4 Message Pane
This is the NetOp Message window message pane:

It will display the message content. The first line of text will describe the message content on the Host. 
You can edit, search and format text pane text from menu commands and Toolbar buttons.
To create an unprepared NetOp message, type it into the pane.
To create a prepared NetOp message, create plain or RTF formatted text in a file and paste it into the 
pane.

Note: RTF formatted text supports hyperlinks, see Format Menu.

3.9.3.5 Status Bar
This is the NetOp Message window status bar:

The fields to the right are active:
• CAPS: Displays black text if CAPS LOCK is enabled.
• NUM: Displays black text if NUM LOCK is enabled.
• OVR: Displays black text if INSERT is enabled.
3.9.4 Monitor
To monitor multiple Host computer screens sequentially, in the NetOp Guest Window select multiple 
Tab Panel Host records and click the Toolbar Action Buttons Monitor button or select the matching 
Connection Menu command to display the Monitor Toolbox and start connecting to the first selected 
record Host.

Note: You must log on to each Host to monitor it.
If Host Guest Access Security does not allow Remote control, connection will be denied, see Allow Guest 
To.

When connected, the Host computer screen image will be displayed, typically in this window:
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Monitor Window

Window controls are explained in Window Control.
This window resembles the Remote Control window, but only these Toolbar and Toolbox buttons are 
enabled:

The Status Bar mouse and keyboard control fields display No Mouse and No Keyboard to indicate that 
monitoring provides no mouse and keyboard control in the Host screen image.
Other Remote Control Display functionalities are available.

Full Screen: Click this window toolbar button or select the matching Title Bar menu command to 
display the Host computer screen image in full screen display, see Remote Control Display.
Click this full screen toolbox button to display the Host computer screen image in window 
display, see Remote Control Display.

Note: Press the zoom hotkey to toggle between window display and full screen display. The zoom 
hotkey is CTRL+Z unless modified, see Remote Control Tab.

Show Connection List: Click this button to display on the Host computer screen the Connection 
List window that displays records of connected Guests, see Connection Notification Tab.

Note: This button will be disabled if Host Guest Access Security does not allow Act as multi 
Guest session administrator, see Allow Guest To.

Save Screen to Clipboard: Click this button or select the matching Title Bar menu command to 
capture the Host computer screen image to the Guest computer clipboard.
Save Screen to File: Click this button or select the matching Title Bar menu command to capture 
the Host computer screen image and display a Windows Save As window that suggests the file 
name <Host name>-<Date>-<Time>.bmp and the NetOp Configuration Files SnapShot directory. 
You can change the file name and directory before saving.
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When the Program Options window Monitor Tab specified Monitor interval has expired, the Guest wil 
disconnect and connect to the next selected record Host.
You can end monitoring from the Monitor Toolbox.
3.9.4.1 Monitor Toolbox
This is the Monitor toolbox:

Its title bar will display:
• While monitoring: Monitoring: <Host name>, <Number> s.: <Number> will count down from the 

Program Options window Monitor Tab specified Monitor interval to zero. After countdown, the 
Guest will disconnect and connect to the next selected record Host.

• While holding countdown: Holding: <Host name>.
• While remote controlling: Remote controlling: <Host name>.
It contains these buttons:

End: End monitoring.

Continue: Continue countdown after Hold.

Hold: Hold countdown.

Previous: Monitor previous Host.

Next: Monitor next Host.

Remote Control/Monitor: Switch between monitor and monitor remote control. The button will 
display a remote control icon when monitoring and a monitor icon when remote controlling.
Full Screen/Window: Switch between window and full screen display. The button will display a 
full screen icon in window mode and a window icon in full screen mode.
Host List: Display a list of monitored Hosts. Select a Host to monitor it.
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Monitor remote control does not enable full Remote Control functionality but enables mouse and 
keyboard control and these additional toolbar buttons:

3.9.5 Get Inventory
You can get the Host computer inventory from one or multiple Hosts from the NetOp Guest Window and 
from a NetOp Script.
• In the NetOp Guest Window, select one or multiple Tab Panel Host records and click the Toolbar 

Action Buttons Get Inventory button or select the matching Connection Menu command to get Host 
computer inventories to the Tab Panel Inventory Tab.

• In a NetOp Script, include an Inventory Action Command.

Connection Properties: Click this button or select the matching Title Bar menu command to 
display the Connection Properties window with a limited tab and option selection.
Send Ctrl+Esc: Click this button or select the matching Title Bar menu command to send the 
keystroke combination CTRL+ESC to the Host to display the Start menu on a Windows Host 
computer or the Window List on an OS/2 Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Use keyboard 
and mouse, see Allow Guest To.
Using this keystroke combination from the keyboard can have undesired effects.

Send Ctrl+Alt+Del: Click this button or select the matching Title Bar menu command to send the 
keystroke combination CTRL+ALT+DEL to the Host to display the security dialog box on a 
Windows 2003/XP/2000/NT Host computer or restart an OS/2 Host computer.

Note: This button will be disabled if Host Guest Access Security does not allow Use keyboard 
and mouse, see Allow Guest To. 
Using this keystroke combination from the keyboard can have undesired effects.
Send Ctrl+Alt+Del will be disabled with Windows ME, 98 and 95 Host computers.
Click or select Restart Host PC to restart the Host computer.

Send Clipboard: Click this button or select the matching Title Bar menu command to send the 
Guest computer clipboard content to the Host computer clipboard.

Note: This button will be disabled if Host Guest Access Security does not allow Transfer 
clipboard, see Allow Guest To.

Retrieve Clipboard: Click this button or select the matching Title Bar menu command to retrieve 
the Host computer clipboard content to the Guest computer clipboard.

Note: This button will be disabled if Host Guest Access Security does not allow Transfer 
clipboard, see Allow Guest To.

Marker Mode: Click this button to make it appear pressed in or select the matching Title Bar 
menu command to checkmark it to start NetOp Marker Utility. Click the pressed in button to 
release it or select the checkmarked command to uncheckmark it to stop NetOp Marker Utility.

Note: This button will be disabled if Host Guest Access Security does not allow Use keyboard 
and mouse, see Allow Guest To.

Lock Keyboard and Mouse: Click this button to make it appear pressed in or select the matching 
Title Bar menu command to checkmark it to disable the Host computer keyboard and mouse. 
Click the pressed in button to release it or select the checkmarked command to uncheckmark it to 
enable the Host computer keyboard and mouse.

Note: This button will be disabled if Host Guest Access Security does not allow Lock keyboard 
and mouse, see Allow Guest To.
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To get the Host computer inventory from a Remote Control session Host to the Tab Panel Inventory Tab, 
click the Toolbar and Toolbox Action Buttons Get Inventory button.
The Command Progress Status window will display command execution.

Note: If Host Guest Access Security does not allow Retrieve Inventory, the command will not execute, 
see Allow Guest To.

Advanced inventory options are available on the Program Options window Inventory Tab.
279



3.9 Guest Actions
280



4 NetOp Host
281



4.1 Summary
4.1 Summary
This chapter explains the functionality of NetOp Host on a computer that runs on a Windows operating 
system.

Note: NetOp Host on a computer that runs on a Linux, Solaris, Mac OSX, OS/2 or DOS operating 
systems is explained in the Administrator’s Manual Other Operating Systems chapter.

NetOp Host enables a computer to be remote controlled from and interact with a computer that runs 
NetOp Guest.
This chapter contains these main sections:
• Host Startup Guide
• NetOp Host Window
• Host Tools
• Host Sessions
• Host Actions

4.2 Host Startup Guide
4.2.1 For Typical Computer Users
NetOp Host is a server type program that enables the matching client type program NetOp Guest on 
another computer to access resources on the NetOp Host computer.
If NetOp Host runs on your computer, you may experience that sometimes things beyond your control 
happen on the computer because a remote computer that runs NetOp Guest accesses your computer. If 
your computer belongs to an organization in which system administrators look after the setup and 
security of all computers, you should not need to be concerned if such things happen. However, you 
should report to your system administrator if things that you do not like happen on your computer.
You can typically verify that NetOp Host is loaded on your computer by this button in the notification 
area in the lower right corner of the screen:
NetOp Host Button

Note: NetOp Host can be set up to run in Stealth mode to not display this button, see General Tab.

Its tooltip that will be displayed briefly when the mouse pointer is over the button will indicate the Host 
status (above: Running with the computer IP address 192.168.102.92).
Right-click the button to display this menu:
NetOp Host Button Menu

Restore/Show: This command will be Restore if the NetOp Host Window is minimized into a NetOp Host 
Button and Show if the NetOp Host Window is on the screen but possibly hidden by other windows. 
Select it or double-click the NetOp Host Button to display the NetOp Host Window in front of other 
windows.
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Exit: Select this command or the matching NetOp Host Window File Menu command or the Window 
Control menu Close command, double-click the Title Bar icon, click the Window Control Close button or 
if the NetOp Host Window is active press ALT+F4 to unload NetOp Host.

Note: Exit can be protected by a Maintenance Password.

Connection List: Select this command to display this window:
Connection List

Window controls are explained in Window Control.
It will display records of connected Guests like the NetOp Host Window Connections Tab, see also 
Connection Notification Tab.

History List: Select this command to display this window:
History List

Window controls are explained in Window Control.
It will display records of connection events since the Host was last loaded like the NetOp Host 
Window History Tab, see also Connection Notification Tab.

Request Help/Cancel Help: This command will be Request Help if the Host status is Running, see Title 
Bar. Select it or the matching Session Menu command or click the matching Toolbar Session Buttons 
button to request help, see Request Help.
This command will be Cancel Help if the Host status is Help Requested, see Title Bar. Select it or the 
matching Session Menu command or click the matching Toolbar Session Buttons button to cancel a 
pending help request, see Request Help.
4.2.2 For Advanced Computer Users
If the setup of your computer and its applications is your own responsibility, you must set up NetOp Host.
After a basic NetOp Remote Control Installation, NetOp Host will not be loaded and will not load and 
start automatically when starting the computer.
Load NetOp Host from Start > (All) Programs > NetOp Remote Control > Host or by one of the 
available Loading Alternatives.
When any user loads NetOp Host for the first time after basic Installation, the Setup Wizard will run to 
initially set up NetOp Host. Select default options to apply a usable initial NetOp Host setup that will load 
and start NetOp Host minimized in a NetOp Host Button, also when starting the computer.
Several NetOp Host setup options are available:
• General setup: See Program Options.
• Guest access security setup: See Guest Access Security.
• Communication setup: See Communication Profiles.
• NetOp log setup: See Log Setup.
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• Protect setup: See Maintenance Password.
By the alternative installation methods Silent Install and NetOp Deployment, NetOp Host can be installed 
in a set up state, see the Documentation Advanced Tools section.
4.2.3 Loading Alternatives
These NetOp Host loading alternatives are available:
 1. In the Windows XP Start menu, select Host if pinned to your Start menu or in your list of most 

frequently used programs.
 2. In the directory where NetOp Host was installed, typically the directory C:\Program Files\Danware 

Data\NetOp Remote Control\Host, run (double-click) NHSTW32.EXE.
 3. Create a desktop shortcut to NHSTW32.EXE and double-click this shortcut.
 4. In the Windows Run or Command Prompt window, execute a command specifying the 

NHSTW32.EXE path and file name. This command can specify certain Host actions in optional 
switches according to this syntax:
<NetOp Host program path and file> [<switch1>] [<switch2>]...

These switches can be used in a NetOp Host load command:

Examples
<NetOp Host program path and file> /R:John C:/TCP/IP /W:

Explanation: Load the Host with the Host name John, start the Host (do not store) enabling TCP/IP and 
other selected communication profiles.
<NetOp Host program path and file> /R:Peter /W:+

Explanation: Load the Host with the Host name Peter, start the Host (store) enabling selected 
communication profiles.
<NetOp Host program path and file> /HD:”Nothing works” 
/HP:”Windows Help” /HC:TCP4 /HA:192.168.102.58

Explanation: Load the Host and send a help request with the problem description Nothing works, help 
provider Windows Help, communication profile TCP4 and IP address 192.168.102.58.

Switch Function
/C:<communication profile> Enable <communication profile> in addition to other selected 

Communication Profiles. Do not store this setting.
/I:<Inventory file path and name> Generate and Get Inventory in <Inventory file path and name>.
/R:<Host name> Name the Host by <Host name>. Store this setting.
/W:[+/-] /W: Start the Host at loading. Do not store this setting.

/W:+ Start the Host at loading. Store this setting.
/W:- Do not start the Host at loading. Store this setting.

Request NetOp help by at least one of 
these switches, see Request Help:
/HD:<Problem description> Specify the problem by <Problem description>.
/HP:<Help provider> Specify a help provider by <Help provider>.
/HC:<Communication profile> Specify a communication profile by <Communication profile>.
/HA:<Help provider address> Specify a help provider address by <Help provider address>.
Cancel a pending NetOp help request, see 
Request Help:
/HH: Cancel a pending help request.
Log on to a connecting NetOp Gateway:
/LGN:<Gateway logon name> Specify a Gateway logon name.
/LGP:<Gateway logon password> Specify a Gateway logon password.
/LGD:<Gateway logon domain> Specify a Gateway logon domain.
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Note: Switch parameters that contain spaces or special characters must be enclosed by double quotation 
marks.

4.2.4 Setup Wizard
If you load NetOp Host for the first time after basic Installation or if you select the Tools Menu Run Setup 
Wizard command, this window will be displayed:

This is the first window of a wizard that will guide you through NetOp Host setup.
Click Cancel to leave the setup wizard without changing NetOp Host setup.

Note: When loading NetOp Host for the first time after a basic Installation, we recommend that you run 
the Setup Wizard.
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Click Next > to display this window:

Select one of these options:

~Default: Follow the Default Track with few setup options (default selection).

{Custom: Follow the Custom Track with many setup options.

Note: For initial setup, we recommend that you follow the Default Track and apply default 
selections.

Click < Back to return to the previous wizard window.
Click Next > to display this window:
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Default Track

Select one of these options:

~Start with Windows: Load and start NetOp Host when Windows starts (default selection).

{Load manually: Do not load and start NetOp Host when Windows starts.
Click Next > to display this window:
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Default Guest Access Password

Specify password: []: Specify in this field the password that connecting Guests must specify. Characters 
will display as dots or asterisks.
Re-enter password: []: Re-specify in this field the password for confirmation.
Click Next > to display this window:
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Register

Select one of these options:

~Yes, I want to register my NetOp license on-line: When clicking Next, display the NetOp Product 
Registration web page in your Internet browser (default selection).

{No. but remind me later: Display this window when loading NetOp Host next time.

{No, I do not want to register my NetOp license now: Do not display this window again.

Note: Registering your license with the NetOp manufacturer may prove useful if you lose your license 
certificate or if you want to upgrade to a newer version of the product.
Do not register a free trial version license or a license that was already registered.
289



4.2 Host Startup Guide
Click Next > to display this window:

Click Finish to end the Setup Wizard.
Custom Track

Select, create, edit or delete Communication Profiles.
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Click Next > to display this window:

Select Program Options.
Click Next > to display this window:
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Select one of these options:

~All Guests have the same password: Click Configure to display the Guest Access Security 
window Guest Access Privileges Tab displaying Grant All Guests Default Access Privileges 
options. Click Next to display the Default Guest Access Password window (default selection).

{Each Guest has its own password: Click Configure to display the Guest Access Security window 
Guest Access Privileges Tab displaying Grant Each Guest Individual Access Privileges Using 
NetOp Authentication options. Select the security role that shall be assigned to added Guests. Click 
Next to display the Individual Guest Access NetOp window.

{Use Windows Security Management: Click Configure to display the Guest Access Security 
window Guest Access Privileges Tab displaying Grant Each Guest Individual Access Privileges 
Using Windows Security Management options. Select the security role that shall be assigned to 
added users and groups. Click Next to display the Individual Guest Access Windows window.

Individual Guest Access NetOp

Select one of these options:

~Yes, add a Guest: Display the Add Guest window (default selection).

{No: Display the Register window.
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Add Guest

Guest ID: []: Specify in this field the name by which a connecting Guest must log on.
Specify password: []: Specify in this field the password by which this Guest must log on. Characters will 
display as dots or asterisks.
Re-enter password: []: Re-specify in this field the password for confirmation.
Click Next > to add this account to the Guest Access Security window Guest Access Privileges Tab Grant 
Each Guest Individual Access Privileges Using NetOp Authentication selection selected security role and 
display the Add Another Account window.
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Add Another Account

Select one of these options:

~Yes, add another account: Display the Individual Guest Access NetOp or Individual Guest 
Access Windows window from which this window was displayed to add another account (default 
selection).

{No: Display the Register window.
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Individual Guest Access Windows

Select one of these options:

~Yes, add a Windows user: Display the Windows Select User window to add a Windows user 
account to the Guest Access Security window Guest Access Privileges Tab Grant Each Guest 
Individual Access Privileges Using Windows Security Management selection selected security role 
and display the Add Another Account window (default selection).

{Yes, add a Windows group: Display the Windows Select Group window to add a Windows group 
account to the Guest Access Security window Guest Access Privileges Tab Grant Each Guest 
Individual Access Privileges Using Windows Security Management selection selected security role 
and display the Add Another Account window.

{No: Display the Register window.
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4.3 NetOp Host Window
This is the NetOp Host window:

It contains these elements:
• Title Bar
• Menu Bar
• Toolbar
• Tab Panel
• Status Bar
4.3.1 Title Bar
This is the NetOp Host Window title bar:

Its window controls are explained in Window Control.
The title bar will display Host status information:
• Loading: Host is loading.
• Stopped: Host communication is disabled.
• Starting: Host communication is being enabled.
• Running: Host communication is enabled. No Guest is connected.
• Connected [<Guest name>]+<Number>: Host communication is enabled. The Guest identified by 

<Guest name> and <Number> other Guests are connected.

Note: If the Program Options window Connection Notification Tab During Connection section 
Display Guest name (if available) in the title bar box is checked, the name by which the connected 
Guest identifies itself will be displayed in square brackets.
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If the Program Options window General Tab Connection section Allow multiple simultaneous Guest 
sessions box is checked, multiple Guests can be connected at the same time. The number of 
connected Guests more than one will be displayed by +<Number>.

• Disconnecting: Host communication is enabled. All connected Guests are being disconnected.
• Help requested: Host communication is enabled. A help request sent to a Guest is pending, see 

Request Help.
• Stopping: Host communication is being disabled.
This status information will also be displayed in the General Tab Status field, on the Windows task bar 
NetOp Host button and tooltip and in the notification area NetOp Host Button tooltip.
Select the Window Control menu Minimize command or click the matching title bar button to display the 
Host only as a notification area NetOp Host Button.
4.3.2 Menu Bar
This is the NetOp Host Window menu bar:

It contains these menus:
• File Menu
• View Menu
• Action Menu
• Session Menu
• Tools Menu
• Help Menu
4.3.2.1 File Menu
In the Menu Bar, select File or if the NetOp Host Window is active press ALT+F to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
View: This command expands into this command:

Message: Select a Messages Tab record and select this command or the matching record context 
menu command to view the record message in a NetOp Message window.

Save As: This command expands into this command:
History: Select the History Tab and select this command or the matching tab pane context menu 
command to display a Windows Save As window that specifies Save as type: All Files (*.*) to save 
the pane content in a file.

Note: The Save As window specifies the file name *.txt to save the pane content as a txt file, but the 
extension is not automatically added to the specified file name.

Delete: This command expands into these commands:
History: Select the History Tab and select this command or the matching tab pane context menu 
command to display a confirmation window to confirm deleting the pane content.
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Messages: Select Messages Tab records and select this command or the matching record context 
menu command to display a confirmation window to confirm deleting selected records and 
matching files.

Exit: Select this command, the matching NetOp Host Button menu command or the Window Control 
menu Close command, double-click the Title Bar icon, click the Window Control Close button or if the 
NetOp Host Window is active press ALT+F4 to unload the Host.
4.3.2.2 View Menu
In the Menu Bar, select View or if the NetOp Host Window is active press ALT+V to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Toolbar: Select this command to hide/display the Toolbar (default: displayed). The command icon will 
appear pressed in when the Toolbar is displayed.
File Transfer Status: This command will be enabled if a Guest is connected. Select it to display the File 
Transfer Status window.
Modem Dialog: Select this command to display the Modem Dialog window.
4.3.2.3 Action Menu
In the Menu Bar, select Action or if the NetOp Host Window is active press ALT+A to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Start: Select this command or click the matching Toolbar Action Buttons button to start the Host to 
enable selected Communication Profiles.
If Guest Access Security does not specify any Guest logon credentials, by default this Security Warning 
will be displayed:

Security Warning

�Don’t show this warning again: Check this box to suppress this security warning (default: 
unchecked).

Note: To reinstate this Security Warning if suppressed, while the Host is unloaded delete the NetOp 
Configuration Files nhstconf.ndb file that will typically reside in C:\Documents and Settings\All 
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Users\Application Data\Danware Data\NetOp Remote Control\Host. Deleting nhstconf.ndb will 
delete the Host setup. When reloading the Host, the Setup Wizard will run to create a Host setup.

Review security settings...: Click this button to display the Guest Access Security window.
Continue: Click this button to close this window to start the Host.
Cancel: Click this button to close this window without starting the Host.

Stop: Select this command or click the matching Toolbar Action Buttons button to stop the Host to 
disable enabled Communication Profiles.
Restart: Select this command or click the matching Toolbar Action Buttons button to stop and start the 
Host to disable and enable selected Communication Profiles.

Note: Some setup changes require Host restart.

Hide: Select this command to display a confirmation window to confirm hiding the Host. If hidden, 
nothing on the screen will indicate that the Host is loaded.

Note: If hidden from this command, the Host will be displayed as before hiding it when reloaded, e.g. by 
restarting Windows.
If hidden from the Program Options window General Tab Stealth mode (hide Host when loaded) option, 
the Host will be hidden when reloaded.
To display a hidden Host, run SHOWHOST.EXE that by default resides in the directory where the Host is 
installed.

4.3.2.4 Session Menu
In the Menu Bar, select Session or if the NetOp Host Window is active press ALT+S to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Disconnect: This command will be enabled if a Guest is connected. Select it or the matching NetOp Host 
Button Connected Menu command or click the matching Toolbar Session Buttons button to disconnect 
from all connected Guests.

Note: From the NetOp Host Button Connected Menu, you can disconnect from one of multiple connected 
Guests.

Chat: This command will be enabled if a Guest is connected. Select it or the matching NetOp Host 
Button Connected Menu command or click the toolbar Session Buttons Chat button to start a Chat 
session with all connected Guests.

Note: From the NetOp Host Button Connected Menu, you can start a Chat session with one of multiple 
connected Guests.

Audio-Video Chat: This command will be enabled if a Guest is connected unless the Guest or the Host is 
engaged in another audio session. Select it or the matching NetOp Host Button Connected Menu 
command or click the toolbar Session Buttons Audio-Video Chat button to start an Audio-Video Chat 
session with the connected Guest that has keyboard and mouse control.

Note: From the NetOp Host Button Connected Menu, you can pass keyboard and mouse control from 
one of multiple connected Guests to another.
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Request Help: This command will be enabled if the Host status is Running, see Title Bar, and if at least 
one of the Program Options window Help Request Tab Options section Enable help service or Enable 
service tickets boxes is checked. Select it or the matching NetOp Host Button menu command or click the 
matching Toolbar Session Buttons button to Request Help from a Guest.
Cancel Help: This command will be enabled if the Host status is Help Requested, see Title Bar. Select it 
or the matching NetOp Host Button menu command or click the matching Toolbar Session Buttons 
button to cancel a pending help request.
4.3.2.5 Tools Menu
In the Menu Bar, select Tools or if the NetOp Host Window is active press ALT+T to display this menu:

Its commands are explained in Host Tools.
4.3.2.6 Help Menu
In the Menu Bar, select Help or if the NetOp Host Window is active press ALT+H to display this menu:

Menu and toolbar controls are explained in Menu and Toolbar Control.
Contents: Select this command to open the NetOp Host Help system that in its left pane displays a 
graphical table of contents.
Online Support: Select this command to open the Support for NetOp Remote Control web page in your 
Internet browser.
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Apply License/Online Registration: If a trial version of NetOp Host is installed, this command is Apply 
License. Select it to display this window:

This window applies license information to a trial version installation to upgrade it to a licensed 
version installation.
Licensed to: []: Specify in this field the licensee name.
Serial number: []: Specify in this field the Host license number.

If a licensed version of NetOp Host is installed, this command is Online registration. Select this 
command to open the NetOp Product Registration web page in your Internet browser.
Quick Guide: Select this command to open the NetOp Host Help system on the Host Startup Guide topic.
About...: Select this command to display this window:
About NetOp Remote Control Host

This window will contain information on your NetOp Host installation. The build number in format 
YYYYDDD (Y=year number digit, D=day number digit) is enclosed in parentheses next to the 
version number.
System Info...: Click this button to display the System Info window.
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4.3.3 Toolbar
This NetOp Host Window toolbar will be displayed unless hidden from the View Menu Toolbar 
command:

Menu and toolbar controls are explained in Menu and Toolbar Control.
The toolbar contains buttons grouped into these sections:
• Action Buttons
• Session Buttons
• Tool Buttons
4.3.3.1 Action Buttons
These are the NetOp Host Window Toolbar action buttons:

4.3.3.2 Session Buttons
These are the NetOp Host Window Toolbar session buttons:

Start: Click this button or select the matching Action Menu command to start the Host to enable 
selected Communication Profiles.

Stop: Click this button or select the matching Action Menu command to stop the Host to disable 
all Communication Profiles.

Restart: Click this button or select the matching Action Menu command to stop and start the Host 
to disable and enable selected Communication Profiles.

Note: Some setup changes require Host restart.

Disconnect: This button will be enabled if a Guest is connected. Click it or select the matching 
Session Menu or NetOp Host Button Connected Menu command to disconnect from all connected 
Guests.

Note: From the NetOp Host Button Connected Menu, you can disconnect from one of multiple 
connected Guests.

Chat: This button will be enabled if a Guest is connected. Click it or select the matching Session 
Menu or NetOp Host Button Connected Menu command to start a Chat session with all connected 
Guests.

Note: From the NetOp Host Button Connected Menu, you can start a Chat session with one of 
multiple connected Guests.

Audio-Video Chat: This button will be enabled if a Guest is connected unless the Guest or the 
Host is engaged in another audio session. Click it or select the matching Session Menu or NetOp 
Host Button Connected Menu command to start an Audio-Video Chat session with the connected 
Guest that has keyboard and mouse control.

Note: From the NetOp Host Button Connected Menu, you can pass keyboard and mouse control 
from one of multiple connected Guests to another.

Request Help: This button will be enabled if the Host status is Running, see Title Bar. Click it or 
select the matching Session Menu or NetOp Host Button menu command to Request Help.

Cancel Help: This button will be enabled if the Host status is Help Requested, see Title Bar. Click 
it or select the matching Session Menu or NetOp Host Button menu command to cancel a pending 
help request.
302



4 NetOp Host
4.3.3.3 Tool Buttons
These are the NetOp Host Window Toolbar session buttons:

Note: Tool buttons and Tools Menu configuration commands will be disabled if configuration files are 
protected, see Maintenance Password. Tool actions can be protected by a Maintenance Password.

4.3.4 Tab Panel
The NetOp Host Window tab panel displays Host properties on tabs:

It contains these tabs:
• General Tab
• Connections Tab
• History Tab
• Services Tab
• Communication Tab
• Names Tab
• Messages Tab

Program Options: Click this button or select the matching Host Tools command to display the 
Program Options window.

Guest Access Security: Click this button or select the matching Host Tools command to display 
the Guest Access Security window.

Communication Profiles: Click this button or select the matching Host Tools command to display 
the Communication Profile Setup window, see Communication Profiles.
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4.3.4.1 General Tab
This NetOp Host Window Tab Panel tab that by default is displayed in front will display general Host 
properties:

Status []: This disabled field will display the Host status like the Title Bar, the Windows taskbar button 
and the NetOp Host Button tooltip.
Host ID []: This typically disabled field will display the Host name specified in the Program Options 
window Host Name Tab Naming section, see also Names Tab. The field will be enabled if the Host status 
is Stopped and in the Host Name Tab Naming section the option Enter name or leave name field blank is 
selected. In this case, you can specify or edit a Host name in the field.
Address []: This disabled field, the NetOp Host Window Status Bar and the NetOp Host Button tooltip 
will display enabled Host computer IP addresses, see Names Tab.
4.3.4.2 Connections Tab
This NetOp Host Window Tab Panel tab will display Guest connections:

Its pane will display records of connected Guests in a table with this column content:
• Sessions: Keyboard and mouse control Guest checkmark and session icons.
• Name: Guest name.
Table controls are explained in Table Control.
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Note: The pane information can be displayed in the Connection List.

4.3.4.3 History Tab
This NetOp Host Window Tab Panel tab will display connection history:

Its pane will display records of connection events since the Host was last loaded in a table with this 
column content:
• Time: Event icon, date and time.
• Name: Guest name.
• Event: Connected or Disconnected.
Table controls are explained in Table Control.

Note: The pane information can be displayed in the History List.

When the Host is unloaded, records are lost. Right-click in the pane to display this context menu:

Save As: Select this command or the File Menu Save As > History command to display a Windows Save 
As window that specifies Save as type: All Files (*.*) to save the pane content in a file.

Note: The Save As window specifies the file name *.txt to save the pane content as a txt file, but the 
extension is not automatically added to the specified file name.

Delete: Select this command or the File Menu Delete > History command to display a confirmation 
window to confirm deleting the pane content.
305



4.3 NetOp Host Window
4.3.4.4 Services Tab
This NetOp Host Window Tab Panel tab will display available NetOp services:

Its pane will display records of NetOp services in a table with this column content:
• Name: Service icon and name.
• Details: Displays different details for each NetOp service:

Encryption: The encryption type of the current or most recent Guest connection, see 
Encryption Tab.
Name Server: Available: 0 if not using NetOp Name Server or if no NetOp Name Server is 
available when communicating using NetOp Name Server. Available: 1 or 2 indicating the 
number of available NetOp Name Servers if communicating using NetOp Name Server, see 
Advanced TCP/IP Configuration.
Security Server: Available: 0 if not using NetOp Security Server or if no NetOp Security 
Server is available when communicating using NetOp Security Server. Available: <Number of 
available NetOp Security Servers> indicating the number of available NetOp Security Servers 
if communicating using NetOp Security Server, see Use NetOp Security Server.

Table controls are explained in Table Control.
4.3.4.5 Communication Tab
This NetOp Host Window Tab Panel tab will display enabled communication profiles:
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Its pane will display records of enabled communication profiles in a table with this column content:
• Profile: Communication device icon and communication profile name.
• Device: Communication profile communication device, see Communication Devices.
• Details: Communication profile configuration details, see Advanced TCP/IP Configuration.
Table controls are explained in Table Control.

Note: Communication profiles will be enabled only if the Host status is Running, Connected or Help 
Requested, see Title Bar.

4.3.4.6 Names Tab
This NetOp Host Window Tab Panel tab will display enabled Host names:

Its pane displays records of enabled Host names in a table with this column content:
• Name: Host name.
• Type: Host name type.
Table controls are explained in Table Control.

Note: Host names will be enabled only if the Host status is Running, Connected or Help Requested. 

Names identify a communicating NetOp module to other NetOp modules and can be specified to connect 
if applicable with the used communication device, see Communication Devices.
Host computer IP addresses will be enabled as IP address type names if communication profiles using the 
communication device TCP/IP are enabled or if the Host is connected by a communication profile using 
the communication device TCP/IP (TCP) or TCP/IP (TCP IPv6), see Communication Tab.
Host computer network card MAC addresses will be enabled as MAC address type names if 
communication profiles using the communication devices NetBIOS or IPX are enabled.
Random MAC addresses assigned by NetOp will be enabled as MAC address type names if 
communication profiles using the communication device Infrared (IrDA) or Terminal Server are enabled 
and if the Host is connected by a communication profile using other communication devices. You cannot 
connect by random MAC addresses assigned by NetOp.
The Host computer Windows or network logon user name will be enabled as a LAN user type name if in 
the Program Options window Host Name Tab Name options section the box Enable User Name is 
checked.
A Host name in the General Tab Host ID field will be enabled as a NetOp Name type name.
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4.3.4.7 Messages Tab
This NetOp Host Window Tab Panel tab will display received NetOp messages.

Its pane will display records of received NetOp messages in a table with this column content:
• Received: Message icon and received date and time.
• From: Guest name.
• Subject: Message first text line.
Table controls are explained in Table Control.
Received NetOp message content will automatically be saved in a rtf file in the NetOp Configuration 
Files Messages directory, typically C:\Documents and Settings\All Users\Application Data\NetOp 
Remote Control\Host\Messages. rtf files in this directory will be displayed as Messages tab records.
Right-click a record or select multiple records and right-click to display this context menu:

View: Select one record and select this command or the File Menu View > Message command to display 
the selected record message in the NetOp Message window.
Delete: Select one or multiple records and select this command or the File Menu Delete > Message 
command to display a confirmation window to confirm deleting selected records and their files.
4.3.5 Status Bar
This is the NetOp Host Window status bar:

If a communication profile using a TCP/IP family communication device is enabled, the right end of the 
status bar will display the Host computer IP address. A + will be displayed after the IP address if multiple 
IP adresses are enabled. Click the + to display other enabled IP addresses. The General Tab Address field 
and the NetOp Host Button tooltip will also display enabled IP addresses.
If a communication profile using the TCP/IP communication device is enabled and in the Advanced TCP/
IP Configuration window Use NetOp Name Server is selected, a yellow pages icon will be displayed in 
the status bar. An indicator may appear on the yellow pages icon:

Nothing: Specified NetOp Name Servers are available.
Red X: No specified NetOp Name Server is available.
Red exclamation mark (!): One of two specified NetOp Name Servers is available.
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Note: NetOp Name Server availability will also be indicated on the Services Tab.

If the mouse pointer is over a menu command or Toolbar button, the status bar will be cleared and a hint 
to the menu command or Toolbar button will be displayed.

4.4 Host Tools
Select Host tools from the NetOp Host Window Tools Menu:

or from the Toolbar Tool Buttons:

Menu and toolbar controls are explained in Menu and Toolbar Control.

Note: Tools Menu configuration commands and Toolbar Tool Buttons will be disabled if configuration 
files are protected, see Maintenance Password. Tool actions can be protected by a Maintenance Password.

These Host tools are available:
• Program Options
• Guest Access Security
• Maintenance Password
• Log Setup
• Communication Profiles
• Modem Database
• Check for New Updates
• Debug Trace
• Run Setup Wizard
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4.4.1 Program Options
Select the NetOp Host Window Tools Menu Program Options command or click the Toolbar Tool 
Buttons Program Options button to display this window:

Note: This command and button will be disabled if configuration files are protected, see Maintenance 
Password. 
If protected by a Maintenance Password, you must specify the correct password in the Maintenance 
Password Enter window to access the Program Options window.

This window specifies Host setup on these tabs:
• General Tab
• Host Name Tab
• Connection Notification Tab
• Audio-Video Chat Tab
• Remote Printing Tab
• Help Request Tab
• Directory Services Tab
• Web Update Tab
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Note: Program Options window specifications are stored in the nhstconf.ndb file that resides in the 
NetOp Configuration Files directory, typically C:\Documents and Settings\All Users\Application 
Data\Danware Data\NetOp Remote Control\Host.
Some Host setup changes require Host restart to apply, see Action Menu or Action Buttons.

4.4.1.1 General Tab
This is the Host Tools Program Options window General tab:

This tab specifies startup and connection options.
Startup
;Start Host when loaded: Leave this box checked to start the Host to enable communication when the 
Host is loaded (default: checked).

;Load Host at Windows startup (run as service): Leave this box checked to load the Host when 
Windows starts on the computer (default: checked).

Note: Loading the Host at Windows startup and starting the Host when loaded will make the Host ready 
to connect to when the Host computer is switched on, even if no user is logged on to Windows.

;Minimize Host when loaded: Leave this box checked to minimize the Host into a NetOp Host Button 
when loaded (default: checked).

�Stealth mode (hide Host when started): Check this box to load the Host hidden to the Host computer 
user (default: unchecked). If hidden, nothing on the screen will indicate that the Host is loaded.
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Note: To display a hidden Host, run SHOWHOST.EXE that by default resides in the directory where the 
Host is installed.

Connection
�Minimize Host on connection with Guest: Check this box to minimize the Host window into a NetOp 
Host Button when a Guest connects (default: unchecked).

�Host top most window on connection with Guest: Check this box to display the Host window in front 
of any other window when a Guest connects (default: unchecked).

�Show file transfer status: Check this box to display the File Transfer Status window when a Guest 
starts a File Transfer session (default: unchecked).

�Send keep alive message: Check this box to send a data packet at intervals while connected to alert the 
Host if the connection has been lost (default: unchecked).

Note: To maintain an ISDN (CAPI) connection during short periods of inactivity, do not check this box 
but select the Short-hold mode option, see ISDN (CAPI) Communication Profile Edit.

;Allow Multiple Simultaneous Guest Sessions: Leave this box checked to allow multiple Guest 
connections to the Host at the same time (default: checked).
4.4.1.2 Host Name Tab
This is the Host Tools Program Options window Host Name tab:

It specifies Host name options and the NetOp Name Server name space ID.
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Naming
This section specifies the name by which the Host will identify itself when communicating.

Note: To communicate by a communication profile that uses a networking communication device 
(NetBIOS, IPX, TCP/IP, Terminal Server), each Host must use a unique name. A Host that uses a name 
that is already used by another communicating Host will be denied to start communicating.

Select one of these options:

{Enter name or leave name field blank: If the Host status is Stopped, the NetOp Host Window 
General Tab Host ID field will be enabled. You can specify a Host name in this field or leave it 
blank.

{Use environment variable []: Specify in the field an environment variable name to name the Host 
by the value of the specified environment variable.

Note: Do not name a network computer Host by the environment variable USERNAME if it is set up 
to Load at Windows startup, see General Tab. If you do that, the Host will load before a user logs on 
to Windows to get the name %USERNAME% and retain this name until reloaded while a user is 
logged on to get the name <Windows logon user name>. Of multiple Hosts named 
%USERNAME%, only one can start communicating.
Name a terminal server Host typically by the environment variable USERNAME, see the 
Documentation Advanced Tools section NetOp in Terminal Server Environments section NetOp 
Naming in a TSE section.
To view available Windows environment variables, in a command prompt window type set and 
press ENTER.

~Use Windows computer name: Name the Host by the Host computer Windows name (default 
selection). Prefer this naming option for network computer Hosts loading at computer startup.

�Prefix with computer workgroup name: Check this box to prefix the Host computer name by 
its domain or workgroup name to make the Host name unique across multiple domains and 
workgroups (default: unchecked).

Separate with: []: The field will display the default separator character (\). You can 
replace it by any other character.

Note: Name a network computer Host typically by this option.
Do not name a terminal server Host by this option. Terminal server Hosts share the Host computer 
Windows name of the terminal server computer. Of multiple Hosts named by the terminal server 
computer name, only one can start communicating.

Name: The Host name resulting from selecting Use environment variable or Use Windows computer 
name will be displayed. A Host name specified in the NetOp Host Window General Tab Host ID field 
cannot be displayed here.
Name Options
;Public Host name: Leave this box checked to respond to broadcast communication, e.g. a Guest 
browsing for Hosts (default: checked).

Caution: Uncheck this box on the Host of a computer that is connected directly to a public network like 
the Internet to make the computer less vulnerable to hacking attempts.

;Enable User Name: Leave this box checked to enable the name of a user logged on to the Host 
computer on the NetOp Host Window Names Tab to enable connections by the user name (default: 
checked).

Caution: Uncheck this box on the Host of a server computer to disable connecting by the name of a 
temporarily logged on administrator to acquire the Windows rights of the administrator, see Run As Tab.
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NetOp Name Server
Name Space ID: []: By default, this field will display PUBLIC. Specify in the field the Name Space ID 
specified on Guests that shall be allowed to connect by using NetOp Name Server.
The Name Space ID will apply only if the Host communicates by a TCP/IP communication profile for 
which in the Advanced TCP/IP Configuration window the Use NetOp Name Server box is checked and 
NetOp Name Servers are specified.

Note: To apply Naming and Name Space ID changes, restart the Host, see Action Menu or Action 
Buttons.

4.4.1.3 Connection Notification Tab
This is the Host Tools Program Options window Connection Notification tab:

It specifies connection notification options.
Upon Connection
�Play sound: Check this box to play a sound when a Guest connects (default: unchecked).

Note: The upon connection sound file STARTHRC.WAV resides in the Media directory of the directory in 
which NetOp Host is installed.

�Display Connection List [] s. (0 = no timeout): Check this box to display the Connection List window 
when a Guest connects (default: unchecked). Specify in the field the number of seconds this window shall 
be displayed (default: 6). Specify 0 to make the window remain on the screen.
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�Password to close Connection List: []: Check this box and specify a password in the field to make the 
Connection List window remain on the screen until closed manually (default: unchecked). Characters will 
display as dots or asterisks. To close the Connection List window, specify the password in a Password 
window.

�Display balloon tip: Check this box to display a balloon tip from the NetOp Host Button when a Guest 
connects (default: unchecked).
During Connection
�Play sound Interval: []s. (10-60): Check this box to play a sound at intervals during a Guest 
connection (default: unchecked). Specify in the field a number in the range for the interval between 
sounds in seconds (default: 10).

Note: The during connection sound file CONTHRC.WAV resides in the Media directory of the directory 
in which NetOp Host is installed.

;Display Guest name (if available) in the title bar: Leave this box checked to display the connected 
Guest name in the NetOp Host Window Title Bar, the Windows taskbar NetOp Host button and the 
NetOp Host Button tooltip (default: checked).

�Animate icon: Check this box to animate the NetOp Host Button double corner lines (default: 
unchecked).
After Connection
�Display History List [] s. (0 = no timeout): Check this box to display the History List window when a 
Guest disconnects (default: unchecked). Specify in the field the number of seconds this window shall be 
displayed (default: 0). Specify 0 to make the window remain on the screen.

�Password to close History List: []: Check this box and specify a password in the field to make the 
History List window remain on the screen until closed manually (default: unchecked). Characters will 
display as dots or asterisks. To close the History List window, specify the password in a Password 
window.

�Display balloon tip: Check this box to display a balloon tip from the NetOp Host Button when a Guest 
disconnects (default: unchecked).
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4.4.1.4 Audio-Video Chat Tab
This is the Host Tools Program Options window Audio-Video Chat tab:

This tab specifies audio and video settings.
Audio Chat

General
; Enable full-duplex audio: Leave this box checked to enable sending audio data between Guest 

and Host in both directions at the same time (default: checked).

Note: Some computer audio systems do not support full-duplex audio.

Microphone Sensitivity
Silence Level: Drag this slide to set the microphone sound input level below which no audio data 
shall be sent (default: second tick from left).
Line Hold: Drag this slide to adjust the period in which audio data shall continue to be sent after the 
microphone sound input level has dropped below the Silence Level (default: sixth tick from left).

Note: Try out different settings for Silence Level and Line Hold to optimize audio communication. 

Check Sound System: Click this button to run a check of the computer sound system and display a 
result message.
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Advanced...: Click this button to display this window:

Playback
Preferred Device: []: The field of this drop-down box displays the preferred audio playback device 
(default: <Use any available device>). The drop-down box list contains the names of playback 
devices found by Windows. Select a name in the list to display it in the field.
Record
Preferred Device: []: The field of this drop-down box displays the preferred audio recording device 
(default: <Use any available device>). The drop-down box list contains the names of recording 
devices found by Windows. Select a name in the list to display it in the field.

Note: If multimedia devices are connected to the computer, the <Use any available device> 
selection may select a connected device instead of the computer sound system. In that case, select 
the computer sound system.

Video Chat
Advanced...: Click this button to display this window:

Select driver to use: []: If a video camera is installed, this drop-down box will contain its driver name. 
Select a driver name in the list to display it in the field.
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If a camera that uses the driver whose name is displayed in the Select driver to use drop-down box field is 
enabled, the image frame will display its captured image.
Format: Click this button to display the Windows Video Format window to format the video capture 
image.
Properties: Click this button to display the Windows Video Source window to specify video source 
properties.
� Disable compression: Check this box to disable video data compression (default: unchecked).
4.4.1.5 Remote Printing Tab
This is the Host Tools Program Options window Remote Printing tab:

This tab specifies remote NetOp printers.
Remote NetOp printers
This pane displays the names of NetOp printers in the Host computer Windows Printers folder (initially 
none).
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Add printer...: Click this button to display this window:

Follow these guidelines that will remain on the screen while you add a NetOp printer. Click Ready... 
to start adding a NetOp printer.

Note: The NetOp printer and the selected remote printing device driver must be installed on the 
computer that sends the print job.
Special instructions for remote printing from DOS applications are available in the NetOp 
KnowledgeBase.

Remove printer: Select a NetOp printer in the pane and click this button to remove it.
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4.4.1.6 Help Request Tab
This is the Host Tools Program Options window Help Request tab:

This tab specifies help request options.
Optional help information
Problem description: []: To always specify the same problem description when requesting help, specify 
it in this field. If the field is left empty, the Help Providers window will be displayed when requesting 
help.
Help provider: []: To always request help from the same help service, specify its name in this field. If the 
field is left empty, the Help Providers window will be displayed when requesting help.
Communication

Communication profile
Select one of these options:

~Use current Host Communication Profile(s): Select this option to send help requests by 
enabled communication profiles (default selection). If multiple communication profiles are 
enabled, the Select Help Request Communication Profile window will be displayed when 
requesting help.

{Use specific Communication Profile []: Select this option to enable the drop-down box to 
select in the drop-down box list a communication profile among available Host communication 
profiles.

Advanced...: Click this button to display this window:
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Advanced Help Request Options

Communication
Phone number or IP address: [] (Optional): A telephone number or IP address will be required if 
requesting help by a communication profile that uses a point-to-point communication device other 
than Infrared (IrDA). You can specify the required telephone number or IP address in the field. If no 
telephone number or IP address is specified in the field and it is required when requesting help, the 
Connect to Help Provider window will be displayed.
Help request timeout if not answered [] min. (1 - 60, 0 = unlimited): Specify in the field a number in 
the range to cancel the help request if not responded to within the specified number of minutes 
(default: 0, i.e. no timeout).
Gateway login
If a help request will be routed through a NetOp Gateway that requires logon, you can specify the 
required logon credentials in this section to log on without displaying a Logon window, see Request 
Help.
Login name: []: Specify in this field the required logon name (default: empty).
Login password: []: Specify in this field the required logon password (default: empty).
Login domain: []: Specify in this field the required logon domain (default: empty).

�Use current login credentials for Windows Security authentication: Check this box to log on by 
the name, password and domain of the user logged on to Windows on the Host computer (default: 
unchecked).

Options
�Add Help Request icon to the tray: Check this box to add this button identified by the tooltip NetOp 
Help Request to the notification area in the lower right corner of the screen (default: unchecked):
NetOp Help Request Button

To request help, double-click the button or select the button Request Help context command.
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Note: If this button is added, the user of a hidden Host can request help, see Action Menu or Action 
Buttons.

;Enable help service: Leave this box checked to enable help request by a help service, see Request Help 
(default: checked).

�Enable service tickets: Check this box to enable help request by a service ticket, see Request Help 
(default: unchecked).
4.4.1.7 Run As Tab
This is the Host Tools Program Options window Run As tab:

It can enable always running the Host as a specific user.
If no user is logged on to the Host computer, the Host will have extensive Host computer rights but no 
network computer rights, see the Documentation Advanced Tools section NetOp Remote Control 
Processes and Windows Security section.
If a user is logged on to the Host computer, the Host will have the rights of the logged on user.
A connected Guest will get the rights of the Host limited by Guest Access Security restrictions.
For certain purposes, typically to assign network computer rights to the Host when no user is logged on to 
the Host computer, you can run the Host as a specific user.
Run Host as specific user
�Enable: Check this box to always run the Host as a specific user (default: unchecked).
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User name: []: Specify in this field the user name.
Password: []: Specify in this field the matching password.
Domain: []: Specify in this field the matching domain.

Caution: Consider carefully in each case the benefits and drawbacks including security risks of always 
running the Host as a specific user. In some cases, you should run the Host as a Windows user created 
exclusively for this purpose.

�Automatically change to random password every week: Check this box to change the password of the 
credentials specified above immediately and every week into a random password to automatically satisfy 
a password change policy.

Caution: Do not check this box if the credentials specified above belong to a user person, as the user 
person will not know the random password.

4.4.1.8 Directory Services Tab
This is the Host Tools Program Options window Directory Services tab:

It specifies directory services to enable authenticating connecting Guests, see Grant Each Guest 
Individual Access Privileges Using Directory Services.
Directory services
The pane will specify directory services as records in a table with this column content (initially empty):
• Name: Directory service name.
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• Directory Server: Directory server IP address or DNS name.
Table controls are explained in Table Control.
Add...: Click this button to display this window:

Directory Service

This window specifies a directory service.
General
Name: []: Specify in this field the name that shall identify this directory service on the Directory 
Services Tab.
Directory Server: []: Specify in this field the directory server IP address or DNS name.
Port: []: Specify in this field the port through which the Host shall connect to this directory server 
(default: 389, the Lightweight Directory Access Protocol (LDAP) port).

�Use secure connection: Check this box to connect to this directory server by a secure connection 
(default: unchecked). The LDAP secure connection port number is 636.
Base DN: []: Specify in this field the directory service distinguished name from which a search shall 
start.
Credentials Tab
This tab specifies the credentials by which the Host will log on to the directory server. The user 
identity determines which directory service information will be available.

�Anonymous bind: Check this box to disable the fields below to search this directory service with 
anonymous user rights (default: unchecked).
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User DN: []: Specify in this field a directory service user distinguished name to search the directory 
service with the rights of this user.
Password: []: Specify in this field the matching password.
Confirm password: []: Re-specify in this field the password for confirmation.
Settings Tab

This tab specifies the search criteria applied to retrieve the properties of a connecting Guest user. 
Initially, its fields are empty. Click the Default... button to display this window:

This window selects a directory service type.
The field of the drop-down box will display the selected directory service type (default: 
Microsoft Active Directory). The drop-down box list will contains name of commonly used 
directory services. If the directory service type of the directory server specified in the Directory 
Service window Directory Server field is available in the list, select it to display it in the drop-
down box field.
OK: Click this button to close the window and specify the default settings of the selected 
directory service type in the Settings Tab fields.

Note: If the Settings Tab fields become filled in from the Select Directory Service window, you 
typically do not need to edit their content.

User search filter: []: Optionally (recommended), specify in this field a search filter to limit the 
search for user attributes to a certain object class.
User attribute: []: Specify in this field the type designation of the searched for user attribute.
User browse filter: []: Optionally (recommended), specify in this field a user browse filter to limit 
the browse for user attributes to certain object classes.
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Group search filter: []: Optionally (recommended), specify in this field a search filter to limit the 
search for group attributes to a certain object class.
Group attribute: []: Specify in this field the type designation of the searched for group attribute.
Group browse filter: []: Optionally (recommended), specify in this field a group browse filter to 
limit the browse for group attributes to certain object classes.
OU search filter: []: Optionally (recommended), specify in this field a search filter to limit the 
search for organizational unit attributes to a certain object class.

Edit...: Select a record in the pane and click this button to display the Directory Service window with the 
properties of the directory service to edit them.
Delete: Select a record in the pane and click this button to delete it.
4.4.1.9 Web Update Tab
This is the Host Tools Program Options window Web Update tab:

It specifies web update options to enable updating the Host installation from the network.
Web Update Settings
Update server: []: Specify in this field the web address of the server from which to download NetOp 
Host update files (default: update.netop.com, the NetOp manufacturer web update server).

Note: To update many NetOp installations in an organization, we recommend to Publish New Updates to 
an internal web update server.

HTTP Proxy: []: Specifying a HTTP proxy is typically not required.
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Before specifying a HTTP proxy, click Update now to test the web update connection. If this yields a 
message indicating connection to the update server, specify no HTTP proxy. 
If Update now yields no connection, click Detect to make NetOp attempt to detect the HTTP proxy server 
to display its name and port number in the HTTP Proxy field. Click Update now to test the connection.
If unsuccessful, consult with your network/system administrator about what must be specified in the 
HTTP Proxy field (format: <Server name>:<Port number>).
Update now: Click this button to connect to the update server specified in the Update server field. A Web 
Update message will notify you if connection to the update server failed, if no updates are available or if 
updates are available and in the latter case ask you if you want to download and install updates.
Schedule...: Click this button to display this window:

In this window, you can specify a schedule of checks for updates including download and installation of 
available update files.
Schedule
Select one of these options:

~Disabled: Disable automatic web update (default selection). The other sections in the window 
will be disabled.

{Automatic download, prompt before install: Automatically download any update files and prompt 
the user when downloaded.

{Automatic download and install: Automatically download and install any update files.

�Allow system restart after install: Check this box to automatically restart the computer after 
update installation if required (default: unchecked). Leave unchecked to deny automatic restart 
to after installation display a message that restart is required to complete the installation.

Run
Select one of these options:

~At loading: Check for updates when the Guest is loaded (default selection). The Delay section in 
the image above will be displayed.
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Delay
[] minute delay: Specify in this field a number to delay the web update by the specified number 
of minutes (default: 0, range 0-99).

{Daily: Check for updates on a daily basis. This section will be displayed:

Start at
[] every [] day: In the first field, specify the time of the day (default: 12:00). In the second 
field, specify by a number an interval in days (default: 1, range 1-99).

�Randomize within the hour: Check this box to randomize the update time within the hour 
following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is 
first loaded thereafter.

{Weekly: Check for updates on a weekly basis. This section will be displayed:

Start at
[] every [] week: In the first field, specify the time of the day (default 12:00). In the second 
field, specify by a number an interval in weeks (default: 1, range 1-99).

�<Weekday>: Check boxes to run scheduled web updates on selected weekdays (default: 
Monday only checked).

�Randomize within the hour: Check this box to randomize the update time within the hour 
following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is 
first loaded thereafter.

{Monthly: Check for updates on a monthly basis. This section will be displayed:

Start at
[] on the [] day of the month: In the first field, specify the time of the day (default: 12:00). In 
the second field, specify by a number the day of the month (default: 1, range 1-28).

�Randomize within the hour: Check this box to randomize the update time within the hour 
following the specified time to avoid crowding (default: unchecked).
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Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is 
first loaded thereafter.

Start date
Year: [] Month: [] Day: []: Select in the drop-down boxes the schedule start date (default: today).
4.4.2 Guest Access Security
Select the NetOp Host Window Tools Menu Guest Access Security command or click the matching 
Toolbar Tool Buttons button to display this window:

It specifies Guest access security options on these tabs:
• Guest Access Privileges Tab
• Guest Policy Tab
• MAC/IP Address List Setup Tab
• Encryption Tab
• Smart Card Tab
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Note: General Guest Access Security specifications will be stored in the NetOp Configuration Files 
nhstconf.ndb file that typically resides in the directory C:\Documents and Settings\All Users\Application 
Data\Danware Data\NetOp Remote Control\Host.

4.4.2.1 Guest Access Privileges Tab
This is the Host Tools Guest Access Security window Guest Access Privileges tab:

It specifies the selected Guest access method and its details.
Guest Access Method []: The field of this drop-down box specifies the selected Guest access method. The 
drop-down box list contains these Guest access methods:
• Grant All Guests Default Access Privileges (default selection)
• Grant Each Guest Individual Access Privileges Using NetOp Authentication
• Grant Each Guest Individual Access Privileges Using Windows Security Management
• Grant Each Guest Individual Access Privileges Using Directory Services
• Use NetOp Security Server
Select a Guest access method in the list to display it in the field to apply this Guest access method to 
connecting Guests. The section below will specify the selected Guest access method details.
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4.4.2.1.1 Grant All Guests Default Access Privileges

This Host Tools Guest Access Security window Guest Access Privileges Tab Guest Access Method drop-
down box selection will display this tab content:

In the left pane, this selection assigns one common security role in a folder named Default Security Role 
to all connecting Guests in a Guest object named Default User.
Default Security Role
Select in the left pane the Default Security Role folder to display this security role pane to the right:
331



4.4 Host Tools
Security Role Pane

Under the heading Allow Guest to it specifies in a checkboxed list which privileges will be granted to a 
connected Guest. Checked privileges will be allowed, unchecked privileges will be denied. You can 
check/uncheck boxes to change privileges.
Under the heading Confirm access it specifies the selected Host computer user access confirmation 
option. You can select one of the available options.
Allow Guest to:

;Remote control: Start a Remote Control session (default: allowed). Indented privileges below 
apply to a Remote Control session:

;Use keyboard and mouse: Execute keyboard and mouse actions on the Host computer screen 
(default: allowed).

;Blank the screen: Turn the Host computer screen black to the Host computer user (default: 
allowed).

;Lock keyboard and mouse: Disable the Host computer keyboard and mouse (default: 
allowed).

;Transfer clipboard: Transfer Guest computer clipboard content to the Host computer 
clipboard or Host computer clipboard content to the Guest computer clipboard (default: 
allowed).

;Execute command (Restart, ...): Execute system control (Execute Command) and other 
commands on the Host computer (default: allowed).

;Request chat: Start a Chat session (default: allowed).

;Request audio chat and transfer sound: Start an audio session including Audio-Video Chat and 
transfer Host application sound (default: allowed).

;Request Video: Enable video in an Audio-Video Chat session (default: denied).

;Send files to Host: File Transfer from the Guest computer to the Host computer (default: 
allowed).
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;Receive files from Host: File Transfer from the Host computer to the Guest computer (default: 
allowed).

;Run programs: Run Program on the Host computer (default: allowed).

;Redirect print: Redirect print jobs between Host computer and Guest computer printing devices 
(default: allowed).

;Remote Manage: Remote Management of the Host computer (default: allowed).

;Retrieve Inventory: Get Inventory of the Host computer hardware and software (default: 
allowed).

;Send Message: Send a NetOp NetOp Message to the Host computer (default: allowed).

;Join Multi Guest session: Join a running Remote Control session (default: allowed).

;Act as a multi Guest session administrator: Manage a multi Guest Remote Control session 
(default: allowed).

Confirm Access:
Select one of these options:

~No: The Host computer user shall not confirm Guest access (default selection).

{Yes, unless: The Host computer user shall confirm Guest access unless any of the checked 
conditions below apply.

�Computer locked: The Host computer is locked (default: unchecked).

�No user logged on: No user is logged on to the Host computer.

�Guest user logged on: The Guest computer user is logged on to the Host computer.
If the Host user shall confirm Guest access, a window like this will be displayed on the Host computer 
when a Guest connects:

Allow: Click this button to allow Guest access.
Deny: Click this button to deny Guest access.

Note: You can customize the Confirm Access window text in a NETOP.INI file 
[TEXT_CONFIRM_ACCESS] section.

Select in the left pane a security role folder to display this security role pane to the right:
Default User
Select in the left pane the Default User Guest object to display these sections to the right:
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Password Section

Password: []: Specify in this field a password of up to 16 characters to enable shared password 
authentication. Characters will display as dots or asterisks.
Confirm password: []: Re-specify in this field the password for confirmation.

Note: To disable password authentication to require no password from a connecting Guest, clear both 
fields. This will leave the Host without Guest access authentication to enable any Guest to connect to the 
Host. Unless suppressed, the Security Warning window will be displayed when the Host starts 
communicating.

Call back Section

Select one of these options:

~No call back: Select this option to not apply call back (default selection).

{Call back to: []: Select this option and specify in the field a telephone number or an IP address to 
make the Host disconnect and reconnect to the specified telephone number or IP address if a Guest 
connects by a communication profile that uses a point-to-point communication device (ISDN 
(CAPI), Serial, Windows Modem, TCP/IP (TCP) or TCP/IP (TCP IPv6)).

Note: Call back to a specified telephone number or IP address will enable connections only from a 
Guest on a computer with this telephone number or IP address.
For alternative Guest address restriction options, see MAC/IP Address List Setup Tab and Allowed 
ISDN Numbers.

{Roving call back: Select this option to request a call back telephone number or IP address from a 
Guest that connects by a communication profile that uses a point-to-point communication device 
(ISDN (CAPI), Serial, Windows Modem, TCP/IP (TCP) or TCP/IP (TCP IPv6)). When the Host 
receives this information, it will disconnect and reconnect to the specified telephone number or IP 
address.

Note: Roving call back is typically used to make connection costs payable by the Host organization, 
e.g. when a travelling employee connects to the home computer.

When a Guest connects, the Host will request a password, if applied.
If the Guest returns the Default User password, the Host will grant the Guest the Default Security Role 
privileges.
You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup 
Tab, Encryption Tab and Smart Card Tab.
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4.4.2.1.2 Grant Each Guest Individual Access Privileges Using NetOp Authentication

This Host Tools Guest Access Security window Guest Access Privileges Tab Guest Access Method drop-
down box selection will display this tab content:

In the left pane, this selection can assign individual Security Roles in named folders to individual Guests 
in named Guest Profile objects.
Initially, the left pane will contain the Security Role folders Full access, View only, Inventory only and 
Remote Management only that will contain no Guest Profile objects. In the image above, a Guest Profile 
object has been added to a Security Role folder for illustration. Double-click a Security Role folder to 
close (collapse) or open (expand) it to display Guest Profile objects in it. You can move Guest Profile 
objects up and down, also between Security Role folders, by drag and drop.
Select a Security Role folder to display the Security Role Pane to the right.
Select a Guest Profile object to display the Password Section and Call back Section to the right.
Right-click a Security Role folder to display this context menu:
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Note: If no Security Role folder is selected, this menu will not contain Add security role.

Add Security Role: Select this command or click the matching button below the pane to display this 
window

Security Role

This window specifies a security role.
Name of security role: []: Specify in the field the security role name.

Add Guest: Select a Security Role folder or a Guest profile object in it and select this command or click 
the matching button below the pane to display this window:

Guest Profile

This window specifies a Guest profile in the selected Security Role folder.
Guest ID: []: Specify in this field the name by which a Guest using this Guest profile will identify 
itself to the Host.
Password: See Password Section.
Call back: See Call back Section.

Delete: Select a Security Role folder or a Guest Profile object and select this command or click the 
matching button below to display a confirmation window to confirm deleting the selected Security Role 
folder or Guest Profile object.

Caution: Deleting a Security Role folder will delete all Guest Profile objects in it.

Rename: Select a Security Role folder or a Guest Profile object and select this command to display this 
window:
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Rename

Rename security role/Guest: []: Edit the name in the field to rename.

Note: Individual NetOp access privileges specifications will be stored in the NetOp Configuration Files 
security.ndb file that typically resides in the directory C:\Documents and Settings\All Users\Application 
Data\Danware Data\NetOp Remote Control\Host.

When a Guest connects, the Host will request NetOp credentials that consist of a Guest ID and password.
If the Guest returns credentials that match a Guest Profile that exists on the Host, the Host will grant the 
privileges of the Security Role that is assigned to the Guest Profile.
You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup 
Tab, Encryption Tab and Smart Card Tab.
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4.4.2.1.3 Grant Each Guest Individual Access Privileges Using Windows Security Management

This Host Tools Guest Access Security window Guest Access Privileges Tab Guest Access Method drop-
down box selection will display this tab content:

In the left pane, this selection can assign individual Security Roles in named folders to individual 
Windows users and groups in named Windows account objects.
Initially, the left pane will contain the Security Role folders Full access, View only, Inventory only and 
Remote Management only that will contain no Windows account objects. In the image above, a Windows 
user object has been added to a Security Role folder for illustration. Double-click a Security Role folder 
to close (collapse) or open (expand) it to display Windows account objects in it. You can move Windows 
account objects up and down, also between Security Role folders, by drag and drop.
Select a Security Role folder to display the Security Role Pane to the right.
Select a Windows account object to display the Domain Section, RAS Section and Call back Section to 
the right.
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Right-click a Security Role folder to display this context menu:

Note: If no Security Role folder is selected, this menu will not contain Add security role and Rename.

Add Security Role: Select this command or click the matching button below the pane to display the 
Security Role window.
Add User: Select a Security Role folder or a Windows account object in it and select this command or 
click the matching button below the pane to display on a Windows 2000+ computer the Windows Select 
Users window to select one or multiple Windows users to add them to the selected Security Role folder.
On a Windows NT or 9x computer, this window will be displayed:

Which domain is the account in: []: The drop-down box list will contain domains recognized by the 
computer. Select one to display it in the drop-down box field as selected.
Select the account to add: []: The drop-down box list will contain the names of users in the domain 
selected in the drop-down box field above. Select one to display it in the drop-down box field as 
selected.
Click OK to add the selected Windows user object.

Add Group: Select a Security Role folder or a Windows account object in it and select this command or 
click the matching button below the pane to display on a Windows 2000+ computer the Windows Select 
Groups window to select one or multiple Windows groups to add them to the selected security role 
folder.
On a Windows NT or 9x computer, the Choose account window explained above displaying groups 
instead of users will be displayed to add groups.
Delete: Select a Security Role or a Windows account object and select this command or click the 
matching button below the pane to display a confirmation window to confirm deleting the selected 
Security Role folder or Windows account object.

Caution: Deleting a security role folder will delete all Windows account objects in it.

Rename: Select a security role folder and select this command to display the Rename window.
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Domain Section

This section will display the selected Windows account object domain.
RAS Section

This section will be included only if the Host computer runs on a Windows Server 2003, XP, 2000 or NT 
operating system.
[] Get call back information from Windows NT Remote Access Service (RAS): Check this box  to use call 
back information stored in Windows NT Remote Access Service (RAS) (default: unchecked).
Call back: This section will be included only if the box in the RAS section above is unchecked, see Call 
back Section.
Windows User Manager: This button will be included only if the Host computer runs on a Windows 
Server 2003, XP, 2000 or NT operating system. Click this button to display the Windows user manager 
window according to the administrator rights of the user logged on to Windows on the Host computer to 
manage users and groups.

Note: Individual Windows access privileges specifications will be stored in the NetOp Configuration 
Files secur_NT.ndb file that typically resides in the directory C:\Documents and Settings\All 
Users\Application Data\Danware Data\NetOp Remote Control\Host.

When a Guest connects, the Host will request Windows credentials that consist of a user name, password 
and domain.
The Host will query Windows Security Management for returned credentials validation and relevant 
group membership information. If the Guest user and/or groups of which the Guest user is a member 
match a Windows account object that exists on the Host, the Host will grant the privileges of the Security 
Role that is assigned to the Windows account object.

Note: A Guest user that is assigned different Security Roles individually and as a member of groups will 
be allowed what is allowed by any applicable Security Role.

You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup 
Tab, Encryption Tab and Smart Card Tab.
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4.4.2.1.4 Grant Each Guest Individual Access Privileges Using Directory Services

This Host Tools Guest Access Security window Guest Access Privileges Tab Guest Access Method drop-
down box selection will display this tab content:

In the left pane, this selection can assign individual Security Roles in named folders to individual 
directory services users and groups in named directory services account objects.
Initially, the left pane will contain the Security Role folders Full access, View only, Inventory only and 
Remote Management only that will contain no directory services account objects. In the image above, a 
directory services user object has been added to a Security Role folder for illustration. Double-click a 
Security Role folder to close (collapse) or open (expand) it to display directory services account objects 
in it. You can move directory services account objects up and down, also between Security Role folders, 
by drag and drop.
Select a Security Role folder to display the Security Role Pane to the right.
Select a directory services account object to display the Directory Service Section and Call back Section 
to the right.
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Right-click a Security Role folder to display this context menu:

Note: If no Security Role folder is selected, this menu will not contain Add security role and Rename.

Add Security Role: Select this command or click the matching button below the pane to display the 
Security Role window.
Add User: Select a Security Role folder or a directory services account object in it and select this 
command or click the matching button below the pane to display this window:

The upper pane will display directory services specified on the Program Options window Directory 
Services Tab with an expandable directory tree structure. Click [+] buttons to expand and [-] buttons 
to collapse directories displaying users with user icons and their common names (cn=<Common 
name>).
Add: Select a user in the upper pane and click this button to add the user as a record in the lower 
pane.
Remove: Select a user record in the lower pane and click this button to remove it.
The lower pane will display records of selected users in a table with this column content:
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• Distinguished Name: Directory path and common name of the user.
• Directory Service: Name of the directory service as specified on the Program Options window 

Directory Services Tab.
Table controls are explained in Table Control.
OK: Click this button to close the window and add the user records in the lower pane to the selected 
Security Role folder.

Add Group: Select a Security Role folder or a directory services account object in it and select this 
command or click the matching button below the pane to display the Select Directory Services Groups 
window that is similar to the Select Directory Services Users window explained above to add group 
objects to a Security Role folder.
Delete: Select a Security Role folder or a directory services account object and select this command or 
click the matching button below to display a confirmation window to confirm deleting the selected 
Security Role or directory services account object.

Caution: Deleting a Security Role folder will delete all directory services account objects in it.

Rename: Select a security role folder and select this command to display the Rename window.
Directory Service Section

This section will display the directory service name and selected directory services account object 
distinguished name (dn).
Call Back: See Call back Section.

Note: Individual directory services access privileges specifications will be stored in the NetOp 
Configuration Files secur_DS.ndb file that typically resides in the directory C:\Documents and 
Settings\All Users\Application Data\Danware Data\NetOp Remote Control\Host.

When a Guest connects, the Host will request directory services credentials that consist of a user name, a 
password and a directory server.
The Host will search the specified directory server to validate returned credentials and to retrieve 
information on Guest user group memberships. If the Guest user and/or groups of which the Guest user is 
a member match a directory services account object that exists on the Host, the Host will grant the 
privileges of the Security Role that is assigned to the directory services account object.

Note: A Guest user that is assigned different Security Roles individually and as a member of groups will 
be allowed what is allowed by any applicable Security Role.

You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup 
Tab, Encryption Tab and Smart Card Tab.
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4.4.2.1.5 Use NetOp Security Server

This Host Tools Guest Access Security window Guest Access Privileges Tab Guest Access Method drop-
down box selection will display this tab content:

This selection uses NetOp Security Server to authenticate each connecting Guest and assign a Security 
Role to it.
Group ID: []: Specify in this field the 32-digit hexadecimal NetOp Security Server group ID that 
identifies the NetOp Security Server group that the Host shall use.

Note: You can copy the NetOp Security Server group ID from NetOp Security Manager, see the 
Documentation NetOp Security Management section Manage Security Database Content section Security 
Settings section Security Policies section Security Server Group Name section.

When a Guest connects, the Host will request logon credentials according to NetOp Security Server 
preferences.
The Host will forward the credentials to NetOp Security Server for validation and compilation of the 
security role that shall be assigned to the Guest according to the security data stored in the security 
database. The resulting security role will be returned to the Host that will apply it to the Guest.
You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup 
Tab, Encryption Tab and Smart Card Tab.
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4.4.2.2 Guest Policy Tab
This is the Host Tools Guest Access Security window Guest Policy tab:

This tab specifies Guest access security policies.
Password
Maximum invalid password attempts: [] (0 = unlimited): Specify in this field a number between 0 and 9 
for the number of consecutive logon attempts that will be allowed to a Guest before the action selected in 
the drop-down box field below will be executed (default: 3).
Action if maximum attempts are exceeded: []: The field of the drop-down box will display the selected 
action. The drop-down box list contains these options:
• Disconnect: Disconnect the Guest (default selection).
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• Disable Host: Make the Host deny any connection attempt and display this window:

• Restart Windows: Restart Windows on the Host computer, which - depending on the Host setup - 
may load and start the Host and make it available for connection.

Select an option in the list to display it in the field.
Disconnect
Action after disconnect: []: The field of the drop-down box will display the selected action. The drop-
down box list contains these options:
• None: No action (default selection).
• Lock computer: Lock the Host computer to display the Windows Computer Locked window. The 

Host will remain running and available for connection.
• Log off Windows: Log off the Host computer user from Windows to display the Welcome to 

Windows window. The Host will remain running and available for connection.
• Restart Windows: Restart Windows on the Host computer, which - depending on the Host setup - 

may load and start the Host and make it available for connection.
Select an option in the list to display it in the field.
System-wide disconnect hotkey: [] Shift [] Ctrl [] Alt [] Win []: Check any of the first four boxes and 
optionally specify a character in the last box to compose a keystroke combination that will disconnect all 
connected Guests whether the NetOp Host Window is active or not (default: empty).
File Transfer
�Disable file transfer before local login: Check this box to disable File Transfer if no user is logged on 
to the Host computer to ensure File Transfer only with the rights of a logged on user (default: unchecked).

Note: This will not be affected by running the Host as a specific user, see Run As Tab.

Record Sessions
�Enable: Check this box to enable Host recording of remote control sessions and enable the rest of the 
section (default: unchecked).
Folder: [][Browse...]: Specify in this field the path of the directory in which session recording files shall 
be saved. Click the Browse button to display the Windows Browse for Folder window to select a folder 
the path of which will be specified in the field.

�Disconnect if recording fails: Check this box to disconnect if session recording fails (default: 
unchecked).

Note: Session recording files will be named <Time stamp>-<Guest ID>-<Host ID>.dwr. Session 
recordings can be played back only on a Guest, see Recordings Tab.

Timeout
Confirm Access: [] s. (0 = no timeout): Specify in this field a number in the range 1 - 9999 to disconnect 
if the Host user has not confirmed Guest access within the specified number of seconds (default: 0).
Authentication: [] s. (0 = no timeout): Specify in this field a number in the range 1 - 9999 to disconnect if 
Guest authentication has not completed within the specified number of seconds (default: 0).
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Inactivity: [] s. (0 = no timeout): Specify in this field a number in the range 1 - 9999 to disconnect if there 
has been no Guest keyboard or mouse activity within the specified number of seconds (default: 0).
4.4.2.3 MAC/IP Address List Setup Tab
This is the Host Tools Guest Access Security window MAC/IP Address List Setup tab:

This tab enables limiting the network addresses from which a Guest can connect.
MAC/IP Address List
�Enable MAC/IP address check: Check this box to limit the network addresses from which a Guest can 
connect to the addresses specified in the pane and enable the pane and buttons (default: unchecked).

Note: MAC addresses will apply if communicating by NetBIOS or IPX Communication Devices. 
IP addresses will apply if communicating by TCP/IP or TCP/IP (TCP) Communication Devices.

The pane will displays records of specified addresses and optional comments (default: empty).
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Add...: Click this button to display this window:

MAC/IP address: []: Specify in this field a MAC or IP address.
Comment: []: In this field, you can specify a comment that will be displayed next to the address in 
the pane.

Edit...: Select an address record in the pane and click this button to display it in the Add/Edit MAC/IP 
Address List window to edit it.
Delete: Select an address record in the pane and click this button to delete it.
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4.4.2.4 Encryption Tab
This is the Host Tools Guest Access Security window Encryption tab:

This tab specifies enabled encryption types.

Note: NetOp communication will be protected by encryption. A range of encryption types is available on 
version 7.0+ NetOp Remote Control modules. One encryption type is available on version 6.5- NetOp 
Remote Control modules. Communicating NetOp modules will automatically negotiate to encrypt 
communication by an encryption type that is enabled on both modules, see Compression/Encryption Tab. 
NetOp modules on which no common encryption type is enabled cannot communicate.

Enabled Encryption Types
The pane displays checkboxed available encryption type icons and names. Leave a box checked to enable 
the encryption type (default: all checked): Uncheck to disable.

;NetOp 6.x/5.x Compatible: NetOp Remote Control version 6.5- compatible encryption.

;None: Module identification encryption but no data encryption.

;Data integrity: Data integrity encryption.

;Keyboard: Keyboard encryption.

;Data integrity and Keyboard: Data integrity and keyboard encryption.
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;High: High level encryption.

;Very High: Very high level encryption.
Show Details: Select an encryption type and click this button to display encryption details.
4.4.2.5 Smart Card Tab
This is the Host Tools Guest Access Security window Smart Card tab:

It specifies Smart Card logon options.
Windows Security Management
Select one of these options:

~Never log on with Smart Card: Enable only credentials logon (default selection).

{Always log on with Smart Card: Enable only Smart Card logon.

{Allow both logon with Smart Card and credentials (name, password and domain): Enable 
credentials and Smart Card logon.

Directory Services
Select one of these options:

~Never log on with Smart Card: Enable only credentials logon (default selection).
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{Always log on with Smart Card: Enable only Smart Card logon.

{Allow both logon with Smart Card and credentials (name, password and server): Enable 
credentials and Smart Card logon.

Select one of these options:

~Subject field: Retrieve the user identification from the subject field (default selection).

{Subject alternative name field (must be a User Principal Name (UPN)): Retrieve the user 
identification from the alternative field.

In the field, specify the directory services attribute type name of the certificate field content only if 
different from a user objects distinguished name.
4.4.3 Maintenance Password
Select the NetOp Host Window Tools Menu Maintenance Password command to display this window:

This window specifies a maintenance password, what it protects and Host configuration files protection.
Change Maintenance Password...: Click this button to display this window:

Old Password: []: This field will be disabled if no maintenance password is specified. To change 
the current maintenance password, specify it in the field. Characters will display as dots or asterisks.
New Password: []: Specify in this field a new maintenance password (max. 16 characters).
Confirm Password: []: Re-specify in this field the new maintenance password for confirmation.

Note: If a maintenance password is specified, maintenance password protection will be enabled and 
the Tools Menu Maintenance Password command will be protected. Disable maintenance password 
protection by leaving the New Password and Confirm Password fields blank.
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Maintenance password required for
�Guest access security: Check this box to apply maintenance password protection to the Tools Menu 
Guest Access Security command and the matching Toolbar Tool Buttons button (default: unchecked).

�All other configuration: Check this box to apply maintenance password protection to all other Tools 
Menu commands and matching Toolbar Tool Buttons except Check For New Updates and Debug Trace 
(default: unchecked).

�Unload and Stop: Check this box to apply maintenance password protection to unloading, see Title 
Bar or File Menu, and stopping, see Action Menu or Action Buttons, the Host (default: unchecked).

Note: Apply Unload and Stop maintenance password protection to prevent accidental Host stop or 
unload that will make it unavailable for connection and/or to Protect security configuration files.

Protect security configuration files
Select one of these options:

~Protect by maintenance password only (if applies): Protect Host setup only by any applied 
maintenance password protection that does not protect Host configuration files (default selection).

{Protect files when connected: Protect (disable changing) Host configuration files and disable 
Tools Menu commands except Check For New Updates and Debug Trace when the Host status is 
Connected to prevent a connected Guest computer user from changing the Host setup.

{Protect files when connected and running: Protect (disable changing) Host configuration files and 
disable Tools Menu commands except Check For New Updates and Debug Trace when the Host 
status is Connected, Help Requested or Running to prevent a Host computer user that by 
maintenance password protection is prevented from stopping or unloading the Host from changing 
the Host setup.

Note: Host configuration files typically reside in the NetOp Configuration Files directory 
C:\Documents and Settings\All Users\Application Data\Danware Data\NetOp Remote 
Control\Host.

If maintenance password protection is enabled, selecting a protected command or clicking a protected 
button will display this window:

Maintenance Password Enter

Enter password: []: Specify in the field the maintenance password.
4.4.4 Log Setup
Select the NetOp Host Window Tools Menu Log Setup command to display the Log Setup window.

Note: Log setup is common to all NetOp modules. Therefore, the Log Setup section is included in the 
Common Tools chapter.
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4.4.5 Communication Profiles
Select the NetOp Host Window Tools Menu Communication Profiles command or click the matching 
Toolbar Tool Buttons button to display this window:

In this window, you can enable/disable, create, edit and delete communication profiles.

Note: A communication profile is a named configuration of a communication device. You can create 
multiple communication profiles with different configurations of each communication device. 
Communication devices are common to all NetOp modules. Therefore, the Communication Devices 
section is included in the Common Tools chapter.

Communication Profile List []: This pane contains checkboxed Host communication profile names. 
Check boxes (default: LAN (TCP) and TCP/IP checked) to enable communication profiles when the Host 
starts communicating.
New: Click this button to display the Communication Profile Edit window to create a communication 
profile.
Edit: Select in the pane a communication profile to highlight it and click this button to display the 
Communication Profile Edit window to edit it.
Delete: Select in the pane a communication profile and click this button to delete it.

Note: To apply changes to enabled communication profiles, you must restart the Host, see Action Menu 
or Action Buttons.

4.4.6 Modem Database
Select the NetOp Host Window Tools Menu Modem Database command to display the Modem window, 
see Modem Database.

Note: The modem database is common to all NetOp modules. Therefore, the Modem Database section is 
included in the Common Tools chapter.

4.4.7 Check for New Updates
Select the NetOp Host Window Tools Menu Check For New Updates command to connect to the update 
server specified on the Program Options window Web Update Tab to check for any new updates to the 
Host installation and if specified on the Web Update Tab download and install any new updates.
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4.4.8 Debug Trace
This command is normally not included in the NetOp Host Window Tools Menu. To add it, in the Help 
Menu select About... to display the About NetOp Remote Control Host window. Press ALT+Z to add the 
Debug Trace command to the Tools Menu.
Select Debug Trace to save a debug trace of recent communication. This debug trace may be requested 
by NetOp support to troubleshoot communication problems. This window will  be displayed:

This window will display where the debug trace is saved.
Yes: Click this button to display the debug trace.
No: Click this button to close the window without displaying the debug trace.

Note: The NetOp debug trace is a plain text file that records recent NetOp communication events. 
Its interpretation requires special NetOp expertise.

4.4.9 Run Setup Wizard
Select the NetOp Host Window Tools Menu Run Setup Wizard command to run the Setup Wizard to 
change Host setup in a guided dialog.

4.5 Host Sessions
NetOp Guest can connect to NetOp Host to run one or multiple simultaneous sessions with it.
When a Guest is connected, the NetOp Host Window will appear like this:

Its Title Bar will display Connected and if selected in the Program Options window Connection 
Notification Tab During connection section the name of the Guest that has keyboard and mouse control 
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in square brackets. If multiple Guests are connected, +1, +2, etc. will indicate the number of additional 
connected Guests.
Among the toolbar Session Buttons, the Disconnect, Chat and Audio Chat buttons will be enabled 
(colored) and the Request help and Cancel help buttons will be disabled (gray).
Connected will also be displayed in the General Tab Status field, on the Windows taskbar NetOp Host 
button and tooltip and in the notification area NetOp Host Button tooltip.
 If a Guest is connected in a session, the NetOp Host Button will have double corner lines. Right-click it 
to display this menu:
NetOp Host Button Connected Menu

Restore/Show to History List: See NetOp Host Button.
Disconnect: If one Guest is connected, this command does not expand. Select it or the matching Session 
Menu command or click the matching Toolbar Session Buttons button to disconnect.
If multiple Guests are connected, this command will expand into these commands:

All: Select this command or the Session Menu Disconnect command or the matching Toolbar 
Session Buttons button to disconnect all connected Guests.
<Guest name>: Select this command to disconnect only the selected Guest.

Suspend Connect: Select this command to checkmark it to deny further Guest connections (default: 
uncheckmarked). Select the checkmarked command to uncheckmark it to allow further Guest 
connections.
Chat: If one Guest is connected, this command does not expand. Select it or the matching Host window 
Session Menu command or click the matching Toolbar Session Buttons button to start a Chat session 
with the Guest.
If multiple Guests are connected, this command will expand into these commands:

All: Select this command or the matching Session Menu Chat command or the matching Toolbar 
Session Buttons button to start a Multi Chat session with all connected Guests.
<Guest name>: Select this command to start a Chat session with only this Guest.

Request Audio-Video Chat: Select this command or the matching Session Menu command or click the 
matching Toolbar Session Buttons button to start an Audio-Video Chat session with the Guest that has 
keyboard and mouse control.
Pass Control...: This command will be included only if multiple Guests are connected. It expands into  
connected Guest name commands. The keyboard and mouse control Guest name command will be 
checkmarked and disabled. Select another Guest name command to pass keyboard and mouse control to 
this Guest making its command the one that is checkmarked and disabled.
These session types are available:

Remote Control
File Transfer
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Chat
Audio-Video Chat
Remote Management

4.5.1 Remote Control
If allowed by Guest Access Security, NetOp Guest can start and end a Remote Control session that will 
display the Host computer screen image on the Guest computer screen. The Host computer user can end a 
remote control session only by disconnecting by the Session Menu or NetOp Host Button Connected 
Menu Disconnect command or the matching Session Buttons button.
If the Program Options window General Tab Allow multiple simultaneous Guest sessions box is checked, 
multiple Guests can take part in a multi Guest Remote Control session. One Guest at a time can have 
keyboard and mouse control on the Host computer screen. Its name can be displayed in the Title Bar. You 
can Pass Control from one Guest to another from the NetOp Host Button Connected Menu.
No window will be displayed on the Host computer screen. The Host computer user and the keyboard and 
mouse control Guest computer user can work on the Host computer screen at the same time, by default 
with the same options.
Guest user remote control options include sending keystroke commands, managing a multi Guest session, 
sending, receiving and saving clipboard content, displaying NetOp Marker Utility on the Host computer 
screen, disabling the Host computer keyboard and mouse and blanking the Host screen to make it appear 
black to the Host user.
Host Guest Access Security can limit the remote control privileges allowed to a Guest.
4.5.2 File Transfer
If allowed by Guest Access Security, NetOp Guest can start and end a File Transfer session to enable the 
Guest computer user to transfer files between the Guest computer and the Host computer. The Host 
computer user can end a file transfer session only by disconnecting by the Session Menu or NetOp Host 
Button Connected Menu Disconnect command or the matching Session Buttons button.
If the Program Options window General Tab Allow multiple simultaneous Guest sessions box is checked, 
multiple Guests can run a File Transfer session at the same time.
No window will be displayed on the Host computer screen. To view what is happening during a file 
transfer session, select the View Menu File transfer status command to display this window:
356



4 NetOp Host
File Transfer Status

The pane will display browsed Host computer directories and received and deleted files.
To display this window when a file transfer session is started, check the Program Options window 
General Tab Show file transfer status box.
Guest Access Security on the Host can limit the file transfer privileges allowed to a Guest.
4.5.3 Chat
If allowed by Guest Access Security, NetOp Guest can start and end a chat session to enable typed text 
communication between the Guest computer user and the Host computer user. The Host can start and end 
a chat session only with connected Guests from the Session Menu or NetOp Host Button Connected 
Menu Chat command or the matching Session Buttons button.
If the Program Options window General Tab Allow multiple simultaneous Guest sessions box is checked, 
multiple Guests can run a joint multi Chat session with one Host. If multiple Guests are connected, 
selecting the Session Menu Chat command or the NetOp Host Button Connected Menu Chat > All 
command or clicking the Session Buttons Chat button will start a chat session with all connected Guests. 
From the NetOp Host Button Connected Menu, you can start a chat session with a connected Guest.
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This window will be displayed:

A similar window will be displayed on participating Guest computer screens.
Dialog: []: This pane displays the chat dialog with each contribution preceded by a sender identification.
Enter Chat contribution and click Send: [][Send]: Specify your contribution in the pane and click Send to 
send it to the other participants.
Font...: Click this button to display the Windows Font window to specify the font of your contribution 
before sending it.
End chat: Click this button to end the chat session. To exclude a Guest from a multi Chat session, select 
its checkmarked command in the NetOp Host Button Connected Menu Chat command submenu. Guest 
participants can withdraw from a multi Chat session. A Guest that has keyboard and mouse control can 
end a multi Chat session.
Save...: Click this button to display a Windows Save As window that suggests to save the dialog in your 
personal directory as a rtf Chat file identified by the current date and time.
4.5.4 Audio-Video Chat
If allowed by Guest Access Security, NetOp Guest can start and end an Audio-Video Chat session to 
enable sound and image communication between the Guest computer user and the Host computer user. 
The Host computer user can start and end an audio-video chat session only with a connected Guest that 
has keyboard and mouse control from the Session Menu or NetOp Host Button Connected Menu Audio-
Video Chat command or the matching Session Buttons button.
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Note: Each Guest and each Host can at the same time run only one audio session including Transfer 
Sound, see Remote Control. If a module is busy with an audio session, audio and audio-video commands 
and buttons will be disabled on the module and on a connected module.

This window will be displayed:
Audio-Video Chat

A similar window with toolbar button controls will be displayed on the Guest computer screen. The 
Guest computer user can enable/disable audio and video, resize the Guest and Host Audio-Video Chat 
window to accommodate a large, medium or small remote video frame and end the session. The Host 
computer user can end the session only by disconnecting.
In the Remote section, the video frame  will display the remote computer video camera image. If video 
communication is disabled, the frame will display No Video. If no camera runs on the remote computer, 
the frame will display No Camera.
In the Local section, the video frame  will display the local computer video camera image. If video 
communication is disabled, the frame will display No Video. If no camera runs on the local computer, the 
frame will display No Camera.
The lower right Volume section has two slides and a display:
• Drag the left  loudspeaker slide to adjust the playback volume (default: maximum).
• Drag the middle microphone slide to adjust the recording volume (default: maximum).
• The right microphone display will monitor the recording volume. The display should remain empty 

while not talking. Colored blocks should partly but not completely fill the display while talking.
Specify audio-video chat options on the Guest Program Options window Audio-Video Chat Tab and the 
Host Program Options window Audio-Video Chat Tab.
4.5.5 Remote Management
If allowed by Guest Access Security, NetOp Guest can start and end a Remote Management session to 
enable the Guest computer user to access a range of Host computer management tools. The Host 
computer user can end a remote management session only by disconnecting by the Session Menu or 
NetOp Host Button Connected Menu Disconnect command or the matching Session Buttons button.
If the Program Options window General Tab Allow multiple simultaneous Guest sessions box is checked, 
multiple Guests can run a Remote Management session at the same time.
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No window will be displayed on the Host computer screen.

4.6 Host Actions
A Host can Request Help from Guests that offer help services.
A Guest can execute these actions on a Host computer:
• Run Program
• Execute Command
• NetOp Message
• Monitor
• Get Inventory
4.6.1 Request Help
The Host user can request help from a Guest that offers help services if the Host status is Running, see 
Title Bar.
Select the Session Menu, NetOp Host Button Menu or NetOp Help Request Button Request Help 
command or click the matching Toolbar Session Buttons button to request help. The command or button 
will be enabled if on the Program Options window Help Request Tab one of the Enable help service or 
Enable service tickets boxes is checked.
If the help request is fully specified on the Program Options window Help Request Tab and the specified 
help service responds, the help request will be delivered.
If on the Program Options window Help Request Tab the Use Current Host Communication Profile(s) 
option is selected  and other than networking communication profiles are enabled, this window will be 
displayed:

Select Help Request Communication Profile

The pane will display <Any initialized communication> and enabled communication profiles. Select 
<Any initialized communication> to use all enabled networking communication profiles or select a 
communication profile.
The field will become enabled if you select a point-to-point communication profile in the pane. 
Specify the telephone number or IP address to connect to.
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If a communication profile using the TCP/IP communication device will be used for the help request and 
both of the Program Options window Help Request Tab Enable help service and Enable service tickets 
boxes are checked, this window will be displayed:

Select one of these options:

~Use help service to search for help providers: Request help from a help service.

{Use service ticket to connect to a specific help provider: Enable these fields to request help 
by a received service ticket number:

Service ticket: []: In this field, specify the service ticket number.
Problem description: []: In this field, you can describe your problem.

Note: A NetOp on Demand Guest can issue service ticket numbers. The Guest user can 
forward a service ticket number to you to enable you to return a help request.
If only Enable service tickets is checked on the Help Request Tab, this window will display 
only enabled service ticket fields.

If  a point-to-point communication profile is selected but no telephone number or IP address has been 
specified, this window will be displayed:

Connect to Help Provider

Specify in the field the telephone number or IP address to connect to.
If the help request must pass through a NetOp Gateway, Gateway security may request logon credentials. 
One of these windows can be displayed:
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• The Shared NetOp Authentication window:

Password []: Specify the Gateway security password.
• The Individual NetOp Authentication window:

Guest ID: []: Specify a Gateway security recognized Guest ID.
Password: []: Specify the matching password.

• The Windows Authentication window:

Login name: []: Specify a Gateway security recognized Windows user name.
Password: []: Specify the matching Windows logon password.
Domain: []: Specify the matching domain.

If the requested Gateway credentials were specified in the Program Options window Help Request Tab 
Advanced Help Request Options window, no logon window will be displayed.
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Note: To browse for help providers beyond the local network segment, use the IP Broadcast List or 
NetOp Name Server, see Advanced TCP/IP Configuration.

If no help service responds, a message will be displayed.
If help services respond and no Problem description and/or no Help provider has been specified on the 
Program Options window Help Request Tab, this window will be displayed:

Help Providers

The field will display any problem description specified on the Program Options window Help 
Request Tab. You can edit a problem description or specify one.
The pane will display responding help services. Select one.
Select: Click this button to request help from the selected help service.

When the help request has been delivered, Request Help will become disabled and Cancel Help will 
become enabled. The NetOp Host Window Title Bar will display Help Requested to indicate that a help 
request is pending.
The help providing Guest user will be notified of the pending help request and will typically respond to it 
by starting a Remote Control session.
Select or click Cancel Help to cancel a pending help request. A pending help request may be cancelled by 
timeout if not responded to, see Advanced Help Request Options. If the Host is restarted or a Guest 
connects, a pending help request will be cancelled.

Note: You can request and cancel help by a command, see Loading Alternatives.

4.6.2 Run Program
If allowed by Guest Access Security, NetOp Guest can run a program on the Host computer, see Run 
Program.
If the program runs in a window, it will be displayed on the Host computer screen to enable the Host user 
to access it. Otherwise, nothing will display on the Host computer screen.
4.6.3 Execute Command
If allowed by Guest Access Security, NetOp Guest can execute these system control commands on the 
Host computer, see Execute Command:
• Log off: Log off the Host computer user from Windows.
• Restart: Restart the Host computer.
• Shut down: Shut down the Host computer.
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• Lock computer: Lock the Host computer to enable the logged on user or an administrator to unlock 
it.

• Wake on LAN: Start a Host computer equipped with a Wake on LAN network card.
4.6.4 NetOp Message
If allowed by Guest Access Security, NetOp Guest can send a NetOp message that will display like this 
on the Host computer screen:
Message

This window contains these elements:
• Title Bar
• Menu Bar
• Toolbar
• Message Pane
• Status Bar
4.6.4.1 Title Bar

Title bar window controls are explained in Window Control.
The title bar and the automatically saved message file will identify the message by its sender name, date 
and time.
4.6.4.2 Menu Bar
The Message window menu bar:

contains these menus:
• File Menu
• Edit Menu
• Search Menu
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4.6.4.2.1 File Menu

This is the Message window File menu:

Save As...: Select this command to display a Windows Save As window that specifies Save as type: RTF 
files (*.RTF) to save the message content in a rich text format file.

Note: Files of received message content will automatically be saved in the NetOp Configuration Files 
Messages directory that typically resides in the directory C:\Documents and Settings\All 
Users\Application Data\Danware Data\NetOp Remote Control\Host.
Records of files in this directory will be displayed on the NetOp Host Window Messages Tab.

Print...: Select this command or click the Toolbar Print button to display a Windows Print window to 
print the Message Pane content.
Close: Select this command or matching Window Controls to close the Message window.
4.6.4.2.2 Edit Menu

This is the Message window Edit menu:

Copy: Select text in the Message Pane and select this command, click the Toolbar Copy button or press 
CTRL+C to copy selected text to the clipboard.
4.6.4.2.3 Search Menu

This is the Message window Search menu:

Find...: Select this command or click the Toolbar Find button to display a Windows Find window to 
search for a specified text string in the Message Pane.
Next: Select this command or press F3 to highlight the next occurrence of the text string specified in the 
Find window.
4.6.4.3 Toolbar
The Message window toolbar:
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contains these buttons:

4.6.4.4 Message Pane
This is the Message window message pane:

Drag the Message window borders to resize the message pane. 
You can print message pane content from the File Menu Print command or the matching Toolbar button.
You can copy message pane content from the Edit Menu Copy command or the matching Toolbar button. 
You can search message pane content from the Search Menu Find command or the matching Toolbar 
button.
4.6.4.5 Status Bar
This is the Message window status bar:

It has no functionality.
4.6.5 Monitor
If Guest Access Security allows Remote Control, NetOp Guest can sequentially monitor the screen 
images of multiple Hosts and switch between monitor mode and Remote Control mode.
On the Host, each monitoring will appear like a short Remote Control session.
4.6.6 Get Inventory
If allowed by Guest Access Security, NetOp Guest can generate, retrieve and copy an inventory of Host 
computer hardware and software.
No window will be displayed on the Host computer screen.

Print: Click this button or select the File Menu Print command to display a Windows Print 
window to print the Message Pane content.

Copy: Select text in the Message Pane and click this button, select the Edit Menu Copy command 
or press CTRL+C to copy selected text to the clipboard.

Find: Click this button or select the Search Menu Find command to display a Windows Find 
window to search for a specified text string in the Message Pane.
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5.1 Summary
5.1 Summary
This chapter explains tools that are common to all NetOp Remote Control modules.
It contains these main sections:
• Communication Devices
• Modem Database and Dialog
• NetOp Log
• System Info
• NETOP.INI
• NetOp Configuration Files

5.2 Communication Devices
This section explains NetOp communication devices and how to create, manage and use communication 
profiles.
NetOp uses the term communication device for a NetOp adaptation of a generally available computer 
communication protocol or a NetOp proprietary communication protocol.
NetOp modules use different configurations of communication devices for different communication 
environments. NetOp uses the term communication profile for a named configuration of a 
communication device.
A newly installed NetOp module will include default communication profiles. You may need to edit 
default communication profiles or create communication profiles to achieve communication profiles that 
are optimized for your communication environment.
In the module window Tools Menu Communication Profiles command Communication Profile Setup 
window or the NetOp Guest Window Tab Panel Quick Connect Tab Communication Profile Section, 
click the New or Edit button to display a window like this:
Communication Profile Edit

In this window, you can create or edit a communication profile.
Communication Information
Description of Communication Profile: []: If this window was opened from a New button, this field will 
be empty. If opened from an Edit button, this field will display the selected communication profile name. 
Specify a name or edit it, if desired.

Note: You can create multiple communication profiles using each communication device. Each 
communication profile must have a unique name.
368



5 Common Tools
Communication Device: []: The field of this drop-down box displays the name of the selected 
communication device. The drop-down box list contains these communication devices:
• NetBIOS
• IPX
• ISDN (CAPI)
• Serial
• Windows Modem
• TCP/IP
• TCP/IP (TCP)
• TCP/IP (TCP IPv6)
• RemPCIPX v. 4.3 (Guest only): See IPX
• RemPCNB v. 4.3 (Guest only): See NetBIOS
• Gateway
• Infrared (IrDA)
• Terminal Server (terminal server modules only)
Select a communication device in the list to display it in the field.

�Use Dial-Up Network: This checkbox will be enabled only if a TCP/IP family communication device 
is selected in the Communication Device drop-down box. Check it to expand the window with a Dial-up 
Network Connection section, see TCP/IP (TCP) Communication Profile Edit.
The lower section of the window will contain configuration options for the communication device 
selected in the Communication Device drop-down box field. Options are explained in the sections 
referred to in the list above.

Note: Communication profiles are stored in the NetOp Configuration Files comprof.ndb file that 
typically resides in the directory C:\Documents and Settings\<User name>\Application Data\Danware 
Data\NetOp Remote Control\<Module name>.

5.2.1 NetBIOS
NetBIOS (Network Basic Input/Output System) is a simple networking communication device.

Note: Each communication profile that uses a networking communication device will support multiple 
NetOp connections.

Communication using NetBIOS in its basic mode (in Windows: Microsoft NetBEUI) cannot pass network 
connection elements like routers.
Communication using NetBIOS over IPX or TCP/IP can pass network connection elements.
Communicating modules must use the same NetBIOS mode. Different NetBIOS modes use different 
adapter numbers.
5.2.1.1 NetBIOS Settings
To connect, specify a name by which the destination NetOp module can respond:
• If a Guest connects or browses using the Host name qualifier H::, see the Guest Program Options 

window Host Name Tab, the Host can respond by its enabled NetOp Name and MAC Address type 
names, see the Host Tab Panel Names Tab.

• If a Guest connects or browses using the Host name qualifier U::, see the Guest Program Options 
window Host Name Tab, the Host can respond by its enabled LAN User type name, see the Host Tab 
Panel Names Tab.

• If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see 
the Guest Program Options window Help Request Tab.
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NETOP.INI Settings
These settings can be used in a NETOP.INI file [NetBIOS] Section:

Resources
NetBIOS requires no special resources.
5.2.1.2 NetBIOS Communication Profile Edit

The upper window section is explained in Communication Devices.
The Guest NetBIOS communication device comes in two versions, NetBIOS for communicating with 
Hosts version 5.0+ and RemPCNB v. 4.3 for communicating with RemPC version 4.3. The lower window 
section that is named NetBIOS or RemPC NetBIOS compatibility has the same content:
Adapter number: [] (0-255): Specify in this field the adapter number assigned to the applicable NetBIOS 
mode, see NetBIOS Adapter Numbers.
List...: Click this button to display the NetBIOS Adapter Numbers window.
5.2.1.2.1 NetBIOS Adapter Numbers

In the NetBIOS Communication Profile Edit window NetBIOS/RemPC NetBIOS Compatibility section, 
click List... to display this window:

The pane displays records of available NetBIOS modes in a table with this column content:
• Number: Mode adapter number.

Key Value Explanation
Max_Packet_Size= <Number> <Number> specifies the maximum packet size in bytes. In case of 

communication problems, try specifying the minimum 512.
Rcv_DG_Threads= 1 or 2 Default is 2 (two datagram threads). If this causes problems, try specifying 1.
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• Description: Mode type.
• Version: Software version number.
• Type: Software type.
• Max packet size: Maximum packet size in bytes.
• MAC Address: Network adapter MAC address.

Note: Network mode records will display the true computer network adapter MAC address. NetOp will 
assign random MAC addresses to inapplicable modes such as dial-up. Do not select any such records.

5.2.2 IPX
IPX (Internetwork Packet Exchange) is a Novell networking communication device. IPX is typically 
used in network environments with NetWare servers and clients.

Note: Each communication profile that uses a networking communication device will support multiple 
NetOp connections.

5.2.2.1 IPX Settings
To connect, specify a name by which the destination NetOp module can respond:
• If a Guest connects or browses using the Host name qualifier H::, see the Guest Program Options 

window Host Name Tab, the Host can respond by its enabled NetOp Name and MAC Address type 
names, see the Host Tab Panel Names Tab.

• If a Guest connects or browses using the Host name qualifier U::, see the Guest Program Options 
window Host Name Tab, the Host can respond by its enabled LAN User type name, see the Host Tab 
Panel Names Tab.

• If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see 
the Guest Program Options window Help Request Tab.

NETOP.INI Settings
This setting can be used in a NETOP.INI file [IPX] Section:

Network Numbers
To find the network number for a computer with a known name, type this from a command prompt:
nlist user=<Name> /a (NetWare 4.x) or
userlist /a (NetWare 3.x)
If your computer is attached to a NetWare server that recognizes the name, it will respond with the 
network number in the address field.
Resources
NetOp uses IPX socket 8641 (hexadecimal) when communicating between a Guest and a Host. NetOp 
uses IPX sockets 8186 and 8187 (hexadecimal) when communicating between a Guest and a RemPC. 
Novell has assigned these sockets to NetOp.

Key Value Explanation
Max_Packet_Size= <Number> <Number> specifies the maximum packet size in bytes. In case of 

communication problems, try specifying the minimum 512.
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5.2.2.2 IPX Communication Profile Edit

The upper section of this window is explained in Communication Devices.
The Guest IPX communication device comes in two versions, IPX for communicating with Hosts version 
5.0+ and RemPCIPX v. 4.3 for communicating with RemPC version 4.3. The lower window section that 
is named IPX or RemPC IPX compatibility has the same content:
Novell Networks
Unless a network list has been created, IPX communication will reach only NetOp modules on the local 
network. You can extend communication to remote networks by the options in this section.
Select one of these options:

{Local network only: Communicate with the local network only.

{User defined list of networks: Enables the Network list... button. Click this button to display the 
Novell Network Numbers window.

~Build list of known networks: NetOp will browse to build a network list from information 
published by the router information protocol (RIP) to communicate with the networks on the list 
(default selection).
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5.2.2.2.1 Novell Network Numbers

In the IPX Communication Profile Edit window IPX/RemPC IPX Compatibility section, click Network 
List... to display this window:

Network numbers
The pane will contain the 8-digit hexadecimal network numbers of selected remote networks.
Add...: Click this button to display this window:

Novell Network Number

Enter network number: []: Specify in this field an 8-digit hexadecimal network number or edit it.
Edit...: Select in the pane a network number and click this button to display the Novell Network Number 
window to edit it.
Delete: Select in the pane a network number and click this button to delete it.
5.2.3 ISDN (CAPI)
CAPI (Common Applications Programmer’s Interface) enables ISDN (Integrated Services Digital 
Network) modems connected to each other to negotiate connection parameters.
NetOp Remote Control version 7.0+ supports only the 32 bit version CAPI 2.0.

Note: ISDN (CAPI) is a point-to-point line communication device. Each of the two ISDN channels will 
support only one NetOp connection.

CAPI works with NetOp only if both ends of an ISDN connection support CAPI. 
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ISDN non-CAPI communication that is not compatible with ISDN CAPI communication uses the Serial 
or Windows Modem communication device.
While CAPI 2.0 is compatible with the older 16 bit version CAPI 1.1, by experience we recommend 
using CAPI 2.0 also at the other end of the connection.
5.2.3.1 ISDN (CAPI) Settings
To connect, specify the destination computer ISDN device telephone number.
If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see the 
Guest Program Options window Help Request Tab.
Resources
An ISDN device that supports CAPI 2.0 must be connected to the computer. CAPI must be configured 
and enabled.
5.2.3.2 ISDN (CAPI) Communication Profile Edit

The upper window section is explained in Communication Devices.
The ISDN section that will be displayed if ISDN (CAPI 2.0) is selected in the Communication Device 
drop-down box has this content:
Own number: []: If no other applications use the same ISDN line, leave this field empty. If other 
applications use the same ISDN line, specify in this field that part of your ISDN device telephone number 
that distinguishes the telephone number used by NetOp from telephone numbers used by other 
applications using the same ISDN line. If connecting through a telephone exchange, specify the last 
number of digits that are typically used for internal telephone numbers.
Enable
�Short-hold mode [] s. (10-250): Check this box to suspend the connection during short periods of 
inactivity to reduce telephone charges (default: unchecked). On the Guest, an additional field for 
specifying a short-hold period in the interval 10-250 seconds is available (default: 10).

�Use of 2 B-channels: Check this box to use both B-channels to increase transmission speed (default: 
unchecked).

Note: These options will work only if selected at both ends of the connection.

Wait before call-back: [ ] s. (1-999): Specify in this field a number in the range to wait that number of 
seconds before callback, if applied, to enable the receiving modem to become ready (default: 10).
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ISDN Number Check (Host only)
[] Enable Guest ISDN number check: Check this box to allow only Guests whose modem ISDN 
telephone number is in the Allowed ISDN Numbers window pane to connect to the Host.
Edit allowed ISDN numbers...: Click this button to display the Allowed ISDN Numbers window.
5.2.3.2.1 Allowed ISDN Numbers

In the Host ISDN (CAPI) Communication Profile Edit window ISDN (CAPI) section, click Edit allowed 
ISDN numbers... to display this window:

The pane will display allowed ISDN telephone numbers.
Add...: Click this button to display this window:

Phone Number

Enter phone number: []: Specify in the field a telephone number or edit it.
Edit...: Select a telephone number in the pane and click this button to display the Phone Number window 
to edit it.
Delete: Select a telephone number in the pane and click this button to delete it.
5.2.4 Serial
The Serial communication device enables communication through a modem through a telephone 
connection or a direct cable connection (null modem). This includes analog communication and non-
CAPI ISDN communication.
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Note: Serial is a point-to-point line communication device. Each Serial modem will supports only one 
NetOp connection.

NetOp modem communication requires the same type of modem at both ends of the communication. 
Available modem types are: analog, non-CAPI ISDN and ISDN (CAPI). ISDN (CAPI) communication 
uses the ISDN (CAPI) communication device.
5.2.4.1 Serial Settings
To connect, specify the destination computer modem telephone number.
If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see the 
Guest Program Options window Help Request Tab.
Resources
To communicate using a digital telephone connection, an ISDN modem supporting the AT command set 
must be connected to and installed on the computer at both ends.
To communicate using an analog telephone connection, an analog modem supporting the AT command 
set must be connected to and installed on the computer at both ends.
5.2.4.2 Serial Communication Profile Edit

The upper section of this window is explained in Communication Devices.
The Serial section that will be displayed if Serial is selected in the Communication Device drop-down 
box has this content:
Modem
[] Null Modem (Direct Connection): Check this box only if using a null modem cable connection 
between the Guest modem and the Host modem.
Modem Name: []: The list of this drop-down box will contain the names of modems in the NetOp Modem 
Database. Search the list to find the name of the modem connected to your computer and select it to 
display it in the drop-down box field. If the modem name is not in the list, use the options below in the 
specified order:
1. Download the most recent Modem Database from the NetOp KnowledgeBase to possibly find your 

modem here.
2. Select Hayes Compatible Fast.
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3. Look into the documentation for your modem or visit the website of the supplier of your modem to 
find the modem command strings required by your modem and create a new modem configuration 
applying these modem strings, see the paragraph New Modem... below.

4. Send a support request to NetOp Support. Be sure to include the exact full name of your modem. We 
will endeavour to get back to you as soon as possible with a solution to your problem.

New Modem...: Select a modem in the drop-down list and click this button to display the Modem 
Configuration window to create a modem configuration in the Modem Database based on the selected 
modem.
Edit Modem...: Select a modem in the drop-down list and click this button to display the Modem 
Configuration window to edit the modem configuration. If the button is disabled, you cannot edit the 
selected modem configuration but you can create a modem configuration based on the selected modem 
configuration, see New Modem above.
(Settings)

Note: With some selected modem configurations, only some of the options will be enabled. You cannot 
edit disabled options. If you need to change non-editable options, create a modem configuration, see New 
Modem above.

Com Port: []: The field of this drop-down will display the selected communication port (default: Com 1). 
The drop-down box list will contain the names of serial communication ports on your computer. Select a 
name in the list to display it in the field.
Data Rate: []: The field of this drop-down box will display the selected data rate (default: Default). The 
drop-down box list will contain Default and commonly used data rates. Select a data rate in the list to 
display it in the field. Default selects the default data rate of your modem. Select a data rate that will 
accommodate the data rate of your modem and the modem you want to connect to.
Flow Control: []: The field of this drop-down box will display the selected flow control (default: 
Default). The drop-down box list will contain flow control options available with your modem. Select a 
flow control option in the list to display it in the field. Generally, select RTS/CTS (return to send/clear to 
send).
Dial Type: []: The field of this drop-down box will display the selected dial type (default: Tone). The 
drop-down box list contains the options Tone and Pulse. Select Tone unless you are connected to an old-
fashioned telephone central that supports only pulse dialing.
Wait before call-back: [ ] s. (1-999): Specify in this field a number in the range to wait that number of 
seconds before callback, if applied, to enable the receiving modem to become ready (default: 10).
5.2.5 Windows Modem
The Windows modem communication device (sometimes referred to as TAPI) enables modem 
communication through a telephone connection or a direct cable connection (null modem). This includes 
analog communication and non-CAPI ISDN communication.

Note: Windows modem is a point-to-point line communication device. Each Windows modem will 
support only one NetOp connection.

NetOp modem communication requires the same type of modem at both ends of the communication. 
Available modem types are: analog, non-CAPI ISDN and ISDN (CAPI). ISDN (CAPI) communication 
uses the ISDN (CAPI) communication device.
Configuration
When a NetOp module is loaded for the first time and the Setup Wizard is run, NetOp can automatically 
detect modems installed in Windows and create communication profiles for them in the Communication 
Profile Setup window.
You can create communication profiles for additional Windows modems from the Windows Modem 
Communication Profile Edit window.
Windows modem uses TAPI (Telephony Application Programmer’s Interface) that is commonly used by 
programs to make data/fax/voice calls, including the Windows applets HyperTerminal, Dial-up 
Networking, Phone Dialer, and other Win32 communication applications.
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With some modems, however, the Windows modem configuration does not provide satisfactory NetOp 
communication. Such cases are typically known by NetOp Support that has developed Serial 
communication profiles that work with these modems, see Serial Communication Profile Edit. Serial 
communication profile setup also enables basic modem communication setup and troubleshooting.
5.2.5.1 Windows Modem Settings
Connect
To connect, specify the destination computer modem telephone number.
If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see the 
Guest Program Options window Help Request Tab.
Resources
To communicate using a digital telephone connection, an ISDN modem that supports the AT command 
set must be connected to and installed on the computer at both ends.
To communicate using an analog telephone connection, an analog modem that supports the AT command 
set must be connected to and installed on the computer at both ends.
5.2.5.2 Windows Modem Communication Profile Edit

The upper section of this window is explained in Communication Devices.
The Windows Modem section that will be displayed if Windows Modem is selected in the Communication 
Device drop-down box has this content:
Connect Using: []: The field of this drop-down box displays the selected modem. The drop-down box list 
contains the names of modems recognized by Windows. Select the modem that you want to use for this 
communication profile and edit the Description of Communication Profile name above, if desired. 
Typically, this is all that is required to configure a Windows modem communication profile. However, 
these options are available:
Configure: Click this button to display the Windows <Modem name> Connection Preferences window 
to edit connection preferences.
Dialing Properties: Click this button to display the Windows Phone and Modem Options window 
Dialing Rules tab to select or specify a location.
Add Modem: Click this button to display the Windows Phone and Modem Options window to add a 
Windows modem.
Dialing from: and Calling Card: The Windows selections will be displayed.
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Wait before call-back: [ ] s. (1-999): Specify in this field a number in the range to wait that number of 
seconds before callback, if applied, to enable the receiving modem to become ready (default: 10).
5.2.6 TCP/IP
TCP/IP (Transmission Control Protocol/Internet Protocol) is a suite of network communication 
protocols. It includes among many others UDP (User Datagram Protocol) that is a widely used 
networking protocol. TCP/IP will connect by TCP/IP (UDP) and optionally communicate by TCP/IP 
(TCP) during a session, see Advanced TCP/IP Configuration.

Note: Each communication profile that uses a networking communication device will support multiple 
NetOp connections.

5.2.6.1 TCP/IP Settings
TCP/IP offers three connect options:
• IP Address
• Name Response
• Name Resolution
IP Address
You can connect from Guest to Host by IP address across any IP network including the Internet. The 
Guest send port number must match the Host receive port number, see Advanced TCP/IP Configuration.
If you connect from outside a network protected by a network address translation (NAT) firewall or 
proxy server to a network computer NetOp module, specify the firewall or proxy server public IP address 
with the port number assigned to the network computer, e.g. 192.168.20.51:1234. Ask the firewall or 
proxy server administrator which port number is assigned to a specific network computer.
Name Response
Name response broadcasts a name, the first characters of a name or no name on the network requesting 
NetOp modules with a matching enabled name to respond. These name response options are available:
• If a Guest connects by a name or browses using the Host name qualifier H::, see the Guest Program 

Options window Host Name Tab, the Host can respond by its enabled NetOp Name type name, see 
the Host Tab Panel Names Tab.

• If a Guest connects by a name or browses using the Host name qualifier U::, see the Guest Program 
Options window Host Name Tab, the Host can respond by its enabled LAN User type name, see the 
Host Tab Panel Names Tab.

• If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see 
the Guest Program Options window Help Request Tab.

Note: A TCP/IP broadcast will reach only computers on the local network segment and computers whose 
IP address or DNS name is specified in the communication profile IP Broadcast List.

Name Resolution
Name resolution resolves a specified name into its matching IP address. These name resolution options 
are available:
• Specify the use of NetOp Name Server in the Advanced TCP/IP Configuration window and specify 

the Name Space ID used by the NetOp modules you want to connect to on the Program Options 
window Host Name Tab. Connect by any enabled destination module name, for a Host help request 
a Guest Help service description, see the Guest Program Options window Help Request Tab. NetOp 
Name Server will resolve the name into the matching IP address to connect by it across any IP 
network including the Internet. You can also Browse for Hosts.

• If a Guest connects by a name using the Host name qualifier DNS::, see the Guest Program Options 
window Host Name Tab, a domain name server will interpret the name as a DNS name name and 
attempt to resolve it into a matching IP address for the Guest to connect by it across any IP network 
including the Internet.
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Note: In most cases, if using the Host name qualifier H:: a domain name server will interpret the 
name as a DNS name and attempt to resolve it into a matching IP address.

• If a Guest connects by a name using the Host name qualifier LDAP::, see the Guest Program 
Options window Host Name Tab, the Guest will search directory services specified on the Guest 
Program Options window Directory Services Tab for a user with this name to connect by the 
matching address attribute that is typically an IP address. You can also Browse for Hosts.

Communication Problems
In case of communication problems, first verify that an IP connection is available by from a command 
prompt typing:
PING <NetOp module IP address>

The PING utility will send four data packets that request a reply. If replies are received, an IP connection 
is available.
If an IP connection is available and connectivity problems persist, consult with your network/system 
administrator. As a last resort, submit a support request to NetOp Support.
Resources
TCP/IP uses one port for sending and one port for receiving communication.
By default, NetOp Remote Control uses port number 6502 for sending and receiving.
In special cases, use other port numbers but remember that the Guest send port number must always 
match the Host receive port number and vice versa.
5.2.6.2 TCP/IP Communication Profile Edit

The upper section of this window is explained in Communication Devices.
The TCP/IP section will be displayed if TCP/IP is selected in the Communication Device drop-down box.
The Dial-up network connection section will be displayed if the Use dial-up networking box is checked.
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Dial-up network connection
Dial-up network profile: []: The field of this drop-down box displays the selected profile. The drop-down 
box list contains the names of available profiles. Select a profile in the list to display it in the field to 
connect to a network by this dial-up network profile.
Dialing from and Calling card: The dialing properties of the selected dial-up network profile will be 
displayed.
Configure: Click this button to display the Windows Dial-up Connection window to configure the dial-up 
connection.
Dialing properties: Click this button to display the Windows Phone and Modem Options window to edit 
the dialing properties of the selected dial-up network profile.
Add profile: Click this button to display the Windows Network Connection Wizard to add a dial-up 
network profile.
TCP/IP
Max packet size (MTU): [] (512 – 5146 bytes): Specify in this field the maximum packet size (range 512-
5146, default: 2600).

Note: A high MTU will increase communication speed and a low MTU may contribute to solving 
communication problems.

[] Optimize for Internet communication: Check this box to apply settings (MTU, data compression, etc.) 
optimized for communicating across the Internet.
Advanced...: Click this button to display the Advanced TCP/IP Configuration window.
IP Broadcast List...: Click this button to display the IP Broadcast List window.
5.2.6.2.1 Advanced TCP/IP Configuration

In the TCP/IP Communication Profile Edit window TCP/IP section, click Advanced... to display this 
window:
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Specify IP Address
;Use all available IP addresses: Leave this box checked to use all available IP addresses (default: 
checked). If the computer is connected to the network with multiple IP addresses and only one of them 
shall be used for NetOp communication, uncheck the box to enable the IP address field.
IP address: []: Specify in this field the IP address that shall be used for NetOp communication.
Specify Port Numbers
;Use default port numbers: Leave this box checked to use the default NetOp port number 6502 for 
Receive port and Send port (default: checked).

Note: Port number 1970 is officially registered to NetOp Remote Control. However, port number 6502 is 
the preferred default port number to allow for compatibility with older NetOp versions.

Receive port: If the Use default port numbers box is checked, 6502 will be displayed. If unchecked, by 
default 6502 will be displayed in an enabled field. Edit the number to specify a non-default Receive port 
number in the range 1025-65535.
Send port: If the Use default port numbers box is checked, 6502 will be displayed. If unchecked, by 
default 6502 will be displayed in an enabled field. Edit the number to specify a non-default Send port 
number in the range 1025-65535.

Note: The Guest Send port number must match the Host Receive port number and vice versa in the case 
of a Host help request.

Options
;Use TCP for session if possible: Leave this box checked to connect by TCP/IP but use TCP/IP (TCP) 
for high speed session communication if available on Guest and Host (default: checked).
NetOp Name Server
�Use NetOp Name Server: Check this box to use NetOp Name Server to resolve NetOp names into IP 
addresses (default: unchecked).

Note: Using NetOp Name Server facilitates connecting across large networks including the Internet, see 
the Documentation NetOp Name Management section.

Primary: []: Leave in this field the default name nns1.netop.com of the primary public NetOp Name 
Server on the Internet or specify the IP address or DNS name of a primary NetOp Name Server running 
on your corporate network.
Secondary: []: Leave  in this field the default name nns2.netop.dk of the secondary public NetOp Name 
Server on the Internet or specify the IP address or DNS name of a secondary NetOp Name Server running 
on your corporate network.

�Ignore port information from Name Server: Check this box to replace the connect port number 
received from NetOp Name Server by the port number specified below (default: unchecked).

Note: Some types of firewalls replace network computer port numbers by invalid port numbers to protect 
network computers against connection attempts. In that case, NetOp Name Server will receive, store and 
return invalid connect port numbers that must be replaced by valid connect port numbers.

Use Port: []: Specify in this field the port number that shall replace the connect port number received 
from NetOp Name Server (default: 6502).

Note: You must specify the applicable Name Space ID on the Guest and Host Program Options window 
Host Name Tab.

5.2.6.2.2 IP Broadcast List

In the TCP/IP Communication Profile Edit window TCP/IP section, click IP Broadcast List... to display 
this window:
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IP Broadcast List

Using TCP/IP, a Guest browse for Hosts and a Host help request will broadcast communication that by 
default will reach only computers on the local network segment. To extend broadcasts beyond the local 
network segment, specify in this window the IP addresses, IP address ranges and DNS names that shall be 
reached by broadcasts when using the communication profile from which this window was displayed.

Note: IP Broadcast List listing will not be required if using NetOp Name Server.

Add...: Click this button to display this window:
IP Broadcast List Enter

Enter DNS name or IP Address: []: Specify in this field an IP address, e.g. 192.168.102.57,  an IP 
address range, e.g. 192.168.102.20-192.168.102.30, or a DNS name, e.g. MAIL_SVR, to add it in 
the IP Broadcast List window pane.

Caution: Specifying an IP address range will make each broadcast send a number of data packets 
matching the number of IP addresses in the range. To avoid excessive network traffic, do not specify 
larger IP address ranges than justified.

Edit...: Select in the pane an IP address, an IP address range or a DNS name and click this button to 
display it in the the IP Broadcast List Enter window to edit it.
Delete: Select in the pane an IP address, an IP address range or a DNS name and click this button to 
delete it.

�Disable local subnet broadcast: Check this box to disable local network segment broadcast to 
broadcast data only to the addresses specified in the pane.
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5.2.7 TCP/IP (TCP)
TCP/IP (Transmission Control Protocol/Internet Protocol) is a suite of network communication 
protocols. It includes among many others TCP (Transmission Control Protocol) that is a commonly used 
point-to-point protocol.

Note: TCP/IP (TCP) is a point-to-point network communication device. Each communication profile 
using TCP/IP (TCP) will support only one NetOp connection. However, you can enable multiple TCP/IP 
(TCP) communication profiles.

5.2.7.1 TCP/IP (TCP) Settings
To connect, specify the destination computer IP address.
If you connect from outside a network protected by a network address translation (NAT) firewall or 
proxy server to a network computer NetOp module, specify the firewall or proxy server public IP address 
with the port number assigned to the network computer, e.g. 192.168.20.51:1234. Ask the firewall or 
proxy server administrator which port number is assigned to a specific network computer.
If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see the 
Guest Program Options window Help Request Tab.
Other TCP/IP (TCP) settings are the same as for TCP/IP.
5.2.7.2 TCP/IP (TCP) Communication Profile Edit

The upper section of this window is explained in Communication Devices.

�Use dial-up networking: Check this box to expand the window with the Dial-up network connection 
section, see TCP/IP Communication Profile Edit (default: unchecked).
The TCP section that will be displayed if TCP/IP (TCP) is selected in the Communication Device drop-
down box has this content:

�Optimize for Internet communication: Check this box to apply settings (MTU, data compression, etc.) 
optimized for communicating across the Internet (default: unchecked).

�Encapsulate in HTTP: Check this box to place NetOp session data inside the HTTP protocol to ease 
firewall passage (default: unchecked). This is also known as HTTP-tunnelling.
Advanced...: Click this button to display the Advanced TCP/IP Configuration window. It will contain no 
Options section and its NetOp Name Server section will be disabled.

Note: You can enable multiple TCP/IP (TCP) and TCP/IP communication profiles that specify the same 
IP addresses and port numbers in the Advanced TCP/IP Configuration window. However, the name of 
each communication profile specified in the Description of Communication Profile field must be unique.
When starting a TCP/IP (TCP) session, Winsock will by default allocate an available Receive port 
number and not bind to the Receive port number specified by NetOp for listening.
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To bind session communication to the Receive port number specified by NetOp, apply this NETOP.INI 
file [TCP] Section setting:
[TCP]

BindToRecvPort=True

5.2.8 TCP/IP (TCP IPv6)
TCP/IP (Transmission Control Protocol/Internet Protocol) is a suite of network communication 
protocols. It includes among many others TCP IPv6 (Transmission Control Protocol for Internet Protocol 
version 6) that is a recently introduced point-to-point protocol for 128-bit IP addresses.

Note: TCP/IP (TCP IPv6) is a point-to-point network communication device. Each communication 
profile using TCP/IP (TCP IPv6) supports only one NetOp connection. However, you can enable multiple 
TCP/IP (TCP IPv6) communication profiles.

TCP/IP (TCP IP v6) is applicable only between computers connected to an IPv6 network.
5.2.8.1 TCP/IP (TCP IPv6) Settings
To connect, specify the destination computer IPv6 address.
If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see Help 
Request Tab.
5.2.8.2 TCP/IP (TCP IPv6) Communication Profile Edit

The upper section of this window is explained in Communication Devices.

�Use dial-up networking: Check this box to expand the window with the Dial-up network connection 
section, see TCP/IP Communication Profile Edit (default: unchecked).
The TCP IPv6 section that will be displayed if TCP/IP (TCP IPv6) is selected in the Communication 
Device drop-down box has this content:

�Optimize for Internet communication: Check this box to apply settings (MTU, data compression, etc.) 
optimized for communicating across the Internet.
Advanced...: Click this button to display the Advanced TCP/IP Configuration window. It will contain no 
Options section and its NetOp Name Server section will be disabled.

Note: You can enable multiple TCP/IP (TCP IPv6) communication profiles that specify the same IPv6 
addresses and port numbers in the Advanced TCP/IP Configuration window. However, the name of each 
communication profile specified in the Description of Communication Profile field must be unique.
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5.2.9 Gateway
Gateway is a NetOp proprietary communication device that enables a network NetOp module to connect 
through a local network NetOp Gateway.
5.2.9.1 Gateway Settings
To connect, identify the destination NetOp module according to the communication device used by the 
local network NetOp Gateway to connect.
Resources
To use Gateway, one or multiple outgoing communication enabled NetOp Gateways must run on the 
local network, see the Documentation NetOp Gateway section.
5.2.9.2 Gateway Communication Profile Edit

The upper section of this window is explained in Communication Devices.
The Gateway section that will be displayed when Gateway is selected in the Communication Device 
drop-down box has this content:
Access Gateway via communication profile: []: The field of this drop-down box will display the name of 
the communication profile that connects to the local network NetOp Gateway (default: <Any initialized 
communication>). The drop-down box list contains <Any initialized communication>, available 
networking communication profiles and Terminal Server. Select a communication profile in the list to 
display it in the field.
Select <Any initialized communication> to browse the local network for NetOp Gateway device groups 
using all enabled networking communication profiles. Select another communication profile to browse 
using only this communication profile that does not need to be enabled. Select Terminal Server only if 
your NetOp module resides on a terminal server client.
Gateway device group
Gateway device groups are administrator specified names of available outgoing point-to-point 
communication on NetOp Gateways on the local network.
Select one of these options:

~Use device group: []: Select this option  to specify a device group name in the field (default 
selection).

{Browse for device groups: Select this option to display the Gateway Device Group List window 
when connecting.
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5.2.9.2.1 Gateway Device Group List

When connecting using a Gateway communication profile for which the Browse for Device Groups 
option was selected in the Gateway Communication Profile Edit window, this window will be displayed:

Its pane will display Gateway device groups on the local network.
Select: Select a device group in the pane and click this button to connect by the selected device group.
5.2.10 Infrared (IrDA)
Infrared (IrDA) is a NetOp proprietary communication device that enables communication between 
NetOp modules on two computers that communicate by infrared light.

Note: Infrared (IrDA) is a point-to-point communication device that supports only one NetOp 
connection.

Configuration
Windows Server 2003, XP, 2000, ME and 98 support infrared communication according to the protocols 
and standards of Infrared Data Association (IrDA). Configure infrared communication in Windows.
5.2.10.1 Infrared (IrDA) Settings
To connect, no destination must be specified.
If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see the 
Guest Program Options window Help Request Tab.
Resources
Infrared communication through transmitters pointing towards each other within working distance must 
be established.
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5.2.10.2 Infrared (IrDA) Communication Profile Edit

The upper section of this window is explained in Communication Devices.
The Infrared (IrDA) section that will be displayed when Infrared (IrDA) is selected in the 
Communication Device drop-down box is empty. There are no setting options for the Infrared (IrDA) 
communication device.
5.2.11 Terminal Server
Terminal Server is a NetOp proprietary communication device that enables NetOp modules that run on a 
terminal server to communicate with each other.

Note: Terminal Server is a networking type of communication device that supports multiple NetOp 
connections. Terminal Server will be available only on NetOp modules installed on a terminal server.

5.2.11.1 Terminal Server Settings
To connect, first select a communication profile:
• To communicate with a NetOp module in the terminal server environment, select the Terminal 

Server communication profile.
• To communicate through a NetOp Gateway on the terminal server console with a networking 

communicating NetOp module on a computer on the terminal server network, enable the Terminal 
Server communication profile and select <Any initialized communication> to make the console 
NetOp Gateway route the communication to its enabled networking communication profiles.

• To communicate through a NetOp Gateway on the terminal server console with a NetOp module to 
which you must connect by point-to-point communication, enable the Terminal Server 
communication profile and select a Gateway communication profile.

Then, specify a name by which the destination module can respond and/or a telephone number or IP 
address if a Gateway communication profile was selected:
• If a Guest connects or browses using the Host name qualifier H::, see the Guest Program Options 

window Host Name Tab, the Host can respond by its enabled NetOp Name and MAC Address type 
names, see the Host Tab Panel Names Tab.

• If a Guest connects or browses using the Host name qualifier U::, see the Guest Program Options 
window Host Name Tab, the Host can respond by its enabled LAN User type name, see the Host Tab 
Panel Names Tab.

• If a Host sends a help request, the Guest can respond by its enabled Help service descriptions, see 
the Guest Program Options window Help Request Tab.

• If a Gateway communication profile was selected, specify the destination module or remote NetOp 
Gateway computer telephone number or IP address.

Note: To connect from outside a terminal server environment to a NetOp module running in a terminal 
server client session, connect through the NetOp Gateway running on the terminal server console.
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5.2.11.2 Terminal Server Communication Profile Edit

The upper section of this window is explained in Communication Devices.
The Terminal Server section that will be displayed when Terminal Server is selected in the 
Communication Device drop-down box is empty. There are no setting options for the Terminal Server 
communication device.

5.3 Modem Database and Dialog
This section explains the Modem Database and Modem Dialog associated with the Serial communication 
device.
5.3.1 Modem Database
Select the Tools Menu Modem Database command to display this window:
Modem

In this window, you can access the modem database Serial modem configurations.

Note: The modem database is stored in the NetOp Configuration Files modems.ndb file that typically 
resides in the directory C:\Documents and Settings\<User name>\Application Data\Danware 
Data\NetOp Remote Control\<Module name>.
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In the pane, the first _Modem Database YYYYDDD record specifies the modem database update year and 
day number. You can download and install the newest available update from the NetOp KnowledgeBase 
Download Updates subsection.

Note: Downloading and installing modems.ndb will overwrite your current modems.ndb.

New: Click this button to display the Modem Configuration window to create a modem configuration. To 
base a new modem configuration on an existing modem configuration, select its record before clicking 
the button.
Edit: Select a record in the pane and click this button to display the Modem Configuration window to edit 
the selected record modem configuration.
Delete: Select a record and click this button to delete it. The button will be disabled if the selected record 
cannot be deleted.
5.3.1.1 Modem Configuration
In the Modem window, click New or Edit to display this window:

In this window, you can create or edit a Modem Database modem configuration.

Note: You cannot edit the content of disabled fields. All fields will be enabled if you create a modem 
configuration.

Name: []: This field will be empty if you create a modem configuration. It will display the name of an 
edited modem configuration. Specify a name or edit it, if desired.
Modem command strings
These fields specify the modem AT command strings. Consult with your modem manual or the modem 
manufacturer website to find the AT command strings required by your modem.
Max data rate
The field of this drop-down box displays the selected maximum data rate or a default value. The drop-
down box list contains typical data rates. Select a data rate applicable to your modem and the modem you 
want to connect to.
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Settings
;RTS/CTS Flow control: Typically, leave this box checked to use Return To Send/Clear To Send flow 
control (default: unchecked).

�Ignore carrier signal: Typically, leave this box unchecked (default: unchecked).

5.3.2 Modem Dialog
Select the View Menu Modem dialog command to display this window:

During Serial modem connect and disconnect, the pane of this window will display the communication 
sent by (>>) and received by (<<) your modem. This information will assist you in diagnosing modem 
connectivity problems.

5.4 NetOp Log
Any NetOp module can log selected NetOp events. NetOp events can be logged:
• On the computer in a local NetOp log.
• On NetOp Security Server in the NetOp Log or on an older version NetOp Access Server or NetOp 

Log Server.
• In the Windows event log of the computer and another computer.
• In a management information system.
This section contains these sections:
• Log Setup
• Local NetOp Log
• NetOp Log Events
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5.4.1 Log Setup
Select the Tools Menu Log Setup command to display this window:
Log Setup

This window specifies NetOp log setup on these tabs:
• Log Setup Tab
• NetOp Local Tab
• NetOp Server Tab
• Windows Event Log Tab
• SNMP Traps Tab
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5.4.1.1 Log Setup Tab

This tab specifies logging options.
Log Events
�Log Locally: Check this box to log NetOp events in a log file on the computer (default: unchecked).

�Log on NetOp Server: Check this box to log NetOp events in the NetOp Log of a NetOp Security 
Server or on an older version NetOp Access Server or NetOp Log Server (default: unchecked).

�Log to Windows Event Log: Check this box to log NetOp events in the Windows event log of the 
computer and/or of another Windows Server 2003/XP/2000/NT computer (default: unchecked).

�Log using SNMP Traps: Check this box to log NetOp events by sending SNMP messages to a 
management information system (default: unchecked).
NetOp Security Server has an additional checkbox:

;Act as log server: Leave this box checked to enable logging other NetOp modules’ NetOp events in the 
security database NetOp Log (default: checked).
NetOp Host and extended Hosts have additional checkboxes, fields and drop-down boxes:

�Custom Host Name for All Log Events: Check this box to enable the field and drop-down box below to 
identify logged events by a customized Host name (default: unchecked). The left field specifies the 
customized Host name composed from right drop-down box components and keyboard characters. These 
components are available:
• %A: IP/MAC address
• %I: Host ID
• %C: Computer name
• %L: Windows logon user name
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Select a component in the right drop-down box list to add it in the left field.

�Custom Guest Name for Connection and Session Log Events: Check this box to enable the field and 
drop-down box below to identify Guests engaged in Connection and Session log events by a customized 
name. The left field specifies the customized Guest name composed from right drop-down box 
components and keyboard characters. These components are available:
• %A: IP/MAC address
• %U: Authenticated user name
• %I: Guest ID
• %C: Computer name
• %L: Windows logon user name
Select a component in the right drop-down box list to add it in the left field.
This is an example of a custom Host and Guest name Local NetOp Log:

20031103,14:10,Host1+User1,0,00000,00000,HCON     +, 

20031103,14:10,Host1+User1,1,00000,00000,HSES     +,User2@192.168.1.2

20031103,14:10,Host1+User1,2,00000,00000,HSESRC   +,User2@192.168.1.2

20031103,14:10,Host1+User1,3,00000,00000,HSESFXFER+,User2@192.168.1.2

20031103,14:10,Host1+User1,4,00000,00000,HSESCHAT +,User2@192.168.1.2

20031103,14:10,Host1+User1,5,00000,00000,HSESAUDIO+,User2@192.168.1.2

20031103,14:10,Host1+User1,6,00000,00000,HSESAUDIO-,User2@192.168.1.2

20031103,14:10,Host1+User1,7,00000,00000,HSESCHAT -,User2@192.168.1.2

20031103,14:11,Host1+User1,8,00000,00000,HSESFXFER-,User2@192.168.1.2

20031103,14:11,Host1+User1,9,00000,00000,HSESRC   -,User2@192.168.1.2

20031103,14:11,Host1+User1,10,00000,00000,HSES     -,User2@192.168.1.2

The Host name was customized as %C+%L. The Guest name was customized as %U@%A.
The Host was started and the Guest started a remote control session, a file transfer session, a chat session 
and an audio chat session and ended sessions in reverse order.
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5.4.1.2 NetOp Local Tab

This tab selects which NetOp events shall be logged and specifies the local NetOp log file.
Select Events to view in list
Select one of these options to display checkboxed event names in the Events to log pane to the right:

~View all Events: Display all available events (default selection).

{View Selected: Enable these options:

�Connection: Check this box to display available connection events.

�Session: Check this box to display available session events.

�Action: Check this box to display available action events.

�Security: Check this box to display available security events.

�Configuration: Check this box to display available configuration events.
Events to log: []: This pane displays checkboxed names of events of the types selected to the left. Check 
boxes to select logging of events (default: all unchecked).
Select all: Click this button to check all boxes in the Events to log pane.
Deselect all: Click this button to uncheck all boxes in the Events to log pane.

Note: NetOp log event codes and arguments are tabulated in NetOp Log Events.

Log File

Note: This section will be enabled only if Log Locally is selected on the Log Setup Tab.
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Log file name: []: This field will display the (path and) name of the log file (default: NETOP.LOG). If no 
path is specified, the log file will reside in the NetOp Configuration Files directory, typically 
C:\Documents and Settings\<User name>\Application Data\Danware Data\NetOp Remote 
Control\<Module name>.

;Write to disk for each log entry: Leave this box checked to write each NetOp event to the local NetOp 
log file immediately (default: checked). Uncheck this box to write NetOp events to the local NetOp log 
file when the NetOp module is unloaded, which consumes less processor capacity.

Note: A new local NetOp log file that will be created when the NetOp module is loaded will overwrite an 
old local NetOp log file with the same path and file name.

5.4.1.3 NetOp Server Tab

This tab selects which NetOp events shall be logged and specifies the Host ID of the logging server.
Select Events to view in list
Select one of these options to display checkboxed event names in the Events to log pane to the right:

~View all Events: Display all available events (default selection).

{View Selected: Enable these options:

�Connection: Check this box to display available connection events.

�Session: Check this box to display available session events.

�Action: Check this box to display available action events.

�Security: Check this box to display available security events.

�Configuration: Check this box to display available configuration events.
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Events to log: []: This pane displays checkboxed names of events of the types selected to the left. Check 
boxes to select logging of events (default: all unchecked).
Select all: Click this button to check all boxes in the Events to log pane.
Deselect all: Click this button to uncheck all boxes in the Events to log pane.

Note: NetOp log event codes and arguments are tabulated in NetOp Log Events.

Host ID for Log Server

Note: This section will be enabled only if Log on NetOp Server is selected on the Log Setup Tab.

Specify in this field the Host ID of the NetOp server selected for logging events or click Browse... to 
browse the network for available logging NetOp servers to display this window:

The pane will displays the Host IDs of responding logging NetOp servers.
Select: Select a Host ID in the pane and click this button to display it in the field.

Note: If on a Host or extended Host the Guest Access Security option Use NetOp Security Server has 
been selected, leave the Host ID for Log Server field empty to log in the NetOp Log of the specified 
security server group security database.
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5.4.1.4 Windows Event Log Tab

This tab selects which NetOp events shall be logged and specifies Windows event logs.
Select Events to view in list
Select one of these options to display checkboxed event names in the Events to log pane to the right:

~View all Events: Display all available events (default selection).

{View Selected: Enable these options:

�Connection: Check this box to display available connection events.

�Session: Check this box to display available session events.

�Action: Check this box to display available action events.

�Security: Check this box to display available security events.

�Configuration: Check this box to display available configuration events.
Events to log: []: This pane displays checkboxed names of events of the types selected to the left. Check 
boxes to select logging of events (default: all unchecked).
Select all: Click this button to check all boxes in the Events to log pane.
Deselect all: Click this button to uncheck all boxes in the Events to log pane.

Note: NetOp log event codes and arguments are tabulated in NetOp Log Events.

Use Windows Event Log

Note: This section will be enabled only if Log to Windows Event Log is selected on the Log Setup Tab.
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;Local: Leave this box checked to log NetOp events in the Windows event log of the computer (default: 
checked).

�Remote: []: Check this box to log NetOp events in the Windows event log of a remote Windows 
Server 2003/XP/2000/NT computer (default: unchecked). Specify in the field the Windows name of the 
remote computer.
5.4.1.5 SNMP Traps Tab

This tab selects which NetOp events to log in a management information system.
Select Events to view in list
Select one of these options to display checkboxed event names in the Events to log pane to the right:

~View all Events: Display all available events (default selection).

{View Selected: Enable these options:

�Connection: Check this box to display available connection events.

�Session: Check this box to display available session events.

�Action: Check this box to display available action events.

�Security: Check this box to display available security events.

�Configuration: Check this box to display available configuration events.
Events to log: []: This pane displays checkboxed names of events of the types selected to the left. Check 
boxes to select logging of events (default: all unchecked).
Select all: Click this button to check all boxes in the Events to log pane.
Deselect all: Click this button to uncheck all boxes in the Events to log pane.

Note: NetOp log event codes and arguments are tabulated in NetOp Log Events.

If Log using SNMP Traps has been checked on the Log Setup tab, a Simple Network Management 
Protocol (SNMP) message will be sent each time a selected NetOp event occurs. NetOp SNMP events are 
defined in the Danware.mib file that resides in the directory where the NetOp module is installed.
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5.4.2 Local NetOp Log
The local NetOp log file is a plain text file with text lines that each log a NetOp event.
Events are ordered chronologically. This example from a Guest log illustrates the typical contents of a 
log:

20011009,15:41,Guest1,0,00000,00000,GACTCOMPR+,TCP/IP

20011009,15:41,Guest1,1,00000,00000,GCONCALL  ,192.168.1.3

20011009,15:41,Guest1,2,00000,00000,GSESFXFER+,

20011009,15:42,Guest1,3,00000,00000,*ACTFILE -,C:\test.txt

20011009,15:42,Guest1,4,00000,00000,GSESFXFER-,

20011009,15:42,Guest1,5,00000,00000,GSESRC   -,

20011009,15:42,Guest1,6,00000,00000,GCONHNGUP ,192.168.1.3

20011009,15:42,Guest1,7,00000,00000,GACTCOMPR-,

Note: NetOp log event codes and arguments are tabulated in NetOp Log Events.

Each line contains this information: date, time, NetOp module name, event number, error code 1, error 
code 2, event code, arguments.

Note: Error codes are currently not implemented and should always be 00000.

The log file above recorded these events:
On October 9, 2001 at 15:41 hours the Guest Guest1 enabled the communication profile TCP/IP.
It connected to the Host with the name 192.168.1.3.
It started a file transfer session.
It sent the file C:\test.txt.
Find out yourself what then happened.
5.4.3 NetOp Log Events
This section displays tables of NetOp events in these sections:

Guest NetOp Log Events
Host and Extended Host NetOp Log Events

5.4.3.1 Guest NetOp Log Events
These NetOp events can be logged from a Guest:
Connection
Event Name Event Code Arguments
Con: Call Host GCONCALL Host name
Con: Disconnect Host GCONHNGUP Host name
Con: Connection lost *CONLOST Host name
Con: User authenticated GCONUSER (none)
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Session

Action

Security

Event Name Event Code Arguments
Ses: Remote control started GSESRC   + Host name
Ses: Remote control stopped GSESRC   - Host name
Ses: File transfer started GSESFXFER+ (none)
Ses: File transfer stopped GSESFXFER- (none)
Ses: Chat started GSESCHAT + (none)
Ses: Chat stopped GSESCHAT - (none)
Ses: Audio started GSESAUDIO+ (none)
Ses: Audio stopped GSESAUDIO- (none)
Ses: Remote Management started GSESRM   + Host name
Ses: Remote Management stopped GSESRM   - Host name

Event Name Event Code Arguments
Act: Help service start GACTHLPSV+ (none)
Act: Help service stop GACTHLPSV- (none)
Act: Help request received GACTHLPRQ+ Host name
Act: Help request cancelled GACTHLPRQ- Host name
Act: File received *ACTFILE + File path and name
Act: File Sent *ACTFILE - File path and name
Act: Host Rebooted *ACTBOOT Host name
Act: Session recording started GACTREC  + Recording file path and name
Act: Session recording stopped GACTREC  - Recording file path and name
Act: Windows event logging failed *ACTWIN  ! (none)
Act: SNMP trapping failed *ACTSNMP ! (none)
Act: Received Clipboard *ACTCLPB + (none)
Act: Sent Clipboard *ACTCLPB - (none)
Act: Received Print Job *ACTPRINT+ (none)
Act: Sent Print Job *ACTPRINT- (none)
Act: Communication Profile Started GACTCOMPR+ Communication profile name
Act: Communication Profile Stopped GACTCOMPR- [Communication profile name]
Act: Inventory received GACTINV Host name
Act: Message sent GACTMSG Host name

Event Name Event Code Arguments
Sec: Password rejected *SECPW   ! Host name
Sec: Confirm access denied *SECCA   ! Host name
Sec: Security Server login GSECACSRV+ Logon name
Sec: Security Server log off GSECACSRV- (none)
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Configuration

5.4.3.2 Host and Extended Host NetOp Log Events
These NetOp events can be logged from a Host or extended Host:
Connection

Session

Event Name Event Code Arguments
Cfg: Help service name defined GCFGHLPSV+ Help service name
Cfg: Help service name deleted GCFGHLPSV- Help service name
Cfg: Local logging turned on *CFGLLOC + Log file name
Cfg: Local logging turned off *CFGLLOC - Log file name
Cfg: Local logging filename changed *CFGLFILE* New log file name
Cfg: Server logging turned on *CFGLSRV + Log server name
Cfg: Server logging turned off *CFGLSRV - Log server name
Cfg: Windows event logging turned on *CFGLWIN + If remote: computer name
Cfg: Windows event logging turned off *CFGLWIN - If remote: computer name
Cfg: Sending SNMP traps turned on *CFGLSNMP+ (none)
Cfg: Sending SNMP traps turned off *CFGLSNMP- (none)
Cfg: Security Server password changed GCFGACPW * NetOp Guest ID
Cfg: Web update check *CFGWUCHK Old build, new build, [timeout error]
Cfg: Web update download *CFGWUDL File name, [timeout error]
Cfg: Web update install *CFGWUINST (none)
Cfg: Web update success *CFGWU   * Old build, new build
Cfg: Web update failed *CFGWU   ! Old build, error message

Event Name Event Code Arguments
Con: Host started HCON     + (none)
Con: Host stopped HCON     - (none)
Con: Callback HCONCALLB Callback number
Con: Connection lost *CONLOST (none)
Con: Name Server started HCONNNS  + (none)
Con: Name Server stopped HCONNNS  - (none)
Con: Security Server started HCONNSS  + (none)
Con: Security Server stopped HCONNSS  - (none)
Con: Gateway started HCONGW   + (none)
Con: Gateway stopped HCONGW   - (none)

Event Name Event Code Arguments
Ses: Session started HSES     + Guest name
Ses: Session stopped HSES     - Guest name
Ses: Remote control started HSESRC   + Guest name
Ses: Remote control stopped HSESRC   - Guest name
Ses: File transfer started HSESFXFER+ Guest name
Ses: File transfer stopped HSESFXFER- Guest name
Ses: Chat started HSESCHAT + Guest name
Ses: Chat stopped HSESCHAT - Guest name
Ses: Audio started HSESAUDIO+ Guest name
Ses: Audio stopped HSESAUDIO- Guest name
Ses: Remote Management started HSESRM   + Guest name
Ses: Remote Management stopped HSESRM   - Guest name
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Action

Security

Event Name Event Code Arguments
Act: Help request sent HACTHLPRQ+ Help service name, problem description
Act: Help request cancelled HACTHLPRQ- (none)
Act: File received *ACTFILE + File path and name
Act: File sent *ACTFILE - File path and name
Act: Host reboot *ACTBOOT (none)
Act: Run Program HACTRUN Program name
Act: Execute Command HACTEXE Command name
Act: Windows event logging failed *ACTWIN  ! (none)
Act: SNMP trapping failed *ACTSNMP ! (none)
Act: Received clipboard *ACTCLPB + (none)
Act: Sent clipboard *ACTCLPB - (none)
Act: Received print job *ACTPRINT+ (none)
Act: Sent print job *ACTPRINT- (none)
Act: Keyboard locked HACTKBD  - (none)
Act: Keyboard unlocked HACTKBD  + (none)
Act: Screen blanked HACTSCR  - (none)
Act: Screen unblanked HACTSCR  + (none)
Act: Host user logged off HACTLOFF (none)
Act: Gateway login HACTGW   + Connecting module name
Act: Inventory sent HACTINV Guest name
Act: Message received HACTMSG Guest name

Event Name Event Code Arguments
Sec: Individual security enabled and changed HSECINDIV+ Guest access method
Sec: Individual security disabled HSECINDIV- Guest access method
Sec: Security role added HSECROLE + Security role name
Sec: Security role deleted HSECROLE - Security role name
Sec: Security role changed HSECROLE * Security role name
Sec: Guest added to role HSECGUEST+ Guest name
Sec: Guest deleted from role HSECGUEST- Guest name
Sec: Guest changed in role HSECGUEST* Guest name
Sec: Password enabled HSECPW   + If individual: Guest name
Sec: Password disabled HSECPW   - If individual: Guest name
Sec: Password changed HSECPW   * If individual: Guest name
Sec: Callback enabled (default only) HSECCALLB+ (none)
Sec: Callback disabled (default only) HSECCALLB- (none)
Sec: Callback changed (default only) HSECCALLB* (none)
Sec: Confirm access enabled HSECCA   + If individual: security role name
Sec: Confirm access disabled HSECCA   - If individual: security role name
Sec: Password rejected *SECPW   ! Guest name
Sec: Confirm access denied *SECCA   ! (none)
Sec: Illegal password limit reached HSECPWLIM! (none)
Sec: Timeout limit exceeded HSECTMOUT AC (inactivity), AU (authentication) or CA 

(confirm access).
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5.4 NetOp Log
Configuration
Event Name Event Code Arguments
Cfg: Local logging started *CFGLLOC + Log file name
Cfg: Local logging stopped *CFGLLOC - Log file name
Cfg: Local logging filename changed *CFGLFILE* New log file name
Cfg: Server logging started *CFGLSRV + Log server name
Cfg: Server logging stopped *CFGLSRV - Log server name
Cfg: Windows event logging started *CFGLWIN + If remote: computer name
Cfg: Windows event logging stopped *CFGLWIN - If remote: computer name
Cfg: Sending SNMP traps started *CFGLSNMP+ (none)
Cfg: Sending SNMP traps stopped *CFGLSNMP- (none)
Cfg: Option change: Start at load HCFGOWAIT* ON/OFF
Cfg: Option change: Load with OS HCFGOLOAD* ON/OFF
Cfg: Option change: Minimize at startup HCFGOMIST* ON/OFF
Cfg: Option change: Stealth mode HCFGOSTLT* ON/OFF
Cfg: Option change: Minimize on connection HCFGOMICO* ON/OFF
Cfg: Option change: On top HCFGOTOP * ON/OFF
Cfg: Option change: Show file transfer HCFGOSFX * ON/OFF
Cfg: Option change: Send keep alive HCFGOALIV* ON/OFF
Cfg: Option selected: Boot after disconnect HCFGOBOOT+ (none)
Cfg: Option selected: Logoff after disconnect HCFGOLOGO+ (none)
Cfg: Option selected: Lock after disconnect HCFGOLOCK+ (none)
Cfg: Option selected: Nothing after disconnect HCFGONOTH+ (none)
Cfg: Option change: Naming method HCFGONAME* (none)
Cfg: Option change: Public Host name HCFGOPUBN* ON/OFF
Cfg: Option change: Enable user name HCFGOUSRN* ON/OFF
Cfg: Option change: Connection notification HCFGONOTI* (none)
Cfg: Option change: Help Request description HCFGOHRD * (none)
Cfg: Option change: Help Request provider HCFGOHRP * (none)
Cfg: Option change: Help Request 
communication

HCFGOHRC * (none)

Cfg: Option change: Help Request phone/IP HCFGOHRPI* (none)
Cfg: Option change: Help Request show icon HCFGOHRSI* ON/OFF
Cfg: Option change: Audio full duplex HCFGOAUFD* ON/OFF
Cfg: Option change: Audio silence level HCFGOAUSL* (none)
Cfg: Option change: Audio line hold HCFGOAULH* (none)
Cfg: Option change: Name space ID HCFGONSID* (none)
Cfg: Maintenance requiry changed for Guest HCFGMRQG* (none)
Cfg: Maintenance requiry changed for Gateway HCFGMRQGW* (none)
Cfg: Maintenance requiry changed for other HCFGMRQO * (none)
Cfg: Maintenance requiry changed for exit/stop HCFGMRQEX* (none)
Cfg: Protect files changed HCFGPROTS* (none)
Cfg: Maintenance password changed HCFGMTPW * (none)
Cfg: Guest access allow to changed (default 
only)

HCFGGALLW* (none)

Cfg: MAC/IP address list changed HCFGMACIP* (none)
Cfg: File transfer disable changed HCFGFX   * (none)
Cfg: Security Server group ID changed HCFGSSG  * (none)
Cfg: Web update check *CFGWUCHK Old build, new build, [timeout error]
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Gateway
These NetOp events can be logged from a Gateway:

Cfg: Web update download *CFGWUDL File name, [timeout error]
Cfg: Web update install *CFGWUINST (none)
Cfg: Web update success *CFGWU   * Old build, new build
Cfg: Web update failed *CFGWU   ! Old build, error message

Event Name Event Code Arguments
GW: Gateway access allowed HGW ACCES+ (none)
GW: Gateway callback HGW CALLB Callback number
GW: Gateway callback changed (default only) HGW CALLB* (none)
GW: Gateway callback disabled (default only) HGW CALLB- (none)
GW: Gateway callback enabled (default only) HGW CALLB+ (none)
GW: Gateway group defined HGW GROUP+ Security role name
GW: Gateway group deleted HGW GROUP- Security role name
GW: Gateway Guest added HGW GUEST+ Guest name
GW: Gateway Guest changed HGW GUEST* Guest name
GW: Gateway Guest deleted HGW GUEST- Guest name
GW: Gateway individual security disabled HGW INSEC- (none)
GW: Gateway individual security enabled (and 
changed)

HGW INSEC+ (none)

GW: Gateway NSS GID changed HGW SSGID* (none)
GW: Gateway password changed (default only) HGW PW   * (none)
GW: Gateway password disabled (default only) HGW PW   - (none)
GW: Gateway password enabled (default only) HGW PW   + (none)
GW: Gateway password rejected *SECGWPW ! Connecting module name
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5.5 System Info
In the Help Menu About... command About NetOp Remote Control Guest window, click the System 
info... button to display this window:

This window has two menus, see below, and displays selected system information in three sections:
• The upper section displays summary program and system information.
• The middle section displays summary screen information.
• The lower section displays summary driver information.
Advanced Display Info Menu

Select a command to display detailed information on the current screen display in a Screen Info window.
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Communication Info Menu

This menu contains one command, Net Addresses. Click this command to display this window:

Net Addresses []: This pane displays computer network addresses enabled in NetOp.

Note: Network addresses are enabled in NetOp only when communication profiles using 
networking communication devices are enabled.

5.6 NETOP.INI
When NetOp is installed on a computer for the first time, a file named NETOP.INI will be created in the 
computer operating system directory (C:\Windows or C:\WINNT). 
This file will be read when a NetOp module is installed or loaded on the computer. NETOP.INI contains 
installation and startup information that determines how NetOp modules are installed and loaded.
Typically, you do not need to worry about the NETOP.INI file, but you can edit it to apply certain 
options.
NETOP.INI uses the standard Windows INI file format with sections, keys and values. It is a plain text 
file that can be edited with a standard text editor like Windows Notepad.
The NETOP.INI file can contain these sections:
[INSTALL]: Specifies NetOp installation settings.
[COEXISTENCE]: Specifies settings for running different NetOp modules on a computer at the same 
time.
[GUEST], [HOST], [GATEWAY], [NNS], [NSS]: Specify startup settings for NetOp modules.
[IPX]: Specifies startup settings for the IPX communication device.
[NETBIOS]: Specifies startup settings for the NetBIOS communication device.
[TCP]: Specifies startup settings for the TCP communication device.
[DTL]: Specifies special communication settings.
[AUDIO]: Specifies special audio settings.
Other sections can be included in the NETOP.INI file.

Note: In the NetOp KnowledgeBase, look into the Documentation section NETOP.INI settings 
subsection to view all currently available NETOP.INI setting options.
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5.6 NETOP.INI
5.6.1 [INSTALL] Section
This section that by default is included specifies the installation directories and program folder of the 
most recently installed NetOp programs. These specifications are the default suggestions when 
reinstalling NetOp.
5.6.2 [COEXISTENCE] Section
This section that by default is included specifies settings for replacing one running NetOp module with 
another and running different NetOp modules at the same time.
Low level coexistence allows NetOp Guest to be loaded on a computer running NetOp Host or an 
extended NetOp Host, temporarily suspending NetOp Host, or vice versa. A Host connected to a Guest 
cannot be suspended. Guest connections to Hosts will be disconnected when a running Guest is replaced 
by a Host.
High level coexistence allows a NetOp Guest to run on a computer at the same time as a NetOp Host or 
extended Host.
This section can contain these keys:

COEXIST=<1, 0 or 2>

The default value 1 will enable low level coexistence, the value 0 will disable coexistence and the value 2 
will enable high level coexistence. If the key is missing, coexistence will be disabled.

LOAD_WARNING=<1 or 0>

The default value 1 will displays a warning message when the user attempts low level coexistence. The 
user will have the options to proceed or cancel. The value 0 will display no warning message. If the key is 
missing, a warning message will be displayed.

DEBUG=<0 or 1>

This optional key can be added to display the loader program commands executing in a separate window. 
If the key is missing or its value is set to 0, the loader program window will not be displayed. If the value 
is set to 1, the loader program window will be displayed.

Note: High level coexistence will enable cascading remote control, i.e. a Guest remote controlling a Host 
on a computer that is running a Guest that in turn remote controls another Host. Running a Guest and a 
Host on a computer at the same time requires that they use different communication profiles. If two TCP/
IP communication profiles are used, they must use different receive port numbers.

5.6.3 [GUEST], [HOST], [GATEWAY], [NNS] and [NSS] Sections
You can use these optional sections for specifying non-default locations of configuration and other files 
created and used by NetOp modules, see Other Locations of NetOp Configuration Files. These sections 
and keys can be used:

[GUEST]

DataPath=<Path>, specifying the path to Guest configuration and other files.
HistoryPath=<Path>, specifying the path to Guest history files.
PhonebookPath=<Path>, specifying the path to Guest phonebook files.
RecordPath=<Path>, specifying the path to Guest record files.
ScriptPath=<Path>, specifying the path to Guest script files.

and/or
[HOST]

DataPath=<Path>, specifying the path to Host configuration and other files.
MessagePath=<Path>, specifying the path to Host message files.

and/or
[GATEWAY]

DataPath=<Path>, specifying the path to Gateway configuration and other files.
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MessagePath=<Path>, specifying the path to Gateway message files.
and/or

[NNS]

DataPath=<Path>, specifying the path to Name Server configuration and other files.
MessagePath=<Path>, specifying the path to Name Server message files.

and/or
[NSS]

DataPath=<Path>, specifying the path to Security Server configuration and other files.
MessagePath=<Path>, specifying the path to Security Server message files.

Other keys can be included in the sections.

Note: The [HOST] key ActualBufferReleaseBlock=<Numbers> is information written by the Host 
program to the NETOP.INI file. It is unimportant to the user but can be used by NetOp specialists for 
troubleshooting.

5.6.4 [IPX] Section
This optional section can contain this key:

Max_Packet_Size=<Number>, where <Number> meaning the maximum communication packet 
size in bytes can be set between 512 and 5000.

This setting can be used for solving communication problems, see IPX Settings.
5.6.5 [NetBIOS] Section
This optional section can contain this key:

Max_Packet_Size=<Number>, where <Number> meaning the maximum communication packet 
size in bytes can be set between 512 and 5000.

This setting can be used for solving communication problems, see NetBIOS Settings.
5.6.6 [TCP] Section
This optional section can contain this key:

BindToRecvPort=True

When starting a TCP/IP (TCP) session, Winsock will by default allocate an available Receive port 
number and not bind to the Receive port number specified by NetOp for listening. To bind session 
communication to the Receive port number specified by NetOp, use this key.
5.6.7 [DTL] Section
This optional section can contain this key:

TimeOutTimes=<Number>, where <Number> meaning the number of resends in addition to the 
default 10 that will be applied to get data packets through can be set between 1 and 50.

Setting this key may be necessary when data packets take a long time to get through or get lost.
5.6.8 [AUDIO] Section
This optional section can contain this key:

Sound_Mix=<Sound mix recording mode name>

This key may be necessary on NetOp Host to enable the transfer of Host application sound if the sound 
mix recording mode name of the Host computer audio device (sound card) is different from Wave Out 
Mix, see Tool Buttons.
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5.6.9 Example
For clarification, a sample NETOP.INI file is shown below with explanations to the right.

5.7 NetOp Configuration Files
The setup of NetOp modules is stored in configuration files, typically with the extension ndb (NetOp 
DataBase).
When a NetOp module is installed on a computer, configuration files specifying the installed setup are 
created in the directory where the NetOp module is installed.
When a user loads a NetOp module for the first time after installation, configuration files are copied from 
the directory where the NetOp module is installed to a user configuration directory. 
The Setup Wizard will run for the user to create a customized setup, the settings of which will be written 
to the configuration files in the user configuration directory. 
Directory folders for other NetOp files created by the user will be created in the user configuration 
directory.
NetOp log files created by the user will by default be saved in the user configuration directory.

NETOP.INI file Explanation
[INSTALL] The INSTALL section
DIRECTORY=C:\Program 
Files\Danware Data\NetOp 
Remote Control

The NetOp program files reside in the directory C:\Program 
Files\Danware Data\NetOp Remote Control

FOLDER=NetOp Remote Control The name of the program folder is NetOp Remote Control
[COEXISTENCE] The COEXISTENCE section
COEXIST=1 Low level coexistence shall be enabled
DEBUG=1 Loader program commands shall be displayed
LOAD_WARNING=1 A load warning window shall be displayed
[Guest] The Guest section
DataPath=F:\SHARED\DATA\Guest The Guest configuration files reside in the directory 

F:\SHARED\DATA\Guest
[Host] The Host section
DataPath=F:\SHARED\DATA\Host The Host configuration files reside in the directory 

F:\SHARED\DATA\Host
[IPX] The IPX section
Max_Packet_Size=512 Transmit IPX data in packets not larger than 512 bytes
[NETBIOS] The NETBIOS section
Max_Packet_Size=2500 Transmit NetBIOS data in packets not larger than 2500 bytes
[DTL] The DTL section
TimeOutTimes=10 Add 10 resends to the default 10
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This table gives an overview of NetOp configuration and other files, their default location and content:

The meanings of <Guest>, <Host> and <Gateway> are explained in Default Location of NetOp 
Configuration Files.
When a user changes the setup of a NetOp module during use, changes are written to the configuration 
files in the user configuration directory immediately or when the NetOp module is unloaded.
When a user loads a NetOp module, the configuration files in the user configuration directory are read to 
re-establish the setup that existed when the user last unloaded the NetOp module.
If the user configuration files are write protected or access to the directories in which they reside is 
denied, user setup changes cannot be written to files and will not be retained.
The setup of a NetOp module can be protected by applying a Maintenance Password. Host user 
configuration files can be protected when the Host is running or connected.
If user configuration files are deleted, the user setup of deleted user configuration files will be lost. When 
the module is loaded after deleting user configuration files, a new user setup in new user configuration 
files will be created.
Most ndb files are written in a NetOp proprietary format and cannot be read or edited separately.

File name Default location File contents
Common files:
COMIPLST.NDB <Guest> or <Host> IP broadcast list
COMPROF.NDB <Guest> or <Host> Communication profiles
MODEMS.NDB <Guest> or <Host> Modem database 
NETOP.LOG <Guest> or <Host> Local event log (default name)
Guest files:
INVCUITM.XML <Guest> Inventory custom items
NOWCONF.NDB <Guest> Guest setup
RUNPROG.NDB <Guest> Run program specifications
*.DWC <Guest>\PhBook Phonebook records
*.DWC <Guest>\History History records
*.DWR <Guest>\record Recording records
*.DWS <Guest>\script Scripts
*.XML <Guest>\inventor Host inventories
*.BMP <Guest>\SnapShot Host screen images
NFM.LOG <Guest> File manager log (default name)
NGUESTW.LOG <Guest> Guest debug trace
SCRIPT.LOG <Guest> Script log (default name)
Host and extended Host files:
ANUMLIST.NDB <Host> Allowed ISDN numbers
DIRSERV.NDB <Host> Directory services setup
MACLIST.NDB <Host> Allowed Guest IP or MAC addresses
NHSTCONF.NDB <Host> Host setup
SECUR_DS.NDB <Host> Directory services roles, users and groups
SECUR_NT.NDB <Host> Windows roles, users and groups
SECURITY.NDB <Host> NetOp roles and Guests
*.RTF <Host>\Messages Messages
NHOSTW.LOG <Host> Host debug trace
Gateway files:
GWSCR_NT.NDB <Gateway> Gateway Windows roles, users and groups
GWSCRTY.NDB <Gateway> Gateway NetOp roles and Guests
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5.7 NetOp Configuration Files
5.7.1 Default Location of NetOp Configuration Files
Computer users can set up NetOp modules partly individually if user profiles are implemented on the 
computer and generally if user profiles are not implemented.
User profiles are implemented with Windows NT systems (Windows Server 2003, XP, 2000 and NT), 
and user profiles can be implemented with Windows 9x systems (Windows ME, 98 and 95).
On Windows Server 2003, XP and 2000, user profile directories are typically C:\Documents and 
Settings\<Windows logon user name>.
On Windows NT, user profile directories are typically C:\WINNT\Profiles\<Windows logon user name>. 
On Windows 9x (ME, 98 and 95), user profile directories, if implemented, are typically 
C:\Windows\Profiles\<Windows logon user name>.
By default, user configuration files will reside in the path:
<User profile directory>\Application Data\<NetOp module path>,
where <NetOp module path> is the full path to the directory where the NetOp module is installed. If the 
NetOp module is installed in the C:\Program Files directory, only the path from that directory will be 
used in <NetOp module path>.

Note: Application Data is a hidden folder that will be displayed only if you select to display hidden 
folders.

If user profiles are implemented on a computer, user Guest configuration files will by default reside in the 
profile directory of the user logged on to Windows and will be individual to the user (<Guest>).
If user profiles are implemented on a computer, user Host and extended Host configuration files will by 
default reside in the All Users profile directory and will be general to all users of the computer (<Host> 
and <Gateway>).
If user profiles are not implemented on a computer, user configuration files will by default reside in a 
Config directory in the directory where the NetOp module is installed (<Guest>, <Host> and 
<Gateway>).
5.7.2 Other Locations of NetOp Configuration Files
NetOp configuration files can be placed in another user individual or general location. In that case, these 
keys must exist in the NETOP.INI file:

[GUEST]

DataPath=<Path>

HistoryPath=<Path>

InventoryPath=<Path>

PhonebookPath=<Path>

RecordPath=<Path>

ScriptPath=<Path>

and/or
[HOST]

DataPath=<Path>

MessagePath=<Path>

and/or
[GATEWAY]

DataPath=<Path>

MessagePath=<Path>

and/or
[NNS]

DataPath=<Path>
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MessagePath=<Path>

and/or
[NSS]

DataPath=<Path>

MessagePath=<Path>

- where <Path> is the full path to the directory where user configuration files shall be stored.
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